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Value-Added Reseller (VAR) Language 

Oracle Retail VAR Applications 
The following restrictions and provisions only apply to the programs referred to in this section and 
licensed to you. You acknowledge that the programs may contain third party software (VAR 
applications) licensed to Oracle. Depending upon your product and its version number, the VAR 
applications may include: 

(i) the MicroStrategy Components developed and licensed by MicroStrategy Services Corporation 
(MicroStrategy) of McLean, Virginia to Oracle and imbedded in the MicroStrategy for Oracle Retail 
Data Warehouse and MicroStrategy for Oracle Retail Planning & Optimization applications. 

(ii) the Wavelink component developed and licensed by Wavelink Corporation (Wavelink) of 
Kirkland, Washington, to Oracle and imbedded in Oracle Retail Mobile Store Inventory 
Management. 

(iii) the software component known as Access Via™ licensed by Access Via of Seattle, Washington, 
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You acknowledge and confirm that Oracle grants you use of only the object code of the VAR 
Applications. Oracle will not deliver source code to the VAR Applications to you. Notwithstanding 
any other term or condition of the agreement and this ordering document, you shall not cause or 
permit alteration of any VAR Applications. For purposes of this section, "alteration" refers to all 
alterations, translations, upgrades, enhancements, customizations or modifications of all or any 
portion of the VAR Applications including all reconfigurations, reassembly or reverse assembly, re-
engineering or reverse engineering and recompilations or reverse compilations of the VAR 
Applications or any derivatives of the VAR Applications. You acknowledge that it shall be a breach 
of the agreement to utilize the relationship, and/or confidential information of the VAR 
Applications for purposes of competitive discovery. 

The VAR Applications contain trade secrets of Oracle and Oracle's licensors and Customer shall 
not attempt, cause, or permit the alteration, decompilation, reverse engineering, disassembly or 
other reduction of the VAR Applications to a human perceivable form. Oracle reserves the right to 
replace, with functional equivalent software, any of the VAR Applications in future releases of the 
applicable program. 
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Send Us Your Comments 
Oracle Retail Macro Space Management, Planner Module User Guide, Release 14.1 

 

Oracle welcomes customers' comments and suggestions on the quality and usefulness of 
this document. 

Your feedback is important, and helps us to best meet your needs as a user of our 
products. For example: 

 Are the implementation steps correct and complete? 

 Did you understand the context of the procedures? 

 Did you find any errors in the information? 

 Does the structure of the information help you with your tasks? 

 Do you need different information or graphics? If so, where, and in what format? 

 Are the examples correct? Do you need more examples? 

If you find any errors or have any other suggestions for improvement, then please tell us 
your name, the name of the company who has licensed our products, the title and part 
number of the documentation and the chapter, section, and page number (if available). 

Note: Before sending us your comments, you might like to 
check that you have the latest version of the document and if 
any concerns are already addressed. To do this, access the 
Online Documentation available on the Oracle Technology 
Network Web site. It contains the most current 
Documentation Library plus all documents revised or 
released recently. 

Send your comments to us using the electronic mail address: retail-doc_us@oracle.com 

Please give your name, address, electronic mail address, and telephone number 
(optional). 

If you need assistance with Oracle software, then please contact your support 
representative or Oracle Support Services.  

If you require training or instruction in using Oracle software, then please contact your 
Oracle local office and inquire about our Oracle University offerings. A list of Oracle 
offices is available on our Web site at www.oracle.com. 

http://www.oracle.com/
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Preface 
This guide describes the Macro Space Management user interface. It provides step-by-
step instructions to complete most tasks that can be performed through the user 
interface. 

Audience 
This User Guide is for users and administrators of Oracle Retail Macro Space 
Management. This includes merchandisers, buyers, business analysts, and administrative 
personnel. 

Documentation Accessibility 
For information about Oracle's commitment to accessibility, visit the Oracle Accessibility 
Program website at 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.  

Access to Oracle Support 
Oracle customers that have purchased support have access to electronic support through 
My Oracle Support. For information, visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are 
hearing impaired. 

Related Documents 
For more information, see the following documents: 
 Oracle Retail Macro Space Management Release Notes 

 Oracle Retail Macro Space Management Administration Module User Guide 

 Oracle Retail Macro Space Management Configuration Module User Guide 

 Oracle Retail Macro Space Management Data Importer User Guide 

 Oracle Retail Macro Space Management Fixture Studio User Guide 

 Oracle Retail Macro Space Management Product Studio User Guide 

 Oracle Retail Macro Space Management Report Designer User Guide 
 Oracle Retail Macro Space Management Merchandiser User Guide 

 Oracle Retail Macro Space Management Planner User Guide 

 Oracle Retail In-Store Space Collaboration Release Notes 

 Oracle Retail In-Store Space Collaboration User Guide 

 Oracle Retail In-Store Space Collaboration Mobile User Guide 

 Oracle Retail Macro Space Planning Installation Guide 

 Oracle Retail Macro Space Planning Data Model  

 Oracle Retail Macro Space Planning Security Guide 

  

http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs
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Customer Support 
To contact Oracle Customer Support, access My Oracle Support at the following URL: 

https://support.oracle.com 

When contacting Customer Support, please provide the following: 

 Product version and program/module name 

 Functional and technical description of the problem (include business impact) 

 Detailed step-by-step instructions to re-create 

 Exact error message received 

 Screen shots of each step you take 

Review Patch Documentation 
When you install the application for the first time, you install either a base release (for 
example, 14.1) or a later patch release (for example, 14.1.1). If you are installing the base 
release or additional patch releases, read the documentation for all releases that have 
occurred since the base release before you begin installation. Documentation for patch 
releases can contain critical information related to the base release, as well as information 
about code changes since the base release. 

Improved Process for Oracle Retail Documentation Corrections 
To more quickly address critical corrections to Oracle Retail documentation content, 
Oracle Retail documentation may be republished whenever a critical correction is 
needed. For critical corrections, the republication of an Oracle Retail document may at 
times not be attached to a numbered software release; instead, the Oracle Retail 
document will simply be replaced on the Oracle Technology Network Web site, or, in the 
case of Data Models, to the applicable My Oracle Support Documentation container 
where they reside. 

This process will prevent delays in making critical corrections available to customers. For 
the customer, it means that before you begin installation, you must verify that you have 
the most recent version of the Oracle Retail documentation set. Oracle Retail 
documentation is available on the Oracle Technology Network at the following URL: 
http://www.oracle.com/technetwork/documentation/oracle-retail-100266.html 

An updated version of the applicable Oracle Retail document is indicated by Oracle part 
number, as well  as print date (month and year). An updated version uses the same part 
number, with a higher-numbered suffix. For example, part number E123456-02 is an 
updated version of a document with part number E123456-01. 

If a more recent version of a document is available, that version supersedes all previous 
versions. 

Oracle Retail Documentation on the Oracle Technology Network 
Documentation is packaged with each Oracle Retail product release. Oracle Retail 
product documentation is also available on the following Web site: 
http://www.oracle.com/technetwork/documentation/oracle-retail-100266.html 

(Data Model documents are not available through Oracle Technology Network. These 
documents are packaged with released code, or you can obtain them through My Oracle 
Support.) 

Documentation should be available on this Web site within a month after a product 
release. 

https://support.oracle.com/
http://www.oracle.com/technetwork/documentation/oracle-retail-100266.html
http://www.oracle.com/technetwork/documentation/oracle-retail-100266.html
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Conventions 
Navigate: This is a navigate statement. It tells you how to get to the start of the procedure 
and ends with a screen shot of the starting point and the statement “the Window Name 
window opens.”  
This is a code sample 
 It is used to display examples of code 
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1 
Overview of Macro Space Planning 

Overview of Macro Space Planning 
The Macro Space Planning Application (which includes the Planner and Merchandiser 
modules) is described in the diagram below. 

 

Macro Space Planning 
Macro Space Planning consists of two applications sharing a common database: Macro 
Space Management and In-Store Space Collaboration. Macro Space Management is 
intended for use at headquarters and has functionality not replicated in In-Store Space 
Collaboration. In-Store Space Collaboration is designed to be portable and can be used 
(via the Internet) at stores within a retail organization. ISSC also has an extension - ISSC 
Mobile. 

Macro Space Management 
Macro Space Management consists of two sorts of modules: store planning modules and 
support modules. 

1. Store Planning Modules 

Store Planning can be carried out in Planner (AutoCAD environment) or 
Merchandiser (Virtual Reality environment). Store Manager, used to administer the 
store hierarchy, can be accessed from either Planner or Merchandiser. 

2. Support Modules 

The support modules are used for three main purposes: to configure Macro Space 
Management, to configure the varying libraries of information and to operate batch 
processes.   
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– Configuring Macro Space Management is carried out using the Administration 
module for global changes and the Configuration module for local, user specific 
changes. 

– Libraries of information maintained include the fixture and gondola libraries 
(Fixture Studio), product library (Product Studio) and the planogram library 
(planogram design within the Merchandiser module). 

– Batch tools include Data importer (for bulk import of data) and Report Designer 
(configuring planogram reports for bulk output) 

In-Store Space Collaboration 
In-Store Space Collaboration uses a common database with Macro Space Management. 
ISSC is more portable than MSM and is often deployed to stores to allow store managers 
to become involved in the store planning process. It can also be used to ensure 
compliance with store plans. It has an extension - ISSC Mobile. ISSC Mobile is designed 
for use by store associates allowing them to identify changes in fixturing and 
merchandise in the store the associate works in. 

Differences between Planner and Merchandiser Modules 
Although the Planner and Merchandiser modules can both be used to develop floor 
plans, they have different capabilities. In general Planner is used for 'Macro'  planning, 
while Merchandiser can be used for 'Micro' planning. The differences between the 
modules are briefly outlined below. 

  Planner Merchandiser 

Zones  Can be added, edited and 
deleted. 

 Can be viewed 'read only' 

Fixtures and 
Gondolas 

 Can be accurately positioned 
using standard AutoCAD 
functionality. 

 Shelves generally not shown 
 Position of signage shown, but 

no text/images available. 

 Can be positioned accurately, 
but not as easily as in Planner. 

 Can work with additional 
detail for equipment - shelves 
and pegs for instance. 

 Can see writing/images on 
signage 

Products  Can only be displayed as 
placeholders - no information 
on quantity or position given. 

 Can be shown as display styles 
on fixtures or shelves - giving 
full information on quantity 
and position. 

 Can be associated with images - 
giving a photorealistic 
appearance. 

Planograms  Can only be seen as 
placeholders - with no 
information available on 
quantity or position of shelves 
or merchandise. 

 Planograms can be seen with 
full detail including position 
and quantity of shelves and 
merchandise. 

Key Performance 
Indicators 

 Can be used for zones and 
fixtures. 

 Can be used for zones, fixtures, 
shelves and products. 

Annotation  Fully configurable annotation.  Basic text labeling. 
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  Planner Merchandiser 

Floor Plans 

  

 Can be prepared for printing 
with fixtures toggled to 2D 
form, specified annotation and 
title blocks. 

 Snapshots can be taken, but no 
formal way of outputting floor 
plans exists. 

Retail Operations and the Planner and Merchandiser Modules 
Note: The information below is intended for general 
guidance and should not be interpreted as being a 
recommended solution. 

This section of help gives a high level overview of store planning and how it integrates 
into the rest of the retail planning process. 

 

Note: Boxes coded in blue are Macro Space Planning 
operations. 

The stages in the retail planning process are broadly as follows: 
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Range and Resource Planning 
This is strategic planning and would include such items as identifying the ranges of 
products to be placed in the store, staff and service levels, etc. As a general procedure, 
this would have retail chain wide implications and not be restricted to a single store. 

Category and Assortment Planning 
Again done at a strategic level, this is the process of braking down the product ranges 
into more specific categories then optimizing the products to be offered in each category. 

Store Planning Criteria 
Following on from the Category and Assortment Planning is the need to set criteria for 
how the store is to be planned. This may well be a guidance document based on 
information from sources such as: 

 Business Intelligence - for example from syndicated data, market basket analysis or 
loyalty card programs. 

 Financial Planning - criteria on the product mix required to meet profitability criteria. 

 Space Allocation - sub-dividing the available space in the store into areas for each 
department and category.   

Planogram Design 
Planogram design will also have been carried out, often based on information from 
category management combined with guidelines on visual merchandising. Planograms 
can be of two types: 

 Individual planograms. These are specific designs that are created or updated as 
required by the planogram designer. 

 Master Planograms: these act as placeholders for categories and sub-categories. There 
is a mapping between individual and master planograms.   

Store Planning 
Store planning (more generally called floor planning) can then commence based on the 
supplied criteria. The planograms placed should meet those criteria. Either master or 
individual planograms can be placed. 

Note: Within Macro Space Planning, store planning is 
generally called floor planning. 

Store Plan Validation 
Once planned, the store plan (floor plan) must be validated against a number of criteria. 
These include: 

 Whether planograms have been placed on appropriate fixtures  

 Whether the planogram adjacencies will maximize (for example) impulse buying 

 Whether financial performance criteria will be met. 

If failures occur during validation, the validation process must be halted and the store 
plan revised. 
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Store and Planogram Publishing 
After the store plan (floor plan) has been validated, the store plan and its associated 
planograms can be published. This is the signal for the execution processes to commence. 

Floor Plan Publishing 
Macro Space Management has the capability to publish floor pans using a batch process. 
This is run by a scheduling tool at regular intervals. The floor plans will be published in a 
specified form to a pre-defined location. 

Planogram Publishing 
Macro Space Management also has the capability to publish planogram designs using a 
batch process. This is run by a scheduling tool at regular intervals. The floor plans will be 
published in a specified form to a pre-defined location. 

 If master planograms have been placed, the planogram publishing process will 
identify a specific individual planogram associated with the master planogram and 
publish that individual planogram. 

 If just individual planograms have been placed, those individual planograms will be 
published. 

Note: Using master planograms can reduce the frequency 
that floor plans need to be published. 

Supply Chain Execution 
In order to execute the store plan, equipment, merchandise, signage and promotional 
material will be required. These requirements must be put into the supply chain in time 
for the goods to be delivered to site. 

Store Plan Execution 
At an appropriate date, the store plan has to be put into effect. Using store labor or sub 
contractors, equipment, merchandise and signage must be placed or changed as 
appropriate. 

Performance Measurement 
At an appropriate time, the performance of the store should be examined by means of 
reports and KPIs. This information can be fed back into the Range and Resource Planning 
and Category and Assortment Planning in time for the next cycle of store planning. 

Overview of Store Planning 
Note: The information below is intended for general 
guidance and should not be interpreted as being a 
recommended solution. 

This section of help gives a high level overview of the store planning process. 
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Store Planning Criteria 
The process starts with store planning criteria for other parts of the retail organization. 
These may include: 

 Business Intelligence - for example from syndicated data, market basket analysis or 
loyalty card programs. 

 Financial Planning - criteria on the product mix required to meet profitability criteria. 

 Space Allocation - sub-dividing the available space in the store into areas for each 
department and category.   

This information serves as a set of criteria and constraints that a floor plan must meet 
before it is released for service. 
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Store Manager 
Store Manager is used for the administration of the store planning process. These 
include: 

 Maintaining the Store Hierarchy 

Maintaining the store hierarchy includes adding, editing and deleting stores, floors, 
revision and floor plans as required. 

 Associating Architectural Plans  

Architectural plans are used as underlays for floor plans in order to show the 
position of walls, doors, windows, lighting and services. Associating architectural 
plans is a two-part process, with the second step required when a floor plan is open. 

 Managing Business Processes 

Stores, Floors, Revision and floor plans all go through different stages in their 
business life cycle. For example a store may be at the design stage, in service, closed 
for refurbishment or sold and out of service. 

Floor Planning 
If a new floor plan is to be created, the general stages are as follows: 

Note: Precise details of departmental areas, number and 
types of fixtures and products, performance targets, etc will 
often be specified in the store planning criteria. 

 Assign Architectural Plan 

An architectural plan should already have been associated with the parent floor for 
the floor plan in Store Manager. This can now be assigned to this specific floor plan.   

 Lay Out Zones  

 The next stage is to lay out the zones within the floor plan. These can be used to 
indicate the positions and areas of departments, sub-departments, aisles, etc. This can 
only be done in the Planner module. Zones come in several broad types: 

– Internal Area: There is only one zone of this type in a floor plan. It is used to 
indicate the maximum extents and area used for retail purposes. 

– Department: This type is used to indicate the departments within a retail outlet. 
Any floor plan that is to be viewed in In-Store Space Collaboration must have 
zones of this type for it to open. 

– Other: This type is often used to indicate sub-departments within a main 
department, aisles, etc. 

 Place Fixtures 

 The fixturing can then be laid out. Fixtures can either be placed individually or a 
gondola runs. Fixture placement is generally done in the Planner module because of 
the ability to place the fixtures with great accuracy. After the fixturing has been 
placed, it is often Bay Numbered - this makes it easier for users to identify a specific 
fixture within a floor plan.   

 Place Aisles  

 The next stage is to draw the aisles. These can only be placed in the Planner model 
and allow the aisle to be identified. The direction the aisle is drawn also serves to 
identify the predominant traffic direction. This can be used when placing multi-bay 
planograms that have been designed to be viewed in a specific sequence. 

 Place Products  
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 After the fixtures and aisles are in place, products can be placed. 'Big ticket' i tems can 
be placed as individual products, but the majority of merchandise is placed in the 
form of planograms. 

 Validate Floor Plan  

 After the floor plan has been created, it is next validated to see the layout is 
optimum. Validation can be done using reports and KPIs. Because of the visual 
nature of KPIs these often allow validation to be completed in the least possible time. 
Validation can include: 

– Whether planograms have been placed on appropriate fixtures. 

– Whether the planogram adjacencies will maximize (for example) impulse 
buying. 

– Whether financial performance criteria will be met. 

 If necessary amendments can be made to the floor plan and the new arrangement 
revalidated. 

 Approve for Service 

 The final stage is to approve the floor plan for service. This is done in Store Manager 
by setting the status to Authorized. This enables the Publish and Effective (Current) 
dates to be set. Macro Space Management batch tools can then be used to 
automatically change the floor plan status and publish the floor plan and its 
associated planograms. 

Information Distribution 
When the floor plan has been approved for service, the next stage is to distribute the 
information at the pertinent time. 

 Set Dates 

 When the floor plan has been approved and set to Authorized status, the Publish and 
Effective Dates are set. 

– The Publish Date is when information is distributed in preparation for putting 
the floor plan into service. This date is set far enough in advance of the 
implementation date that all preparations for putting the floor plan into service 
(including ordering equipment and merchandise) can be put in hand. 

– The Effective Date is when the floor plan will be put into service (made current). 
This date will usually be integrated with the retailers strategic planning so that 
the change is made in coordination with promotional and advertising 
campaigns, etc. 

 Run Update Status  

 UpdateStatus.exe is a small Macro Space Management utility that can automatically 
change the status of floor plan. It is generally set to run as a batch process on a 
nightly schedule. When the Publish Date has been met or exceeded, Update Status 
will change the status of the floor plan from Authorized to Published. In most 
implementations this also sets the floor plan to read only status. This prevents 
further changes to the floor plan unless an administrator deliberately overrides this. 

 Auto-Publish Floor Plan  

 Another Macro Space Management application can be scheduled to publish the floor 
plan on the Publish Date. A copy of the specified floor plan (typically in DWF or PDF 
format) will be sent to a pre-defined location. From there the retail chain can make 
arrangements to distribute the information to the store - typically by e-mail. 

 Auto-Publish Planograms 
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 A further Macro Space Management application can be scheduled to publish the 
planograms on the Publish Date. A copy of the specified floor plan (typically in PDF 
or Word format) will be sent to a pre-defined location. From there the retail chain can 
make arrangements to distribute the information to the store - typically by e-mail. 

 Distribute to Supply Chain  
 In parallel with publishing the information, information needs to be sent to the 

supply chain for the equipment, merchandise, signage and promotional material 
needed. This is generally achieved by running reports on the floor plan to identify 
the types and quantities required, then creating the appropriate purchase orders. 

 Run Update Status  

 UpdateStatus.exe executes as a batch process on a nightly schedule. When the 
Effective Date has been met or exceeded, Update Status will change the status of the 
floor plan from Published to Current. In  most implementations this also maintains 
the floor plan at read only status. This prevents further changes to the floor plan 
unless an administrator deliberately overrides this. 

 Simultaneously with update status changing the status of this floor plan to Current, 
any pre-existing Current floor plan for this specific floor will have its status changed 
to Historical. This indicates it has been superseded by a more recent version. 

 Implementing the Floor Plan  

 On the Effective Date, the s tore will know to put the changes into effect. This means 
setting out the fixturing, populating it with merchandise and setting up the signage 
and promotional material. This will require careful planning and allocation of labor. 

Floor Plan Updating 
Once a floor plan has been put into service, it will probably be subject to a series of 
updates. These may vary from changing a number of the planograms on the end caps 
through to remodeling a substantial part of the store. A typical procedure is described 
below: 

 Modify Fixtures 

 The fixtures are modified as required. Typical examples include adding or removing 
display bins from an aisle or changing the widths of several aisles. 

 Manually Update Planograms 

 If the fixturing has been changed, it may be necessary to manually populate the 
modified fixtures with the appropriate planograms. 

 Run Planogram Substitutions  

 Planogram substitutions are an automated way of changing the specified planograms 
in one or more stores. This can be done in several forms including: 

– One to One Substitutions: A planogram is swapped out for one of identical size. 

– One to Many Substitutions: A large planogram is swapped out for several 
smaller ones. 

– Many to One Substitutions: Several smaller planograms are swapped out and 
replaced by a single large one. 

 There are a number of reasons for planogram substitutions. The more common ones 
include: 

– Space Trading: Reducing the space assigned to a poorly performing category and 
increasing the space available to a better performing one. 

– Seasonal Changes: Swapping out seasonal goods; for example changing 
Halloween products for Christmas ones. 
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– Special Offers: Swapping out standard planograms for planograms containing 
products in modified packaging for the special offer. 

 Validate Floor Plan  

– After the floor plan has been created, it is next validated to see the layout is 
optimum. Validation can be done using reports and KPIs and would be similar 
to the exercise carried out when the floor pan was first created. 

Information Distribution 
When the revised floor plan has been approved for service, the next stage is to distribute 
the information at the pertinent time. This follows the same procedure as implementing 
the original floor plan. 

Using Prototype Stores 

Overview of Prototype Stores 
One useful concept in Macro Space Management is that of Prototype Stores. 

 

Prototype Stores are exemplars of a store that has an idealized layout. They may be 
actual stores that are performing better than average. Alternatively they may be 'paper' 
stores that have been designed as guidance for real store layouts. The process is as 
follows: 

1. Store Planning Criteria  

Store planning criteria are received in tabular for. This will be information on 
departmental areas, numbers and types of fixtures and products, suggested product 
adjacencies, etc. 

2. Create and Design Prototype Store 

The planning criteria are then used to design the prototype store. This results in the 
tabular information in the planning criteria being transformed into a series of spatial 
relationships where departments, equipment and merchandise are placed relative to 
each other. After the store plan has been optimized by means of reports and KPIs, it 
is ready for use as a reference. 
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3. Set Store as a Prototype  

The store can then be designated as a prototype by checking the Set as Prototype 
check box in the General tab of the Add/Edit Store dialog box in Store Manager. 

4. Select Prototype Store and Create Floor Plan 

The child store is then associated with its prototype store by selecting the  prototype 
store from the list of those available in the Add/Edit Store dialog box in Store 
Manager. This information is now set in the File Properties dialog box. Any floor 
plans now created can potentially reference the information held on the prototype 
store in the database. This information is: 

– Information in the Properties Window of the Object Browser: The Custom SQL 
supplied with Macro space Planning can be modified to show the quantities in 
the Prototype and Child stores for comparison purposes. 

– Information in the Object Grid: The information supplied in the object grid can 
be customized (Custom SQL) to show only equipment and merchandise in the 
Prototype Store. 

– The Store Comparison tool: This compares the quantities of equipment, 
merchandise categories and planograms in the prototype and its child and 
specifies differences between the two. 

– KPI's and Reports: These can be customized to the client's requirements and can 
be used to look at specific aspects of the floor plan. 

5. Design Floor Plan 

Using the Prototype Store, the child floor plan can then be designed. A typical use of 
the functionality would be to take a prototype store of 30,000 ft2 and create a child 
plan of similar area but different physical layout containing broadly similar 
department sizes and equipment/merchandise placements.   

Note: Information in the Object Browser and Object Grid is 
controlled by SQL statements in the Custom SQL  table in the 
database. Modifying this SQL can change the information 
appearing to customer specific requirements. The code in the 
application has the ability to use specific tags in the Custom 
SQL such as {Fileid}. This allows the code to execute the SQL 
statement with the File ID (FIL_ID) of the currently open floor 
plan in the 'where' clause. 

MSM Batch Processes 
There are certain processes in the store planning process that can be automated and run 
on a regular schedule using a scheduling tool. These are: 

 Data Importer 

 ODI Planogram Importer 

 Automated Calculations 

 Update Status 

 Floor Plan Processing 

 Floor Plan Publishing 

 Planogram Publishing 
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Batch Processes 

Data Importer 

 
Data Importer is a Macro Space Management (MSM) module that allows imports of data 
into the MSM database to be configured and executed. In principle any table (including 
custom information) can be imported into the database and used for reporting purposes. 

ODI Planogram Importer 

 

Oracle Data Integrator (ODI) is another Oracle application. It can be configured to import 
planogram definitions. This requires an XML file to be configured by the retailer in a 
very specific format. This XML file can then be imported into the MSM database by ODI. 

Automated Calculations 
MSM provided a series of automated calculations that can be used to ensure the 
information in the database is current before reports are generated. These calculations 
are: 

 Allocated Areas: Allocating floor area to fixture to take into account the aisles around 
them when generating performance data. 

 Aisle Adjacency: Identifying which fixtures are associated with an aisle. 



 Custom SQL 

 Overview of Macro Space Planning 13 

 Fixture Adjacency: Identifying which fixtures are to the left, right above or below 
each other. 

 Product Adjacency: Identifying which products are to the left right or on the same 
fixture. 

 Face Planes: Calculating the frontal area of each product for performance metrics. 

 Space Measurement: Calculating the volume of each product for performance 
metrics. 

Update Status 
Update Status is a small MSM utility that is capable of changing the status of a store or 
floor plan. This allows dates for actions to be pre-set then automatically executed. This 
utility is typically used by retailers to trigger ordering of the equipment and merchandise 
required to execute a store plan change. 

Floor Plan Processing 
Floor Plan processing enables the user to update a Planner floor plan prior to publishing 
by carrying out items such as synchronization, refreshing annotation or updating 
calculations. 

Floor Plan Publishing 
Floor Plan Publishing enables the user to automatically generate an electronic copy of the 
floor plan and deposit it in a specified directory. From there the retailer can disseminate 
the information to the store. 

Planogram Publishing 
Planogram Publishing enables the user to automatically generate an electronic copy of 
the planograms that will be changed during a reset of a floor plan and deposit it them a 
specified directory. From there the retailer can disseminate the information to the store. 

Custom SQL 

 
 This information is for DBAs and Administrators only. Standard users cannot access the 
database and modify the requisite tables. It is given to indicate that information in a 
number of parts of Macro Space Planning can be customized to meet specific 
requirements. 

Definition of Custom SQL 
The code used in Macro Space Planning has the ability to update SQL statements so they 
are specific to the currently active floor plan, etc, when it executes them. This is an 
addition to Standard SQL and is done by the use of placeholders such as {Fileid} for File 
ID. 

 In Standard SQL, a simple statement would be Select PRODUCT_NAME from PRODUCT 
where FIL_ID = 123 

 Custom SQL is of the form Select PRODUCT_NAME from PRODUCT where FIL_ID = 
{Fileid} 

When the code references the Custom SQL it identifies the placeholder and substitutes 
the File ID of 123 from the currently active floor plan for {Fileid}. This enables the 
application to return a specific sub-set of results for the currently active floor plan, etc. 
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In the screen shot below, a Quick Report is being used in a floor plan to identify the 
planograms that can be placed. The fields that appear can all be customized by a DBA or 
Administrator with the correct permissions in the database. For example, if the 
planograms have User Defined Attributes (UDAs) associated with them, key UDA's 
could be displayed in the Quick Report. Similarly, if this floor plan is associated with a 
prototype store, quantities of planograms in the currently active floor plan could be 
compared with those in the prototype store. 

 

Where Custom SQL Can Be Used 
Custom SQL can be used in the following ways: 

 To populate data into the Properties and Summary Windows in the Object Browser. 

 To populate data into the Object Grid and to specify the filters and sort criteria 
available. 

 To populate data into some of the Find dialog boxes. 

 To specify some of the data for annotation in Planner. 

 To specify data that can be referenced by Title Blocks. 

 To specify the data that will appear in Quick Reports. 

Where Custom SQL is Stored 
The primary repository for Custom SQL is in the Custom SQL table in the database; 
although other tables come into use. The Custom SQL itself is stored in the CSQ_SQL 
field. This can be edited to change the table referenced and fields displayed. Some 
custom SQL can be modified by using the Custom Query dialog box accessed from the 
General menu in the Administration module. 
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Note: See the Oracle Retail Macro Space Planning Data Model 
for more information. 

Overview of Other MSM Modules 
A number of other modules affect the behavior of equipment and merchandise in the 
Planner and Merchandiser modules. These are described briefly below - for more 
information see the help files for the respective modules. 

Note: Users will need the appropriate privileges to access 
these modules. 
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Administration Module 
Access to the Administration module is generally carefully restricted. The settings made 
have a global effect for all users of the Planner and Merchandiser modules. Examples 
include: 

Option Description Planner Merch 

Floor Plan 
Publishing 

How floor plans are published (made available to 
stores for implementation) 

X X 

Planogram 
Publishing 

How planograms are published (made available to 
stores for implementation) 

X X 

Statuses The statuses available to show how far a store, item 
of equipment, item of merchandise, etc, is through its 
business life cycle. 

X X 

Annotation (Text 
Styles) 

How annotation for zones, fixtures, products and 
planograms draws 

X   

Zones The hierarchy of available zones to place in a floor 
plan 

X   

Ranges The list of temperature ranges that can be assigned to 
equipment and merchandise. This affects equipment 
and merchandise when display styles are used. 

  X 

Styles The list of styles that can be assigned to equipment 
and merchandise. This affects equipment and 
merchandise when display styles are used. 

  X 

Planogram 
Substitution 

How to automatically substitute one planogram for 
another in floor plans 

X X 

Data Security  What access rights users have for specific objects 
such as stores or planograms. 

X X 

Title Blocks How a 'frame' of information is added to the floor 
plan before it is published. Information in the title 
block can include store name, floor plan designer's 
name, date of implementation, etc. 

X   
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Configuration Module 
The Configuration Module can be called from the file menu of either the Planner or 
Merchandiser modules. Only four tabs will be available (the full range only being 
available if called from the Administration module). These four tabs affect the behavior 
of the Planner and Merchandiser modules on a user by user basis - the settings do not 
have a global effect. Examples include: 

Option Description Planner Merch 

Zones Tab  How zones are drawn when being added to the 
floor plan. 

 How zones are highlighted in the floor plan. 

X 

X 

  

Fixturing tab  How the Add Fixture dialog box functions 
 How Connection Points function 

 Highlighting of Fixtures 

X 
X 

X 

  
X 

Merchandising Tab  Selection Method for Fixtures 

 Highlighting of Products 

 Checking Planogram Placement Validity  

X 

X 

X 

  

  

X 

Merchandiser tab  Appearance of buildings, equipment and 
merchandise 

  X 

Fixture Studio 
Fixture Studio is another Macro Space Planning module. It is used to configure the 
Fixture and Gondola Hierarchies, together with Fixtures and Gondolas themselves. 
Settings in Fixture Studio affect the behavior of Equipment in the Planner and 
Merchandiser modules. Examples include: 

Option Description Planner Merch 

Insertion height The height at which equipment is inserted in the floor 
plan - a fixture will generally be inserted at floor 
level, a hanging sign 10 feet above it. 

X X 

Connection Points Datum's by which one item of equipment aligns itself 
with another. In Planner, this is only Fixtures; in 
Merchandiser it is fixtures and shelves. 

X X 

Associated 
Equipment 

This is used to specify whether one item of 
equipment can accept another - for example whether 
a fixture will accept shelves. 

  X 

Temperature 
Range 

Compared to the temperature range on the display 
style being placed to determine if it is compatible 
with the equipment it is being placed on. 

  X 

Style Compared to the style of the display style to 
determine if the display style can be placed on a 
specific fixture or shelf. 

  X 

Merchandisable 
Areas 

Determines the volume that merchandise can take up 
on a fixture or shelf. 

  X 
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Product Studio 
Product Studio is another Macro Space Planning module. It is used to hold information 
on the products available for placement in floor plans. This product information can 
either be imported from another database or entered manually. Settings in Product 
Studio affect the behavior of merchandise in the Planner and Merchandiser modules. 
Examples include: 

Option Description Planner Merch 

Product Colors The colors products for merchandiser at different 
levels in the hierarchy can be configured 

X X 

Publish, Effective 
and Expiry Dates 

These specify the dates an item of merchandise is 
available between and what date information will be 
published to users. 

X X 

Temperature 
Range 

Compared to the temperature range on the parent 
fixture or shelf to determine if the display style can be 
placed. 

  X 

Style Compared to the style on the parent fixture or shelf to 
determine if the display style can be placed. 

  X 

Product 
Dimensions 

The size of a specific display style - this will determine 
the number of items that can be inserted on a fixture or 
shelf. 

  X 

Peg Holes Specifies the datum point by which a display style 
hangs from a product or rail. 

  X 

Images Associates an image with a display style that can 
subsequently be displayed in a floor plan. 

  X 

About Synchronization and Adjacencies 
When fixtures, fittings and gondolas are placed on the drawing using MSM tools, they 
are also sent as data to the Macro Space Management central database. If fixtures in the 
drawing are modified with AutoCAD tools, this will change the drawing, but may not 
necessarily update the central database. The process of making sure the AutoCAD 
drawing and the Macro Space Management Central database hold the same information 
is known as synchronization. There are three forms of synchronization: 

 Manual Synchronization 

Manual synchronization is synchronization carried out by the user by invoking the 
functionality from the menu bar or Retail toolbar. 

 Dynamic Synchronization 

Dynamic Synchronization can be turned on or off by the user. If turned on, many of 
the changes made by AutoCAD tools are simultaneously written back to the 
database. 

 Auto-Synchronization 

Auto-Synchronization is used when changes have been made to the database by 
work carried out in the Merchandiser module, in In-Store Space Collaboration or by 
Batch tools. If active, when a floor plan is subsequently opened in Planner, the 
required updates will be made to the floor plan. Dependent on settings; confirmation 
may be required from the user first. 



 About Synchronization and Adjacencies 

 Overview of Macro Space Planning 19 

Whether a user will need to manually perform synchronization before calculating 
adjacencies will depend on the synchronization operations chosen. The example below 
shows the process for when dynamic and auto-synchronization are off. 

 

After the drawing has been synchronized with the central database, the Adjacency 
calculations can be run. 

Fixture Adjacency calculations establish the physical relationship of one fixture to 
another. 

These relationships are used for both bay numbering and as the basis for subsequent 
Product Adjacency calculations. 

Product Adjacency calculations establish the relationship of one type of product to 
another. They cannot be run until the Fixture Adjacencies have been calculated. 
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2 
Logging In 

How Passwords and Privileges are Configured 
Passwords and privileges are configured in Macro Space Management's Administration 
module. 

Note: Access to the Administration Module is normally 
restricted to a limited number of users. This is because the 
Administration Module can be used to set a wide variety of 
parameters affecting how Macro Space Planning operates.   

Access rights to the Macro Space Management modules are set using the Functional 
Security option. 

 
Users are assigned to User Groups in the User Groups Tab. Which modules a User Group 
can access is specified in the Group Relationships tab. A user's privileges thus depend on 
what user groups they are assigned to. 
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In the above example, User 1 is only a member of the Equipment Planner user group. 
Accordingly, their access is restricted to the Fixture Studio and Planner modules. User 2 
is a member of the Equipment Planner and Merchandiser Planner user groups. They 
have wider access and can use the Fixture Studio, Planner, Product Studio and 
Merchandiser modules. 

Logging in to Macro Space Management Modules 
When a user first attempts to access a Macro Space Management module, the Log In 
dialog box will appear. 

 
This requires the user to enter a User Name and Password. If these are correct, the user 
will be able to access the desired module. After the initial log in, information will be held 
in Security Server. Users will therefore be able to access all other Macro Space 
Management modules they have permissions for without the need to log in again. If the 
user enters an incorrect user name or password, a warning will result. 

 
If the user attempts to log into a module for which they do not have permissions for, a 
warning will appear and the log in attempt will be terminated. 

Note: The permissions for which modules can be accessed 
are configured in the Administration module. 
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Password Changes 
Macro Space Management can be configured to require password changes at specified 
intervals. If one of these intervals has been exceeded, the user will be asked to change 
their password the next time they log in. This can be done by means of the Change 
Password >>> option on the Log In dialog box. This will reveal another part of the 
dialog box where the changed password can be entered and confirmed. 

 

Security Server 
Security Server is a Macro Space Management process that runs in the background and 
is normally not visible to users. When running, it can be seen in the Processes tab of 
Windows Task Manager as the AVT5SecurityServer.exe *32 process. 

 
How Security Server operates is shown in the following flowchart. 
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1. The user opens a Macro Space Management module from a shortcut or the Windows 
start menu. 

2. Security server starts but remains in the background. 

3. The Log In dialog box appears. 

4. The user types their user name and password into the Log In dialog box. 

5. Security Server validates the user name and password against the information held 
in the database. If they are correct and the user has sufficient privileges, the Macro 
Space Management module opens. 

6. Security Server holds information on what other privileges the user has in Macro 
Space Management. 

7. If the user attempts to access other modules, Security Server will check the 
information it holds and allow or deny access as required. This means that a user 
only has to log into Macro Space Management once per session. 

8. When the user exits the last Macro Space Management module, Security Server also 
closes. 

Security Server and Application Errors 
On occasion a Macro Space Management module might encounter a significant error and 
automatically close. Because the closure was not user initiated, Security Server does not 
close but remains open in the background. If the module that unexpectedly closed is 
reopened, Security Server will contain information incompatible with the restart and 
further application errors will result. 

In the event of a Macro Space Management module failing unexpectedly, carry out the 
following actions: 

1. Save the information in any other Macro Space Management modules that are open 
and close those modules. 

2. Open Windows Task Manager, select the Processes tab, highlight the 
AVT5SecurityServer.exe *32 process and click End Task. 

3. When Security Server has closed, the required Macro Space Management modules 
can be restarted. 
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3 
Object Browser 

About the Object Browser 
The Object Browser offers Macro Space Management users a single point of access to the 
Zone, Fixture, Product, and Planogram libraries and the Key Performance Indicators 
(KPI’s).   It is found in both the Planner and Merchandiser environments but is slightly 
different in each application.  This section of help is specific to the Object Browser in 
Merchandiser. The Object Browser can also be used in conjunction with the Object Grid - 
see the section on the Object Grid for more information. 

 
The Object Browser can be turned off by clicking on the ‘x’ in the upper right corner. It 
can be opened by selecting the Show Object Browser option on the View drop down 
menu. 

The Object Browser has a series of parts. These are described below. 
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The Active Date is used as a filter to ensure that equipment and merchandise that are 
placed in the floor plan are going to be physically available at the time the floor plan is 
anticipated going into service. 

Tabs allow the Object Browser to be switched from one function to another. 

At present, the Object Browser can be used to added, edit, and delete Zones, Fixtures, 
and Merchandise. It can also be used to display and hide KPIs. 

Each tab has the same general components. 

A Toolbar at the top allows various functions to be accessed. These typically allow 
adding, editing, and deleting of the required objects, together with  searching, filtering 
and refreshing options. 

The Fixturing and Merchandising Tabs have Sub-Tabs. 

In Fixturing, the user can click on one or other button to select Fixturing or Gondola 
operations. 

In Merchandising, the user can use the buttons to switch between planograms and 
products. 

Each tab has a series of Information Windows. These vary from tab to tab but can 
include: 

 Hierarchical trees: These give information on what objects can be added, edited, or 
deleted in the drawing. In the Zones Tab for example, the hierarchical tree allows the 
user to select different types of zones. 

 The Properties window: This gives details of the selected object. 

 The Summary window: This gives totals of types of objects placed in the drawing. 

 The Preview window: This shows a low resolution image of the selected object. 

 In the fixturing tab for example, this would be an image of the selected fixture. 

The Information windows can be opened or closed by clicking on the Splitter Bars. 
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The Refresh Option 
All toolbars have a Refresh option. Clicking Refresh will update the application with the 
latest information from the database. This means that if information has been updated in 
another module (for example the Administration module) since the application was 
opened Planner (or Merchandiser) will be updated to match. For example, if the zone 
definitions have been updated in the Administration Module after Planner was opened, 
clicking Refresh will bring the updated information into Planner. 

Repositioning the Object Browser 
Right clicking on the left border of the Object Browser brings up a number of options for 
repositioning it. 

 
For example unchecking the Allow Docking option allows the Object Browser to be 
floated and moved to any desired position 

The Active Date 
The Active Date can be seen at the top of the Object Browser. It can be used as a filter to 
ensure that equipment and merchandise being placed in the floor plan will be physically 
available at the time the floor plan is anticipated as going into service. This is done by 
comparing the Effective Dates for equipment and merchandise with the Active Date. Any 
equipment or merchandise with an Effective Date (the date at which it comes into 
service) after the Active Date for the floor plan will not be available for placement as they 
will not be physically available when the floor plan is implemented. 

Setting the Active Date 
The Active Date can be set in one of two ways: from the Object Browser or in Store 
Manager. 

Setting from the Object Browser 
To set from the Object Browser, double click on the Active Date. This will bring up the 
Active Date dialog box. 
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The Active Date can then be set by means of the radio button: 

 If an Effective Date has been set for the Floor Plan in Store Manager, selecting that 
radio button will import that date. 

 Selecting the Current Date radio button will set the data to Today's date. 

 Selecting the Other Date radio button allows the user to select a date of their choice. 

Setting in Store Manager 
If setting in Store Manager, navigate to the pertinent floor plan in the list of files, right 
click and select Properties. This will bring up the File Properties dialog box. The Active 
Date can then be set using the calendar control. 

 

The Zones Tab 

Overview of the Zones Tab 
Macro Space Management uses Zones to assign space to different departments and non-
sales areas.  The zone types available to your business are customized within the 
Administration Module.  Zones can also be used to help user’s select fixtures or 
merchandise. 
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The Zones tab is divided into three sections: 

 The Toolbar – provides controls to add, modify, and delete zones from a store plan. 

 The Zones Window – shows a hierarchy of available zones. 

 The Properties Window – when a Zone is selected from the hierarchy, its properties 
are visible in this window. 

Toolbar 

 

Icon Description 

 

Add Zone 

 

Add Hole 

 

Delete all Zones of that type 

 

Delete selected Zone or Hole Boundary 

 

Highlight Zone in Floor Plan 

 

Highlight Selected Zone in Tree 

 

Find Zone in Hierarchy 

 

Detect Clashes 

 

Options 

 
Refresh 

 

Add Hatch 

 

Remove Hatch 

The Hierarchy Window 
The hierarchy window displays the zone hierarchy. This hierarchy is defined in the 
Administration module and shows all the zones that can be added to a store plan. 

 
The hierarchy can be expanded using the plus control next to each item on the hierarchy. 
It can also collapsed by using the minus control next to each item. The type of zone in the 
hierarchy is indicated by the icon. 
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Icon Description 

 

Internal Area Zone 

 

Department Zone 

 

Other Zone Type 

The Properties Window 
The Properties window displays information for the zone that has been selected in the 
zone hierarchy. The content of this window is by modifying the Custom SQL in the 
database. This allows an implementer to specify the information that appears in the 
window. 

Note: See the Oracle Retail Macro Space Planning Data Model 
for information on Custom SQL. 

 

Note: See the Oracle Retail Macro Space Planning Data Model 
for information on Custom SQL. 

The Fixturing Tab 

Overview of the Fixturing Tab 
The Fixturing tab allows users to add fixtures, fittings, gondolas and other equipment to 
the store plan. It is divided in to five parts as follows: 

 The toolbar – provides controls that allow users to add, edit, and delete fixtures and 
gondolas 

 The Fixtures window – shows a hierarchy of available blocks and gondolas 

 The Properties window – after selecting a block from the hierarchy, this window 
shows the details for the selected block.  The content of this window is customizable.  

A fourth option - the Fixtures Summary Window – shows details of the zones based on 
the currently active floor plan. This is now called from the View menu but can be docked 
in the Object Browser if required. 

The Fixturing Tab Toolbar in the Object Browser enables the user to control all aspects of 
adding, editing and deleting fixtures and gondolas within the Planner and Merchandiser 
environments. 

Clicking on the Switch Buttons will determine whether the Fixturing or Gondola options 
are active. 
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Fixturing Toolbar 

 

Icon Option Description 

 

Add Fixture Add a fixture to a floor plan. This will cause the Add Fixture dialog 
box to appear. 

 

Delete Fixture Deletes any selected fixtures in the currently active floor plan. 

 

Highlight 
Fixture in Floor 
Plan 

If selected, selecting a fixture in the Object Browser Fixture 
Hierarchy will cause the pertinent fixture to be highlighted in the 
floor plan. The exact nature of the highlighting will depend on 
selections made in the Fixturing Tab of the Configuration Module. 

 

Highlight 
selected item in 
tree 

If selected, selecting a fixture in the floor plan will cause the 
pertinent fixture to be highlighted in the Object Browser Fixture 
Hierarchy. 

 

Find This option brings up the Find dialog box, allowing users to search 
for objects in the Fixture Hierarchy.  

 

Options This option brings up the Fixturing Tab of the Configuration 
module, allowing users to customize their settings. 

 

Refresh This option refreshes the Object Browser with the latest information 
on fixtures and gondolas in the database. 

 

Show Attributes This option shows the fixture attributes for any selected fixtures. 
Fixture attributes are customizable items of information assigned to 
specific fixtures. 

 

Promotional 
Fixtures 

This option allows the user to assign or remove the Promotional 
Attribute and to highlight fixtures with the promotional attribute.  

Gondola Toolbar 

 
 

Icon Option Description 

 

Add Fixture This option is grayed out and unavailable in Merchandiser. 

 

Delete Fixture This option is grayed out and unavailable on the Gondola toolbar. 

 

Highlight Fixture 
in Floor Plan 

This option is grayed out and unavailable on the Gondola toolbar. 

 

Highlight 
selected item in 
tree 

This option is grayed out and unavailable on the Gondola toolbar. 
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Icon Option Description 

 

Find This option is grayed out and unavailable on the Gondola toolbar. 

 

Options This option is grayed out and unavailable on the Gondola toolbar. 

 

Refresh This option refreshes the Object Browser with the latest 
information on fixtures and gondolas in the database. 

 

Show Attributes This option shows the fixture attributes for any selected fixtures. 
Fixture attributes are customizable items of information assigned to 
specific fixtures. 

 

Promotional 
Fixtures 

This option allows the user to assign or remove the Promotional 
Attribute and to highlight fixtures with the promotional attribute. 
This option has no effect in the merchandiser module. 

The Hierarchy Window 
The Hierarchy window displays both the block and the gondola hierarchies.  To toggle 
between the hierarchies use the Blocks or Gondolas buttons respectively. The hierarchies 
are defined in the Fixture Studio environment and show all the fixtures and gondolas 
that can be added to a store plan. 

The hierarchy can be expanded using the plus control next to each item on the hierarchy. 
It can also collapsed by using the minus control next to each item. An item in the 
hierarchy can be highlighted by clicking on the name of the block or gondola. 

 
The icons preceding the fixture name identify the type of equipment - equipment of 
similar types will have the same icon. 

The Properties Window 
The Properties window displays information for the block that has been selected in the 
blocks hierarchy. The content of this window is by modifying the Custom SQL in the 
database. This allows an implementer to specify the information that appears in the 
window. 

Note: See the Oracle Retail Macro Space Planning Data Model 
for information on Custom SQL. 
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Placing Fixtures and Gondolas 
To add a block to the store plan, highlight the required block in the hierarchy. You can 
then either press the Add Fixture button on the tool bar, or drag and drop the fixture to 
the store plan drawing. When a block is added the Insert fixture dialog opens. 

 
These controls allow blocks to be positioned accurately in the store plan. Pressing the left 
mouse button places the block in an initial position. Pressing the right mouse button or 
the <Esc> key finishes placing the block. 

Placing Gondolas 
To add a gondola to the store plan, highlight the required gondola in the 
hierarchy.  Press the Add Gondola button on the toolbar or drag and drop the gondola to 
the store plan drawing. 

The user is prompted to select a start point for the gondola. Pressing the left mouse 
button opens the Gondola Run dialog box. 
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The Gondola Run dialog box allows the user to select the dimensions of the blocks to use 
in the gondola.  It also allows the number of bays or length of the gondola to be set.  Once 
the desired options have been set, pressing the OK button closes the dialog and places all 
the blocks required for the gondola run in to the store plan. 

The Merchandising Tab 
The Merchandising tab allows users to add product placeholders (products), and 
planogram placeholders (planograms) to the store plan. A product is any category, sub-
category, or SKU that is included in the product hierarchy, i.e. any level in the hierarchy. 
Planograms are also organized in to a hierarchy of planogram groups. However, you can 
only place planograms in to the store plan. Planogram groups cannot be placed. 
Placeholders are markers that can be placed on to fixtures to indicate the product 
category, sub-category or planogram that will be used. 

The Merchandising tab is divided in to 5 parts: 

 The toolbar – provides controls that allow products and planograms to be added, 
edited, and deleted. 

 The Merchandise window – shows a hierarchy of available products and 
planograms. 

 The Properties window – shows details for the product that has been selected in the 
product hierarchy. Similarly, it will show details of a planogram that has been 
selected in the planogram hierarchy. The content of this window is customizable. 

 The Summary window – shows details of products and planograms placed based on 
the active store plan. The content of this window is customizable.  

 The Preview window – shows a sample picture of product display styles selected in 
the product hierarchy 

Note: Product display styles (which show the physical form 
of the SKU) are only available in Merchandiser. 

The Merchandising Tab Toolbar in the Object Browser enables the user to control all 
aspects of adding, editing and deleting products and planograms within the Planner and 
Merchandiser environments. 
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Clicking on the Switch Buttons will determine whether the Product or Planogram options 
are active. 

Products Toolbar 

 
 

Icon Option Description 

 

Add Product This option is grayed out. Products can be added by dragging and 
dropping. 

 

Delete 
Product 

This option is grayed out and unavailable in Merchandiser. Products can 
be directly deleted in the floor plan. 

 

Highlight in 
Store 
  

This option does not operate in Merchandiser. 

 

Highlight in 
Tree 

  

If selected, selecting a product in the floor plan will cause the pertinent 
product  to be highlighted in the Object Browser Fixture Hierarchy 

 

Find This option brings up the Find dialog box, allowing users to search for 
objects in the Fixture Hierarchy.  

 

Options This option brings up the Merchandising Tab of the Configuration 
module, allowing users to customize their settings. 

 

Refresh This option refreshes the Object Browser with the latest information on 
products and planograms in the database. 

Planogram Toolbar 

 
 

Icon Option Description 

 

Add Planogram This option is grayed out. Planograms can be added by 
dragging and dropping. 

 

Delete Planogram This option is grayed out and unavailable in Merchandiser. 
Planograms can be directly deleted in the floor plan. 

 

Reverse Planogram 
Placement Direction 

This option is current grayed out. 
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Icon Option Description 

 

Highlight in Store This option does not operate in Merchandiser. 

 

Highlight in Tree If selected, selecting a planogram in the floor plan will cause 
the pertinent planogram be highlighted in the Object Browser 
Fixture Hierarchy. 

 

Find This option brings up the Find dialog box, allowing users to 
search for objects in the Fixture Hierarchy.  

 

Properties  This option brings up the Merchandising Tab of the 
Configuration module, allowing users to customize their 
settings. 

 

Refresh This option refreshes the Object Browser with the latest 
information on products and planograms in the database. 

The Hierarchy Window 
The hierarchy window displays both the product and the planogram hierarchies. To 
toggle between the hierarchies use the Products or Planograms buttons respectively. The 
Product hierarchy is defined in the Product Studio module and shows all the products 
that can be added to a store plan. The Planogram hierarchy can be configured in 
Merchandiser and shows all the planograms that can be added to a store plan. The 
hierarchy can be expanded using the plus control next to each item on the hierarchy. It 
can also collapsed by using the minus control next to each item. 

Product Hierarchy 

The product hierarchy is show down as far as SKU level. Products at Display Style level 
are not shown in Planner because they can neither be placed nor seen. 

 
The different colored folders show the different levels in the hierarchy. 

Icon Description 

 

Product Company 

 

Product Group 

 

Product Division 

 

Product Department 

 

Product Class 

 

Product Sub-Class 

 

Product Item 
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Icon Description 

 

Product SKU 

Planogram Hierarchy 

Planograms are organized in a hierarchy of planogram groups, with planograms 
associated with a specific group. 

 
The different colored folders show the different levels in the hierarchy. 

Icon Description 

 

Planogram Company 

 

Planogram Group 

 

Product Division 

 

Product Department 

 

Planogram Class 

 

Planogram Sub-Class 

 

Planogram 
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If Master Planograms have been implemented, there will be two different icons to 
indicate the type of planogram. 

Icon Description 

 

Individual Planogram 

 

Master Planogram 

The Properties Window 
The Properties window displays information for the merchandise that has been selected 
in the product or planogram hierarchy. The content of this window is by modifying the 
Custom SQL in the database. This allows an implementer to specify the information that 
appears in the window. 

Note: See the Oracle Retail Macro Space Planning Data 
Model for information on Custom SQL. 

 

The KPI Tab 
The KPI’s tab of the Object Browser allows users to see performance of a store plan at a 
glance. The available KPI’s are customizable and more can be added by users with access 
to the Administration Module. The KPI tab is divided in to three parts: 
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 The toolbar – provides controls that allow KPI’s to be run and modified. 

 The KPI Hierarchy window – shows a tree of available KPI’s. 

 The Legend window – shows the color bands associated with the active KPI. 

When the tab is first opened the Layers and Legend windows are blank. These windows 
are populated when a KPI is run. 

Note: Some KPIs require information such as financial data 
to be imported into the Macro Space Planning database 
before they will work correctly. 

The KPI Tab Toolbars in the Object Browser are used to Add and Edit KPI’s. They are 
also used to Edit and Delete the list of KPI’s selected for display in the ViewPorts 

Toolbar 

 

Icon Description Purpose 

 

Add KPI Apply the currently selected KPI in the hierarchy to the currently active 
floor plan. 

 

Remove 
KPI 

Clear the current KPI from the floor plan. 

 

Edit KPI Edit the parameters for the currently active KPI. 

 

Refresh KPI Refresh the current KPI 

 

View Data View the data being used in the currently active KPI. 

 
Refresh All Refresh the Object Browser with the latest information from the database. 
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See the section on KPIs for more information. 
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4 
Object Grid 

About the Object Grid 
The Object Grid provides an alternative to selecting lower level objects in the Object 
Browser, including Zones, Fixtures, Products and Planograms. 

 
It is used in conjunction with the Object Browser and is available in both the Planner and 
the Merchandiser environments. 

Note: The OBJECT_GRID_DATALIMIT system variable is 
used to set the maximum number of results that will be 
returned in the Object Grid. The optimum value for this 
system variable will vary from system to system depending 
on the performance of that system. The value set will have to 
be a compromise between execution speed of the query and 
whether the result set returned is sufficient for the user's 
needs. 

The Object Grid has the following major parts: 
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Object Grid Options 

Tabs and Options 
There are three tabs: 

 The Data Tab contains a list of all returned results up to the limit set in the 
OBJECT_GRID_DATALIMIT system variable. Results are also constrained by the 
filters in use. 

 The Sort Tab allows the user to select the fields the data will be ordered by and 
whether the data will be in ascending or descending order. 

 The Filter Tab allows the raw data sent to the Object Grid to be filtered to a smaller 
sub-set before it is displayed in the Object Grid. 

For the settings in the filter and sort tabs to be active the appropriate check boxes (just to 
the right of the tabs) must be selected. 

Search Options 
Once a result set has been returned, it is possible to search for any value in the results by 
entering that value into the text box and clicking the Find icon to the right. The results 
can be stepped through by repeatedly clicking the find icon. 

Refresh and Add Buttons 
For data to be added to the Object Grid, the refresh button must be toggled on 
(depressed). Clicking on a node in the appropriate hierarchy will return the results 
associated with that note. Highlighting a result and clicking the Add button will result in 
that object being added to the floor plan in Planner. Objects must be 'dragged and 
dropped' in order to add them to a Merchandiser floor plan. 

Determining the Data that Appears in the Object Grid  
The data that appears in the Object Grid is determined by the Custom SQL in the 
AVTTB_CUSTOM_SQL table. System DBAs with access to the database can modify this 
Custom SQL to change the information that appears. 
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Note: If the custom SQL includes a column named RGB, then 
the row will be colored using the value in the column. This 
will allow certain rows to be highlighted, which could be 
used indicate high performing products or planograms, or 
simply indicate which products have already been placed. 

Turning Object Grid Display On or Off 
The Object Grid Display can be turned off by clicking the close button in the upper right 
corner. It can be turned back on by using the Object Grid option on the View pull down 
menu.  

Note: The Object Grid can be ''dragged and dropped' to 
different sides of the screen if the Allow Docking option is 
selected from the right click menu. If Allow Docking is not 
on, the Object Grid can be positioned at any point on the 
screen. 

The Object Grid Sort and Filtering Tabs 
The Sort tab and Filter tab allow data to be sorted and filtered accordingly. Settings can 
be made in either tab but they will not become active unless the pertinent check boxes 
have been selected in the Data tab. 

 

The Sort Tab 
The Sort tab allows the user to determine which columns will be used to sort the data 
and the priority with which they will be used. Settings will not take effect unless the Use 
Sort check box in the Data tab is ticked. 

 

The selected fields determine both the fields that will be used for sorting. The sequence 
they are selected in specifies the priority that will be used. The available fields for sorting 
will match the fields in the Data tab. The order specifies whether data will be shown 
ascending (A -->Z) or descending (Z-->A). 
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Note: Data can also be sorted by clicking on the column 
headers in the Data tab. 

Clicking the Clear button will remove all settings in the tab. 

The Filter Tab  
The Filter Tab can be used to filter the full list of results down to a more restricted set 
pertinent to the fixtures being merchandised. Settings will not take effect unless the Use 
Filter check box in the Data tab is ticked. 

 
 The Field specifies the field that is to be used to filter the data. The sequence they are 

selected in specifies the priority that will be used. 

 The Operator specifies how the value will be used. For example the = sign requires 
and exact match, the LIKE option uses implied wild cards to match all or part of the 
value being searched for. 

 The Value is the numeric or text value that is to be matched. 

 The Combination can be set to AND or OR. If set to AND, all conditions must be met. 
If set to OR, multiple conditions can be met. 

Note: The OR condition applies to all fields set. If four AND 
fields and one OR field is specified, the OR field will return a 
set of results independent of the AND fields. 

Clicking the Clear button will remove all settings in the tab. 

Using the Object Grid 
The Object Grid will behave in different ways depending on which tab of the Object 
Browser is selected. The results returned can be customized by modifying the 
information in the AVTTB_CUSTOM_SQL table. (This table is only accessible by 
Administrators with access rights to the database). 

Zones Tab 
The Zones Tab gives the opportunity to return lists of products or planograms associated 
with specific zones. This can serve as a pre-filtering process. In the example below, 
highlighting the Packet Goods zone in the Object Browser (with the Refresh button 
toggled on) in the Object Grid has returned all planograms associated with that zone. The 
Custom SQL for the Object Browser has been configured to show placed planograms in 
red and non-placed planograms in black. 
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Fixturing Tab 
The Fixturing Tab allows users to select fixtures based on their parent fixture group in 
the Object Browser. In the example below, the Basic Racking Shelving Fixture Group has 
been selected in the Object Browser. With the Refresh button on the Object Grid toggled 
on, this returns all shelves associated with that fixture group (and any child fixture 
groups). 

 

Note: Gondolas cannot be selected using the Object Grid. 

Merchandising Tab 
The Merchandising Tab allows users to select products or planograms based on their 
parent group in the Object Browser. This functionality operates in both the floor plan and 
the planogram design window - although it operates differently in both. There are two 
custom SQL statements powering the Object Grid - one for floor plans and one for 
planogram design. Each piece of Custom SQL can return results for either products or 
planograms. Many retail chains configure the Custom SQL to return planograms while in 
the floor plan and products while in the planogram design window. This section of help 
will discuss that situation. 

Returning Planograms for Floor Plans 
The general way of setting up the Custom SQL for floor plans is to get it to return results 
of planograms. This will happen when the appropriate level in is clicked in either the 
product or planogram hierarchies. Clicking on a group in the planogram hierarchy will 
return all planograms that are associated with that group or its children. Clicking on a 
Department, Class or Sub-Class is the product hierarchy will return all planograms 
associated with that type of product. Clicking at other levels in the product hierarchy (for 
example Item) will result in an error message. 

As with other results in the Object Grid, the precise results returned can be configured by 
Administrators using the Custom SQL. 
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Key Performance Indicators 
The Object Grid cannot carry out any actions associated with KPIs. 
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5 
Store Manager Business Processes 

Store Manager Business Processes 
Store Manager enables Equipment Layout Managers, Merchandise Managers and Store 
Planners to control the business process flows relating to planning and maintaining the 
'bricks and mortar' stores within a retail organization. It can perform the following 
general functions: 

Grouping Together Stores of Common Purpose in the Hierarchy 
Stores can be assigned to multiple clusters in the Store Hierarchy. This enables stores 
with similar characteristics to be grouped together for reporting of control purposes. For 
example the New York Store could be a member of The North America, Large store and 
Regional Manager 1 clusters. This enables groups of stores to be selected - for example all 
stores in North America, or all stores of size over 50,000 square feet. 

 
It also allows stores sharing (for example) similar demographic characteristics to be 
grouped together. For example clusters could be created according to the ethnic mix of 
the store catchment area. If a 'Hispanic' cluster was created, that would enable all stores 
with a predominantly Hispanic shopper base to be grouped together. This would allow 
the product mix going into the stores to be optimized to suit that specific customer base. 
For example, the stores might have a higher proportion of burritos, enchiladas and fajitas 
than a store catering to a predominately Asian or Caucasian clientele. 

Similarly, stores could be characterized according to the average wealth of the shoppers 
using them - for example 'Low Income' , Middle Income' and 'High Income' clusters could 
be created an stores assigned accordingly. Stores in the 'High Income'  cluster would then 
be selected for planograms containing a higher proportion of 'premium' products than 
average. Similarly, stores in the 'Low Income'  cluster would have planograms with more 
'value' products. 

Controlling Business Life Cycle 
The planning process for any new floor plan can go through a number of stages, several 
of which will require approval before the floor plan is put into service. 
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In the above example, it can be seen that the floor plan goes through a number of statuses 
during the creation process. For example the fixturing is placed then approved by a 
manager, before the merchandise is placed and approved. It is also possible to use In-
Store Space Collaboration (ISSC) to control business flows. ISSC users have the option to 
Accept or Reject a floor plan. These options will advance or reverse the current status of 
the floor plan. 

The floor will eventually reach Authorized status where dates can be specified for when 
preparations should be started for putting the floor plan into service (Publishing) and 
when the floor plan will be put into service (made Current). The floor plan will normally 
be automatically changed to Published and Current status by a Macro Space 
Management utility called Update Status. (This utility should be set to run at regular 
intervals by a scheduling tool).The software will also automatically change the status of 
the floor plan to Historical when it is superseded by a more recent plan. 

Batch processes can be used when the floor plan reaches Publish status to auto-generate 
the pertinent floor plan and planograms. 

Communicating Information 
Store Manager can also be used as a medium for communicating information. This is 
done in several ways. 

File Notes 
It is possible to a ttach notes (short lines of text information) to floor plans. This enables 
store planners in Macro Space Management and In-Store Space Collaboration (who may 
be based in very different locations) to communicate requests and information to each 
other. This information can be seen in the Notes tab of the floor plan Properties dialog 
box. Users in different applications have different capabilities. 

 MSM Users can only add File notes, together with reading and deleting existing 
notes. 
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 ISSC users can add notes to zones, fixtures, shelves, product and planograms. They 
can also mark notes as resolved and delete notes. 

 ISSC Mobile users can add new notes to zones, fixtures, shelves, product and 
planograms. They can also add notes to existing notes, continuing a conversation. 
Finally, they can make notes as resolved. 

 

Publishing a Floor Plan 
When a floor plan is Published, a hard or electronic copy can be generated via a 
batch process. The retailer must the use their own systems to disseminate this copy of 
the floor plan to the store in preparation for putting it into effect. Simultaneously, the 
retailer must generate a report specifying the equipment, merchandise and signage 
required to put the floor plan into effect. Orders will then need to be placed so that 
these items are available when required. Batch processes can be used when the floor 
plan reaches Publish status to auto-generate the pertinent planograms. 

Making a F loor Plan Effective (Current) 
When a floor plan is made effective (current), that is the signal for it to be put into 
service. The retailer should create a report identifying which store plans have 
achieved Current status and notify the stores accordingly. 

Reports and the Macro Space Planning Database 
Information generated in Store Manager is stored in the Macro Space Planning database. 
It will generally require custom reports to disseminate this information to other 
departments and stores within a retail organization. Example of reports could include: 

 Floor plans that have reached a stage in their business life cycle that requires 
approval before the next stage is commenced. 

 Floor plans that have reached published status. 

 Bills of material for the equipment in a floor plan 

 Lists of products and planograms in a floor plan 

 Lists of floor plans that have reach current status and need to be put into service. 
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 KPIs for the performance of merchandise in a floor plan. 

These reports are not supplied with the application. It is the responsibility of the retailer 
to develop appropriate reports that suit their specific business processes. 

Integrating Store Manager into Retail Processes 
Every retailer will have their own business processes. This section of the user guide can 
only cover basic principles in brief detail. It is intended to give new users of the 
application some insights into how store manager could be used within the existing 
processes. Users will have to adapt the general principles to suit their specific case. 

Identify Need for Floor Plan Change 
Typically the need for producing a new floor plan will originate from an external system. 
For example, a specific category in category management might have seasonal 
components that require updating. An instance of this might be in the meat department, 
where the 'Bacon and Sausage' category might be allocated more space in the summer 
season than in winter due to increased sales because of barbecues in the summer months. 

The retailer will have to have some form of system integrating Category Management 
and Macro Space Planning so that requirements to update floor plans can be 
communicated from one system to another. 

Floor Plan Created in Store Manager 
As a result of the identified need, instructions would be given to a store planning 
manager to create a revised floor plan. The manager in turn would give instructions to a 
specific floor planner to create a new floor plan (or modify an existing one). 

Floor Plan Ready for Approval 
When the floor planner has completed the floor plan, a retailer's internal systems would 
probably require approval. This could be done in many ways - for example a senior 
manager could be given In-Store Space Collaboration enabling them to view the reports 
and KPIs before deciding whether to approve or reject the proposed floor plan. 

Floor Plan Set to Authorized Status 
On the floor plan getting approved, it can be set to Authorized status. This allows two 
dates to be set: 

1. The Publish Date  

The Publish Date specifies the date at which the floor plan is to be to be sent to the 
store in preparation for implementation. It is also the date at which information on 
the equipment and merchandise required for the changes need to be sent to supply 
chain management so that they can be placed on order. 

2. The Effective Date 

The Effective Date schedules the date a t which the floor plan will come into service 
(becomes Current). It can also serve as advance information for a Workforce 
Management System as to the amount of labor, etc., required for the changes. This 
would allow the retailer to plan for labor utilization within the store or arrange for an 
external merchandise change management organization to come in on the scheduled 
date. 
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Update Status Changes Floor Plan Status to Published 
Update Status is a small Macro Space Management utility that is typically run every 
night by means of a scheduling tool. At the appropriate date it will change the status of 
the floor plan to Published. 

Publishing Planogram Designs and Floor Plan 
At the same time as the status is changed, other batch tools can be used to publish any 
pertinent planogram designs in the floor plan and publish the floor plan itself. This 
information will be put in specified folders on a specific server. The retailer will have to 
use their reporting systems to identify the quantities of equipment, merchandise and 
signage needed to make the change. This information will then need to be communicated 
to the supply chain systems and orders placed. 

The retailer will also need to use their systems to distribute the planogram designs and 
the floor plan to the store, together with information on when the changes are intended 
to come into effect. 

Note: As well as ordering the equipment, merchandise and 
signage, other preparatory work may be required - for 
example in ensuring the labor is available to make the 
changes on the specified date. 

Update Status Changes Floor Plan Status to Current 
Update Status (run by the scheduling tool) changes the status of the floor plan to current. 
Retailers can develop a reporting tool to identify all floor plans scheduled to become 
current within a specified period and confirm that the store has made the necessary 
preparations to put the changes into effect. 

Financial KPIs and Reports 
Macro Space Management allows retailers to understand how efficiently they are using 
space within their bricks and mortar outlets. Running KPIs and reports enables retailers 
to optimize future floor plans. It also allows information to be fed back into Category 
Management to optimize future categories and their associated assortments. 

Importing Data and Setting up Store Manager 
Before commencing use of Store Manager, thought needs to be given as to what data is 
imported and how data is to be structured within Store Manager. 

Importing Data 
Macro Space Management has a Data Import module. This enables data to be taken from 
external databases and imported into the Macro Space Planning central database. 
Activating this module brings up the MSM Data Importer dialogue box. 
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This allows the classes of data to be imported to be selected. Data Importer is fully 
configurable. Oracle’s consultants can configure the exact nature of the data import so 
that specified data is selected from the designated databases and imported into the 
required fields within Macro Space Management’s central database. 

Configuring the Store Manager Hierarchy 

General 
Before Macro Space Management can be used, it is necessary to set up a Hierarchical Tree 
within Store Manager. This structure enables the stores to be arranged in logical 
groupings by means of Clusters and Sub-clusters. The performance of individual Stores 
can be compared against selected Prototype Stores, while the performance of one cluster 
of stores can be compared against another cluster. The structure of this hierarchical tree 
should be carefully considered as it will affect the quality of information that can be 
produced using Macro Space Management, and hence determine the effectiveness of 
Macro Space Management as a tool for improving the profitability of a business. 

Planning the Structure 
Typical information needed to plan how individual stores should be assigned within the 
structure includes: 

 Store Size 

 Store Turnover 

 Store Location 

 Store Demographics 

Criteria can then be developed as to cluster types, and hence whether individual stores 
should be assigned to single or multiple clusters. For example, a store could be associated 
with three separate and distinctive clusters. One cluster would enable the store to be 
compared against those in other regions, one against stores of similar turnover, and the 
third against stores of similar size. Consideration should also be given to which stores 
can be designated as Prototypes for comparison purposes. Correctly assigned prototype 
stores will also allow swift and effective comparison of individual store performance 
against an exemplar. A correctly planned structure can significantly improve the 
performance of a retail organization – a poorly planned structure could prevent the full 
power of Macro Space Management being used. 
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6 
Overview of Store Manager 

The Store Manager Menu Bar 
The Store Manager Menu bar contains gives access to four menus: 

 

File Menu 
The File option activates a pull down menu with options primarily concerned with the 
store hierarchy. Some of these may be grayed out depending on what Store Manager 
function is being used. This menu can be used to add, edit and delete files and to 
associate files and architectural plans. If a file is highlighted, it can also be used to call the 
File Properties dialog box. 

 

Edit Menu 
The Edit option activates a menu with options to cut, copy and paste some objects in the 
hierarchy such as clusters, stores and files. Some of these may be grayed out depending 
on what item in the hierarchy is selected. 

 

View Menu 
The View  option activates a menu with various options controlling the appearance of 
Store Manager and the way it displays information. 
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Tools Menu 
The Tools option contains a series of options used to check in files, check directory 
integrity, import files and create hierarchies. 

 

Basic Concepts 
This section of help covers some basic concepts helpful to new users. 

Hierarchical Structures 
A Hierarchical structure is one where objects are organized in the form of a tree. The 
more fundamental data is close to the trunk, while the more dependent data is further 
out on the branches. 

 
The store manager hierarchy has the following levels: 

Level Description 

Root The top level of the hierarchy 
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Level Description 

Cluster 
Acts as a container for stores. (The arrangement of clusters can be extended by the use of 
sub clusters. 

Store A physical retail outlet.  

Floor Stores can be assigned multiple floors. A minimum of one floor must be present in each 
store. 

Revision 
Revisions hold floor plans of a common purpose. Any example might be the floor plans 
for a specific season. A floor can have multiple revisions.  A minimum of one revision 
must be present for each floor. 

Floor 
Plan The lowest level in the hierarchy. 

Parent-Child Relationships 
Some objects within Store Manager are linked together in such a manner that changes to 
one object may result in changes to other objects linked to it. Such objects are described as 
being in a parent-child relationship. The object that has dependent objects associated 
with it is known as the parent, while the objects that are associated with the parent object 
are known as the children. In a hierarchical structure, children of one parent can be 
parents of their own children in turn. When the status of a parent object is changed; it can 
often result in changes to the status of child objects. Similarly, the status of parent objects 
can sometimes only be changed when the status of the appropriate child object is correct. 
When a parent object is deleted, it affects all the associated child objects. Conversely, a 
child object can often be deleted without affecting the parent. 

 
In the above example, the Ground Floor is a child of the Berlin store, but is a parent 
several Revisions - including Fall Plans. 

Status 
Status defines the current standing of an object within the business life cycle. For 
example, Stores generally have three statuses. 
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At the beginning of the process, the Store has a Proposed status as it is only at the design 
stage. When the store has been built, its status will change to Open. Finally, if the store 
has reached the end of its useful life, it will be assigned Closed status. The status of an 
object thus changes as Macro Space Management users move through the business cycle. 

Publish and Effective Dates 
Publish  and Effective dates are associated with the status of a floor plan. The Publish 
date is the date a t which the floor plan is issued to the stores. Floor plans are typically 
published a number of days or weeks in advance of the time the changes are required. 
The Effective date is the date at which the published drawing becomes current. Publish 
and Effective dates can be turned on or off by making changes to the 
ENABLE_FILE_TRIGGER_DATES  system variable in the Administration Module. If 
enabled, Publish and Effective dates can be used to automatically change the status of 
revisions and drawings by making use of the UpdateStaus.exe file in the C:\Oracle 
Retail\MSM\Apps Windows folder 

Note: UpdateStatus.exe can be set to run on a daily or 
weekly basis by the Windows task manager or a scheduling 
tool, allowing some degree of automation of common tasks. 

RFBin 
The RFBin  is Macro Space Management’s equivalent of the Recycle Bin. Files marked for 
deletion are sent to the RFBin, but will not be permanently deleted until  the Purge option 
is used in the Tools menu. Its location is specified in the Directories tab of the 
Configuration module. The directories tab can only be accessed when the Configuration 
Module is opened from within the Administration module. 
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Overview of Store Manager Module 

Accessing the Store Manager Module 
Store Manager can be accessed from either the Planner or Merchandiser modules. In  
Planner, Store Manager is accessed by clicking on the Open File option in the standard 
toolbar. Alternatively, the Open File option can be selected from the File menu. 

  
In Merchandiser, Store Manager is accessed by clicking on the Open File option in the 
standard toolbar. Alternatively, the Open File option can be selected from the File menu. 

 

Overview of Store Manager Module 
Macro Space Management contains large amounts of information. This can be as specific 
as the current contents of a shelf in a single store or as general as the floor plans to be 
implemented business wide in 6 months time. This mass of information has to be 
organized and administered. Within Macro Space Management this is achieved by the 
Store Manager module. Store Manager operates in a similar way to Windows Explorer. It 
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has been designed to be easy to use and allows information to be grouped in a way that 
reflects the structure of the organizations. 

 
The menu and tool bars can be seen to the top left of the window. The hierarchical tree of 
Clusters, Stores, Floors and Revisions can be seen to the left of the window. The files 
associated with a particular Revision can be seen in the frame to the upper right. A 
preview of the drawing to be selected can be seen at the bottom. 

Using Store Manager you can: 

 Assign your retail outlets to logical groupings, allowing comparisons and analysis of 
sales to be made between individual stores or groups of stores. 

 Assign or change floor plans for stores, allowing the effects of differing store layouts 
or merchandising mixes to be evaluated. 

 Carry out routine administration on the files used within Macro Space Management. 

 Get reports on the data used within Macro Space Management. 

 Interface with external programs allowing import and export of data to and from 
those programs. 

Note: Macro Space Management's sister program, In-Store 
Space Collaboration, can be used to access and edit drawings 
held in the central Macro Space Planning database. 

The Store Manager Toolbar 

 
The Store Manager toolbar contains a series of options for administering the objects and 
files in Macro Space Management. Depending on which operation is being carried out, 
one or more options may be grayed out (unavailable). 
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Icon Description 

 

  

Close Store Manager 

 

  

Open a Drawing 

 

  

Add an Item 

 

  

Edit an Item 

 

  

Delete an Item 

 

  

Associate File  

 

  
Associate Architectural Plan 

 

  
Search 

 

  
Cut 

 

  
Copy 

 

  
Paste 

 

  
Properties 

 

  
Large icons for files 

 

  
Small Icons for files 

 

  
List of files 

 

  
Details of files 
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7 
The Store Manager Hierarchy 

General Note on Adding, Editing and Deleting Objects 
There are three broad ways of invoking the Add, Edit or Delete options. 

File Menu 
Objects can be added to, edited in or deleted from the hierarchy by highlighting an 
appropriate object and selecting the pertinent option from the File menu. 

 

Toolbar 
Objects can be added to, edited in or deleted from the hierarchy by highlighting an 
appropriate object and selecting the pertinent option from the Toolbar menu. Some of 
these functions may not be active depending on the object selected. 

 

Right Click Menu 
Objects can be added to, edited in or deleted from the hierarchy by highlighting an 
appropriate object right clicking to bring up the Right Click Menu . 
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Deleted Objects 
Whether objects are visible after deletion depends on whether the Show Files Marked 
for Deletion  option has been selected in the Options  dialog box accessed from the View 
menu. If selected, objects marked for deletion will show with a black cross. 

 
If not selected, the objects marked for deletion will be hidden from view until purged. 

Adding, Editing and Deleting Clusters 
The Add and Edit dialog boxes are identical but for the title. Only the Add dialog box 
will be shown in this section, but the descriptions of the fields equally apply to the Edit 
dialog boxes. 

Adding (and Editing) Clusters 
To add a Cluster, highlight the Store Root or another cluster and select Add from the File 
Menu, Toolbar or Right Click Menu. The Add Cluster dialog box will appear. 

 
 

Option Description 

Cluster ID Once the dialog box is saved, this field will populate with the ID from the pertinent 
table in the database. 

Cluster 
Name This is the name assigned to the cluster. 

Cluster 
Type 

This is assigned from a drop down list. It is normally used as a filter for reporting 
purposes. 
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Cluster 
Code This is the unique identifying code assigned to the cluster. 

Deleting Clusters 
To delete a cluster, highlight it and select Delete from the File Menu, Toolbar or Right 
Click Menu . The cluster is now marked for deletion but will not be permanently 
removed until purged using the Purge option from the Tools menu. 

Adding, Editing and Deleting Stores 
The Add and Edit dialog boxes are identical but for the title. Only the Add dialog box 
will be shown in this section, but the descriptions of the fields equally apply to the Edit 
dialog boxes. 

Adding (and Editing) Stores 
To add a store, highlight the parent cluster and select Add  from the File Menu, Toolbar 
or Right Click Menu. The Add Store dialog box will appear. There are four tabs. 

General Tab 

 
 

Option Description 

Store ID 
Once the dialog box is saved, this field will populate with the ID from the pertinent 
table in the database. 

Store Code This is the unique code used to identify the store. 

Store Name This is the name of the store. 

Directory 
Name 

This is the name of the directory that will be automatically created to hold the files 
associated with the store. It will be created below the Store Root specified in the 
Directories Tab of the Configuration Module. 
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Option Description 

Latitude This can be entered to identify the position of the store. 

Longitude This can be entered to identify the position of the store. 

Status 
This is set from a drop down list. It specifies where the store is in its business life 
cycle. 

Opened 
Date 

This is the date the store is scheduled to open. If the store is not at Open status when 
this date is reached, Update Status will automatically change the status to Open. 

Closed Date 
This is the date the store is scheduled to close. If the store is not at Closed status when 
this date is reached, Update Status will automatically change the status to closed. 

Store 
Prototype 

This enables the user to specify another store to be used as a prototype for comparison 
purposes. Available prototypes are set by selecting the Set as Prototype check box. 

Set as 
Prototype 

This check box designates the store as a Prototype. If set as a prototype, it cannot have 
a prototype store assigned to it. 

Units Tab 

 
 

Option Description 

Input Units   

Length: These are the default length units used for the floor plan. 

Area These are the default area units used for the floor plan. 

Display/Output 
Units 

  

Length These are the default length units used for displaying information the floor 
plan. 
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Option Description 

Alternative Length 
These are the alternative length units used for displaying information for the 
floor plan. 

Area 
These are the default area units used for displaying information the floor 
plan. 

Alternative Area 
These are the alternative area units used for displaying information for the 
floor plan. 

Address Tab 

 
 

Option Description 

Address There are 4 lines available to enter the address of the store. 

Post Code This fie ld holds the post code of the store. This might be used in the UK. 

Area Code This fie ld holds the area code of the store. This might be used in the US. 

Telephone This fie ld holds the telephone number of the store. 
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Attributes Tab 

 
The attributes tab contains the name and value of the User Defined Attributes assigned to 
the store. The available attributes are configured in the Administration Module and will 
vary from retailer to retailer. Users can enter then pertinent data in the dialog box. 

Deleting Stores 
To delete a store, highlight it and select Delete  from the File Menu, Toolbar or Right 
Click Menu . The store is now marked for deletion but will not be permanently removed 
until purged using the Purge option from the Tools menu. All child objects will be 
deleted as well. 

Adding Stores to Multiple Clusters 
Stores can belong to more than one cluster. This enables stores sharing a common 
characteristic to be grouped together for reporting, control or planning purposes. 

 
In the above example, the New York store is in the following clusters: 

 North America 
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 Large Stores 

 Regional Manager 1 

This enables New York to be selected along with all stores in North America, all Large 
Stores or all stores supervised by Regional Manager 1. 

Note: Copying a store merely associates it with multiple 
clusters - i t does not duplicate the floor plans associated with 
the store. 

Adding Stores to Multiple Clusters 
To add a store to a multiple cluster, highlight the store and chose the Copy option from 
the Edit menu, Toolbar or right click menu. Select the required cluster to copy the store 
to and use the Paste option from the Edit menu, Toolbar or right click menu. 

Removing Stores from Multiple Clusters 
To remove a store from a cluster, highlight the store then select the Delete Link option 
from the right click menu. This will remove the database link between the store and that 
specific cluster, but it will remain associated with any other clusters it has been copied 
into. 

Adding, Editing and Deleting Floors 

Add and Edit Dialog Boxes 
The Add and Edit dialog boxes are identical but for the title. Only the Add dialog box 
will be shown in this section, but the descriptions of the fields equally apply to the Edit 
dialog boxes. 

Adding (and Editing) Floors 
To add a floor, highlight the parent store and select Add from the File Menu, Toolbar or 
Right Click Menu. The Add Floor dialog box will appear. 
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Option Description 

Floor ID 
Once the dialog box is saved, this field will populate with the ID from the 
pertinent table in the database. 

Floor Type 
This is the type of floor. It is set from a drop down list which is pre-populated with 
names like Basement, Ground Floor, and so on. The list of available names can be 
configured directly in the database. 

Description This is the directly input information on the floor. 

Directory 
This is the name of the directory that will be automatically created to hold the files 
associated with the floor. It will be created below the directory for the parent store. 

Status 
This is set from a drop down list. It specifies where the floor is in its business life 
cycle. 

Allocated Area 
Tolerance 

This is a value that can be entered for reporting purposes. It allows the actual area 
allocated for retail purposes to be compared with some theoretical value if a report 
is created. 

Elevation This fie ld can be used to specify the height above ground level for reporting 
purposes. 

Edit Levels 

This button can be used to open a dialog box for  editing the default levels for 
items of equipment that are to be placed at levels other than floor level. Examples 
would be posters and banners. If not activated during the creation of the floor, 
these levels cannot be edited later. 

Level Details Dialog Box 
When fixtures and fittings are configured in the fixture studio, they can be set to place at 
floor level or some other specified height. These other heights are specified in the 
database as defaults, but it is possible to change those values for a specific floor. This is 
done by clicking Edit Levels... in the Add floor dialog box. This will bring up the Level 
Details dialog box. The available insertion heights can be selected from the Level 
Description drop down list and values typed into the Level Elevation text box. When all 
values have been changed as required click OK. 

 

Note: This dialog box must be opened from the Add Floor 
dialog box when the floor is created. It will then be available 
for editing. If it is not opened when the floor is created, no 
subsequent editing will be possible. 

Deleting Floors 
To delete a floor, highlight it and select Delete from the File Menu , Toolbar or Right 
Click Menu . The floor is now marked for deletion but will not be permanently removed 
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until purged using the Purge option from the Tools menu. All child objects will be 
deleted as well. 

Adding, Editing and Deleting Revisions 
The Add and Edit dialog boxes are identical but for the title. Only the Add dialog box 
will be shown in this section, but the descriptions of the fields equally apply to the Edit 
dialog boxes. 

Adding (and Editing) Revisions 
To add a floor, highlight the parent floor and select Add from the File Menu, Toolbar or 
Right Click Menu. The Add Revision dialog box will appear. 

 
 

Option Description 

Revision ID 
Once the dialog box is saved, this field will populate with the ID from the 
pertinent table in the database. 

Revision 
Number 

This is a number that can be assigned to the revision. 

Revision 
Description This is the name of the revision. 

Directory 
This is the name of the directory that will be automatically created to hold the files 
associated with the floor. It will be created below the directory for the parent floor. 

Status This is set from a drop down list. It specifies where the revision is in its business 
life cycle. 

Season 
Description 

This drop down list allows the user to select a season from a list of predefined 
seasons. If set, this can be used (in conjunction with the Custom SQL) to filter data 
in the Object Grid.  

Birth Date This is the date the revision was created. 
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Option Description 

Death Date This is the date the revision went out of service. 

Deleting Revisions 
To delete a revision, highlight it and select Delete from the File Menu, Toolbar or Right 
Click Menu . The revision is now marked for deletion but will not be permanently 
removed until purged using the Purge option from the Tools menu. All child objects will 
be deleted as well. 

Adding, Editing and Deleting Floor Plans 

Adding Floor Plans 
If the Add Proposal Drawing check box is selected when a new revision is created, a new 
floor plan will be automatically created in the new revision. To add a new or additional 
floor plan, go to the right hand pane in Store Manager and bring up the right click menu. 
Select New Drawing. A new floor plan will be created. 

 
When the floor plan is first created, it will be auto-assigned a name - in this example 
Proposal290. 

 
This name can be changed by highlighting it and selecting Rename from the right click 
menu. 

Editing Floor Plans 
When a floor plan has been added, it can be edited by highlighting it and selecting the 
Properties option on the Right click menu. This will bring up the Properties dialog box. 

Details Tab 
The Details tab contains information of the floor plan. 
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File Name is the name assigned to the file - this will typically be the name of the floor 
plan. 

Location is the path to where the physical copy of the DWG file is held. This will be 
below the Store Root specified in the Directories Tab of the Configuration Module. 
(This tab is only accessible if the configuration module is opened via the Administration 
module). 

File Predecessor is the name of the file this file was derived from. This will be populated 
if the file was created automatically as a result of the Planogram Substitution process. 

Type shows the extension of the file - and hence its type. The DWG extension indicates it 
is an AutoCAD file. 

Size is the physical size of the file. 

File Status is where the floor plan is in its business life cycle. See the section on statuses 
for more information. 

Prototype Store is the name of another store which can be used for comparison purposes. 
After being set up through the Custom SQL, i t is possible to compare the selected floor 
plan with the floor plan at Current status in the prototype store. This enables differences 
to be compared for reporting purposes. 

Active Date is the date at which the floor plan is scheduled to come into service. This 
date can be used as a filter to determine whether equipment of merchandise will be 
available for placement at the time which the floor plan will be made current (active). 

Publish Date will be grayed out and unavailable until the floor plan is at Authorized 
status. Once set, the publish date is the date at which Update Status  will automatically 
change the status of the floor plan to Published. A copy of the floor plan will then be 
placed in the designated export directory for onward transmission to the store in 
preparation for putting the floor plan into service. When the Publish Date first appears, it 
will be set to a default value by the software. 

Effective Date will be grayed out and unavailable until the floor plan is at Authorized 
status. Once set, the effective date is the date at which Update Status will automatically 
change the status of the floor plan to Current. This is the signal (via an appropriate 
reporting system) for the store to put the floor plan into effect. When the Effective Date 
first appears, i t will be set to a default value by the software. 
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Created is the date the floor plan was originally created in Store Manager. Alternatively, 
if the floor plan was imported, this will be the date it was originally created in raw 
AutoCAD. 

File Modified is the date the floor plan was originally created in Store Manager. 
Alternatively, if the floor plan was imported, this will be the date it was last modified in 
raw AutoCAD. Once the file has been saved in Planner, the database will hold the date of 
that save but the File Modified field will continue to show the date it was last modified in 
raw AutoCAD. 

Last Modified is the date the file was last saved by a user in the Planner or Merchandiser 
modules or in In-Store Space Collaboration. 

Modified by Automation  is the date the file was last modified by a batch process such as 
planogram substitution. 

Last Modified By is the individual or process that last modified the file. 

Note: The Created, File Modified, Last Modified and 
Modified by Automation  dates can be used to decide on 
how to manually synchronize the floor plan if Auto-
Synchronization is not enabled: see the section on 
synchronization. 

File Last Published is the date the file was last published as a result of Update Status 
being run. 

File Made Current is the date the file was made current - typically as a result of Update 
Status being run. 

File Made Historical is the date the floor plan was superseded as a current file by 
another floor plan. This change is made automatically by the software and the date set 
accordingly. 

ID is the value of the FIL_ID field in the AVTTB_FILE table in the database. This 
information is provided to assist support personnel in problem solving. 

Checked Out indicates whether the file is in use or not. 

Notes Tab 
The Notes tab holds details of notes created in Macro Space Management, in In-Store 
Space Collaboration and in ISSC Mobile. These notes are visible in all three applications 
and serve both to record and communicate data.   
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Macro Space Management 

Macro Space Management users can add or delete notes. 

 Notes are added by clicking Add and typing data into the blank line. Notes in MSM 
only apply to the floor plan itself and cannot be applied to objects within that floor 
plan. 

 Notes are deleted by highlighting them and clicking Delete. 

 If the floor plan is at a status that is not Read Only (for example not at Current or 
Historical status), the notes can be edited. As well as the note text being modified, the 
Updated date will change. 

Notes added in ISSC and ISSC Mobile can also be associated with zones, fixtures, shelves, 
products and planograms. There is no way of identifying the type of note in the Notes 
tab. 

In-Store Space Collaboration 

ISSC users can add notes to the floor plan. They can also add notes to objects in the floor 
plan such as zones and fixtures. These notes can be read in MSM. 

ISSC Mobile 

ISSC Mobile users can add notes to zones, fixtures, shelves, products and planograms, 
but not floor plan notes. They can also add additional notes to an existing note, stating a 
conversation. These notes can be read in MSM. ISSC mobile users can only add notes to 
floor plans at Current status. 

UDA Option 
Clicking the UDA button will bring up the Floor Plan User Defined Attributes dialog 
box. This holds retailer specific information for the floor plan. In the example below, it 
has been configured to hold information on why the floor plan is being updated. 
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The list of available fields can be configured using the User Defined Attributes option 
from the General Menu in the Administration module. Users in Store Manager can then 
set the values for each floor plan. Depending on how each field has been configured in 
the Administration module, users can enter numeric, text or currency values, select from 
a drop down list, enter a date from a calendar or select or deselect a check box. Some 
values can be defined as mandatory when they are configured in the Administration 
module. These are indicated by a blue asterisk. A mandatory value is not filled will be 
indicated by a red cross. An example of this as can be seen for the Responsible Planner 
field in the screen shot below. 

 
 If the user attempts to close the User Defined Attributes dialog box without setting a 
mandatory attribute, a warning will result. 
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Accessing the File UDA dialog box directly 
If required, the File UDA dialog box can be accessed directly from the right click menu in 
the list pane in Store Manager. 

 
If multiple floor plans have been selected, the File UDA dialog box will display the 
attributes for the last floor plan selected. 

Importing, Exporting and Copying Floor Plans 
Floor plans can be either imported or copied. 

Importing Floor Plans 
Floor plans can be imported into Store Manager. This is done by highlighting an existing 
floor plan (this can be a blank) and then selecting the Import New Version of Drawing 
option from the right click menu. 
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This will bring up the Import Drawing dialog box. 

 
This enables users to browse to the Windows folder holding the floor plan and select it. 
On clicking the Open button, the Import New Version of File dialog box will appear. 

 
Users can select whether to keep the existing file name or use that of the file to be 
imported. 
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Important Note: objects in the imported floor plan will not 
be written to the MSP database until the file has been 
synchronized 'Match the Drawing'. Blocks in the imported 
floor plan that also exist in Fixture Studio will then be 
written to the database. 

Exporting Floor Plans 
Floor plans can be exported from Store Manager by highlighting the pertinent floor plan 
then selecting Export from the right click menu. This will bring up the Export Drawing 
dialog box. 

 
The filename will be a composite of the form: Store_Name_Floor 
Name_Revision_Name_File_Name. After selecting an appropriate directory, the file can 
be exported by clicking the Save button. 

Copying Floor Plans 
Floor plans can be copied within a revision or from one revision to another. Copying is 
done by highlighting the required floor plan then selecting the Copy option from the 
right click menu. After navigating to the required location, the Paste option can be used 
from the right click menu to place a copy of the file. At the same time and exact copy of 
all existing information in the database for the original file is created for the copied file. 

Note: If copying from one floor to another, any architectural 
plans associated with the original should be temporarily 
unchecked. Once the floor plan has been pasted to the 
revision in the new floor, it can be associated with any 
architectural plans associated with that floor. The 
architectural plans can also be re-associated with the old 
floor plan. 
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Associating Architectural Plans 

Overview of Architectural Plans 
Architectural Plans can only be associated with Floors. They contain information on the 
structure and fabric of the building including the position of walls, doors, electrical 
systems and other services. 

 
The above screen shot shows a DWG type architectural plan in isometric view. Its 
outlines show fainter than other objects in the floor plan because it effectively servers as 
an underlay to the floor plan. This architectural plan shows the structure of the store and 
allows the zones to be correctly drawn and the fixtures correctly positioned with respect 
to the walls, doors and windows. 

Architectural plans are used in two stages: 

1. They must first be associated with a parent floor in Store Manager. 

2. After the architectural plan has been associated with a specific floor, it can then be 
associated with any child floor plan. This is done from the Insert menu in the Planner 
module once the floor plan has been opened in Planner. 

Types of Architectural Plans 
Macro Space Planning recognizes two forms of architectural plans:   

 DWG files can only be used within the Planner module. 

 DWF files can be used both within the Planner module and in In-Store Space 
Collaboration (ISSC). 

Associating an Architectural Plan 
Architectural plans can only be associated with floors. Once associated this makes them 
available for use within any floor plan associated with the parent floor. Architectural 
Plans can be associated by highlighting the required floor then selecting the Associate 
Architectural Plan command from the File menu, the Toolbar or the right click menu. 
This will bring up the Architectural Plan Association dialog box. 
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1. Browse to the required file 

2. Click OK 

3. The file will be copied to the specified folder and will become available for use 
within individual floor plans. 

Note: The architectural plan will not appear in an individual 
floor plan unless it is associated with it using the Insert 
menu in the Planner module once the floor plan has been 
opened in Planner. 

Associating Files 
Files can be associated with any level of the store hierarchy except clusters. Any form of 
file can be associated including: 

 Word documents  

 Excel spreadsheets  

 PDF Files 

These files can be used for many purposes including: 

 Performance reports at store, floor and floor plan level 

 Store specific information on suggested improvements to merchandise 

 Non-MSP information that will be useful for store planners. 

How to Associate Files 
Files can be associated by highlighting the required object in the hierarchy and then 
 selecting the Associate File command from the File menu, the Toolbar or the right click 
menu. This will bring up the File Association dialog box. 
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1. Browse to the required file. 

2. Specify whether the file is to be copied into Store Manager or whether a link is to be 
created to an external file. 

3. Click OK. 

4. If the file is copied, a copy will be imported into the appropriate folder in Store 
Manager. 

 
5. If a file is linked, MSP will hold a copy of the path to the file. 

Note: If linking to a file, ensure it is available on a network 
resource or it might not be available to all users. 

The advantage of linked files is that the latest version will be available if they are 
updated by an external program. Copied files will need to be re-imported in order that 
the latest version is available in Store Manager. 

Deleting Associated Files 
Deleting associated files may be carried out by highlighting them then selecting the 
Delete command from the File menu, the Toolbar or the right click menu. The file will 
not be permanently deleted until the Purge option is used from the Tool menu. 

 



 

Status 81 

8 
Status 

Overview of Statuses 

Concept of Statuses 
Statuses are used to indicate where an object is in its business life cycle. For example a 
store will go through a design stage, be built, be opened, be closed for refurbishment, 
reopen for business and finally be closed as its structure wears out or it is sold. By being 
able to set statuses in the store hierarchy, store planners can indicate where stores, floors, 
revision and floor plans are in their business life cycle - and hence control activities based 
on that information. The example below shows example statuses for a store. 

 
For example, a floor plan may go through a series of stages during the planning 
processes - these would include laying out the equipment, receiving approval for that 
layout, laying out the merchandise, receiving approval for that merchandise, authorizing 
that floor plan to go into service, publishing the floor plan, putting it into service and 
finally retiring it from service. 

Because a large retail organization may have several thousand stores and an even large 
number of floor plans, it is standard practice to set up a report identifying which objects 
have had their statuses changed recently and what actions are required. 

Configuring Statuses 
Macro Space Planning has a set of default statuses configured. The list of available 
statuses can be modified using the Status dialog box in the Administration module. This 
also allows the order statuses are displayed, whether they are reversible, whether files 
become read only when the status is selected, etc. 
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Note: See the Oracle Retail Macro space Management 
Administration Module User Guide for more information. 

 

Users and In-Store Space Collaboration 
Users in In-Store Space Collaboration have the ability to indirectly change the status of a 
floor plan. When closing and saving a floor plan, some users have the option to Accept or 
Reject that floor plan. This will result in the present status of that floor plan being 
changed to a predefined alternative. 

Non-Reversible Statuses 
Some statuses are set to be non-reversible - users can select that status, but having 
selected it cannot then manually reset that status to an earlier one. 

Non-Selectable Statuses 
Some statuses can be set to not be selectable manually. An example of this is Current 
status as floor plans are normally automatically changed to that status by the Update 
Status functionality. 

Example of Controlling Business Flows with Statuses 
The following is a simple example of how statuses can be used to control business flows: 
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1. The process flow starts with a floor plan at Proposal status. 

2. After laying out the fixturing, the store planner changes the status to Fixturing ready 
for Approval. This alerts his manager. 

3. The manager reviews the layout of the fixturing. If they disagree with it, they set the 
status back to Proposal - causing the store planner to rework the fixturing. If the 
manager agrees with the layout of the equipment they change the status to Fixturing 
Accepted. 

4. Once the status has been changed to Fixturing Accepted, the store planner places the 
merchandise. When this is complete, the store planner sets the status to Merchandise 
ready for Approval. 

5. The manager reviews the layout of the merchandise. If they disagree with it, they set 
the status back to Fixturing Accepted - causing the store planner to rework the 
products and planograms. If the manager agrees with the layout of the equipment 
they change the status to Merchandise Accepted. 

6. At an appropriate time, the manager then changes the status to Layout Verified and 
Ready for Store Approval. This makes the floor plan visible in In-Store Space 
Collaboration. 

7. The store manager opens the floor plan in ISSC. They have two choices when saving 
it. Clicking Reject will change the sta tus back to Proposal, starting the whole 
planning process again. Clicking Accept will change the status to Authorized. The 
Publishing and Effective dates will then be set. 

8. When the Publish date is reached, the Update Status tool will change the status to 
Published, causing a copy of the floor plan to be sent to the store in preparation for 
its implementation. 

9. When the Effective date is reached, the Update Status tool will change the status to 
Current. The store will then be notified to put the plan into effect. 

10. When another floor plan for that store becomes current, the existing store plan will 
be superseded and will be set to Historical status. 
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Changing the Status of Objects 

Changing Statuses 
Statuses can be changed by selecting the required store, floor, revision or floor plan in the 
store hierarchy. It can then be opened for edit using the right click menu or the edit 
option from the Edit menu on the menu bar or the edit option from the toolbar. 

Clusters 
Clusters and sub-clusters are administrative devices for arranging stores in logical 
groupings. As such they do not have a status. 

Stores 
Statuses for stores are set using the Status drop down list in the Store dialog box. 

 
If a store is set to Closed, all associated floor plans will be set to Read Only status. Any 
attempt to open those files for editing will result in the appearance of a warning dialog 
box. 

 

Floors 
Statuses for floors are set using the Status drop down list in the Floor dialog box. 
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If a floor is set to Closed, all associated floor plans will be set to Read Only status. Any 
attempt to open those files for editing will result in the appearance of a warning dialog 
box. 

 

Revisions 
Statuses for revisions are set using the Status drop down list in the Revision dialog box. 

 
If a revision is set to Closed, all associated floor plans will be set to Read Only status. 
Any attempt to open those files for editing will result in the appearance of a warning 
dialog box. 
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Files 
Statuses for revisions are set using the Status drop down list in the File Properties dialog 
box. 

 
Some statuses for floor plans may not be reversible - for example, if the status is set 
manually to Published, it may not be possible to set it back to an earlier date. Other 
statuses are not selectable - for example it is not generally possible to set the status to 
Current manually as this is normally done automatically when Update Status is run. 

When the floor plan status is set to Authorized, it becomes possible to set up Publish 
Date and Effective Date. 

 When the Publish Date is reached, if Update Status is run, this will change the status 
to Published. 

 When the Effective Date is reached, if Update Status is run, this will change the 
status to Current. 
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Advanced Administration 

Customizing Display Options 
The appearance of some aspects of the Store Manager module can be customized via the 
Options option on the View pull down menu. This brings up the Options dialogue box. 

 

Display Options 

Show Files Marked for Deletion 
The Show Files Marked for Deletion option is used to specify whether files marked for 
deletion are to remain visible or are to be hidden. If the Show files option is chosen, files 
marked for deletion will be shown with the deleted icon. 

 

Note: Files marked for deletion are not permanently 
removed from the database until  the Purge option has been 
used from the Tools menu. 

Show Store Codes 
This option allows users to specify whether or not the Store Code will be displayed 
before the Store Name in the store hierarchy. 
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Show Grid 
If active, this option adds a grid to the list of objects displayed in the list view pane on the 
right hand side of Store Manager. 

Show Large Icons 
This check box changes the icon size. 

Show Tooltips for Tree View 
If active, this option displays the store, floor or revision code when the mouse pointer is 
held over the object within the Store Manager hierarchy. 

Show Tooltips for List View 
If active, displays the full path when the mouse pointer is held over a file in the list view 
pane on the right hand side of Store Manager. 

Show Document Preview 
If active, this option puts a preview of the document at the bottom of the Store Manager 
Window 

Date Format 
This option uses a drop down list to select the form the date is displayed in. 

Enable Drag and Drop 
If enabled, this allows the Store hierarchy to be rearranged by dragging and dropping. 

Enable Automatic File Renaming 
This option is not currently active. 

Enable Column Reordering 
If active, this allows the columns in the list view pane on the right hand side of Store 
Manager to be dragged and dropped to a  different order. 

Enable Editing 
This option is not currently active. 

Enable Multiple File Selection 
If active, this option allows the user to multi-select files for further operations. 

Populate on Demand 
The Populate on Demand Option does not load full information for the store hierarchy 
until the users opens a specific branch. That branch is then populated with full data as 
the user opens it. If this option is not selected, all branches of the hierarchy populate as 
Store Manager is opened. 
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Windows Folders and the Store Hierarchy 
Store Manager has a specified structure. Objects are ordered in this sequence: 

1. Clusters  

2. Stores  

3. Floors  

4. Revisions 

5. Files 

Specific files associated with specific levels on the hierarchy will be in the appropriate 
folders. For example architectural plans will be associated with floors and floor plans in 
folders associated with revisions. 

 
Clusters only exist in the Macro Space Planning database. For Stores, Floors and 
Revisions, Windows folders are created below the Store Root specified in the Directories 
tab of the Configuration module - this tab can only be accessed if the Configuration 
module is accessed via the Administration module. 
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Any physical files associated with specific levels on the hierarchy will be in the 
appropriate folders. For example Architectural plans will be in folders associated with 
floors and floor plans in folders associated with revisions. 

Searching the Store Hierarchy 
The search facility can be activated by clicking the search icon on the toolbar. 

 
This brings up a dialogue box with a dialogue box with a series of options. Select the 
required options and click on OK. 

  
The search function in Store Manager performs an in-string search and does not support 
wild-cards. It will thus only return exact matches. The search starts from any selected 
node, and can be set to search up or down from that node. 

Significance of Dates in File Properties Dialog Box 
The File Properties dialog box that can be accessed from Store Manager contains a series 
of dates that give information on how and when the file was last modified or processed. 
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These dates have the following significance: 

Option Description 

Created 
 This is the date the floor plan was originally created in Store Manager. 
Alternatively, if the floor plan was imported, this will be the date it was 
originally created in raw AutoCAD. 

File Modified This is the date the floor plan was last modified in raw AutoCAD. 

Last Modified This is the date the file was last saved by a user in the Planner or Merchandiser 
modules or in In-Store Space Collaboration. 

Modified by 
Automation 

 This is the date the file was last modified by a batch process such as planogram 
substitution. 

These dates are often used to decide on the correct actions when manually or 
automatically synchronizing the floor plan. 

Note: See the section on synchronization for more 
information. 

List Checked Out Files 
Checked out files are files that the database has flagged as being in use for some reason. 
These include: 

 File is checked out to a user in either Macro Space Management or In-Store Space 
Collaboration. 

 File is checked out to a batch process. 

 File has remained checked out due to a software problem. 

In these instances, users with access to Store Manager can manually check the files back 
in. 
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Note: If the file is manually checked back in, all changes 
since the previous save will be lost. 

 
 Selecting All Checked Out Files lists every file checked out from Store Manager. This 

option is only available to users in a User Group with the Administrator role. 

 Selecting My Checked Out Files lists the files checked out by that particular log in 
identity. (This can also be accessed by <Ctrl + O>). 

After the option has been selected, the user has the option to check files back in by 
highlighting them then clicking Check In. 

 

Purging from Store Manager 
The Purge option allows users to permanently delete several types of object: 

 Objects in the Store Manager hierarchy such as clusters, stores, floors, revisions and 
floor plans. 

 Back-up files for AutoCAD (files with a BAK extension) 

 Text log files created for Store Manager. 

Purging can only be carried out by users belonging to User Groups that have the 
Administrators role assigned. 

Removing Objects from the Store Manager Hierarchy 
Permanent removal of objects from the Store Manager hierarchy is done in two stages. 
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1. The required object is marked for deletion in the store hierarchy. If the selected object 
is a DWG file, i t will be moved to the RFBin. The location of this folder is specified in 
the Directories tab of the Configuration Module. (This tab is only accessible when the 
Configuration module is accessible via the Administration module). 

2. The objects are permanently deleted using the Purge option from the Tools menu. 

Deleting Objects 
Depending on settings in the Options dialog box (View menu), objects marked for 
deletion will either be hidden from view or denoted with the Deleted icon. 

 
If a top level object (for example a store) is marked for deletion, all child objects will be 
marked for deletion as well.  If the up level object is undeleted, all child objects will have 
to be manually undeleted.   

Purging Objects 
Purging objects results in their permanent removal from the Macro Space Planning 
database. In the case of the DWG files used for floor plans, these will also be physically 
deleted from the RFBin - where they were move to when marked for deletion. 

Note: Purged DWG floor plans files cannot be recovered, so 
care should be taken to ensure they are no longer required. 

To purge objects, select the Purge option from the Tools menu. 

 
This will bring up the Items Marked for Deletion dialog box 
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Items marked for deletion are highlighted and then removed by clicking Destroy. 

Note: The right click menu gives the option to Select All 
Files, Deselect All Files, Destroy or Undelete files. 

Objects cannot be deleted if they have child objects associated with them. The most 
common example of this occurring is when an architectural plan is in the list of files to be 
deleted. All floor plans associated with the architectural plan should be deleted before 
the architectural plan itself is deleted. 

Purging .BAK files 
When Planner modifies a file, some settings in Planner can cause it to save a back-up 
version. This is saved with the file extension .BAK. Because floor plans can be large, these 
.BAK files can occupy a considerable amount of server or hard disc space. Purging the 
files frees up this space and may improve performance. 

Purging Log Files 
Store Manager writes a series of log files when any errors occur. These files accumulate 
over time. The "purge log files" allows the option of deleting these files; either between a 
date range, or on the user’s computer. 

 

Importing Directories 
The Import Directory option allows files to be imported into the Store Manager file 
structure and corresponding entries to be made in the database. The import process is as 
follows: 



 Store/Cluster view 

 Advanced Administration 95 

Preparation 
The files to be imported must have a data structure compatible with Store Manager – the 
files should be in the store/floor/revision/file hierarchy. If there are multiple stores to 
import, these files should under a common directory. 

Importing 
1. A parent cluster should be selected within the Store Manager hierarchy, (or created if 

required). This parent cluster will be the target for the files to be imported. If any 
object other than a cluster is selected, this option will be grayed out and unavailable. 

2. The Import Directory option should then be selected from the Tools menu. This will 
bring up a dialogue box called Directory Structure Import. This has three options 
called Preview, Options and Results. 

 
3. In the Preview tab, use the Browse button to navigate to the require source for the 

directories to be imported. 

4. In the Options tab specify the file extensions to be excluded from the import. 

5. Click the Import button to import the information. 

6. The results can be seen in the Result tab. 

Store/Cluster view 
Selecting the Store/Cluster view option brings up a window allowing an alternative way 
of viewing the information held within the hierarchical data structure within Store 
Manager. Stores are listed in the sequence determined by their unique identification 
code. The cluster to which the store has been allocated is displayed immediately below 
the store. Where stores are assigned to multiple clusters, this will be shown. For example 
the Berlin store belongs to both the Europe and Large Store clusters. 
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Integrity Check 
The Integrity Check compares the store directory structure shown in the current display 
window with that registered in the database. Any errors found are displayed and should 
be brought to the attention of the Systems Administrator for rectification. 

 
 The ID  column contains a list of the File ID’s used by Macro Space Management as 
references for the files. If a File ID is missing, this means a problem with the directory 
structure. 

The Type is the type of object. It can be a Store, Floor or Revision. Clusters and sub-
clusters will not appear as they are folders for holding files, not files themselves. 

The Description is the name given to the object. 

The Path is the path in the directory structure to the designated object. 

Log Files 
Log files are files recording events and problems during operation of Macro Space 
Management. This enables problems to be investigated at a later date. They can be found 
at the location specified in the Directories tab of the Configuration Module - this tab is 
only available if the configuration module is open via the Administration module. 
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Double clicking on a specific file will bring up a log of that aspect of Macro Space 
Management’s operations. 

Note: In many cases, log files have been superseded by 
information written back to tables in the Macro Space 
Planning database. 
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Update Status 

Overview of UpdateStatus.exe 
UpdateStatus.exe is a small Macro Space Management tool that can be used to change the 
status of floor plans. 

 
1. The initial stage is to set the Publish and Effective dates when a floor plan reaches 

Authorized status 

2. Update status is set to execute every night by means of a scheduling tool. 

3. When the Publish date is met or exceeded, the status of the floor plan is changed to 
Published. 

4. When the Effective Data is met or exceeded, the status of the floor plan is changed to 
current. 

5. At the same time as the status of the floor plan is changed to current any pre-existing 
current file for that floor is changed to Historical status. 

Running Update Status 
There are three ways of running UpdateStatus.exe; directly, using Windows Scheduler or 
using another batch scheduling tool. It is normal to install a copy of Macro Space 
Management on the batch server - UpdateStatus would generally be run from there. 

1. Running Directly 

To run UpdateStatus.exe directly, navigate to the C:\Program Files\Oracle 
Retail\MSM\Common directory on the batch server. 
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Click on AVT5UpdateStatus.exe to run the file. 

2. Through Windows Scheduler 

Windows Scheduler gives the option of running UpdateStatus.exe automatically at 
set intervals. 

3. Through other Batch Scheduling Tools 

UpdateStatus.exe can also be run though more advanced batch scheduling tools. 

Command Line Switches 
If run through via a batch scheduling tool, the command line switch /Silent allows the 
user to run it without confirmatory dialog boxes appearing. 

Using UpdateStatus.exe 
To use UpdateStatus.exe the following actions are required. 

 
The process is carried out as follows: 

1. Open the file Properties dialog box  

This is done by highlighting the required file within the right hand pane of Store 
Manager then right clicking to bring up the pop-up menu. Selecting Properties from 
this menu will bring up the Properties dialogue box. 
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Note: setting the varying values required for Update Status 
is carried out by clicking the down arrow on the pertinent 
field. In the above screenshot, the effective date is being set. 

2. Set File status to Authorized 

This is done by highlighting the required file within the right hand pane of Store 
Manager then right clicking to bring up the pop-up menu. Selecting Properties from 
this menu will bring up the Properties dialogue box. 

3. Set the Publish Date  
The Publish Date is the date at which the floor plan will be set to Publish status by 
Update Status. This will allow the requisite store to begin preparations for 
implementing the changed floor plan. The default Publish Date is set a specific 
number of days ahead of date the value is being set - this time period is set by the 
PUBLISH_DATE_LEAD_PERIOD system variable in the Administration module. 

The Publish Date can be set using the drop down calendar. 

4. Set the Effective Date  

The Effective Date is the date at which the floor plan will be set to Current status by 
Update Status. This is the date at which the requisite store will carry out the changes 
required for the floor plan. The default Effective Date is set a specific number of days 
ahead of date the value is being set - this time period is set by the 
EFFECTIVE_DATE_LEAD_PERIOD system variable in the Administration module. 

The Effective Date can be set using the drop down calendar. 

5. Run UpdateStatus.exe 

Update status can be run manually. However, it is more normal to run it using a 
scheduling tool. 
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 When the Publish Date is met or exceeded, the status of the file will be changed to 
Published. 

 When the Effective Date is met or exceeded, the status of the file will be changed to 
Current. 

Note: If a floor contains several files of Authorized status 
with Effective dates before the date Update Status.exe is run, 
only the latest file will have Current status - all other files 
will have Historical Status.   

  If run directly, a small pop-up window will report the results. 

 
Note: UpdateStatus.exe will not actually publish the file or 
notify the store that Publish or Current status has been 
reached. This has to be done via MSMs Automated Floor 
Plan Publishing functionality and the retail organizations 
own reporting tools. 

Potential difficulties with UpdateStatus.exe 

Multiple Authorized Files within a Floor 
If there are multiple Authorized files within a floor, when UpdateStatus.exe is run, it will 
sequentially change them to Current status based on the Effective Date. As each file is 
changed to Current status, it will change the preceding file to Historical Status. 

Multip le Revisions 
Each Revision for a floor can only contain one Authorized file. Therefore, if a floor is to 
have multiple Authorized files, multiple Revisions must be created for that floor. If a 
floor only has a single Revision then this can only contain a single Current file and a 
single Authorized file. (It can contain multiple Proposed and Historical files. If a floor has 
multiple revisions, then care must be taken to keep track of which Revision contains the 
Current version of the drawing. Files with an Effective Date greater than the date 
UpdateStatus.exe is run will not have their status changed. All Effective Dates set to a 
date before the date UpdateStatus.exe is run will be changed to Current status in the 
sequence based on the date and time they were authorized. This will result in all but the 
last file set to Authorized being set first to current, and then to historical status. This 
means that only the last file to be set to Authorized will retain Current status. 

Status of Revisions 
UpdateStatus.exe does not currently change the status of Revisions when floor plans 
within the Revision have their status changed. It is therefore currently possible to have a 
Current file in a Revision that is not of Current status. 
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Dates 
UpdateStatus will change the status of a floor plan depending on whether the Publish 
Date or Effective Date has been met or exceeded. Running Update status at 23.30 on 12th 
June will have a different date to running it at 00.15 on 13th June, although the two 
instances are only 45 minutes apart. 
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Automated Calculations 
Automated Calculations are used to ensure the information held in the database has 
been updated for reporting purposes. It provides an alternative to some of the options in 
batch floor plan processing or the options in the pre-processing tab of the Floor Plan 
Publishing Configuration dialog box in the Administration module. Because 
Automated Calculations operates globally, access needs to be assigned to a User group 
before a member of that User Group can access the functionality.  

 

Accessing Adjacency Calculations 
Access to the Automated Calculations functionality is assigned in the Functional Security 
dialog box in the Administration module. Users who have not had those permissions 
assigned will see a warning dialog box if they attempt to access the functionality. 

 

Running Manually 
If access permissions have been granted, Automated Calculations can be run manually 
from the dialog box accessed from the provided shortcuts or run directly from the 
C:\Oracle Retail\MSM\Common folder.  Users can then select which calculations to run and 
which file status those calculations will be run on. Users using this functionality should 
be aware that calculations will be updated for all specified files in the database. 
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Running from the Command Line 
Automated Calculations can also be run from the Windows command line using the 
following syntax: 
"Path\AVT5AutomatedCalcs.exe" /Silent /Options /Status /Files 
An example would be: 
"C:\Oracle Retail\MSM\Common\AVT5AutomatedCalcs.exe" /Silent /Options 25 /Status 
23|25|27 
This syntax can either be used to update the results of calculations for a number 
of files by entering the data manually, or it can be put into a file and run as 
part of a batch process. 

Path and File Name 
The path is the location where the AVT5AutomatedCalcs.exe file is located. 

/Silent 
This option is used to suppress confirmatory dialog boxes when automated calculations 
are being run in batch mode. 

/Options 
This is a bitwise value specifying the selected options. 

Value Calculation 

0 No selection 

1 Aisle Adjacency 

2 Allocated Areas 

4 Face Planes 

8 Fixture Adjacencies 

16 Product Adjacencies 

32 Space Measurements 

/Status 
The statuses for files to process are specified as pipe delimited STA_ID's from the Status 
table: for example 23|25|27. 

/Files 
The ID of specific files to process is specified as a comma separated list of FIL_IDs from 
the File table: for example 235, 483, 679 

Note: For full information on these tables see the Oracle Retail 
Macro Space Planning Data Model. 
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12 
Planner Module 

Overview of Planner Module 
The Planner Module is based on AutoCAD. It can be used to plan the layout of 
departments (zones), equipment and merchandise within stores with considerable 
accuracy. It can also be used to generate reports on performance to enable the user to 
continually improve the efficiency and profitability of that store. 

 

It has the following components: 

Component Description 

Menu Bar This allows users to access various AutoCAD and Planner module commands. 

Toolbars These allow users to access various AutoCAD and Planner toolbars. 

Object 
Browser 

This allows users to add edit and delete zones, equipment and merchandise. It also 
allows users to see visual performance reports (hot-spotting/Key Performance 
Indicators). 

Object Grid This is an alternative method for users to place fixtures, products and planograms. 

Command 
Line This allows text based input for many AutoCAD and Planner commands 

Status Bar  This allows many AutoCAD commands to be toggled on or off. 

Floor Plan This is the currently active representation of a floor within a specific store. 
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13 
Planner Menu Overview 

The File Menu 
The File Menu  allows users access to a number of general options. 

Note: This section of the help file refers to the File menu 
associated with the 2014 version of AutoCAD. Users using 
earlier versions of AutoCAD may find a slightly different 
menu. 

 
 

Functionality  Source Comment 

Open Macro Space 
Management 

Opens Store Manager 

Close Macro Space 
Management 

Closes the current drawing 

Save Macro Space 
Management 

Saves the current drawing 

eTransmit AutoCAD See AutoCAD Help File for further information. 

Export AutoCAD See AutoCAD Help File for further information. 
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Functionality  Source Comment 

Publish AutoCAD See AutoCAD Help File for further information. 

Publish 
Planograms 
Immediately 

Macro Space 
Management 

Publishes any planograms associated with the 
currently open file to the folders specified in the 
Administration module. 

Publish Floor 
Plans 

Macro Space 
Management 

Publishes any selected floor plans to the folders 
specified in the Administration module. 

Print Planograms Macro Space 
Management 

Prints any planograms associated with the 
currently open floor plan. 

Plot AutoCAD/Macro 
Space Management 

This menu allows the user to call the Print floor 
Plans dialog box using the Plot > Search and Print 
option. For the other options see the AutoCAD 
Help File. 

Options AutoCAD See AutoCAD Help File for further information. 

Configuration Macro Space 
Management 

Opens the Configuration Module 

Synchronize Macro Space 
Management 

Opens the Synchronization Module  

Refresh Browser Macro Space 
Management 

Refreshed the Object Browser with the latest 
information from the database 

Drawing Utilities AutoCAD Calls varying AutoCAD utilities - see AutoCAD 
Help File for further information. 

Send AutoCAD See AutoCAD Help File for further information. 

Drawing 
Properties 

AutoCAD See AutoCAD Help File for further information. 

Exit Macro Space 
Management 

Exits the Module 

The Edit Menu 
The Edit Menu gives access to AutoCAD Functionality. 

Note: This section of the help file refers to the Edit menu 
associated with the 2014 version of AutoCAD. Users using 
earlier versions of AutoCAD may find a slightly different 
menu. 
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Functionality  Source Comment 

Undo AutoCAD Allows the last command(s) to be undone. The exact text will 
vary depending on what the last executed command was. In 
the example above, Undo can be used to stop the Publish 
Planograms Immediately command. 

Redo AutoCAD Allows the last command(s) to be undone. (The exact text will 
vary depending on what the last executed command was). 

Cut AutoCAD See AutoCAD Help File for further information. 

Copy AutoCAD See AutoCAD Help File for further information. 

Copy with Base 
Point 

AutoCAD See AutoCAD Help File for further information. 

Copy Link AutoCAD See AutoCAD Help File for further information. 

Paste AutoCAD See AutoCAD Help File for further information. 

Paste as Block AutoCAD See AutoCAD Help File for further information. 

Paste as 
Hyperlink 

AutoCAD See AutoCAD Help File for further information. 

Paste to Original 
Coordinates 

AutoCAD See AutoCAD Help File for further information. 

Paste Special AutoCAD See AutoCAD Help File for further information. 

Clear AutoCAD See AutoCAD Help File for further information. 

Select All AutoCAD See AutoCAD Help File for further information. 

OLE Links AutoCAD See AutoCAD Help File for further information. 

Find AutoCAD See AutoCAD Help File for further information. 
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The View Menu 
The View Menu provides the following options: 

Note: This section of the help file refers to the View menu 
associated with the 2014 version of AutoCAD. Users using 
earlier versions of AutoCAD may find a slightly different 
menu. 

 
 

Functionality  Source Comment 

Redraw AutoCAD See AutoCAD Help File for further information. 

Regen AutoCAD See AutoCAD Help File for further information. 

Regen All AutoCAD See AutoCAD Help File for further information. 

Display 2D Macro Space 
Management 

Displays the drawing in Macro Space 
Management 2D Mode. (The blocks must have been 
configured accordingly). 

Display 3D Macro Space 
Management 

Displays the drawing in Macro Space Management 
3D Mode. (The blocks must have been configured 
accordingly). 

Zoom AutoCAD See AutoCAD Help File for further information. 

Pan AutoCAD See AutoCAD Help File for further information. 

Orbit AutoCAD See AutoCAD Help File for further information. 
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Functionality  Source Comment 

Walk and Fly AutoCAD See AutoCAD Help File for further information. 

Aerial view AutoCAD See AutoCAD Help File for further information. 

Rotate View AutoCAD See AutoCAD Help File for further information. 

Viewports AutoCAD See AutoCAD Help File for further information. 

3D views AutoCAD See AutoCAD Help File for further information. 

Visual Styles AutoCAD See AutoCAD Help File for further information. 

Toolbars AutoCAD See AutoCAD Help File for further information. 

Color Products Macro Space 
Management 

Allows products to be colored according to their 
level in the Product Hierarchy. 

Reports Macro Space 
Management 

Allows simple reports to be produced on objects 
within the current drawing. 

Drawing 
Comparison 

Macro Space 
Management 

Allows one drawing to be compared with another. 

Show (Hide) Object 
Grid 

Macro Space 
Management 

Will show or hide the Object Grid. 

Show Fixturing 
Summary 

Macro Space 
Management 

Show a summary of the equipment in the currently 
active floor plan. This window can be docked in the 
Object Browser 

Show 
Merchandising 
Summary 

Macro Space 
Management 

Show a summary of the merchandise in the currently 
active floor plan. This window can be docked in the 
Object Browser 

Show Zones 
Summary 

Macro Space 
Management 

Show a summary of the zones in the currently active 
floor plan. This window can be docked in the Object 
Browser 

The Summary Window 
The Summary window displays information on the zones, Fixtures or Merchandise 
placed in the currently open floor plan. The content of this window is configurable by 
modifying the Custom SQL in the database. This allows an implementer to specify the 
information that appears in the window. As an example, the window could include a 
comparison between the zones in the currently open floor plan and any designated 
prototype store. This window is called from the View menu although it can be docked in 
AutoCAD once called. 

Note: Custom SQL is modified in the Custom SQL table in 
the database. For more information on this table see the 
Oracle Retail Macro Space Planning Data Model.  

Zone Summary 
The Zone Summary shows information on the zones present in the currently active floor 
plan. The information displayed is configurable. 
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Fixturing Summary 
The Fixturing Summary shows information on the equipment present in the currently 
active floor plan. The information displayed is configurable. 

 

Merchandising Summary 
The Merchandising Summary shows information on the product present in the currently 
active floor plan. The information displayed is configurable. 
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The Insert Menu 
The Insert Menu provides ways to attach further information to the store plan. 

Note: This section of the help file refers to the Insert menu 
associated with the 2014 version of AutoCAD. Users using 
earlier versions of AutoCAD may find a slightly different 
menu. 

 
 

Functionality  Source Comment 

Block AutoCAD See AutoCAD Help File for further information. 

External 
References 

AutoCAD See AutoCAD Help File for further information. 

DWF Underlay AutoCAD See AutoCAD Help File for further information. 

Add 
Architectural 
Plan 

Macro Space 
Management 

X-Refs an architectural plan to the currently active floor 
plan. This architectural plan must previously have been 
added to the parent floor in Store Manager. 

Add Title Block Macro Space 
Management 

Adds a title block to the currently active floor plan. 

Update Title 
Block 

Macro Space 
Management 

Updates the information in the title block in the currently 
active floor plan. 

Bay Numbering Macro Space 
Management 

Add numbering to the fixtures in the store plan 
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The Format Menu 
The Format Menu  provides allows the user to control the layers, dimensions and units 
associated with the drawing. 

Note: This section of the help file refers to the Format menu 
associated with the 2014 version of AutoCAD. Users using 
earlier versions of AutoCAD may find a slightly different 
menu. 

 
 

Functionality  Source Comment 

Layer Aliases Macro Space Management 
& AutoCAD 

Calls a mixture of Macro Space Management 
and AutoCAD functionality. 

Layer AutoCAD See AutoCAD Help File for further 
information. 

Layer States 
Manager 

AutoCAD See AutoCAD Help File for further 
information. 

Layer Tools AutoCAD See AutoCAD Help File for further 
information. 

Dimension Style AutoCAD See AutoCAD Help File for further 
information. 

Units AutoCAD See AutoCAD Help File for further 
information. 

Drawing Set Up Macro Space Management Allow the user to select the scales for Paper 
space. 

The Modify Menu 
The Modify Menu  provides functionality for modifying objects in the store plan. 

Note: This section of the help file refers to the Modify menu 
associated with the 2014 version of AutoCAD. Users using 
earlier versions of AutoCAD may find a slightly different 
menu. 
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Functionality  Source Comment 

Properties AutoCAD See AutoCAD Help File for further information. 

Match 
Properties 

AutoCAD See AutoCAD Help File for further information. 

Change to 
ByLayer 

AutoCAD See AutoCAD Help File for further information. 

Object AutoCAD See AutoCAD Help File for further information. 

Clip AutoCAD See AutoCAD Help File for further information. 

Erase AutoCAD See AutoCAD Help File for further information. 

Copy AutoCAD See AutoCAD Help File for further information. 

Array AutoCAD See AutoCAD Help File for further information. 

Move AutoCAD See AutoCAD Help File for further information. 

Rotate AutoCAD See AutoCAD Help File for further information. 

Blocks Macro Space Management 
& AutoCAD 

Calls a mixture of Macro Space Management 
and AutoCAD functionality. 

Attributes Macro Space Management Allow the user to select the scales for Paper 
space. 

Text Macro Space Management 
& AutoCAD 

Calls a mixture of Macro Space 
Management and AutoCAD functionality. 

Calculations Menu 
The Calculations Menu enables users to initiate varying calculations that write data into 
the central Macro Space Planning database. 
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None of the functionality accessed from this menu is AutoCAD functionality. 

Tools Menu 
The Tools menu allows users to call or run Planogram Substitution.   

 
 

Functionality  Source Comment 

Planogram 
Substitution 

Planogram Substitution is a module that can be called 
from the Planner, Merchandiser or Administration 
modules. 

Pertinent 
permissions 
required. 

Run Planogram 
Substitution 

Planogram Substitution is a module that can be called 
from the Planner, Merchandiser or Administration 
modules. 

Pertinent 
permissions 
required. 

Permissions to access the planogram substitution functionality are set in the 
Administration module. If the appropriate permissions are not available, a warning 
message will result and access to the functionality will be denied. 

 

The Window Menu 
The Window Menu allows users to arrange multiple drawings, if open, and to select an 
active drawing from a set of open drawings. 

Note: This section of the help file refers to the Window menu 
associated with the 2014 version of AutoCAD. Users using 
earlier versions of AutoCAD may find a slightly different 
menu. 
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All functionality in this menu is AutoCAD functionality. 

The Help Menu 
The Help Menu contains a number of options that access Help and Assistance. 

Note: This section of the help file refers to the Help menu 
associated with the 2014 version of AutoCAD. Users using 
earlier versions of AutoCAD may find a slightly different 
menu. 

 

Functionality  Source Comment 

AutoCAD Help AutoCAD See AutoCAD Help File for further 
information. 

New Features Workshop AutoCAD Not yet available 

Planner Help Macro Space 
Management 

Calls Macro Space Management's Help File 
for this module. 

Additional Resources AutoCAD See AutoCAD Help File for further 
information. 

Customer Involvement 
Program 

AutoCAD See AutoCAD Help File for further 
information. 

About AutoCAD Gives the AutoCAD version. 

About Planner Macro Space 
Management 

Gives the Planner version 
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14 
Customizable Buttons 

Customizable Buttons 

Overview of Functionality 
Customizable buttons are used in the Planner module. They are an optional item during 
the installation process, so not all retailers will have this functionality implemented. If 
implemented, the Planner user will see the Customizable Button toolbar. 

 
This toolbar has ten buttons by default, each of which can call a stored procedure. This 
stored procedure is created by an implementer or administrator and can execute any task 
against data in the database. 

Example of Customizable Button Use 
The stored procedures called by the customizable buttons can execute any task that can 
be carried out by manipulating the data in the database. An example of this is splitting a 
floor plan up into departmental level floor plans, allowing multiple planners to work on 
a store plan simultaneously. 

 
1. A floor plan at current status (i.e. already in service) is opened. 

2. Clicking a customizable button runs a stored procedure that creates a series of floor 
plans for the individual departments in the floor plan. 

3. Multiple store planners work on the departments they are responsible for. 

4. Clicking on another customizable button runs a stored procedure that reassembles 
the department level floor plans into a single floor plan. 

This would allow a floor plan to be revised in a quick time scale using a team of floor 
planners, each with expertise in a particular department of the store. 
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Example of Using the Functionality 
An example of how to use the customizable Button functionality works is as follows: 

 

Open Floor Plan 
This functionality can only be used when a floor plan is open. Attempting to use it 
without one open will result in an error message. 

 

Click Customizable Button 
The purpose of each customizable button can be seen by hovering the mouse pointer 
over it. This will bring up the button name and a tooltip. These are customized during 
implementation. The functionality is run by clicking the selected button in the toolbar. 

Note: Pressing F1 will bring up the AutoCAD help - not 
Planner help. 

 

Note: Customizable buttons can also be run by typing 
AVT_CUSTOM into the command line, then entering the 
name of the command. 
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Verifying Permissions 
Permission to use the functionality is assigned by an Administrator in MSMs 
Administration module.  If the user does not have permission, the functionality will not 
run and a message to this effect will appear in AutoCAD's command line. 

 

Stored Procedure Execution 
If sufficient permissions exist, the stored procedure will execute.  A stored procedure is a 
way of directly manipulating data in the database. The data can be manipulated to 
perform a large number of tasks. What is configured will be retailer specific. Ask your 
administrator for details. 

Command Line Results 
Once the stored procedure has been executed, the results will appear in the AutoCAD 
command line. 

 
In the above example the stored procedure was designed to replace outdated fixtures. 
The message indicates that this was completed successfully. 

Carry out Necessary Follow Up Actions 
After the stored procedure has executed, some follow up actions may be necessary. In the 
case of the above example where a stored procedure was used to replace outdated 
fixtures, it is necessary for the user to first synchronize the floor plan 'match the database' 
and then manually save changes to the floor plan. If they do not and merely exit the floor 
plan the changes made by the stored procedure will be rolled back and the floor plan will 
revert to the state of when the floor plan was last saved. This could be different from 
before the button was pressed because any other changes will also be rolled back. 
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15 
Find and Open 

Overview of Find and Open 
Find and Open provides and alternative to opening floor plans via Store Manager. It will 
return a list of all floor plans that a user has permissions for and allow them to select 
which to open. It is accessed from the File menu in the Planner module. 

 
Selecting the Find and Open option will bring up the Find and Open dialog box. 
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Note: Users will only be able to see floor plans they have 
been assigned permissions for in the Administration 
Module. If a user has not been assigned those permissions, 
they will not be able to see the floor plan in the Find and 
Open dialog box. 

The basic method of operation is as follows: 

 

Administration Module 
Within the Administration Module: 
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 The Stores users have permissions to open floor plans from are assigned in the Data 
Security dialog box - Stores Tab. 

 The Store Statuses users have permissions to open floor plans from are assigned in 
the Data Security dialog box - Statuses Tab 

 The File Statuses users have permissions to open floor plans from are assigned in the 
Data Security dialog box - Statuses Tab. 

 Custom SQL (configurable from the Custom Query option accessed from the General 
Menu in the Administration module) will determine what fields appear in the Find 
and Open dialog box. This is done by modifying the Floor Plan Print dialog box. 

 The Custom Query Option in the Administration Module (General Module) can be 
used to configure what fields can be search using the Find option. This is done by 
modifying the Stores query. 

These settings determine what will appear in the Find and Open Floor Plans dialog box 
when it is accessed in the Planner module and what fields can be searched. 

Note: In order to access the Administration Module, users 
must have permission to do so. 

Planner Module 
The Print Floor Plans dialog box may be accessed from the File Menu > Find and Open 
option. Users with permissions to access the Planner module automatically have 
permission to use the functionality. 

Using Find and Floor Plan 
The functionality is used as follows: 

1. The Find and Open Plans dialog box is selected from the file menu. 

2. The appropriate floor plans are selected in the Filtering tab of the Print Floor Plans 
dialog box. 

3. Settings determining the visual appearance of the printed drawing are specified in 
the Rendering tab. 

4. On clicking the Open button, the selected floor plans will be opened. At the same 
time as they are opened, the required changes to the visual appearance (specified in 
the Rendering tab) will be made. 

5. After the selected floor plans have been opened, the Find and Open Plans dialog box 
will remain open until the Cancel button has been clicked. 

The Filtering Tab 
The Filtering tab enables the user to select the Floor Plans to open. It will populate with 
all floor plans that the user has permission to access. 
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Find 
Which fields Find will operate on is determined by the Custom SQL configured in the 
Custom Query option accessed from the General Menu in the Administration module. 
The Find option can be used by typing text into the text box then clicking the Find icon. 
Each successive click will move the user to the next floor plan matching the text being 
searched for. When no more matches are available, a confirmatory dialog box will 
appear. 

 
Find operates with explicit or implied wild cards. The explicit wild cards are: 

Wild Card Description 

* Any characters 

? Any character in this position 

# Any number in this position 
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If explicit wild cards are not used, implicit wild cards will be assumed. For example the 
text entry 'New' will be treated as '*New*' and will find New York, New Delhi, etc. 

Right Click Menu 
The right click menu provides a quick way of modifying the selected items. 

 
 Select All will select (but not check) all rows of data  

 Clear All will deselect (but not uncheck) all rows of data  

 Check Selected will check all rows of selected data  

 Uncheck Selected will uncheck all rows of selected data  

 Check All will check all rows of data  

 Uncheck All will uncheck all rows of data 

 Paste allows users to paste a carriage returned list of floor plan identifiers from the 
Windows clipboard. All rows in the dialog box that match the pasted information 
will be checked. 

Filtering 
The dialog box is provided with a series of filters on each column. Setting a filter on one 
column will affect data in all other columns. 
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They are used as follows: 

1. Show All - this option shows all results. 

2. Custom Filter - this option allows users to set fil ters using Boolean logic. The options 
are: 

– Equal to: will return rows that are an exact match for the entered text. 

– Not Equal to: will return rows that do not match the text string 

– Contains: will return rows where part of the data matches the text string. (Uses 
implied wild cards). 

– Does not contain: will return rows where no part of the data matches the text 
string. (Uses implied wild cards). 

– Begins with: will return rows where the text string is an exact match for the start 
of the data. 

– Ends with: will return rows where the text string is an exact match for the end of 
the data. 

– Does not begin with: will return rows where the text string is not an exact match 
for the start of the data. 

– Does not end with: will return rows where the text string is not an exact match 
for the end of the data. 

3. Blanks - column will be filtered to only show rows with null values. 

4. Non-Blanks - column will be filtered to only show rows containing a value 

5. Results - column will be filtered to only show the selected result. 
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Boolean logic also includes the use of And or Or. 

 And means that both conditions must be met. A and B means the data returned must 
contain both A and B. 

 Or means either condition can be met. A or B means the data returned can contain 
either A or B. It does not need to contain both. 

Selecting Floor Plans to open 
Floor plans may be selected for opening by ticking the appropriate check box. On 
clicking OK, the floor plan(s) will open. 

The Rendering Tab 
The Rendering Tab  is used to ensure the visual appearance of the floor plan is as 
desired. 

 

Set Layer Theme 
If the check box is selected, users can select a layer theme from the drop down list. A 
number of layer themes can exist - each holding a specific set of settings for the 
individual layers. Selecting a specific layer theme, will automatically configure the 
individual layers to the settings designated for that layer theme. 

These layer themes are configured in the Layer Themes dialog box accessed from the 
Layer Aliased dialog box on the Format menu. 
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Change Visual Appearance 
If the checkbox is ticked, this allows users to change the visual appearance of the 
drawing. The options are: 

 2D Wire Frame 

 3D Wire Frame 

 Hidden Detail 

 Shaded 

 Shaded with Edges  

 Conceptual 

 Realistic 

 
The images above show the different visual appearances available. They can be set by 
means of the Visual Styles toolbar or Visual Styles Manager. 

Set Layout 
If the checkbox is ticked the users can select one of two options: Add Titleblock or Use 
Existing Layout. 

1. Add Titleblock 

If the Add Titleblock option is selected, users may select a title block from a drop 
down list. The list of available title blocks is configured using the Title Block option 
on the Planning menu in the Administration module. 
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2. Use Existing Layout 

If the Use Existing Layout option is selected, users can enter a name matching the 
name of a paper space tab. This may be typed in. Alternatively it may be selected 
from the drop down list, which will contain the last ten names. Information in the 
drop down list is not case sensitive and the following wild cards may be used: 

 

Wild Card Comment 

* Any number of characters 

? Any single character 

# Any single number 

 

The names of the paper space tabs can be seen at the foot of the floor plan in the 
Planner module. In the example below they are named Overall Store, Food and 
Drink, Electrical and Clothing. 
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16 
Floor Plan Printing 

Overview of Floor Plan Printing 
Floor Plan Printing allows the user to list all floor pans that they have access rights to. 
They then have the ability to select plans to be printed and, before they are printed, 
specify how the appearance and data associated with the floor plans can be updated. 
After printing, all changes will be undone so that the floor plan is in the condition it was 
in before printing. 

Note: Users wishing to Publish the floor plan (output it in 
electronic or hard copy form with permanent changes) 
should use the Immediate Floor Plan Publishing option from 
the File menu. 

Assessing Floor Plan Printing 
The Print Floor Plan functionality is accessed from the File Menu > Plot > Search and 
Print option. Users with permissions to access the Planner module will automatically 
have permission to use the functionality. 

 
The Print Floor Plan dialog box will appear. 
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If there are any errors during selecting the options, a warning icon will appear on the 
appropriate tab and an explanation will appear in the status bar. In the example below, 
there is a problem with the selected options on the collation tab. 

 

Reversing Changes Made During Floor Plan Printing 
Options in the Print Floor Plans dialog box allow the use to specify the changes required 
to the floor plan before it is printed. The settings selected in the Rendering and Pre-
Processing tabs will affect the visual appearance of the floor plan and will be made 
before it printing. This allows users to review a hard copy version of the floor plan in a 
specified condition. 

After printing, the changes will be reversed and the floor plan returned to the state it was 
before printing. The status of the floor plan will also be left unchanged. 
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Using Floor Plan Printing 
The basic method of operation is as follows: 

 

Administration Module 
Within the Administration Module: 

 The Stores users have permissions to print floor plans from are assigned in the Stores 
option of the Status tab of the Data Security dialog box. 

 The Store statuses users have permissions to print floor plans from are assigned in 
the Stores option of the Status tab of the Data Security dialog box. 

 The file statuses users have permissions to print floor plans from are assigned in the 
Files option of the Statuses tab of the Data Security dialog box. 

Note: the floor plans that a user can see are dependent on the 
combination of store, store status and file status permissions. 

 The fields that display in the Filtering Tab of the Print floor Plans dialog box are 
configured in the Custom SQL dialog box. 

These settings determine what will appear in the Print floor Plans dialog box when it is 
accessed in the Planner and Merchandiser modules. 

Note: In order to access the Administration Module, users 
must have permission to do so. 

Planner Module 
The Print Floor Plans dialog box may be accessed from the File Menu > Plot option. Users 
with permissions to access the Planner module automatically have permission to use the 
functionality. 

Using Floor Plan Printing 

The functionality is used as follows: 

 The Print Floor Plans dialog box is selected from the file menu. 

 The appropriate floor plans are selected in the Filtering tab of the Print Floor Plans 
dialog box. 

 Settings determining the visual appearance of the printed drawing are specified in 
the Rendering tab. 

 Settings determining how data associated with the floor plan is updated are specified 
in the Pre-Processing tab. 
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 The sequence the selected floor plans are to be printed in is specified in the Collation 
Tab. 

 On clicking the Print button, the first floor plan will be opened (if not already open) 
in the sequence specified in the Collation Tab. 

 Changes will be made to the floor plan as specified in the Rendering and Pre-
processing tabs. 

 The floor plan will be printed on the default printer associated with the user's 
computer. 

 The changes made for printing purposes will be undone and the floor plan checked 
back in. 

Errors and Results 
If any settings in the Print Floor Plans dialog box are not set, an error symbol will be 
displayed on the tab containing the data with the problem. The Print button will also be 
grayed out and unavailable. Users must correct the problems before the Print button will 
activate. 

 

The Filtering Tab 
The Filtering tab enables the user to select the Floor Plans to print. It will populate with 
all floor plans which have Publish Dates on or before the current date. 
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Find 
The Find option can be used by typing text into the text box then clicking the Find icon. 
Each successive click will move the user to the next floor plan matching the text being 
searched for. When no more matches are available, a confirmatory dialog box will 
appear. 

 
Find operates with explicit or implied wild cards. The explicit wild cards are: 

Wild Card Description 

* Any characters 

? Any character in this position 

# Any number in this position 
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If explicit wild cards are not used, implicit wild cards will be assumed. For example the 
text entry 'New' will be treated as '*New*' and will find New York, New Delhi, etc. 

Right Click Menu 
The right click menu provides a quick way of modifying the selected items. 

 
 Select All will select (but not check) all rows of data  

 Clear All will deselect (but not uncheck) all rows of data  

 Check Selected will check all rows of selected data  

 Uncheck Selected will uncheck all rows of selected data  

 Check All will check all rows of data  

 Uncheck All will uncheck all rows of data 

 Paste allows users to paste a carriage returned list of floor plan identifiers from the 
Windows clipboard. All rows in the dialog box that match the pasted information 
will be checked. 

Selecting Floor Plans to Process 
Floor plans may be selected for printing by ticking the appropriate check box. 

Using Filters in the Filtering Tab 
The Filtering Tab is provided with a series of filters on each column. Setting a filter on 
one column will affect data in all other columns. 
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They are used as follows: 

 Show All - this option shows all results. 

 Custom Filter - this option allows users to set fil ters using Boolean logic. The options 
are: 

– Equal to: will return rows that are an exact match for the entered text. 

– Not Equal to: will return rows that do not match the text string 

– Contains: will return rows where part of the data matches the text string. (Uses 
implied wild cards). 

– Does not contain: will return rows where no part of the data matches the text 
string. (Uses implied wild cards). 

– Begins with: will return rows where the text string is an exact match for the start 
of the data. 

– Ends with: will return rows where the text string is an exact match for the end of 
the data. 

– Does not begin with: will return rows where the text string is not an exact match 
for the start of the data. 

– Does not end with: will return rows where the text string is not an exact match 
for the end of the data. 

 Blanks - column will be filtered to only show rows with null values. 

 Non-Blanks - column will be filtered to only show rows containing a value 

 Results - column will be filtered to only show the selected result. 
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Boolean logic also includes the use of And or Or. 

 And means that both conditions must be met. A and B means the data returned must 
contain both A and B. 

 Or means either condition can be met. A or B means the data returned can contain 
either A or B. It does not need to contain both. 

The Rendering Tab 
The Rendering Tab is used to ensure the visual appearance of the floor plan is as desired. 

 

Set Layer Theme 
If the check box is selected, users can select a layer theme from the drop down list. A 
number of layer themes can exist - each holding a specific set of settings for the 
individual layers. Selecting a specific layer theme, will automatically configure the 
individual layers to the settings designated for that layer theme. 

These layer themes are configured in the Layer Themes dialog box accessed from the 
Layer Aliased dialog box on the Format menu. 
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Change Visual Appearance 
If the checkbox is ticked, this allows users to change the visual appearance of the 
drawing. The options are: 

 2D Wire Frame 

 3D Wire Frame 

 Hidden Detail 

 Shaded 

 Shaded with Edges  

 Conceptual 

 Realistic 

 
The images above show the different visual appearances available. They can be set by 
means of the Visual Styles toolbar or Visual Styles Manager. 

Set Layout 
If the checkbox is ticked the users can select one of two options: Add Titleblock or Use 
Existing Layout. 

1. Add Titleblock 

If the Add Titleblock option is selected, users may select a title block from a drop 
down list. The list of available title blocks is configured using the Title Block option 
on the Planning menu in the Administration module. 
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2. Use Existing Layout 

If the Use Existing Layout option is selected, the user has two options; to publish all 
layouts except model space, or to publish selected layouts. 

– All layouts except model space 

– If this option is selected, all layouts except the model space layout will be 
published for each floor plan. The layout names option will also be grayed out 
and unavailable. 

– Layout Names  

– If this option is selected, users can enter a name matching the name of a paper 
space tab. This may be typed in. Alternatively it may be selected from the drop 
down list, which will contain the last ten names. Information in the drop down 
list is not case sensitive and the following wild cards may be used: 

Wild 
Card 

Comment 

* Any number of 
characters 

? Any single 
character 

# Any single number 

– The names of the paper space tabs can be seen at the foot of the floor plan in the 
Planner module. In the example below they are named Overall store, food and 
drink, Electrical and Clothing. 

 
– If multiple layout names are required, these should be separated by a comma. 

3. Set Viewing Direction 

The viewing direction can be set if a Layout tab has been selected in the set Layout 
section. Users can then select the View direction from the drop down list. The options 
are: 

– Plan 

– NE Isometric 

– SW Isometric 

– SE Isometric 

– NW Isometric 

– N Elevation 
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– E Elevation 

– S Elevation 

– W Elevation 

These correspond to the options in the 3D view option from the View menu, or in the 
View toolbar. 

If the user elects to Use Custom View, the user will be able to type in the name of a 
custom view. This custom view name may use standard wild cards to allow for 
inconsistencies in the actual name. It will not be case sensitive. 

The example below shows a floor plan in SW Isometric view. 

 

The Collation Tab 
The Collation Tab allows users to specify the sequence the floor plans will be printed in. 
This makes it easier to sort and distribute them after printing. 

At least one collation option must be selected, or the tab will show as having an error. 
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The available options can be ordered by highlighting them, then using the up or down 
arrows. The options are made active by using the check boxes. 

 Region is a specific type of cluster set in the Cluster type drop down list in the 
Cluster dialog box in Store Manager. 

 District is a specific type of cluster set in the Cluster type drop down list in the 
Cluster dialog box in Store Manager. 

 
 Store Number is the Store Code in the Store dialog box in Store Manager. 

 Store Name is the Store Name in the Store dialog box in Store Manager. 
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 Floor Type is the Floor Type in the Floor dialog box in Store Manager. 

 Floor Description is the Floor Description in the Floor dialog box in Store Manager. 

 
 Revision Name is the Revision Name in the Floor dialog box in Store Manager. 

 Revision Number is the Revision Number in the Floor dialog box in Store Manager. 
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 Effective Date is the Effective Date in the File Properties dialog box in Store Manager 

 Publish Date is the Publish Date in the File Properties dialog box in Store Manager. 

 

The Pre-Processing Tab 
The Pre-processing tab is used to ensure that the information in the floor plan is up to 
date. 
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Synchronize 
Synchronize is used to make sure that the information in the floor plan matches that held 
in the Macro Space Planning database. This information could differ for a number of 
reasons: 

 Changes have been made in the floor plan using AutoCAD tools and these changes 
have not been written to the database. 

 Changes have been manually made to floor plans in the Merchandiser module, or in 
In-Store Space Collaboration. 

 Changes have been made to floor plans in the database by batch processes. 

 Changes have been made to the floor plan outside Macro Space Planning - for 
example in raw AutoCAD. 

The following options are available: 

 None - no synchronization operations will be carried out. 

 Auto-Synchronize - the application will automatically detect which form of 
synchronization is required: 

– If the information in the database exceeds the date the floor plan was last 
modified and saved in Planner (or modified in raw AutoCAD), the information 
will be synchronized "match the database". 

– If the date of the information in the floor plan (or the date it was modified in raw 
AutoCAD) exceeds the date the information was written to the database, the 
information will be synchronized "match the drawing". 
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- If (i) the date the floor plan was last modified in raw AutoCAD exceeds the 
date the floor plan was last modified in Planner and (ii) the date the floor 
plan was last modified in Planner is less than the date the floor plan was last 
modified in Merchandiser, In-Store Space Collaboration or by a batch 
process, synchronization will be by 'cross-matching'. 
- Information in the floor plan for zones, fixtures and other blocks and aisles 
will be written to the database. 

 Information in the database for shelves and merchandise will be written into the 
floor plan. 

– Synchronize to Match Database - information in the database will be written into 
the floor plan. 

– Synchronize to Match Drawing - information from the floor plan will be written 
to the database. 

– Cross Match - information on zones, fixtures and other blocks and aisles will be 
written to the database, while information on shelves and merchandise will be 
written into the floor plan. 

Items to Synchronize 
Once the synchronization method has been selected, specific items can be selected for the 
synchronization operation to work on. 

 Include Fixtures - fixtures and fittings will be synchronized. 

 Include Shelves - shelf objects will be synchronized. 

 Include Products - products and planograms will be synchronized 

 Include Other Blocks - include blocks not yet registered in Fixture Studio. 

 Include Zones - Zones will be synchronized. 

 Include Views - view positions in Planner or Merchandiser will be synchronized. 
(This will not affect In-Store Space Collaboration). 

 Include Aisles - Aisles will be synchronized. 

The following points should be noted: 

 If shelf positions are changed in Planner and the 'Synchronize to Match Drawing' 
option is selected, the modified shelf positions will be written back to the database. 
This could potentially affect any planograms using those shelves. 

 Zones can only be added, edited or deleted in Planner. If 'Synchronize to Match 
Database' is selected, the current zone information in the Planner floor plan will be 
changed to match that held in the database. This might be done to reverse changes 
made and saved in the Planner module. 

 Aisles can only be added, edited or deleted in Planner. If 'Synchronize to Match 
Database' is selected, the current aisle information in the Planner floor plan will be 
changed to match that held in the database. This might be done to reverse changes 
made and saved in the Planner module. 

Restructure Drawing 
Restructure Drawing allows users to update the drawing so that the blocks in the 
drawing match the latest information defined in Fixture Studio. 

 Redefine Blocks from Disc - this will result in the DWG files in the drawing being 
updated with the latest versions of those DWG files defined in Fixture Studio. 
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 Explode Composite Blocks - this will explode all blocks defined as composites in 
Fixture Studio. These blocks will be placed on Layer 0 and will require having Color, 
Line type and Line-Weight to set to BYLAYER. 

Note: Composite Blocks that are not flagged as composite in 
Fixture Studio will not be exploded. 

 Reset Levels - this will reset the elevation of the block to that defined by the level 
assigned to it in the Insertion Tab of the Block Details dialog box in Fixture Studio. 

 Reset Color, Line type and Line-Weight to BYLAYER - this option will look at the 
color, line type and line weight of each instance of a block in the drawing. It they 
differ from the defaults for that layer, they will be set back to those defaults. 

 Reset Layer - if blocks have been moved to a layer different to that specified in the 
Insertion Tab of the Block Details dialog box in Fixture Studio, the block will be 
restored to the default layer. 

Annotation 
The annotation option allows users to update the annotation in the floor plan so it 
matches the latest annotation rules specified in the Text Styles option in the 
Administration Module. 

 Annotate Fixtures - all fixtures that have had the 'Include in Fixture Annotation' 
check box ticked in the Category Tab of the Block Details dialog box in Fixture Studio 
will have their annotation updated. 

 Annotate Products - all products, planograms and planogram profiles will have their 
annotation updated. 

 Annotate Zones - all zones will have their annotation updated. 

 Update Title Block - all text boxes in the title block that reference information in the 
database will have that information updated. 

Calculations 
This option is used to update the calculations associated with the floor plan. This has a 
number of benefits including ensuring that reports based on this floor plan are accurate 
and up to date. It also ensures that annotation draws correctly. 

 Calculate Areas - this updates the area calculations; and hence the floor area assigned 
to each fixture. 

 Calculate Fixture Adjacencies - this updates the fixture adjacencies; and hence the 
relationship of one fixture to another. 

 Calculate Product Adjacencies - this updates the product adjacencies; and hence the 
relationship of one product to another. 

 Calculate Aisle Adjacencies - this updates the aisle adjacencies; and hence which 
products share an aisle. 

 Calculate Space Measures - this updates space measures: the volume occupied by 
each product in a planogram. 

 Calculate Face Planes - this updates face planes: the frontal area occupied by each 
product in a planogram. 
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Floor Plan Processing 

The Filtering Tab 
The Filtering tab enables the user to select the Floor Plans to Process. It will populate 
with all floor plans which have Publish Dates on or before the current date. 

 

Find 
The Find option can be used by typing text into the text box then clicking the Find icon. 
Each successive click will move the user to the next floor plan matching the text being 
searched for. When no more matches are available, a confirmatory dialog box will 
appear. 

 
Find operates with explicit or implied wild cards. The explicit wild cards are: 
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Wild Card Description 

* Any characters 

? Any character in this position 

# Any number in this position 

 

If explicit wild cards are not used, implicit wild cards will be assumed. For example, the 
text entry 'New' will be treated as '*New*' and will find New York, New Delhi, etc. 

Right Click Menu 
The right click menu provides a quick way of modifying the selected items. 

 
 Select All will select (but not check) all rows of data  

 Clear All will deselect (but not uncheck) all rows of data  

 Check Selected will check all rows of selected data  

 Uncheck Selected will uncheck all rows of selected data  

 Check All will check all rows of data  

 Uncheck All will uncheck all rows of data 

Selecting Floor Plans to Process 
Floor plans may be selected for processing by ticking the appropriate check box. 

Using Filters in the Filtering Tab 
The Filtering Tab is provided with a series of filters on each column. Setting a filter on 
one column will affect data in all other columns. 
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They are used as follows: 

 Show All - this option shows all results. 

 Custom Filter - this option allows users to set fil ters using Boolean logic. The options 
are: 

– Equal to: will return rows that are an exact match for the entered text. 

– Not Equal to: will return rows that do not match the text string 

– Contains: will return rows where part of the data matches the text string. (Uses 
implied wild cards). 

– Does not contain: will return rows where no part of the data matches the text 
string. (Uses implied wild cards). 

– Begins with: will return rows where the text string is an exact match for the start 
of the data. 

– Ends with: will return rows where the text string is an exact match for the end of 
the data. 

– Does not begin with: will return rows where the text string is not an exact match 
for the start of the data. 

– Does not end with: will return rows where the text string is not an exact match 
for the end of the data. 

 Blanks - column will be filtered to only show rows with null values. 

 Non-Blanks - column will be filtered to only show rows containing a value 

 Results - column will be filtered to only show the selected result. 
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Boolean logic also includes the use of And or Or. 

 And means that both conditions must be met. A and B means the data returned must 
contain both A and B. 

 Or means either condition can be met. A or B means the data returned can contain 
either A or B. It does not need to contain both. 

The Rendering Tab 
The Rendering Tab  is used to ensure the visual appearance of the floor plan is as 
desired. 

 

Set Layer Theme 
If the check box is selected, users can select a layer theme from the drop down list. A 
number of layer themes can exist - each holding a specific set of settings for the 
individual layers. Selecting a specific layer theme, will automatically configure the 
individual layers to the settings designated for that layer theme. 

These layer themes are configured in the Layer Themes dialog box accessed from the 
Layer Aliased dialog box on the Format menu. 
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Change Visual Appearance 
If the check box is ticked, this allows users to change the visual appearance of the 
drawing. The options are: 

 2D Wire Frame 

 3D Wire Frame 

 Hidden Detail 

 Shaded 

 Shaded with Edges  

 Conceptual 

 Realistic 

 
The images above show the different visual appearances available. They can be set by 
means of the Visual Styles toolbar or Visual Styles Manager. 

Set Layout 
If the checkbox is ticked the users can select one of two options: Add Titleblock or Use 
Existing Layout. 

 Add Titleblock  

 If the Add Titleblock option is selected, users may select a title block from a drop 
down list. The list of available title blocks is configured using the Title Block option 
on the Planning menu in the Administration module. 
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 Use Existing Layout 

 If the Use Existing Layout option is selected, users can enter a name matching the 
name of a paper space tab. This may be typed in. Alternatively it may be selected 
from the drop down list, which will contain the last ten names. Information in the 
drop down list is not case sensitive and the following wild cards may be used: 

Wild Card Comment 

* Any number of characters 

? Any single character 

# Any single number 

 The names of the paper space tabs can be seen at the foot of the floor plan in the 
Planner module. In the example below they are named Overall store, food and drink, 
Electrical and Clothing. 

 

The Pre-processing Tab 
The Pre-processing tab is used to ensure that the information in the floor plan is up to 
date. 
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Synchronize 
Synchronize is used to make sure that the information in the floor plan matches that held 
in the Macro Space Planning database. This information could differ for a number of 
reasons: 

 Changes have been made in the floor plan using AutoCAD tools and these changes 
have not been written to the database. 

 Changes have been manually made to floor plans in the Merchandiser module, or in 
In-Store Space Collaboration. 

 Changes have been made to floor plans in the database by batch processes. 

 Changes have been made to the floor plan outside Macro Space Planning - for 
example in raw AutoCAD. 

The following options are available: 

 None - no synchronization operations will be carried out. 

 Auto-Synchronize - the application will automatically detect which form of 
synchronization is required: 

– If the information in the database exceeds the date the floor plan was last 
modified and saved in Planner (or modified in raw AutoCAD), the information 
will be synchronized "match the database". 

– If the date of the information in the floor plan (or the date it was modified in raw 
AutoCAD) exceeds the date the information was written to the database, the 
information will be synchronized "match the drawing". 



The Pre-processing Tab 

160 Oracle Retail Macro Space Management 

– If (i) the date the floor plan was last modified in raw AutoCAD exceeds the date 
the floor plan was last modified in Planner and (ii) the date the floor plan was 
last modified in Planner is less than the date the floor plan was last modified in 
Merchandiser, In-Store Space Collaboration or by a batch process, 
synchronization will be by 'cross-matching'. 

 -Information in the floor plan for zones, fixtures and other blocks and aisles will be 
written to the database. 

 -Information in the database for shelves and merchandise will be written into the 
floor plan. 

 Synchronize to Match Database - information in the database will be written into the 
floor plan. 

 Synchronize to Match Drawing - information from the floor plan will be written to 
the database. 

 Cross Match - information on zones, fixtures and other blocks and aisles will be 
written to the database, while information on shelves and merchandise will be 
written into the floor plan. 

Items to Synchronize 
Once the synchronization method has been selected, specific items can be selected for the 
synchronization operation to work on. 

 Include Fixtures - fixtures and fittings will be synchronized. 

 Include Shelves - shelf objects will be synchronized. 

 Include Products - products and planograms will be synchronized 

 Include Other Blocks - this synchronizes all blocks assigned as type 'other' in Fixture 
Studio. 

 Include Zones - Zones will be synchronized. 

 Include Views - view positions in Planner or Merchandiser will be synchronized. 
(This will not affect In-Store Space Collaboration). 

 Include Aisles - Aisles will be synchronized. 

The following points should be noted: 

 If shelf positions are changed in Planner and the 'Synchronize to Match Drawing' 
option is selected, the modified shelf positions will be written back to the database. 
This could potentially affect any planograms using those shelves. 

 Zones can only be added, edited or deleted in Planner. If 'Synchronize to Match 
Database' is selected, the current zone information in the Planner floor plan will be 
changed to match that held in the database. This might be done to reverse changes 
made and saved in the Planner module. 

 Aisles can only be added, edited or deleted in Planner. If 'Synchronize to Match 
Database' is selected, the current aisle information in the Planner floor plan will be 
changed to match that held in the database. This might be done to reverse changes 
made and saved in the Planner module. 

Restructure Drawing 
Restructure Drawing allows users to update the drawing so that the blocks in the 
drawing match the latest information defined in Fixture Studio. 

 Redefine Blocks from Disc - this will result in the DWG files in the drawing being 
updated with the latest versions of those DWG files defined in Fixture Studio. 
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 Explode Composite Blocks - this will explode all blocks defined as composites in 
Fixture Studio. These blocks will be placed on Layer 0 and will require having Color, 
Line type and Line-Weight to set to BYLAYER. 

Note: Composite Blocks that are not flagged as composite in 
Fixture Studio will not be exploded. 

 Reset Levels - this will reset the elevation of the block to that defined by the level 
assigned to it in the Insertion Tab of the Block Details dialog box in Fixture Studio. 

 Reset Color, Line type and Line-Weight to BYLAYER - this option will look at the 
color, line type and line weight of each instance of a block in the drawing. If they 
differ from the defaults for that layer, they will be set back to those defaults. 

 Reset Layer - if blocks have been moved to a layer different to that specified in the 
Insertion Tab of the Block Details dialog box in Fixture Studio, the block will be 
restored to the default layer. 

Annotation 
The annotation option allows users to update the annotation in the floor plan so it 
matches the latest annotation rules specified in the Text Styles option in the 
Administration Module. 

 Annotate Fixtures - all fixtures that have the ' Include in Fixture Annotation' checkbox 
ticked in the Category Tab of the Block Details dialog box in Fixture Studio will have 
their annotation updated. 

 Annotate Products - all products, planograms and planogram profiles will have their 
annotation updated. 

 Annotate Zones - all zones will have their annotation updated. 

 Update Title Block - all text boxes in the title block that reference information in the 
database will have that information updated. 

Calculations 
This option is used to update the calculations associated with the floor plan. This has a 
number of benefits including ensuring that reports based on this floor plan are accurate 
and up to date. It also ensures that annotation draws correctly. 

 Calculate Areas - this updates the area calculations; and hence the floor area assigned 
to each fixture. 

 Calculate Fixture Adjacencies - this updates the fixture adjacencies; and hence the 
relationship of one fixture to another. 

 Calculate Product Adjacencies - this updates the product adjacencies; and hence the 
relationship of one product to another. 

 Calculate Aisle Adjacencies - this updates the aisle adjacencies; and hence which 
products share an aisle. 

 Calculate Space Measures - this updates space measures: the volume occupied by 
each product in a planogram. 

 Calculate Face Planes - this updates face planes: the frontal area occupied by each 
product in a planogram. 
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Floor Plan Publishing 

Permissions to Run Immediate Floor Plan Publishing 
Before a user can run Immediate Floor Plan Publishing, they must first have been 
assigned the appropriate permissions in the Administration module. This is done using 
the Functional Security dialog box accessed from the Security menu. 

Note: this dialog box will only be accessible to users with 
access rights to the Administration Module. 

 
Users assigned to the Automation Command Group (such as the Administrator User 
Group) can run all Automation Functionality. User Groups assigned to the child 
Command Groups (Floor plan automated publishing, Floor plan publishing, Planogram 
publishing) have the ability to use that functionality. In  the example above, the 
Equipment Planning Manager and Merchandise Planning Manager User Groups have 
been assigned permission to use the Floor Plan Publishing functionality. 

Note: Floor Plan Automated Publishing (the right to run 
calculations on floor plans) is a separate user group. Users 
with permissions for Floor Plan Publishing can set 
calculation options in the Pre-processing tab of the Floor 
Plan Publishing Configuration dialog box. These will 
execute during the publishing of floor plans. They will not 
execute unless the user is a member of a User Group with 
permissions for the Floor Plan Automated Publishing User 
Group. 

The User Groups precise rights depend on settings in the Permissions dialog box. This is 
accessed from the right click menu in the Functional Security dialog box. 
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This will bring up the Permissions dialog box. 

 
 If the User Group belongs to a Command Group higher in the Command Group 

hierarchy, by default i t will inherit the permissions from that higher Command 
Group. This permission can be varied at the lower level by changing the selections 
made using the check boxes. 

 If the User Group only exists at this level in the hierarchy, the Permissions dialog box 
will initially have all check boxes blank. The Administrator must then assign Allow 
or Deny permissions.   

Dates Floor Plans will be Published 
The purpose of publishing a floor plan is to disseminate information on the type, 
quantity and layout of equipment and merchandise to those tasked with implementing 
the change. Publishing a floor plan can be done in hard copy or electronic format. The 
date at which this is executed depends on the Publish Date set in the File Properties 
dialog box in Store Manager. 
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Note: the Publish Date operates on the date only and takes 
no account of the time of day. Publish Dates are stored in 
Date/Time format in the database, but the functionality only 
references the Date. 

 
Another factor affecting the date at which at which floor plans will be published is the 
Lead Time Tolerance (Hours) setting on the Output tab of the Floor Plan Publishing 
Configuration dialog box in the Administration Module. 

Note: this dialog box will only be accessible to users with 
access rights to the Administration Module. 
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Batch processes can be set to start at any time of the day. For example, the batch process 
might initiate at 8 p.m. (20.00 hrs) in the evening to allow the maximum number of batch 
processes to be run before users come in for work again the following morning. 
However, the Publish date for the floor plan might be set for when the following day 
begins at midnight. The Lead Time Tolerance (Hours) setting allows for this. 

For example, if batch process is run on the 2nd June at 20.00 hrs in the evening and has 
no lead time tolerance, a floor plan that has a Publish Date of 3rd June would be ignored 
for publishing purposes by this run of the batch process. If however, the Lead Time 
Tolerance (Hours) setting is set to 5 hours, this will be added onto the Date and Time for 
the batch process and cause the batch process to operate as if i t were running at 01.00 hrs 
in the morning of 3rd June. All  floor plans with a Publish Date of 3rd June would then be 
published. 

Criteria for Publishing Floor Plans 
There are two criteria for publishing floor plans: 

 Floor Plan Publish Date is equal to or earlier than the current date 

If the Publish Date set in the File Properties dialog box in Store Manager is equal to 
or earlier than the current date (taking into account the Lead Time Tolerance (Hours) 
setting), the floor plan will be published. 

 Floor Plan has been Updated since it was Published 

In some implementations of Macro Space Planning it is possible that the floor plan 
may have been modified after it was last published. The condition for this is that the 
Modified by Planner date is greater than the Last Published Date. 
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Locations Floor Plans will be Published To 
The locations Floor Plans will be published to and the file names used are specified in the 
Output tab of the Floor Plan Publishing Configuration dialog box in the Administration 
module. 

Note: this dialog box will only be accessible to users with 
access rights to the Administration Module. 

 
This dialog box allows Administrators to specify the directory structure, file format and 
file name that will be used when floor plans are published. 

The starting point for the location floor plans will be published to in electronic form can 
be seen in the details for the Floor Plan Publish system directory specified in the 
Directories Tab of the Configuration module. This tab can only be accessed if the 
Configuration module is opened from the Administration module. 
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The Filtering Tab 
The Filtering Tab is used to select the floor to publish. 
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Find 
The Find option can be used by typing text into the text box then clicking the Find icon. 
Each successive click will move the user to the next floor plan matching the text being 
searched for. When no more matches are available, a confirmatory dialog box will 
appear. 

 
Find operates with explicit or implied wild cards. The explicit wild cards are: 

Wild Card Description 

* Any characters 

? Any character in this position 

# Any number in this position 
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If explicit wild cards are not used, implicit wild cards will be assumed. For example the 
text entry 'Wine' will be treated as '*Wine*' and will find White Wine, Red Wine, etc. 

Right Click Menu 
The right click menu provides a quick way of modifying the selected items. 

 
 Select All will select (but not check) all rows of data  

 Clear All will deselect (but not uncheck) all rows of data  

 Check Selected will check all rows of selected data  

 Uncheck Selected will uncheck all rows of selected data  

 Check All will check all rows of data  

 Uncheck All will uncheck all rows of data 

 Paste allows users to paste a carriage returned list of floor plan identifiers from the 
Windows clipboard. All rows in the dialog box that match the pasted information 
will be checked. 

Selecting Floor Plans to Process 
Floor plans may be selected for printing by ticking the appropriate check box. 

Using Filters in the Filtering Tab 
The Filtering Tab is provided with a series of filters on each column. Setting a filter on 
one column will affect data in all other columns. 
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They are used as follows: 

 Show All - this option shows all results. 

 Custom Filter - this option allows users to set fil ters using Boolean logic. The options 
are: 

– Equal to: will return rows that are an exact match for the entered text. 

– Not Equal to: will return rows that do not match the text string 

– Contains: will return rows where part of the data matches the text string. (Uses 
implied wild cards). 

– Does not contain: will return rows where no part of the data matches the text 
string. (Uses implied wild cards). 

– Begins with: will return rows where the text string is an exact match for the start 
of the data. 

– Ends with: will return rows where the text string is an exact match for the end of 
the data. 

– Does not begin with: will return rows where the text string is not an exact match 
for the start of the data. 

– Does not end with: will return rows where the text string is not an exact match 
for the end of the data. 

 Blanks - column will be filtered to only show rows with null values. 

 Non-Blanks - column will be filtered to only show rows containing a value 

 Results - column will be filtered to only show the selected result. 
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Boolean logic also includes the use of And or Or. 

 And means that both conditions must be met. A and B means the data returned must 
contain both A and B. 

 Or means either condition can be met. A or B means the data returned can contain 
either A or B. It does not need to contain both 

The Rendering Tab 
The Rendering Tab  is used to ensure the visual appearance of the floor plan is as 
desired. 

 

Set Layer Theme 
If the checkbox is selected, users can select a layer theme from the drop down list. A 
number of layer themes can exist - each holding a specific set of settings for the 
individual layers. Selecting a specific layer theme, will automatically configure the 
individual layers to the settings designated for that layer theme. 

These layer themes are configured in the Layer Themes dialog box accessed from the 
Layer Aliased dialog box on the Format menu in the Planner module. 
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Change Visual Appearance 
If the check box is ticked, this allows users to change the visual appearance of the 
drawing. The options are: 

 2D Wire Frame 

 3D Wire Frame 

 Hidden Detail 

 Shaded 

 Shaded with Edges  

 Conceptual 

 Realistic 

 
The images above show the different visual appearances available. Within the Planner 
module, the option can be set in either the Visual Styles toolbar or Visual Styles Manager. 

Set Layout 
If the checkbox is ticked the users can select one of two options: Add Titleblock or Use 
Existing Layout. 

 Add Titleblock  

– If the Add Titleblock option is selected, users may select a title block from a drop 
down list. The list of available title blocks is configured using the Title Block 
option on the Planning menu in the Administration module. 
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 Use Existing Layout 

– If the Use Existing Layout option is selected, the user has two options; to publish 
all layouts except model space, or to publish selected layouts. 

 All layouts except model space 

– If this option is selected, all layouts except the model space layout will be 
published for each floor plan. The layout names option will also be grayed out 
and unavailable. In addition, if this option is chosen, it will not be possible to 
republish floor plans. This is because without a list of specified layout names, it 
is not possible to determine which layouts require republishing. 

 Layout Names 

– If this option is selected, users can enter a name matching the name of a paper 
space tab. This may be typed in. Alternatively it may be selected from the drop 
down list, which will contain the last ten names. Information in the drop down 
list is not case sensitive and the following wild cards may be used: 

Wild Card Comment 

* Any number of characters 

? Any single character 

# Any single number 

– If wild cards are used, the Republish option will only publish a single match for 
each floor plan. For example, if the wildcard is Con*, the Confectionery layout 
will be published and the Consumables layout will be omitted. 

– The names of the paper space tabs can be seen at the foot of the floor plan in the 
Planner module. In the example below they are named Overall Store, Food and 
Drink, Electrical and Clothing. 

 
– If multiple layout names are required, these should be separated by a comma. 

The Collation Tab 
The Collation Tab allows users to specify the sequence floor plans will be published or 
printed in. Its main use is in printing hard copy versions of the floor plans where the 
sequence they are printed in makes it easier to sort and distribute them after printing. 

At least one collation option must be selected, or the tab will show as having an error. 
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The available options can be ordered by highlighting them, then using the up or down 
arrows. The options are made active by using the check boxes. 

 Region is a specific type of cluster set in the Cluster type drop down list in the 
Cluster dialog box in Store Manager. 

 District is a specific type of cluster set in the Cluster type drop down list in the 
Cluster dialog box in Store Manager. 

 
 Store Number is the Store Code in the Store dialog box in Store Manager. 

 Store Name is the Store Name in the Store dialog box in Store Manager. 
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 Floor Type is the type selected from the drop down list in the Floor dialog box in 

Store Manager. 

 Floor Description is the Description in the Floor dialog box in Store Manager. 

 
 Revision Number is the Revision Number in the Revision dialog box in Store 

Manager. 

 Revision Name is the Revision Description in the Revision dialog box in Store 
Manager. 
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 Publish Date is the Publish Date set in the File Properties dialog box in Store 

Manager. 

 Effective Date is the Effective Date set in the File Properties dialog box in Store 
Manager. 

 

The Pre-processing Tab 
The Pre-processing tab is used to ensure that the information in the floor plan has been 
correctly updated. 
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Synchronize 
Synchronize is used to make sure that the information in the floor plan matches that held 
in the Macro Space Planning database. This information could differ for a number of 
reasons: 

 Changes have been made in the floor plan using AutoCAD tools and these changes 
have not been written to the database. 

 Changes have been manually made to floor plans in the Merchandiser module, or in 
In-Store Space Collaboration. 

 Changes have been made to floor plans in the database by batch processes. 

 Changes have been made to the floor plan outside Macro Space Planning - for 
example in raw AutoCAD. 

The following options are available: 

 None - no synchronization operations will be carried out. 

 Auto-Synchronize - the application will automatically detect which form of 
synchronization is required: 

– If the information in the database exceeds the date the floor plan was last 
modified and saved in Planner (or modified in raw AutoCAD), the information 
will be synchronized "match the database". 

– If the date of the information in the floor plan (or the date it was modified in raw 
AutoCAD) exceeds the date the information was written to the database, the 
information will be synchronized "match the drawing". 
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– If (i) the date the floor plan was last modified in raw AutoCAD exceeds the date 
the floor plan was last modified in Planner and (ii) the date the floor plan was 
last modified in Planner is less than the date the floor plan was last modified in 
Merchandiser, In-Store Space Collaboration or by a batch process, 
synchronization will be by 'cross-matching'. 

 - Information in the floor plan for zones, fixtures and other blocks and aisles will be 
written to the database. 

 - Information in the database for shelves and merchandise will be written into the 
floor plan. 

 Synchronize to Match Database - information in the database will be written into the 
floor plan. 

 Synchronize to Match Drawing - information from the floor plan will be written to 
the database. 

 Cross Match - information on zones, fixtures and other blocks and aisles will be 
written to the database, while information on shelves and merchandise will be 
written into the floor plan. 

Date information can be seen in the File Properties dialog box in Store Manager. 

 

Items to Synchronize 
Once the synchronization method has been selected, specific items can be selected for the 
synchronization operation to work on. 

 Include Fixtures - fixtures and fittings will be synchronized. 

 Include Shelves - shelf objects will be synchronized. 

 Include Products - products and planograms will be synchronized 

 Include Other Blocks - this synchronizes all blocks assigned as type 'other' in Fixture 
Studio. 

 Include Zones - Zones will be synchronized. 

 Include Views - view positions in Planner or Merchandiser will be synchronized. 
(This will not affect In-Store Space Collaboration). 
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 Include Aisles - Aisles will be synchronized. 

The following points should be noted: 

 If shelf positions are changed in Planner and the 'Synchronize to Match Drawing' 
option is selected, the modified shelf positions will be written back to the database. 
This could potentially affect any instances of placed planograms using those shelves. 

 Zones can only be added, edited or deleted in Planner. If 'Synchronize to Match 
Database' is selected, the current zone information in the Planner floor plan will be 
changed to match that held in the database. This might be done to reverse changes 
made and saved in the Planner module. 

 Aisles can only be added, edited or deleted in Planner. If 'Synchronize to Match 
Database' is selected, the current aisle information in the Planner floor plan will be 
changed to match that held in the database. This might be done to reverse changes 
made and saved in the Planner module. 

Restructure Drawing 
Restructure Drawing allows users to update the drawing so that the blocks in the 
drawing match the latest information defined in Fixture Studio. 

 Redefine Blocks from Disc - this will result in the DWG files in the drawing being 
updated with the latest versions of those DWG files defined in Fixture Studio. 

 Explode Composite Blocks - this will explode all blocks defined as composites in 
Fixture Studio. These blocks will be placed on Layer 0 and will require having Color, 
Line type and Line-Weight to set to BYLAYER. 

Note: Composite Blocks that are not flagged as composite in 
Fixture Studio will not be exploded. 

 Reset Levels - this will reset the elevation of the block to that defined by the level 
assigned to it in the Insertion Tab of the Block Details dialog box in Fixture Studio. 

 Reset Color, Line type and Line-Weight to BYLAYER - this option will look at the 
color, line type and line weight of each instance of a block in the drawing. If they 
differ from the defaults for that layer, they will be set back to those defaults. 

 Reset Layer - if blocks have been moved to a layer different to that specified in the 
Insertion Tab of the Block Details dialog box in Fixture Studio, the block will be 
restored to the default layer. 

Annotation 
The annotation options allow users to update the annotation in the floor plan so it 
matches the latest annotation rules specified in the Text Styles option in the 
Administration Module. 

 Annotate Fixtures - all fixtures that have the ' Include in Fixture Annotation' check 
box ticked in the Category Tab of the Block Details dialog box in Fixture Studio will 
have their annotation updated. 

 Annotate Products - all products, planograms and planogram profiles will have their 
annotation updated. 

 Annotate Zones - all zones will have their annotation updated. 

 Update Title Block - all text boxes in the title block that reference information in the 
database will have that information updated. 
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Calculations 
This option is used to update the calculations associated with the floor plan. This has a 
number of benefits including ensuring that reports based on this floor plan are accurate 
and up to date. It also ensures that annotation  draws correctly. 

 Calculate Areas - this updates the area calculations; and hence the floor area assigned 
to each fixture. 

 Calculate Fixture Adjacencies - this updates the fixture adjacencies; and hence the 
relationship of one fixture to another. 

 Calculate Product Adjacencies - this updates the product adjacencies; and hence the 
relationship of one product to another. 

 Calculate Aisle Adjacencies - this updates the aisle adjacencies; and hence which 
products share an aisle. 

 Calculate Space Measures - this updates space measures: the volume occupied by 
each product in a planogram. 

 Calculate Face Planes - this updates face planes: the frontal area occupied by each 
product in a planogram. 

The Validation Tab 
The Validation Tab enables users to set a series of validation checks that must be 
satisfied before the floor plan is published. If any of the checks fail, the floor plan will be 
not be published and details written to the AVTTB_PROCESS_FILE_LOG table. 
Information in this table can be read by means of a BI Publisher report or similar. 
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The tolerance values will use the system units, i.e. inches for imperial systems, and 
millimeters for metric systems. The values on the left are the lower tolerance; the values 
on the right are the upper tolerance. 

 Check for equipment that is obsolete or not yet available - if selected, this 
validation option will compare the effective and expiry dates of the equipment 
against the effective date of the planogram 

The Effective and Expiry Dates of the equipment are set in the Category tab of the Block 
Details dialog box in Fixture Studio. 
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The Effective Date of the Planogram is set in the Details tab of the Planogram design 
dialog box in the Merchandiser module. 
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This validation check will error if the Planogram Effective Date is before the Equipment 
Effective Date or after the Equipment Expiry Date. 

The relevant part of the check will be ignored if the equipment effective or expiry date is 
undefined. 

 Check for empty fixtures - if selected, this validation option will search for fixtures 
which do not contain any products. 

 Check for expired planograms - if selected, this validation option will compare the 
effective and expiry dates of the planogram against the effective date of the floor-
plan. It will check: 

– The Effective Date of the Planogram is less than or equal to the Floor Plan 
Effective Date 

– The Floor Plan Effective Date is less than the Planogram Expiry Date 

The Floor Plan Effective Date is set in the File Properties dialog box in Store Manager. 
(Store Manager can be accessed from the Planner or Merchandiser modules). 
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Note: Active Dates can also be set in the File Properties 
dialog box in Store Manager. 

The relevant part of the check will be ignored if the planogram effective or expiry date is 
undefined. 

 Check for store-specific planograms - if selected, this validation option will check the 
placed planograms are either store specific and associated with this store, or are 
generic planograms that are associated with all stores. 

Whether planogram are store specific or not is specified in the Stores tab of the 
Planogram Design dialog box in the Merchandiser module. 
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 Check that planograms are placed on correct length fixtures - if checked, this option 
will check that the length of the planogram falls within the total of the fixture lengths 
that the planogram is placed on. This check will take into account the length 
tolerances. 

 Check that planograms are placed on correct depth fixtures - if checked, this option 
will check that the depth of the planogram matches the fixture depths that the 
planogram is placed on. This check will take into account the depth tolerances. 

 Check that planograms are placed on correct height fixtures - if checked, this option 
will check that the height of the planogram matches the fixture heights that the 
planogram is placed on. This check will take into account the heights tolerances. 

 Check that planograms are placed on correct fixture styles - if checked, this option 
will check that the fixture style assigned to the planogram matches the fixture styles 
assigned to the fixtures it has been placed on. 

Floor Plan Publishing and Status Change 
When floor plans are reviewed and accepted for subsequently being put into service, the 
status is set to Authorized and the Publish Date and Effective Dates set in the File 
Properties dialog box in Store Manager. 
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When Floor Plan Publishing is run, the status of the Floor Plan will be changed to 
Published. (Depending on settings in the Status dialog box, it may also be changed to 
Read Only). 

 
This change of status allows the progress of the floor plan through its business life cycle 
to be monitored. 
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19 
Planogram Publishing 

Overview of Planogram Publishing 
Note: The way that planogram publishing performs in the 
Planner and Merchandiser modules is dependent of settings 
in other modules. This section is included so that users of the 
Planogram Publishing Functionality can discuss requested 
changes with the Administrators. The default settings for the 
Planogram Publishing dialog box are derived from settings 
in the Planogram Publishing Configuration dialog box in the 
Administration module. 

The purpose of publishing a planogram is to disseminate information on the type, 
quantity and location of shelves and merchandise to those tasked with implementing the 
change. Publishing a planogram design can be done in hard copy or electronic format. 
The date at which this is executed depends on the Publish Date set in the Details tab of 
the Planogram Design dialog box in the Merchandiser module. 

 

The Planogram Publishing functionality is used to disseminate planogram designs to 
specified printers or Windows folders to facilitate implementing those planogram 
designs. 
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Note: a retail organization will still need a method of 
distributing the planogram designs from the printer or 
Windows folder to the end user. 

The basic method of operation is as follows: 

 

1. Administration Module  

The Administration module is used to configure access to the different parts of the 
functionality. It is also used to assign permissions to print or publish specific floor 
plans and planograms. Finally, it is used to configure how the batch processes for 
publishing floor plans will work. There are three options that affect publishing and 
printing of floor plans. 

– The Functional Security option (Security menu) allows Administrators to control 
who can run Planogram Publishing as a batch process. It also controls who can 
access Immediate Planogram Publishing in the Planner Module. It also allows 
Administrators to control who can access Report Designer to create report 
templates for publishing planogram designs. 
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– The Data Security option (Security menu) allows Administrators to control what 
planograms a user can print or publish from in the Planner and Merchandiser 
modules (and in In-Store Space Collaboration). 

– The Custom Query dialog box allows an Administrator to specify what fields 
will appear in the Immediate Planogram Publish dialog box in the Planner 
module. 

2. Configuring Outputs for Batch Process 

The outputs for the batch process output of Planograms are configured in the 
administration module using the Planogram Publishing Configuration dialog box. 

3. Running as a Batch Processes 

Planogram Publishing ban be run as a batch process - typically run overnight so that 
this processor hungry tasks can be executed without affecting the manual users of 
the system. The settings determining how this operates are set in the Planogram 
Publishing Configuration dialog box. 

The rights to do this are set in Functional Security in the Administration Module. 

4. Planner Module  

Within the Planner module, the Immediate Publishing of Floor Plans functionality 
can only be used by users for whom permissions have been granted in the 
Administration module. 

5. Merchandiser Module  

Within the Merchandiser module, the Immediate Publishing of Floor Plans 
functionality can only be used by users for whom permissions have been granted in 
the Administration module. 

6. Report Designer 

Report Designer can be used to create report templates that determine the format the 
planogram design is published in. 

7. Other Functionality 

There are three other items of functionality that affect planogram publishing. 

– Configuration Module - the Directories tab allows users to specify where the root 
folders holding published planograms are located. Sub-folders holding specific 
planograms will be created as children of this root folder. 

– Tables in the Macro Space Planning database hold the results of planogram 
publishing operations. 

– BI Publisher (or a similar application) can be used to generate reports based on 
the information held in the database - for example the names and results of 
planograms that have been published. 

Permissions to Run Immediate Planogram Publishing 

Accessing the Functionality 
Before a user can run Immediate Planogram Publishing, they must first have been 
assigned the appropriate permissions in the Administration module. This is done using 
the Functional Security dialog box accessed from the Security menu. 

Note: this dialog box will only be accessible to users with 
access rights to the Administration Module. 
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Users assigned to the Automation Command Group (such as the Administrator User 
Group) can run all Automation Functionality. User Groups assigned to the child 
Command Groups (Floor plan automated publishing, Floor plan publishing, Planogram 
publishing) have the ability to use that functionality. In  the example above, the 
Merchandise Planning Manager User Group has been assigned permission to use the 
Planogram Publishing functionality. The User Group's precise rights depend on settings 
in the Permissions dialog box. This is accessed by highlighting the User Group and 
selecting the Edit Permissions option from the right click menu. This will bring up the 
Permissions dialog box. 

 
1. If the User Group belongs to a Command Group higher in the Command Group 

hierarchy, by default i t will inherit the permissions from that higher Command 
Group. This permission can be varied at the lower level by changing the selections 
made using the check boxes. 

2. If the User Group only exists at this level in the hierarchy, the Permissions dialog box 
will initially have all check boxes blank. The Administrator must then assign Allow 
or Deny permissions.   

Giving Permission for Planogram Publishing 
In order for a user to publish planograms, they must have access rights to the planogram 
groups containing both the master and individual planograms involved. This is set via 
the Planogram tab of the Data Security dialog box accessed from the Security menu in the 
Administration module. Permissions are inherited from higher level groups. Giving 
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permissions to a top level group will give permissions to all planograms that are children 
of that group. Giving permissions to lower level groups will make access to planograms 
more restrictive. 

 
After assigning user groups to planogram groups, users must also be assigned 
permissions in the Edit permissions dialog box accessed by right clicking a User Group. 
Users require full permissions. 

 

Dates Planograms will be Published 
The purpose of publishing a planogram is to disseminate information on the type, 
quantity and location of shelves and merchandise to those tasked with implementing the 
change. Publishing a planogram design can be done in hard copy or electronic format. 
The date at which this is executed depends on the Publish Date set in the Details tab of 
the Planogram Design dialog box in the Merchandiser module. 

Note: the Publish Date operates purely on the date only and 
takes no account of the time of day. Publish Dates are stored 
in Date/Time format in the database, but the functionality 
only references the Date. 
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Another factor affecting the date at which at which planograms will be published is the 
Lead Time Tolerance (Hours) setting on the Output tab of the Planogram Publishing 
Configuration dialog box in the Administration Module. 

Note: this dialog box will only be accessible to users with 
access rights to the Administration Module. 
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Batch processes can be set to start at any time of the day. For example, the batch process 
might initiate at 8 p.m. (20.00 hrs) in the evening to allow the maximum number of batch 
processes to be run before users come in for work again the following morning. 
However, the Publish date for the floor plan might be set for when the following day 
begins at midnight. The Lead Time Tolerance (Hours) setting allows for this. 

For example, if batch process is run on the 2nd June at 20.00 hrs in the evening and has 
no lead time tolerance, a planogram that has a Publish Date of 3rd June would be ignored 
for publishing purposes by this run of the batch process. If however, the Lead Time 
Tolerance (Hours) setting is set to 5 hours, this will be added onto the Date and Time for 
the batch process and cause the batch process to operate as if i t were running at 01.00 hrs 
in the morning of 3rd June. All  planograms with a Publish Date of 3rd June would then 
be published. 

Criteria for Publishing Planograms 
There are two criteria for publishing planograms: 

1. Publish Date has been exceeded 

If the Publish Date set in the Details Tab of the Planogram Design dialog box in 
Merchandiser exceeds the current date (taking into account the Lead Time Tolerance 
(Hours) setting in the Planogram configuration dialog box in the Administration 
module), the floor plan will be published. 

2. Planogram has been Updated since it was Published 
It is possible that the floor plan may have been modified after it was last published - 
for example of a later revision has been created. The condition for this is that the Last 
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Modified date is greater than the Last Published Date. These can be seen on the 
Properties tab of the Planogram Design dialog box in the Merchandiser module. 

 

Note: Planograms may also be republished if the Republish 
planogram if files are missing option has been checked in the 
Planogram Publishing Configuration dialog box. 

Master Planograms 
Master Planograms act as placeholders in floor plans - see the detailed section on master 
planograms in the section on Merchandise. Because a master planogram acts as a 
placeholder for individual planograms, there is no need to update the floor plan every 
time an individual planogram is changed. Instead, when the planogram is published, the 
functionality will substitute the mapped individual planogram for the master planogram 
present in the floor plan. 

Locations Planograms will Be Published To 
The locations Planogram designs will published to and the file names that will be used 
are specified in the Output tab of the Planogram Publishing Configuration dialog box in 
the Administration module. If the date is included in the filename and the planograms 
are being organized by store then the store specific effective dates will be used. 

Note: this dialog box will only be accessible to users with 
access rights to the Administration Module. 
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Note: For the Master Planogram functionality to work, the 
output format must be set to Organize by Store. 

This dialog box allows Administrators to specify the directory structure, file format and 
file name that will be used when planogram designs are published. The starting point for 
the location planograms will be published to in electronic form can be seen in the details 
for the Planogram Publish system directory specified in the Directories Tab of the 
Configuration module. 
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The Filtering Tab 
The Filtering tab enables the user to select the Planograms to publish. It will populate 
with all planograms in the currently active floor plan. 

Note: If there are multiple instances of a planogram in a floor 
plan, only a single entry will appear in the list of 
planograms. 

The Filtering tab returns a list of all planograms in the database. If only specific zones 
have been loaded into the floor plan when it was opened, the Filtering tab will also 
contain the planograms in the zones that were not loaded. 

Note: The option to only load specific zones is controlled by 
the Express Load option in the Merchandiser tab of the 
Configuration module. 
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Planograms may be selected for printing by ticking the appropriate check box. The report 
to be used can be selected on the Template tab, while the order in which the planograms 
will print is specified on the Collation tab. 

Master Planograms 
If master planograms are in a floor plan, these should map to individual planograms. The 
individual planogram that will list will be the one where the floor plan date is set to 
between the planograms Effective and Expiry dates. 

Find 
The Find option can be used by typing text into the text box then clicking the Find icon. 
Each successive click will move the user to the next floor plan matching the text being 
searched for. When no more matches are available, a confirmatory dialog box will 
appear. 

 
Find operates with explicit or implied wild cards. The explicit wild cards are: 

Wild Card Description 

* Any characters 

? Any character in this position 
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Wild Card Description 

# Any number in this position 

 

If explicit wild cards are not used, implicit wild cards will be assumed. For example the 
text entry 'Wine' will be treated as '*wine*' and will find I Bay Red Wine, 1 Bay White 
Wine, etc. 

Pick  
Pick takes the user to the currently active floor plan. They can then use AutoCAD 
selection methods to select specific planograms. When the AutoCAD selection is 
completed with a right mouse click, the user will be returned to the Print Planogram 
dialog box and the dialog box will populate with the selected planograms. 

Right Click Menu 
The right click menu provides a quick way of modifying the selected items. 

 
 

Option Effect 

Select All This will select (but not check) all rows of data. 

Clear All This will deselect (but not uncheck) all rows of data. 

Check Selected This will check all rows of selected data. 

Uncheck Selected This will uncheck all rows of selected data. 

Check All This will check all rows of data. 

Uncheck All This will uncheck all rows of data. 

 

Paste allows users to paste a carriage returned list of floor plan identifiers from the 
Windows clipboard. All rows in the dialog box that match the pasted information will be 
checked. 

Filters 
The Filtering Tab is provided with a series of filters on each column. Setting a filter on 
one column will affect data in all other columns. If a fil ter is active it will be shown by the 
symbol on the column header. 
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They are used as follows: 

Option Description 

Show All  This option shows all results. It can be used to remove the effects of any applied 
filters. 

Custom 
Filter 

This option allows users to set filters using Boolean logic. The options are: 
 Equal to: will return rows that are an exact match for the entered text. 

 Not Equal to: will return rows that do not match the text string 

 Contains: will return rows where part of the data matches the text string. (Uses 
implied wild cards). 

 Does not contain: will return rows where no part of the data matches the text 
string. (Uses implied wild cards). 

 Begins with: will return rows where the text string is an exact match for the start 
of the data. 

 Ends with: will return rows where the text string is an exact match for the end of 
the data. 

 Does not begin with: will return rows where the text string is not an exact match 
for the start of the data. 

 Does not end with: will return rows where the text string is not an exact match 
for the end of the data. 

Blanks Column will be filtered to only show rows with null values. 

Non-Blanks Column will be filtered to only show rows containing a value 

Planogram 
list  Column will be filtered to only show the selected result. 
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The Templates Tab 
The Templates Tab allows users to specify the template format to be used when printing 
planogram designs. 

 

The user can use a radio button to specify the form the report will take: an imported 
'associated planogram document' or a template that is configured in the Report Designer 
Module. 

Use Associated Planogram document 
This option publishes the planogram design information using a pre-generated report 
using one of the following file formats: BMP, GIF, JPEG, JPG, PDF, PNG, TIFF or WMF. 
This report will be imported when a planogram is imported using Oracle Data Integrator 
(ODI). The Associated Document (if available) is specified in the Associated Document 
text box in the Details tab of the Planogram Design dialog box in the Merchandiser 
module. 
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There are two options (selected using the radio button) for when the pre-generated 
report is missing. 

 Write an error to the AVTTB_PUBLISH_POG_LOG table. Information in this table 
can be read by means of a BI Publisher report or similar. 

 Use the default Report Designer template. 

Use Template   
This option allows the user to define the way the template from the Report Designer 
module is selected. There are two options (selected using the radio button): 

 Use Planograms preferred template, if defined - this option is specified in the 
Preferred Template drop down list in the Details tab of the Planogram Design dialog 
box in the Merchandiser module. 

 Use Selected Template from List Below - this option can be set by checking items in 
the list of available templates. One or more templates may be selected. If multiple 
templates are selected, the name of the template will be added to the file name in 
brackets - for example 1_Bay_Mixed_Fizzy_Drinks (Basic Planogram Report).pdf 

If necessary, the list of templates can be searched by entering a text string into the drop 
down list, then clicking the Find button. (Actual or implied wild cards can be used). Each 
click of the Find button will cause the search engine to move forward through the 
matching results until no results are left. 

Note: the last 10 text searches can be selected using the drop 
down list in the text box. 
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The Collation Tab 
The Collation Tab allows users to specify the sequence the planogram designs will be 
published or printed in.  At least one collation option must be selected, or the tab will 
show as having an error. The order of the collation options can be modified highlighting 
them and then using the Up or Down arrows. 

 

The available options can be ordered by highlighting them, then using the up or down 
arrows. The options are made active by using the check boxes. 

 Region is a specific type of cluster set in the Cluster type drop down list in the 
Cluster dialog box in Store Manager. 

 District is a specific type of cluster set in the Cluster type drop down list in the 
Cluster dialog box in Store Manager. 

 
 Store Number is the Store Code in the Store dialog box in Store Manager. 
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 Store Name is the Store Name in the Store dialog box in Store Manager. 

 
 Department is the department (zone) in the floor plan the planogram is associated 

with. 

 Aisle is the aisle the planogram is associated with. For this option to operate, aisles 
must first be drawn in the floor plan in the Planner module. In the example below, 
Aisle F-1 has been drawn between two runs of fixtures. 

 
 Bay Number is the bay number associated with the fixtures the planogram is placed 

on. For this option to operate, the fixtures in the floor plan must previously have 
been bay numbered. 
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 Bay Group  is the Name assigned to a number of fixtures sharing a common 

characteristic. It is assigned in the Name field of the Bay Numbering dialog box in 
the Planner module. 

 
 Planogram Name is the name of the planogram. This is set in the Name field of the 

Planogram Design dialog box in Merchandiser. 

 Planogram Code  is the code for the planogram. This is set in the Client Code field of 
the Planogram Design dialog box in Merchandiser. 
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The Validation Tab 
The Validation tab enables users to set a series of validation checks that must be satisfied 
before the planogram design is published. If any of the checks are failed, the details will 
be written to the AVTTB_PUBLISH_POG_LOG table. Information in this table can be 
read by means of a BI Publisher report or similar. 
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1. Check for empty shelves - this option will check the parent fixture and associated 
shelf objects. It will raise an error report if: 

– The fixture and associated shelf objects can be populated with product 
placeholders, but no product placeholder has been placed. 

– The fixture and associated shelf objects can be populated with display styles, but 
no display styles have been placed. 

2. Check for products that have expired or are not yet effective - this option will check 
all products in the planogram against the effective date of the planogram. It will raise 
an error report if: 

– The Product Effective Date is after the Planogram Effective Date - i.e. the product 
is not yet available to place in the planogram. 

– The Product Expiry Date is before the Planogram Effective Date - i.e. the product 
will expire while the planogram is still in service. 

The check will be ignored if the product effective or expiry date is undefined. 

The Planogram Effective Date is set in the Details tab of the Planogram Design dialog 
box in Merchandiser. 
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The Product Effective and Expiry dates are set in the Details tab of the SKU dialog 
box in Product Studio. 
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3. Check for equipment that is obsolete or not yet available - this option will check all 

equipment in the planogram against the effective date of the planogram. It will raise 
an error report if: 

– The Equipment Effective Date is after the Planogram Effective Date - i.e. the 
equipment is not yet available for the planogram. 

– The Equipment Expiry Date is before the Planogram Effective Date - i.e. the 
equipment will be taken out of service while the planogram is still in use. 

The check will be ignored if the equipment effective or expiry date is undefined. The 
Equipment Effective and Expiry dates are set in the Category tab of the Block Details 
dialog box in Fixture Studio. 
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4. Validation Scope - this controls when to apply the validation checks. There are three 
options - selectable by the radio button. 

– Apply to all planograms. 

– Apply to non-imported (manually created) planograms. 

– Apply to imported planograms. 

The application will automatically distinguish between imported and manually 
created planograms by means of the information held in the Macro Space Planning 
database. 
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20 
Planogram Printing 

Overview of Planogram Printing 
Planogram Printing allows users to select planograms in the currently active floor plan 
and print out information on the ones they have permissions to print. 

Note: Users wishing to Publish the planogram design 
(output it in electronic or hard copy form with permanent 
changes) should use the Immediate Planogram Publishing 
option from the File menu. 

Note: The default settings for this dialog box are derived 
from settings in the Planogram Publishing Configuration 
dialog box in the Administration module. 

 
The basic method of operation is as follows: 
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1. Administration Module  

Within the Administration Module: 

– The planogram users have permissions to print are assigned in the Data Security 
dialog box - Planograms Tab. 

– The fields that display in the Filtering Tab of the Print Planograms dialog box are 
configured in the Custom SQL dialog box. 

– Planograms can be printed using report templates specified in the Report 
Designer module. Permission to access this module is specified in the Functional 
Security dialog box. 

These settings determine what will appear in the Print Planograms dialog box (and 
the reports that will be available) when it is accessed in the Planner and 
Merchandiser modules. 

Note: In order to access the Administration Module, users 
must have permission to do so. 

2. Planner Module  

The Print Planograms dialog box may be accessed from the File Menu - a floor plan 
containing planograms must previously have been opened. Users with permissions 
to access the Planner module automatically have permission to use the functionality. 

3. Merchandiser Module  

The Print Planograms dialog box may be accessed from the File > Print Menu - a 
floor plan containing planograms must previously have been opened. Users with  
permissions to access the Merchandiser module automatically have permission to 
use the functionality. 

4. Report Designer 

The Report Designer module is used to design report templates that can be specified 
for use in the Print Planograms dialog box. Permissions to access this module are 
assigned in the Functional Security dialog box in the Administration module. 
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Using Planogram Printing 
The functionality is used as follows: 

1. A floor plan containing planograms is opened in the Planner or Merchandiser 
module. 

2. The Print Planogram option is selected from the File menu in the Planner or 
Merchandiser module. 

3. The appropriate planograms are selected in the Filtering tab of the Print Planograms 
dialog box based on the date selected in the dialog box. 

4. The report to use is specified in the Templates tab. 

5. The sequence the selected floor plans are to be printed in is specified in the Collation 
Tab. 

6. On clicking the Print button, the selected planogram reports will be printed on the 
default printer associated with the user's computer. 

Accessing the Functionality 

Note: before accessing the Print Planogram functionality, 
users should open a floor plan containing planograms. 

The Print Planogram functionality is accessed from the File Menu > Print option. Users 
with permissions to access the Planner module will automatically have permission to use 
the functionality. 

 
When the Print Planogram dialog box opens it will be populated with all planograms in 
the currently active floor plan. By default, they will be not be selected. The columns that 
are displayed in the dialog box are configurable in the Custom SQL option available from 
the General Menu in the Administration module.  The appropriate revision for any 
planogram will be listed based on the floor plan date specified in the dialog box. Any 
Master Planograms in the floor plan will be mapped to specific individual planograms. If 
the individual planograms have store specific effective dates specified, these will be used 
in determining what planogram revision is appropriate.  

Errors and Results 
If any settings in the Print Planograms dialog box are not set, an error symbol will be 
displayed on the tab containing the data with the problem. The Print button will also be 
grayed out and unavailable. 
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Users must correct the problems before the Print button will activate. 

The Filtering Tab 
The Filtering tab enables the user to select the Planograms to print. It will populate with 
all planograms in the currently active floor plan. 

Note: If there are multiple instances of a planogram in a floor 
plan, only a single entry will appear in the list of 
planograms. 
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Planograms may be selected for printing by ticking the appropriate check box. The report 
to be used can be selected on the Template tab, while the order in which the planograms 
will print is specified on the Collation tab. 

Floor Plan Date 
The Floor Plan Date is for use with the Master Planogram functionality. When master 
planograms are present, this date is used to determining which corresponding individual 
planogram to print. The initial date set depends on the floor plan status. 

Status Initially Set Date 

Proposed The date will be set to the floor plans active date. If this has not been set, it will be 
set to today's date. 

Authorised 
The date will be set to the floor plans effective date. If the floor plans effective date 
has not been set, it will be set to the active date. If neither date has been set, it will 
be set to today's date. 

Published 
The date will be set to the floor plans effective date. If the floor plans effective date 
has not been set, it will be set to the active date. If neither date has been set, it will 
be set to today's date. 

Current The date will be set to today's date. 

Superseded 
(Historical) 

The date will be set to the floor plans expiry date - the date it was replaced by a 
more recent floor plan. 
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It is possible to use the control to change the set date. If the effective and expiry date have 
been set, the date can only be varied between those limits. If these dates have not been 
set, these is no limit to that date can be set. 

Floor Plan Date and Master Planograms 
If master planograms are in a floor plan, these should map to individual planograms. The 
individual planogram that will be listed will be the one where the floor plan date is set to 
between the planograms Effective and Expiry dates. 

Find 
The Find option can be used by typing text into the text box then clicking the Find icon. 
Each successive click will move the user to the next floor plan matching the text being 
searched for. When no more matches are available, a confirmatory dialog box will 
appear. 

 
Find operates with explicit or implied wild cards. The explicit wild cards are: 

Wild Card Description 

* Any characters 

? Any character in this position 

# Any number in this position 

 

If explicit wild cards are not used, implicit wild cards will be assumed. For example the 
text entry 'Wine' will be treated as '*wine*' and will find I Bay Red Wine, 1 Bay White 
Wine, etc. 

Pick (Planner Only) 
Pick takes the user to the currently active floor plan. They can then use AutoCAD 
selection methods to select specific planograms. When the AutoCAD selection is 
completed with a right mouse click, the user will be returned to the Print Planogram 
dialog box and the dialog box will populate with the selected planograms. 

Right Click Menu 
The right click menu provides a quick way of modifying the selected items. 
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Option Effect 

Select All This will select (but not check) all rows of data. 

Clear All This will deselect (but not uncheck) all rows of data. 

Check Selected This will check all rows of selected data. 

Uncheck Selected This will uncheck all rows of selected data. 

Check All This will check all rows of data. 

Uncheck All This will uncheck all rows of data. 

 

Paste allows users to paste a carriage returned list of floor plan identifiers from the 
Windows clipboard. All rows in the dialog box that match the pasted information will be 
checked. 

Filters 
The Filtering Tab is provided with a series of filters on each column. Setting a filter on 
one column will affect data in all other columns. If a fil ter is active it will be shown by the 
symbol on the column header. 
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They are used as follows: 

Option Description 

Show All  This option shows all results. It can be used to remove the effects of any applied 
filters. 

Custom 
Filter 

This option allows users to set filters using Boolean logic. The options are: 
 Equal to: will return rows that are an exact match for the entered text. 

 Not Equal to: will return rows that do not match the text string 
 Contains: will return rows where part of the data matches the text string. (Uses 

implied wild cards). 
 Does not contain: will return rows where no part of the data matches the text 

string. (Uses implied wild cards). 
 Begins with: will return rows where the text string is an exact match for the start 

of the data. 

 Ends with: will return rows where the text string is an exact match for the end of 
the data. 

 Does not begin with: will return rows where the text string is not an exact match 
for the start of the data. 

 Does not end with: will return rows where the text string is not an exact match 
for the end of the data. 

Blanks Column will be filtered to only show rows with null values. 

Non-Blanks Column will be filtered to only show rows containing a value 

Planogram 
list  Column will be filtered to only show the selected result. 
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The Templates Tab 
The Templates Tab allows users to specify the template format to be used when printing 
planogram designs. 

 
The user can use a radio button to specify the form the report will take: an imported 
'associated planogram document' or a template that is configured in the Report Designer 
Module. 

Use Associated Planogram document 
This option publishes the planogram design information using a pre-generated report 
using one of the following file formats: BMP, GIF, JPEG, JPG, PDF, PNG, TIFF or WMF. 
This report will be imported when a planogram is imported using Oracle Data Integrator 
(ODI). The Associated Document (if available) is specified in the Associated Document 
text box in the Details tab of the Planogram Design dialog box in the Merchandiser 
module. 
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There are two options (selected using the radio button) for when the pre-generated 
report is missing. 

 Write an error to the AVTTB_PUBLISH_POG_LOG table. Information in this table 
can be read by means of a BI Publisher report or similar. 

 Use the default Report Designer template. 

Use Template   
This option allows the user to define the way the template from the Report Designer 
module is selected. There are two options (selected using the radio button): 

 Use Planograms preferred template, if defined - this option is specified in the 
Preferred Template drop down list in the Details tab of the Planogram Design dialog 
box in the Merchandiser module. 

 Use Selected Template from List Below - this option can be set by checking items in 
the list of available templates. One or more templates may be selected. If multiple 
templates are selected, the name of the template will be added to the file name in 
brackets - for example 1_Bay_Mixed_Fizzy_Drinks (Basic Planogram Report).pdf 

If necessary, the list of templates can be searched by entering a text string into the drop 
down list, then clicking the Find button. (Actual or implied wild cards can be used). Each 
click of the Find button will cause the search engine to move forward through the 
matching results until no results are left. 

Note: the last 10 text searches can be selected using the drop 
down list in the text box. 
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The Collation Tab 
The Collation Tab allows users to specify the sequence the planogram designs will be 
printed in. Its main use is in printing hard copy versions of the designs where the 
sequence they are printed in makes it easier to sort and distribute them after printing. At 
least one collation option must be selected, or the tab will show as having an error. The 
order of the collation options can be modified highlighting them and then using the Up 
or Down arrows. 

 
The available options can be ordered by highlighting them, then using the up or down 
arrows. The options are made active by using the check boxes. 

 Region is a specific type of cluster set in the Cluster type drop down list in the 
Cluster dialog box in Store Manager. 

 District is a specific type of cluster set in the Cluster type drop down list in the 
Cluster dialog box in Store Manager. 
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 Store Number is the Store Code in the Store dialog box in Store Manager. 

 Store Name is the Store Name in the Store dialog box in Store Manager. 

 
 Department is the department (zone) in the floor plan the planogram is associated 

with. 

 Aisle is the aisle the planogram is associated with. For this option to operate, aisles 
must first be drawn in the floor plan in the Planner module. In the example below, 
Aisle F-1 has been drawn between two runs of fixtures. 
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 Bay Number is the bay number associated with the fixtures the planogram is placed 

on. For this option to operate, the fixtures in the floor plan must previously have 
been bay numbered. 

 
 Bay Group is the Name assigned to a number of fixtures sharing a common 

characteristic. It is assigned in the Name field of the Bay Numbering dialog box in 
the Planner module. 

 
 Planogram Name is the name of the planogram. This is set in the Name field of the 

Planogram Design dialog box in Merchandiser. 

 Planogram Code is the code for the planogram. This is set in the Client Code field of 
the Planogram Design dialog box in Merchandiser. 
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21 
Synchronization 

Overview of Synchronization 

Planner and Synchronization 
The Planner module is based on AutoCAD. Work done in the floor plans is initially 
saved back to an AutoCAD (DWG) file before information is written back to the Macro 
Space Planning (MSP) database. However, there are ways that the information in the 
AutoCAD floor plan can diverge from the information held in the database. These ways 
are: 

 The floor plan has been modified in Raw AutoCAD. 

 AutoCAD functionality can be used which results in changes to the floor plan, but 
not to the database. This will occur when dynamic synchronization is set to Off. 

 Changes can be made to the floor plan in the Merchandiser module - this will write 
information back to the MSP database but not to the AutoCAD drawing in Planner. 

 Changes can be made to the floor plan in In-Store Space Collaboration - this will 
write information back to the MSP database but not to the AutoCAD drawing in 
Planner. 

 Changes can be made to the floor plan using batch processes such as Planogram 
Substitution. This will write information back to the MSP database but not to the 
AutoCAD drawing in Planner. 

Synchronization is therefore used to ensure that what is show graphically in the floor 
plan is also what is held in the database. There are three forms of synchronization. 

Manual Synchronization 
Manual synchronization is synchronization carried out by the user by invoking the 
functionality from the menu bar or Retail toolbar. 

Dynamic Synchronization 
Dynamic Synchronization can be turned on or off by the user. If turned on, the changes 
made by AutoCAD tools are simultaneously written back to the database. 

Auto-Synchronization 
Auto-Synchronization is used when changes have been made to the database by work 
carried out in the Merchandiser module, in In-Store Space Collaboration or by Batch 
tools. If active, when a floor plan is subsequently opened in Planner, the required 
updates will be made to the floor plan. Dependent on settings; confirmation may be 
required from the user first. 

Manual Synchronization 
Manual Synchronization is used to ensure that the information held in the floor plan in 
the Planner module is identical to the information held in the database. It is done using 
the Synchronization dialog box. 
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Synchronization can be done in several ways: 

Match the Drawing 
Data in the database will be overwritten with data from the drawing. 

 
In this example, the drawing contains Fixtures 1, 2 and 3, together with products A, B 
and C. This information overwrites the data on Fixtures 2, 3 and 4 and their associated 
products B, D and E that was originally held in the database. 

Match the Database 
Data in the drawing will be overwritten with data from the database. 
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In this example, the drawing contains Fixtures 1, 2 and 3, together with products A, B 
and C. This information is updated with Fixtures 2, 3 and 4 and their associated products 
B, D and E that is held in the database. 

Merge 
Merge combined the data in the drawing and the database so the same information is 
present in both places. Where information is present in both locations, merging can be 
done with priority to the drawing or priority to the database. 

 
 In this Merge example, priority has been given to the drawing. Data is modified as 
follows: 

 Fixture 4 and Product E do not exist in the drawing, so they are added. 

 Fixture 1 and Product A do not exist in the database, so they are added. 

 Fixtures 2 and 4, together with Product B are identical in both the database and 
drawing, so no changes are made. 

 Product C in the drawing coincides with Product D in the database. Because priority 
has been given to the drawing, Product C overwrites Product D in the database. 

Keep Identical 
Keep identical only keeps items that are identical in the drawing and the database. 
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In this example, only Fixtures 2 and 3 and product B are identical. After the synchronize 
operation these three items only will be present in both database and drawing. 

Manual Synchronization Dialog Box 

Accessing the Synchronization Dialog Box 
The synchronization dialog box can be accessed by the Synchronization  option on the 
File menu. Alternatively, it can be accessed from the Retail toolbar. 

 

Parts of the Synchronization Dialog Box 
The synchronization dialog box has the following components. 

 

 Synchronization Options: These specify the form synchronization is to take - for 
example write the contents of the floor plan to the database (Match the Drawing). 

 Items to Synchronize: These specify what objects in the floor plan are to be 
synchronized - for example zones, aisles and fixtures. 

 Venn Diagram: This can be used to determine which synchronization option is 
required.  

 Synchronize Button: This initiates manual synchronization options. 
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If the mouse pointer is poised over a category of information in the Venn diagram, the 
cursor will change from a pointer to a hand. Left clicking on the category will bring up a 
dialogue box with details of the items. 

. 

Guidelines for Manually Synchronizing 
The appropriate synchronization actions can be determined using the Venn diagram in 
the synchronization dialog box. This will vary according to the Synchronization option 
selected in the upper right of the dialog box. The Venn diagram identifies: 

 Objects that are identical in the drawing (floor plan) and the database. 

 Objects that exist in the drawing and database but differ in some way - for example 
in their position. 

 Objects that exist in the drawing only. 

 Objects that exist in the database only.   

Note: Manual Synchronization will only be required if Auto-
Synchronization and Dynamic Synchronization have not 
been enabled. 

Match the Drawing 
The Match the Drawing option has a light blue circle highlighting what data is identical 
in the drawing and database, what is different and what is in the drawing only. The dark 
blue circle shows data in the database only. 
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Use this option when the information in the currently active Planner floor plan is the 
version you wish to save back to the database. This may be required if: 

 A raw AutoCAD drawing has been imported. 

  The USERI1 system variable has been set to 0 and the results of specific AutoCAD 
operations are not being written to the database. 

Match the Database 
The Match the Database option has a light blue circle highlighting what data is identical 
in the floor plan and database, what is different and what is in the database only. The 
dark blue circle shows data in the drawing only. 

 
Use this option if the floor plan has been modified outside of the planner module. This 
could occur if: 

 The floor plan has been updated in the Merchandiser module. 

 The floor plan has been updated in In-Store Space Collaboration 

 The floor plan has been updated by a batch process. 
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Merge 
This option is not commonly used. It might be required if changes have been made to the 
floor plan in the Planner module but not written back to the database. If the floor plan is 
in this condition when (for example) batch tools are used it will be difficult to establish 
what the correct version of the drawing should be like. In this event it may be necessary 
to merge to changes so that floor plan and database are identical, then use KPI's and 
reports to determine where errors exist in the floor plan. 

 
All data is enclosed within the light blue circles. 

 Data in the drawing but not in the database will be written to the database. 

 Data in the database but not in the drawing will be written to the drawing. 

 Data for objects that have differences (but are identical in position) will be 
overwritten in the drawing or database depending on which priority radio button is 
selected. 

Only Keep Identical 
This option is not commonly used. It applies to a similar situation where a floor plan has 
had changes made in both the planner module and (for example) by a batch process. The 
data may have become confused. The most practical option might be only to keep data 
that is identical in the drawing and database as only this data can be guaranteed to be 
correct. Any necessary changes can then be reapplied. 
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All data is enclosed within the blue circle. Only data shown as identical within the 
drawing and database will be retained. 

Dynamic Synchronization 

Overview of Dynamic Synchronization 
Dynamic Synchronization can be turned on or off as required. The setting determines 
whether changes to Fixtures, Product Blocks  and Other Blocks  made in a Planner 
AutoCAD floor plan using AutoCAD commands are automatically written back to the 
database when they are executed or whether manual synchronization is subsequently 
required. 

DYNAMIC_SYNC System Variable 
The initial setting for a new user is governed by the value of the DYNAMIC_SYNC 
system variable set in the System Variable dialog box accessed from the General menu of 
the Administration module. This may be set to one of two options: 

 Off: Dynamic sync is not enabled. 

 On: Dynamic Sync is enabled 

The first time a user accesses a Planner floor plan, the dynamic synchronization setting 
for that user will be set to that matching the DYNAMIC_SYNC system variable. After the 
global value of dynamic synchronization has been set, individual users can then toggle 
dynamic synchronization on or off as required. 

Changing Individual Settings for Dynamic Synchronization 
Once an individual user has been assigned the global value for dynamic synchronization, 
they can change this as desired via the AutoCAD command line. 

 
Entering the command AVT_DYNAMICSYNC will allow users to enter On or Off as an 
option. 
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Note: once users have entered their personal setting for 
Dynamic Synchronization this will not be affected by 
changes to the DYNAMIC_SYNC system variable. 

Use of Dynamic Synchronization 
Users have the option of turning Dynamic Synchronization On or Off. There are 
advantages for either option. 

Dynamic Synchronization On 
If dynamic synchronization is on, changes made to fixtures, products , planograms and 
other blocks  made with AutoCAD tools will be immediately written back to the 
database. This will mean the information in quick reports, the summary window in the 
Object Browser, etc will be continually updated. However, for large floor plans, 
performance of the application may be marginally slowed. 

Dynamic Synchronization Off 
If dynamic synchronization is off, performance of the application may be slightly faster. 
However, the user will have to manually synchronize the floor plan in order to ensure 
that the effects of changes made with AutoCAD tools will be written back to the 
database. 

Auto-Synchronizing 
Depending on settings in the Administration module, it is possible to set the floor plan to 
automatically undergo the required changes when opened in the Planner module. 
Depending on the precise settings, this will either require the user to confirm the 
synchronization can occur, or it will occur without requiring permission. If confirmation 
is required, a dialog box will appear, requiring the user to click Yes before 
synchronization can proceed. 

 

Note: Depending on the auto-synchronize options, different 
objects will be synchronized - see below for details. 

How Auto-Synchronization Works 
Auto-Synchronization works by comparing a series of dates held in the File table in the 
database. This table is only available to people with permissions to access the database - 
although most can be seen in the File Properties dialog box in Store Manager. 
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These dates have the following significance: 

Properties 
Dialog Box 
Date 

Comment 

Created 

This is the date the floor plan was originally created. If the floor plan was created 
in Store Manager, this will be the date the floor plan was created. If the floor plan 
was copied from another floor plan in Store Manager, this will be the date the floor 
plan was copied. If the floor plan was imported, this will be the date it was 
originally created in raw AutoCAD. 

File Modified 

This is the date the floor plan was originally created in Store Manager. 
Alternatively, if the floor plan was imported, this will be the date it was last 
modified in raw AutoCAD. Once the file has been saved in Planner, the FIL_DATE 
field will hold the date of that save but the File Modified fie ld will continue to 
show the date it was last modified in raw AutoCAD. 

Last Modified This is the date the file was last saved by a user in the Planner or Merchandiser 
modules or in In-Store Space Collaboration. 

Modified by 
Automation 

This is the date the file was last modified by a batch process such as planogram 
substitution. 

DWG Date (not 
in Dialog Box) 

This date is stored purely in the DWG file for the floor plan. It is the date the floor 
plan was last saved to the windows folder. This could have been done in raw 
AutoCAD or it could have been done via the Planner module. 

The logic of Auto-Synchronization can be seen in the following flowchart. 

1. Changes can be made outside of the Planner floor plan leading to differences 
between the data held in that floor plan and the database. 

2. If Auto-Sync has been turned on in the Administration module, the dates associated 
with the floor plan will be compared. 

3. Depending on the results in the Check Modified Dates stage, different types of auto-
synchronization will be carried out. 
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Case 1 - Changes made in Merchandiser or ISSC 
This is checked by seeing if the following cases apply: 

Last Modified Date > File Modified Date >= DWG Date 

1. If the Last Modified Date is greater than the File Modified Date this means the file 
was last modified in Merchandiser or ISSC. 

2. If the File Modified Date is greater than or equal to the DWG Date  (not visible in the 
File Properties dialog box) this means the file has not been modified by an external 
application such as raw AutoCAD or the file has not been overwritten by a new raw 
AutoCAD file.  

If one of these cases is true, then the Planner floor plan will by synchronized match the 
database as the database holds more recent information that in the Planner floor plan.  

Case 2 - Changes made by a Batch Process 
This is checked by seeing if the following cases apply: 

Modified by Automation > Last Modified Date >= DWG Date 

1. If the Modified by Automation date is greater than the Last Modified Date this 
means the file was modified by a batch process after the floor plan was last 
physically saved by a Planner user. 

2. If the Last Modified Date is greater than or equal to the DWG Date  (not visible in the 
File Properties dialog box) this means the file has not been modified by an external 
application such as raw AutoCAD or the file has not been overwritten by a new raw 
AutoCAD file.  

If one of these cases is true, then the floor plan will be synchronized Match the Database 
as the database holds more recent information that in the Planner floor plan.. 

Case 3 - Changes made outside of MSM or ISSC simultaneous with adding in Raw 
AutoCAD drawing 
This is checked by seeing if both the following cases apply: 

DWG Date > Last Modified Date 

And 

Modified by Automation date > Last Modified Date OR DWG Date > File Modified 
Date 

1. If the DWG date is greater than the Last Modified Date this means the floor plan has 
been modified by an external program such as raw AutoCAD 

AND 

2. Either of the following is true: 
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a.  Modified by Automation Date  is greater than Last Modified Date means the 
data for the floor plan in the database has been modified after the floor plan 
was last saved by the user 

b.  File Modified Date is greater than Last Modified Date means the Planner 
floor plan has been updated  after a used updated date in merchandiser or 
ISSC. 

If Case (1) and one of the options in Case (2) is true then the floor plan will be 
synchronized Cross Match as the database contains more recent information than the 
floor plan and the floor plan has also been updated by an external program such as raw 
AutoCAD. 

Synchronization Options 

Synchronize 'Match the Database' 
The following objects will be synchronized. 

 Fixtures  

 Products  

 Other Blocks  

Synchronize 'Match the Drawing' 
The following objects will be synchronized: 

 Fixtures  

 Products  

 Other Blocks  

 Zones 

 Aisles 

Synchronize 'Cross Match' 
The following objects will be synchronized: 

 Fixtures  

 Shelves  

 Products  

 Other Blocks  

 Zones 

 Aisles 

Fixtures, other blocks, zones and aisles will be updated in the database to match the floor 
plan using the existing synchronize functionality. Shelves, planogram definition 
placeholders and product placeholders will be updated in the floor plan to match the 
database using the existing Synchronize functionality. 
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Prototype Stores 

Overview of Prototype Stores 
Prototype Stores are a Macro Space Management concept. They are stores that can be 
designated as having specific properties that can be used as a basis for comparison for 
other stores. 

Setting and Designating Prototype Stores 
Designating a store as a prototype store is done is Store Manager by checking the Set as 
Prototype check box in the General Tab of the Add/Edit Store dialog box (left hand 
screen shot below). Once prototype stores have been designated, they can be selected as 
the basis for comparison by other stores. This is done by selecting the required from the 
Store Prototype drop down list in the General Tab of the Add/Edit Store dialog box 
(right hand screen shot below). This associates the store with its designated prototype 
store in the database. This link can then be used for reporting purposes. 

 

A further action will be required in the File Properties dialog box (right click Menu in 
Store Manager). 
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Here the Prototype Store to be used as the basis for comparison is set using the drop 
down list in the Details tab. 

Technicalities of Using Prototype Stores 
When a prototype store is assigned, a flag is set in the database. 

 The STR_PROTOTYPE field is set in the Store table when the prototype store is 
designated in the Add/Edit Store dialog box in Store Manager. 

 The STR_PROTOTYPE field is set in the File table when the prototype store is 
designated in the File Properties dialog box in Store Manager. 

This information can then be used by Macro Space Management's Custom SQL to 
generate information specific to the currently active floor plan. Example uses include 
comparing the zones, equipment or merchandise between a store and its designated 
prototype. This comparison normally meets two criteria: 

 The floors are the same type; for example the first floor in one store is being 
compared with the first floor in another. 

 The floor plan in the prototype store is at Current status as this represents the in-
service version of the prototype store. 

Note: For details on these tables see the Oracle Retail Macro 
Space Planning Data Model. 

Example Uses of Prototype Stores 
Once a store has been set as a prototype and referenced by another store/floor plan, the 
information can be used in several ways: 

 As a basis for comparison in the Object Browser. 

 As a filter for selection in the Object Grid. 

 As a basis for comparison in Quick Reports  

 As data used in Key Performance Indicators (KPIs). 

 As a store to compare against in Store Comparison. 
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Using Prototype Stores in Planner 

Example Uses of Prototype Stores 
Once a store has been set as a prototype and referenced by another store/floor plan, the 
information can be used in several ways: 

 As a basis for comparison in the Object Browser. 

 As a filter for selection in the Object Grid. 

 As a basis for comparison in Quick Reports  

 As data used in Key Performance Indicators (KPIs). 

 As a store to compare against in Store Comparison. 

Summary window 
The information displayed in the Summary Window can be customized by changing the 
Custom SQL that returns the information. In the example below, the standard 
information has been customized to allow a comparison of the area of the zones in the 
current and prototype stores. This allows the areas of the zones in stores of dissimilar 
shape to be adjusted until they occupy roughly the same area. 

 
Similar modifications can be made to the Custom SQL to display comparisons between 
the equipment and merchandise in the current and prototype stores. 

Object Grid  
The information displayed in the object grid for the current floor plan can be compared 
relative to information in the prototype store. In the example below, planograms present 
in the prototype store and already placed in the current floor plan are shown in black, 
planograms present in the prototype store but not yet present in the current floor plan 
are shown in red. 
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Quick Reports 
Prototype Stores can also be used in Quick Reports. In the example below, the Quick 
Report has been set up to show the base linear for products at sub-class level in the 
currently active store and its associated prototype. 

 

KPIs 
KPI's are another way of comparing the prototype store to the currently active store pan. 
In the example below, planogram performance in the current floor plan is being 
compared to that of the prototype store. This enables anyone viewing the floor plan to 
see relative performance at a glance. 
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Drawing Comparison 
Drawing Comparison is a utility available from the View menu in the Planner module. 
The utility allows comparison of equipment, merchandise categories or planograms 
between a designated prototype store and the current floor plan. 
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Architectural Plans 

Using Architectural Plans 
Architectural Plans are used as underlays to floor plans. They allow zones and fixturing 
to be accurately placed in relation to doors, windows, walls and other physical features. 
Architectural plans may also contain information on services such as electrical power 
sockets, essential for the location of chiller and freezer units. 

 
Architectural plans are used in two stages: 

1. They must first be associated with a parent floor in Store Manager. 

2. After the architectural plan has been associated with a specific floor, it can then be 
associated with any child floor plan. This is done from the Insert menu in the Planner 
module once the floor plan has been opened in Planner. 

Types of Architectural Plans 
Macro Space Planning recognizes two forms of architectural plans:   

 DWG files can only be used within the Planner module. 

 DWF files can be used both within the Planner module and in In-Store Space 
Collaboration (ISSC). 

Because of a current limitation of the software, if a DWF file is to be used for ISSC, it 
must be associated before any DWG files are associated for use in Planner. If this is not 
done, the DWF file will fail to appear in ISSC. 

Note: The DWF file used in ISSC must be of type Sheet , not 
of type 3D. Only DWF files of type Sheet will show as 
architectural plans in ISSC. 

Architectural plans are not visible in ISSC Mobile. 
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Associating the Architectural Plan with a Floor in Store Manager 
To associate the architectural plan with a floor in store manager: 

1. Highlight the required floor in the Store Manager. 

2. Click Add Architectural Plan on the toolbar. 

 
3. This will bring up the Associate Architecture Plan dialog box. 

 
4. Browse to the required architectural plan, select it and click OK. The architectural 

plan will now be associated with a floor. 

 

Associating an Architectural Plan with a Specific Floor Plan 
To associate an architectural plan with a specific floor plan: 

1. Select Add Architectural Plan from the Insert Menu. 
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2. This will bring up the Architectural Drawings dialog box. 

 
3. The available architectural plans will be displayed in the dialog box. Select the 

required plans and click OK. The architectural plans will now be associated with that 
floor plan as an underlay. 

Removing Architectural Plans 
To remove an architectural plan, select the Add Architectural Plan option from the 
Insert menu. Deselect the architectural plans it is desired to remove. Click OK and they 
will no longer be associated with the floor plan.  
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Title Blocks 

Overview of Title Blocks 
Title Blocks are used to put a frame round a drawing in preparation for publishing it in 
hard copy or PDF form. Title Blocks can also contain information on the drawing. 

Note: For a full explanation of how to create a Title Block see 
the Macro Space Management Administration Module Help File. 

 
 

Option Description 

Title Block 
This is a special form of AutoCAD DWG file that overlays the store plan on model 
space. It contains text based information on the floor plan and one or more View 
Ports to display the drawing. 

View Port 
The View Port (of which there may be one or several) can be a window cut through 
the title block to show the floor plan underneath. 

Title Block 
Information 

This is a series of fields that can be populated with specific items of information. In 
the example above data like the store code and store name are shown, but any 
information in the database can be configured to appear. 
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Option Description 

Scaled Floor 
Plan The floor plan is visible through the View Port. It is set to a specific scale.  

Each Title Block is designed for a specific size of paper, so if drawings are to be printed 
off in a range of sizes, title blocks should be created for each size. A metric 
implementation of Macro Space Management may contain title blocks for A2, A3 and A4 
size paper, while and imperial one may contain title blocks for ANSI A, ANSI B, ANSI C, 
ANSI D and ANSI E size paper. 

Using Title Blocks 
There are three ways title blocks can be used: 

Option Description 

Print from Planner 
module 

Once a title block has been added to a floor plan it can be printed using 
AutoCAD Plot functionality. Using this method, floor plans can be printed at 
any status. 

Publish Floor Plans 
from Planner 
module 

The Publish Floor Plans option on the File menu allows users to manually 
publish selected floor plans. Dependent on settings in the Floor Plan 
Publishing configuration dialog box, a title block can be included. 

Batch Publish Floor 
Plans 

Floor plans can be batch published - the normal way of publishing floor plans 
in bulk. The functionality allows a title block to be specified. 

Overview of Creating Title Blocks 
There are two stages to creating title blocks: preparation and configuration. 

Preparation 
There are two actions required for preparation. These are carried out at the 
implementation stage and will generally not be modified afterwards. 

 
 

Action Description 

Read in 
Canonical 
Media 

Canonical media is the AutoCAD term for paper size. These have to be read into 
the database from the network printers before floor plans can be published. 

Create Custom 
SQL 

Custom SQL is a slightly modified form of standard SQL. It can be used to extract 
information from the Macro Space Planning database so that it can be inserted into 
the title block. 

Configuration 
There are a series of steps to be following in order to create a title block and make it 
available for use in published floor plans. 
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Action Description 

Create Title Block in 
Planner 

A Title Block is a special form of AutoCAD drawing. This had to be created 
in the Planner module and written to a specific Windows folder. 

Register Title Block in 
Fixture Studio  

After the Title Block has been created, it must next be registered in Fixture 
Studio. This will make it appear in the list of blocks available for placement. 

Add Title Block 
Information in 
Administration 

Once the title block has been registered in Fixture Studio, some additional 
information needs to be added in the Administration module. This includes 
information such as the size of the viewport - in effect a window cut 
through the title block so that the floor plan can be seen through it. 

Add Title Block to 
floor plans 

After the Title Block has been created in Planner registered in Fixture Studio 
and added to the list of title blocks in Administration, it can then be used in 
floor plans. 

Influence of AutoCAD Settings on Title Block Parameters 
Some AutoCAD parameters influence the configuration of Title Blocks.  An example is 
the AutoCAD options dialog box. 

 

One setting that affects how title blocks function is the option to plot offset from the 
printable area or edge of the paper. This affects the parameters set in the Title Blocks 
dialog box accessed from the Planning Menu in the Administration module.  These 
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AutoCAD settings should be consistent on all machines used to publish floor plans. This 
setting may also affect some AutoCAD functionality. 

Note: See the AutoCAD help files for more information. 

Placing and Updating Title Blocks in Planner 
To place Title Blocks in Planner, select the Add Title Blocks option from the Insert menu. 

 
This will bring up the Title Blocks dialogue box. 

 
The list of available Title Blocks is that specified in the Administration Module.  To place 
a Title Block, highlight it in the list then click OK. 
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Updating Title Block Information 
The text information in the Title block is populated when added. However, if the floor 
plan is subsequently modified, the information may become outdated.  An example 
would be if the number of fixtures and planograms is changed. In  this event the 
information in the title block can be updated by means of the Update Title Block  option 
on the Insert menu. 

Editing the Title Block Attributes 
If i t is needed to manually update the information in the Title Block, the attributes can be 
edited for that instance of the title block by double clicking on the frame of the Title 
Block. This will bring up the AutoCAD Properties dialog box. This can be used to 
modify the values of the attributes for that floor plan. This will not normally be required 
as the information in the title block can be refreshed by means of the Update Title Block 
option on the Insert menu. 
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Modification of Title Blocks 
On occasion Title Blocks can be redesigned in Planner and reregistered in Fixture Studio. 
 Providing the title block has kept the same name, any new instance in a floor plan will 
be automatically be added using the latest version of the Title Block. Any existing 
instances of the older version of the title block should be updated with the Redefine 
blocks from Disc option in the Restructure Drawing dialog box available from the 
Modify > Blocks menu in Planner.  Once the Title Block has been redefined, the 
attributes it contains should be updated by the Update Title Block option on the Insert 
Menu in Planner. 
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Zones in Planner 

Overview of Zones 
Note: The information in this section is for guidance only. It 
should not be taken as a definitive business process. 

 

Configuring Zones 
Zones are configured in the Administration Module - their properties can thus only be 
changed by a user with Administration privileges. 

Placing Zones 
After the floor plan has been created in Store Manager, the next stage is to subdivide the 
available floor area into departments/zones. These zones serve to define a section of 
floor that is used for a specific and clearly defined purpose. Examples would include 
areas for food and drink sales, cafeterias, holding stock or staff only areas. 
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Zones can be added to a floor plan and subsequently edited. If zones contain obstructions 
such as staircases, pillars or lifts, 'holes' can be cut in the zone to allow for these non-
productive areas. 

Clashing Zones 
Because it is important for reporting accuracy to avoid overlapping zones of the same 
type, a Detect Clashes facility is available. This allows overlapping zones to be easily 
identified and corrected. 

Filtering using Zones 
It is possible to configure Macro Space Management so that the zones can be used for 
filtering purposes when selecting from the Object Grid. For example, it is possible to filter 
the list of available products to they are pertinent for the zone the selected fixture is in. 

Reporting using Zones 
Zones can be used as filters for reporting purposes. For example it is possible to return 
performance figures per square foot department by department. 

Zones, Filtering and Reporting 

Technicalities of Allocating Fixtures to Parent Zones 
Zones have several uses for reporting purposes. The exact use depends on what parent 
type the zone has been assigned to in the Administration module. The three zone types 
are: 

 Internal Area  

 Department 

 Other 

Internal Area 
The Internal Area type zone is used to define the maximum area used for retail purposes. 
There should only be one zone of zone type Internal Area per floor. In the example 
below, it defines the maximum area within the store. 
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For accuracy, the internal area zone can be added in a series of stages. This prevents the 
thickness of walls being taken into account. In the example below, an internal area has 
been added for each room in the store, ensuring the total area relates to floor area alone 
and not occupied by the footprint of the walls. 

 
The internal area zone also set bounds for how much area can be assigned to a fixture in 
the Allocated Area calculation. 

Department 
Department type zones are the main zone used for reporting purposes. This is because 
fixtures can be assigned to one (and one only) department type zone. (This information is 
stored in the ZON_ID field of the AVTTB_FIXTURE table). 
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Other 
All zones not of Internal Area type or Department type belong to the Other type. Fixtures 
can be assigned to multiple zones of type Other as well as type Department. (This 
information is stored in the AVTTB_ZONE_FIXTURE_LINK table). 

Example of Reporting using Department and Other Type Zones 
Consider the example below. In the left hand image all the fixtures are within a 
Department type zone. In  the AVTTB_FIXTURE table they will be shown as exclusively 
belonging to that department for reporting purposes. 

 

In the right hand image sub-departments have been assigned within the main 
department. The AVTTB_ZONE_FIXTURE_LINK table will show fixtures as belonging 
to both the parent department and the pertinent sub-department. In the case of fixtures 
crossing the sub-department boundaries, they may be show as belonging to bother 
departments. Filtering and reporting needs to take this into account. 

Note: Information on how fixtures are assigned to tables is 
not normally accessible to ordinary users. The information 
on tables specified above is mainly for the benefit of 
implementers and administrators. 

Filtering 
Because of the way Macro Space Management (MSM) automatically assigns fixtures to 
parent zones, this information can be used for filtering purposes in the Object Grid. For 
example, it is possible to modify the Custom SQL (AVTTB_CUSTOM_SQL table) for the 
Object Grid so that it only displays products and planograms pertinent to the zone the 
selected fixtures are in. This form of filtering can be used to save time and make it faster 
to populate a floor plan with merchandise. 

Reporting 
Zones can be used as filters for reporting purposes. For example, because fixtures are 
associated with zones and products or planograms can then be associated with their 
parent fixtures, i t is possible to report on the performance of the merchandise within a 
specific zone. These reports can then be aggregated as necessary. For example, it would 
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be possible to report in the sub-departments within the Food and Drink department to 
see how sub-segments of this department were performing. It would then be possible to 
aggregate these reports up to see the performance of the entire department. Because 
zones have measurable areas, it is possible to report performance related to area. 

Department or Sub-Department Area Profit Profit/square foot 

Drinks 10,000 ft2 $44,000 $4.40/ft2 

        

Spirits and Liqueurs 1,500 ft2 $10,000 $6.67/ft2 

Wines 2,000 ft2 $12,000 $6.00/ft2 

Beers and Lagers 2,500 ft2 $13,500 $5.40/ft2 

Soft Drinks 4,000 ft2 $8,500 $2.13/ft2 

Zones and the Administration Module 
Options in the Administration Module allow several aspects of Zones to be configured. 

Note: The Administration Module is only available to users 
with Administrators Privileges. 

If you do not have these privileges, you will not be able to access the Administration 
Module. 

 Zone Types can be configured using the Zone Types option. 

 Zone Definitions can be configured using the Zone Definition option. 

 Zone Hatch Styles can be configured using the Hatch Styles option. 

 Zone Annotation can be configured in using the Text Styles option. 

Zone Types 
Zones are assigned to one of three types: Internal Area, Department and Other. These 
types are configured in the Zone Types dialog box. 

 

Zone Definitions 
Zone definitions are the actual zones that are placed. The hierarchy, name, hatch style 
and color, etc, can all be set up in the Zone Definitions dialog box in the Administration 
module. 
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Hatch Styles 
Hatch styles are a method of coloring zones in both the Planner and Merchandiser 
modules. Planner comes with a pre-configured set of hatch styles, but hatch styles need 
to be configured for Merchandiser. This is done in the Hatch Styles dialog box. 

 

Annotation 
The annotation for zones is controlled from the Text Styles dialog box. This allows full 
control over the text description placed, together with its position and size. 
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Zones and In-Store Space Collaboration 
In-Store Space Collaboration (an application that can use and modify data created in 
Macro Space Planning can only work within department type zones within a floor plan. 
If no zones of that type are available, then an error message will result when a user tries 
to open that floor plan. 

 
Accordingly, all floor plans intended for use within In-Store Space Collaboration should 
have a minimum of one department type zone. 

Practical Tips for Drawing Zones 
When drawing zones, some practical tips should be borne in mind. 

Zones and End Caps 
End caps on gondolas present a specific problem as far as zones and reporting are 
concerned. By virtue of their position, many end caps are precisely bisected by a zone 
drawn along the axis of gondola. This 50/50 split can cause problems with reporting as it 
is difficult for the functionality to determine which zone the majority of the fixture is in. 
In the example below, the central gondola is precisely bisected by the boundaries of two 
zones. 
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The solution is to move the position of the boundaries by using AutoCAD vertices. To do 
this, select a boundary line for a zone, right click and select Add Vertex. 

 
With Object Snap (OSNAP) turned on, snap the line to a corner of the end cap. 



 Practical Tips for Drawing Zones 

 Zones in Planner 263 

 
Continue until  both zones have been lead round the sizes of the end caps. In the example 
below, one zone boundary has been selected for clarity. 

 
This will ensure accuracy for any reports based on zones. 
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Zones on the Object Browser 

Overview of Zones on the Object Browser 
The Zones Tab can be used to add and delete zones in the currently active floor plan. It 
can also be used for other operations involving zones including highlighting them in the 
zone hierarchy or floor plan and adding and removing hatching. 

 
 The Zones Toolbar contains a series of icons used to control operations concerning 

zones. 

 The Zones Hierarchy displays the available zones. 

 The Properties Window has information on the zone currently highlighted in the 
hierarchy. 

Using the Object Browser for Zone Operations 

Overview of the Zones Tab 
Macro Space Management uses Zones to assign space to different departments and non-
sales areas.  The zone types available to your business are customized within the 
Administration Module.  Zones can also be used to help user’s select fixtures or 
merchandise. 

The Zones tab is divided into three sections: 
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 The Toolbar – provides controls to add, modify, and delete zones from a store plan. 

 The Zones Window – shows a hierarchy of available zones. 

 The Properties Window – when a Zone is selected from the hierarchy, its properties 
are visible in this window. 

Toolbar 

 
 

Icon Description 

 

Add Zone 

 

Add Hole 

 

Delete all Zones of that type 

 

Delete selected Zone or Hole 

 

Highlight Zone in Floor Plan 

 

Highlight Selected Zone in Tree 

 

Find Zone in Hierarchy 

 

Detect Clashes 

 

Options 

 
Refresh 

 

Add Hatch 

 

Remove Hatch 

The Hierarchy Window 
The hierarchy window displays the zone hierarchy. This hierarchy is defined in the 
Administration module and shows all the zones that can be added to a store plan. 
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The hierarchy can be expanded using the plus control next to each item on the hierarchy. 
It can also collapsed by using the minus control next to each item. The type of zone in the 
hierarchy is indicated by the icon. 

 

Icon Description 

 

Internal Area Zone 

 

Department Zone 

 

Other Zone Type 

The Properties Window 
The Properties window displays information for the zone that has been selected in the 
zone hierarchy. The content of this window is by modifying the Custom SQL in the 
database. This allows an implementer to specify the information that appears in the 
window. 

Note: See the Oracle Retail Macro Space Planning Data Model 
for information on Custom SQL. 

 

The Refresh Option 
The Refresh option in the toolbar refreshes zone information in the Object Browser. 

 
Refresh 

Clicking on the Refresh button in the zones tab will load the latest zone information from 
the database into the zone hierarchy. This is used to update the Object Browser when 
changes have been made to Zone Types and Zone Descriptions in the Administration 
module. 

Creating and Editing Zones 

Adding the Zone 
Zones can be added to the currently active floor plan by highlighting a zone in the zone 
hierarchy in the Object Browser and clicking the Add Zone icon on the toolbar. 
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Add Zone 

Drawing the Zone 

Note: Zones must be a single closed boundary. If the end of 
the line defining the boundary is not correctly attached to 
the start (Closed in AutoCAD terminology), the zone will 
not draw correctly. 

Once Add Zone has been selected from the Object Browser toolbar, the Specify start 
point prompt will appear in the command line. 

 
The zone can be drawn using various methods in AutoCAD. The easiest of these are: 

 Using OSNAPS 

An effective way to draw a zone conforming to the contours of door, walls, stairs, etc, 
is to turn AutoCAD's OSNAP (Object Snap) functionality on and draw the zone 
section by section, snapping to specific points in an architectural plan. The final part 
of the zone (joining the line back to the start point) is best done by typing the 
AutoCAD Close command into the command line. This will cause a line to be drawn 
from the position of the last drawn point to the start of the zone, thus forming the 
closed boundary required for the zone to be drawn directly. 

 Drawing the zone using AutoCAD's coordinate system 

An alternative way of drawing the zone is to draw a line to points defined by 
AutoCAD's coordinate system; either to absolute points (560,480) or to points relative 
to the last point (@560,480). As per the OSNAP method, the final part of the zone 
(joining the line back to the start point) is best done by typing the AutoCAD Close 
command into the command line. 

Adding Holes 

 

 

Add Hole 

To cut the hole, highlight the zone into which the hole is to be cut in the zone hierarchy in 
the Object Browser then click the Cut Hole icon on the Zone toolbar. The hole can then be 
drawn in a similar way to a zone. 

Reason for Holes 
There will be unproductive areas of floor in any floor plan. In the example below, the 
area under the stairs cannot be used. The white rectangle visible under the stairs 
represents a hole cut in the zone. 
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This allows performance metrics to be based on the usable area of the zone, not its total 
area.   

 
In this example, the Gross Area of the zone is 3466 square feet and the net area 2926 
square feet. Assuming the zone has generated $50,000 of sales in a week, using the gross 
area would give sales of $14.4 per square foot and using the net area would give sales of 
$17.1 per square foot. The latter figure is probably more representative of how the zone is 
performing. 

Editing the Zone Boundaries 
The position of a zone boundary can be changed using AutoCAD Grips. To resize a zone, 
click on the boundary to activate the grips. These appear as blue squares or rectangles. 
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The grips can then be used to drag the zone boundary to its new position. 

 
On hitting the Escape Key, the boundary will become permanent in its new position. 
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The zone annotation will update to reflect the new size, but changes in the zone 
boundary position will not be written back to the database. Accordingly, after the zone 
boundaries have been modified, the floor plan must be synchronized Match the 
Drawing.   

A slightly more advanced way of changing the zone boundaries is to activate the 
AutoCAD grips, the hover the mouse pointer over one of them. This will bring up a list 
of additional options. 

 
After using these options, the floor plan must again be synchronized. 

Hatching the Zone 
If zones are not set to hatch automatically on being placed (configuration module), they 
can be hatched (or have the hatching removed) by means of the Add Hatch or Delete 
Hatch icons on the Zones toolbar. 
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Add Hatch 

 

Remove Hatch 

 

The example below show solid, hexagon and zig-zag hatches. 

 
 To hatch a zone, select the zone in the hierarchy and click the Hatch icon. 

  To remove the hatch, select the zone in the hierarchy and click the Delete Hatch icon 

Deleting Zones and Holes 
Deleting holes and zones can be done in one of two separate ways: 

 Deleting all instances of a zone (and its associated holes) in a floor plan  

 Deleting a specific instance of a zone or a hole 

 
 

Icon Description 

 

Delete all Zones of that type 

 

Delete selected boundary 

Deleting all instances of a zone (and its associated holes) in a floor plan 
Deleting all instances of a zone within a floor plan is done by highlighting the 
appropriate zone in the zone hierarchy in the object browser and clicking Delete zone in 
the toolbar. The Delete Zone confirmation will appear. On clicking OK, the zone will be 
deleted. 

 
This option is useful when a zone is drawn in several parts. For example a zone might 
have an aisle for general passage running through it. In this case the zone might be 
drawn in two parts: one either side of the aisle. Deleting all zones of that type ensures 
that both parts of the zone would be deleted. 
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Deleting a specific boundary of a zone or a hole 
Deleting as specific boundary of a zone or hole within a floor plan (or hole within a zone) 
is done by clicking the Delete Selected Zone or Hole icon on the toolbar. A prompt will 
appear in the command line asking the user to select 

 
On left clicking the outline of a zone or hole, it will be deleted from the floor plan without 
the need for further confirmation. 

Zone Highlighting Options 
There are three highlighting options available on the zones toolbar. 

 
 

Icon Description 

 

Highlight Zone in Floor Plan 

 

Highlight Selected Zone in Tree 

 

Find Zone in Hierarchy 

Highlight Zone 
Highlight zone allows a user to find a zone in the floor plan. The option has to be turned 
on by toggling the icon on the Zones toolbar so it is depressed. After the icon has been 
toggled on, highlighting any zone in the zone hierarchy will cause the selected zone to be 
highlighted in the floor plan. The highlighting method will depend on setting in the 
Zones tab of the Configuration module. 

Note: It is recommended that the Highlight zone option be 
left off until needed - leaving it on may have a marginal 
impact on performance in the floor plan. 

Highlight Selected Item in Tree 
Highlight Selected Item in Tree allows a user to select a zone in the floor plan and have it 
highlighted in the Zone Hierarchy in the Object browser. The option has to be turned on 
by toggling the icon on the Zones toolbar so it is depressed. Clicking on the boundary of 
the zone in the floor plan will then cause that zone to be highlighted in the hierarchy. 

Note: It is recommended that the Highlight zone option be 
left off until needed - leaving it on may have a marginal 
impact on performance in the floor plan. 

Find in Hierarchy 
Clicking the Find Zone In Hierarchy option brings up the Find Zone dialog box. 
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To use this dialog box: 

1. Type an item of text into the text box. 

2. Click the Find icon. This will bring up a list of zones matching that text. 

3. Highlight a zone and click OK. This will highlight the zone in the zone hierarchy. 

Find In Tree 
Find in Tree allows users to search for Zone Names in the Zone Hierarchy. 

 
 

 

Find Zone in 
Hierarchy 

Clicking the icon will bring up the Find Zone dialogue box. 

 
To use the dialog box: 

1. Type part of all of a zone name into the Find text box. 

2. Click the Find icon. A list of all zones matching the search string will appear. 

3. Highlight the required zone in the list and click OK. 

4. The required zone will be highlighted in the hierarchy. 
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Detect Clashes 
Clashes occur when the boundaries of two zones of the same type (which must be on the 
same AutoCAD layer) overlap. This could mean inaccurate reporting. If the Detect 
Clashes option in the zones tab of the Configuration module has not been selected, the 
Detect Clashes option on the Zones toolbar can be used to manually check for clashes. 

 
 

 

Detect Clashes 

 
If clashes exist, the offending zones will be highlighted. 

 
In the above example highlighting has been set to the thicken option - the two 
overlapping zones have greatly thickened boundaries. 

Configuring Zone Behavior 
The way zones behave can be configured in the Configuration module. To access the 
Zones tab, click Options  on the Zones toolbar. 

 
 

 

Options 

 

This will bring up the Zones tab of the Configuration module. 



Configuring Zone Behavior 

276 Oracle Retail Macro Space Management 

 

The general options are as follows: 

 Auto Close will cause the zone boundary to close (became a continuous boundary) 
when drawing it if you left click with the mouse within the Proximity distance of the 
start point of the zone. 

 Hatch determines if the zones should hatch when drawn. 

 Hatch over Text specifies whether the hatch should overlap the text or not. 

 Detect Clashes will cause any zones of the same zone type to flash if the boundaries 
overlap when being drawn. This is important for reporting accuracy. 

 Prompt for Name will allow the user to enter a custom name for the zone when 
placing it. 

The highlight options are as follows: 

 Thicken Boundary will cause the zone boundary to thicken when the Highlight Zone 
option is chosen on the zone toolbar. 

 Flash will cause the zone boundary to flash when the Highlight Zone option is 
chosen on the zone toolbar. 

 Zoom will cause the zone boundary to increase in size when the Highlight Zone 
option is chosen on the zone toolbar. 
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Fixturing on the Object Browser 

Overview of Fixturing on the Object Browser 
Clicking on the Fixturing Tab on the Object Browser brings up a series of options for 
adding, editing and deleting Fixtures and Gondolas. 

 

 The Toolbar gives access to a series of options concerning fixtures. 

 The Buttons allow the user to toggle between Fixtures (Blocks) and Gondolas. 

 The Hierarchy Window allows users to select fixtures (or gondolas) from the list 
available. 

 The Properties Window shows the properties assigned to the selected fixture. 

Using the Object Browser for Fixturing Operations 

Overview of the Fixturing Tab 
The Fixturing tab allows users to add fixtures, fittings, gondolas and other equipment to 
the store plan. It is divided in to five parts as follows: 

 The toolbar – provides controls that allow users to add, edit, and delete fixtures and 
gondolas 

 The Fixtures window – shows a hierarchy of available blocks and gondolas 

 The Properties window – after selecting a block from the hierarchy, this window 
shows the details for the selected block.  The content of this window is customizable.  
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A fourth option - the Fixtures Summary Window – shows details of the zones based on 
the currently active floor plan. This is now called from the View menu but can be docked 
in the Object Browser if required. 

The Fixturing Tab Toolbar in the Object Browser enables the user to control all aspects of 
adding, editing and deleting fixtures and gondolas within the Planner and Merchandiser 
environments. 

Clicking on the Switch Buttons will determine whether the Fixturing or Gondola options 
are active. 

Fixturing Toolbar 

 
 

Icon Option Description 

 

Add Fixture Add a fixture to a floor plan. This will cause the Add Fixture dialog 
box to appear. 

 

Delete Fixture Delete the fixtures that are currently in a selection set in the floor 
plan. 

 

Highlight 
Fixture in Floor 
Plan 

If selected, selecting a fixture in the Object Browser Fixture 
Hierarchy will cause the pertinent fixture to be highlighted in the 
floor plan. The exact nature of the highlighting will depend on 
selections made in the Fixturing Tab of the Configuration Module. 

 

Highlight 
selected item in 
tree 

If selected, selecting a fixture in the floor plan will cause the 
pertinent fixture to be highlighted in the Object Browser Fixture 
Hierarchy. 

 

Find This option brings up the Find dialog box, allowing users to search 
for objects in the Fixture Hierarchy.  

 

Options This option brings up the Fixturing Tab of the Configuration 
module, allowing users to customize their settings. 

 

Refresh This option refreshes the Object Browser with the latest information 
on fixtures and gondolas in the database. 

 

Show Attributes This option shows the fixture attributes for any selected fixtures. 
Fixture attributes are customizable items of information assigned to 
specific fixtures. 

 

Promotional 
Fixtures 

This option allows the user to assign or remove the Promotional 
Attribute and to highlight fixtures with the promotional attribute.  

Gondola Toolbar 
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Icon Option Description 

 

Add Fixture Adds the highlighted gondola to the currently active floor plan. 

 

Delete Fixture This option is grayed out and unavailable on the Gondola toolbar. 

 

Highlight Fixture 
in Floor Plan 

This option is grayed out and unavailable on the Gondola toolbar. 

 

Highlight 
selected item in 
tree 

This option is grayed out and unavailable on the Gondola toolbar. 

 

Find This option is grayed out and unavailable on the Gondola toolbar. 

 

Options This option is grayed out and unavailable on the Gondola toolbar. 

 

Refresh This option refreshes the Object Browser with the latest 
information on fixtures and gondolas in the database. 

 

Show Attributes This option shows the fixture attributes for any selected fixtures. 
Fixture attributes are customizable items of information assigned to 
specific fixtures. 

 

Promotional 
Fixtures 

This option allows the user to assign or remove the Promotional 
Attribute and to highlight fixtures with the promotional attribute. 
This option has no effect in the merchandiser module. 

The Hierarchy Window 
The Hierarchy window displays the gondola hierarchy.  To toggle between the 
hierarchies use the Blocks or Gondolas buttons respectively. The hierarchies are defined 
in the Fixture Studio environment and show all the fixtures and gondolas that can be 
added to a store plan. The hierarchy can be expanded using the plus control next to each 
item on the hierarchy. It can also collapsed by using the minus control next to each item. 
An item in the hierarchy can be highlighted by clicking on the name of the gondola. 

 
The icons preceding the fixture name identify the type of equipment - equipment of 
similar types will have the same icon. 

The Properties Window 
The Properties window will be blank while Gondolas are selected on the Fixturing tab 
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Adding Fixtures 
To add a block to the store plan, highlight the required block in the hierarchy. Then 
either click Add Fixture on the tool bar, or drag and drop the fixture to the store plan 
drawing. When a block is added the Insert fixture dialog opens. 

 
These controls allow blocks to be positioned accurately in the store plan. Pressing the left 
mouse button places the block in an initial position. Pressing the right mouse button or 
the <Esc> key finishes placing the block. 

Note: for more information on these options, see the section 
on the Add Fixture dialog box. 

Refreshing the Object Browser 
The Refresh option refreshes both Fixtures and Gondola information in the respective 
hierarchical trees. 

 

Refresh This option refreshes the Object Browser with the latest 
information on fixtures and gondolas in the database. 

Clicking on the Refresh button in the Fixturing tab will load the latest fixture information 
from the database into the Fixture hierarchy. At the same time, it will load the latest 
gondola information from the database into the Gondola Hierarchy. Dragging and 
dropping a fixture from the appropriate hierarchy after the refresh button has been 
pressed will add that fixture to the drawing using the latest definition from Fixture 
Studio. Similarly, using the Add button will also add a fixture to the drawing using the 
latest definition from Fixture Studio. If a drawing is already open then fixtures already 
placed in the drawing will not use any changes loaded during the refresh operation until 
the drawing is closed and reopened. However, new fixtures added to the open drawing 
will use the new data. 

Deleting Fixtures 
Deleting Fixtures is done from the Object Browser. 

Note: Fixtures can also be deleted using AutoCAD tools. 

Sequence of Actions Required 
There are two potential ways of deleting fixtures. The first is to select the required fixture 
first. 

1. Select required fixture or fixtures and right click to confirm selection. 

2. Click the Delete icon. 

3. The selected fixtures will be deleted. 

The alternative is to select the delete option first. 

1. Click the Delete icon 

2. Select required fixture or fixtures. 

3. Right click to confirm selection and the fixtures will be deleted. 
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Either way is valid. This example will use the latter option of selecting the delete option 
first and the fixtures last. 

Deleting Fixtures 
Deleting products can be carried out as follows: 

 
1. Select the Fixtures Button on the Merchandising tab of the Object Browser 

2. Select the Delete option from the Toolbar 

3. Selecting Fixtures 

On clicking Delete Fixture, the command line in Planner will prompt users to select 
fixtures. 

 
These can be selected by standard AutoCAD methods including left clicking individual 
fixtures or using window and crossing selection boxes. In this instance, four fixtures have 
been selected be left clicking, the information being reflected in the command line. 

 

Note: Clicking on the products themselves will not be 
effective - deleting products requires the user to select the 
parent fixtures for the products. Accordingly, users should 
left click on the fixture itself or use window and crossing 
selection boxes that encompass both the product and its 
parent fixture. 

On right clicking to complete the selection, the fixtures will be deleted. 
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Fixture Highlighting Options 
There are two highlighting options available on the Fixturing toolbar. 

 Highlight Fixture 

 Highlight Selected Fixture in Tree 

 
 

 

Highlight 
Fixture in 
Floor Plan 

If selected, selecting a fixture in the  Object Browser Fixture Hierarchy 
will cause the pertinent fixture to be highlighted in the floor plan. The 
exact nature of the highlighting will depend on selections made in the 
Fixturing Tab of the Configuration Module. 

 

Highlight 
selected item 
in tree 

If selected, selecting a fixture in the floor plan will cause the pertinent 
fixture to be highlighted in the Object Browser Fixture Hierarchy. 

Highlight Fixture 
Highlight zone allows a user to find a fixture in the floor plan. The option has to be 
turned on by toggling the icon on the Fixturing toolbar so it is depressed. After the icon 
has been toggled on, highlighting any fixture in the fixture hierarchy will cause the 
selected fixture to be highlighted in the floor plan. The highlighting method will depend 
on setting in the Fixturing tab of the Configuration module. 

Note: It is recommended that the Highlight Fixture option be 
left off until needed - leaving it on may have a marginal 
impact on performance in the floor plan. 

Highlight Selected Item in Tree 
Highlight Selected Item in Tree allows a user to select a fixture in the floor plan and have 
it highlighted in the Fixture Hierarchy in the Object browser. The option has to be turned 
on by toggling the icon on the Fixturing toolbar so it is depressed. Clicking on the 
boundary of the fixture in the floor plan will then cause that fixture to be highlighted in 
the hierarchy. 

Note: It is recommended that the Highlight Fixture in Tree 
option be left off until needed - leaving it on may have a 
marginal impact on performance in the floor plan. 

Finding Fixtures in the Hierarchy 
Find in Tree allows users to search for fixtures in the Fixture Hierarchy. 
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Find This option brings up the Find dialog box, allowing users to 
search for objects in the Fixture Hierarchy.  

 

Clicking the icon will bring up the Find Block dialogue box. 

 
To use the dialogue box: 

1. Type a text string into the text box 

2. Click on the search Icon 

3. Any fixtures with  a name matching the search string will be listed 

4. To select a fixture in the hierarchy, highlight it and click the OK button 

Fixture Attributes 
Fixture Attributes can be assigned by selecting a fixture or fixtures and clicking on the 
Fixture Attribute icon in the toolbar. 

 
 

 

Show 
Attributes 

This option shows the fixture attributes for any selected fixtures. 
Fixture attributes are customizable items of information assigned 
to specific fixtures. 

 

This will bring up the Fixture attributes dialogue box. If multiple fixtures are selected, 
only fields with common data will display information. The list of Fixture Attributes that 
are displayed is configured in Fixture Studio and can customized to suit an individual 
retailer's requirements. 
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Fixture attributes can have many uses. In  the above screen shot, the fixture attributes are 
configured to check on in-store compliance. Macro Space Management's sister product in 
the Macro Space Planning suite (In-Store Space Collaboration) can be used on the floor of 
a store enabling a user to walk around and physically examine the fixtures. Fixtures that 
have problems relative to the current version of the floor plan can have the check boxes 
ticked. 

The same data is visible in Macro Space Management (MSM) and In-Store Space 
Collaboration (ISSC). After a store survey using ISSC, MSM users can run a KPI to 
determine which fixtures have attributes assigned. This enables the floor plan to be 
updated by taking into account what is physically present in a store. 

Promotional Fixtures 
Certain fixtures with a store are known to generate high levels of profits. Examples 
include end caps on gondolas and displays by the checkout designed to increase impulse 
buying. Macro Space Planning allows specific fixtures in a floor plan to be designated as 
Promotional Fixtures. These fixtures can them be readily identified. They can then be 
used for special offers, promotions or the introduction of new products, etc. 

Some retail chains also have a specific team responsible for merchandising promotional 
fixtures - designating the fixtures as such assists in identifying which fixtures that team is 
responsible for the merchandise on. 

Assigning Promotional Fixtures 
Once fixtures have been placed in a floor plan, they can be designated as promotional 
fixtures by using the Promotional Fixtures option from the Blocks toolbar of the 
Fixturing tab of the Object Browser. 
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Promotional 
Fixtures 

This option allows the user to assign or remove the 
Promotional Attribute and to highlight fixtures with the 
promotional attribute.  

Identifying Promotional Fixtures 
Once promotional fixtures are assigned, they can be identified in two ways in a floor 
plan. 

Highlight 
The Promotional Fixtures option includes a highlight option in the drop down list of 
options. This will cause any fixtures that have been designated as Promotional fixtures to 
be highlighted in the floor plan. The exact highlighting method will depend on the 
options selected in the Merchandising Tab of the configuration module. 

Key Performance Indicator 
 Another way of identifying promotional fixtures is with  KPI's. Without the KPI selected, 
the Promotional Fixtures are difficult to identify. With the KPI active, the promotional 
fixtures are readily apparent. In this case the end caps have been designated as 
promotional fixtures. 

 

Note: one of the easiest ways of seeing fixture KPI's is to use 
the Conceptual Visual Style option from the View >  Visual 
Styles menu. This causes the entire fixture to color, not just 
the outlines. 
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Using Promotional Fixtures 
There are a number of ways of using promotional fixtures. One possible method is: 

1. Identify fixtures that have a high visibility to shopper traffic. Such fixtures 
include end caps on gondolas, display on checkout, power wings and bins in the 
centre of aisles. 

2. Use the Promotional Fixture on the Object Browser to designate those fixtures as 
promotional fixtures. 

3. Bay number these fixtures differently from other fixtures in the floor plan - possibly 
with a P suffix. 

4. It is then possible to report on and merchandise those fixtures separately to the other 
fixtures in the store - for example it would be possible to produce a weekly store plan 
showing promotional fixtures only that would allow a constantly changing program 
of special offers. 
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The Insert Fixture Dialog Box 

Overview of Insert Fixture Dialogue Box 

Options in the Insert Fixture Dialog Box 
The Insert/Edit Fixture dialogue box appears when the Add Fixture icon is clicked on the 
Fixtures toolbar. 

 

Note: The availability of some of these options depends on 
settings within the Fixturing tab of the Configuration 
Module. For example the arraying option will not be 
available if the Auto Reinsert option is checked. 

This dialogue box contains a series of options for manipulating the fixture during 
placement. 

Icon Description 

 

Move Fixture 

 

Attach Fixture to Another 

 

Move and Align Fixture  

 

Move Fixture to be between others 

 

Place Fixture on Top of Another 

 

Offset the Fixture 

 

Place Fixture In-Line with Another 

 

Change Justification 

 

Rotate the Fixture 

 

Rotate the UCS 
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Icon Description 

 

Create an Array of Fixtures 

 

Change the Size of the Fixture 

 

Add the same fixtures as the last added 

 

Undo the last change 

 

Modify the Options for this Fixture  

The Insert Fixture dialog box is used by toggling on the required option. Click on each 
button to activate the required option. When that operation is completed, select the next 
option if one is required. When the fixture placement options is satisfactory; complete 
insertion by clicking on the cross in the upper right corner of the Insert/Edit Fixture 
dialogue box, or press <Escape>. 

Configuring Operation of the Insert Fixture Dialog Box 
The exact way the Insert Fixture dialog box behaves is configured in the Fixturing Tab of 
the Configuration module. This can be accessed by clicking the Properties icon in the 
Fixturing toolbar on the Object Browser. 
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Placement Options 
Placement Options determine which button in the Insert Fixture dialog box is active 
when it is first activated. There are three options in the drop down list: 

 Auto Move makes the move button active. 

 Auto Attach makes the Attach button active. 

 Auto Align makes the Align button active. 

Other Options 
Other options can be selected by means of the check boxes. 

 Auto Rotate requires the user to specify a rotation angle when the fixture is first 
inserted. 

 Auto Reinsert allows the user to add additional copies of the fixture by left clicking 
in the floor plan. 

 Explode Composites causes all blocks specified as composites in Fixture Studio to be 
exploded into their component blocks when inserted into the floor plan. (This feature 
is not currently active) 

 Display UCS Icon controls display of the UCS icon in the floor plan. (This feature is 
not currently active). 

 Prompt for Sizes will cause a dialog box to appear when a stretchable block is placed 
in the floor plan. This allows the user to select the specific size for the block. 

Recommended Options 
New users may find the following settings easiest to use when first using the Insert 
Fixture dialog box. 

 Placement option set to Auto Move. 

 Auto Rotate and Auto Reinsert set to off. 
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 Explode Composites, Display UCS Icon and Prompt for Sizes set to on. 

Move Fixture option 

 
This option will be active when the Insert Fixture dialog box first opens if the Auto Move 
option has been chosen in the Fixturing tab of the configuration module. 

If toggled on, the fixture being currently inserted will place in the floor plan where the 
cursor is left clicked. Clicking in the floor plan will also turn the move option off in the 
dialog box. If it is desired to move the fixture again, the Move button should be toggled 
on, whereupon the fixture can be moved and repositioned by right clicking in the floor 
plan again. 

If, there are no further operations to carry out, placement is completed by clicking on the 
x in the upper right part of the Insert/Edit Fixtures dialogue box, or pressing <Escape>. 

Attach Fixture to Another option 

 
This option will be active when the Insert Fixture dialog box first opens if the Auto 
Attach option has been chosen in the Fixturing tab of the configuration module. 

Auto Attach allows two fixtures to be snapped together in a precise alignment by means 
of connection points. Connection points are assigned to fixtures in the Connections Tab 
in the Block Details dialog box in Fixture Studio - see the Fixture Studio help file for more 
information. The behavior of the connection points is controlled by settings in the 
Fixturing tab of the Configuration module. This can be accessed by clicking the 
Properties icon in the Fixturing toolbar on the Object Browser. 
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The behavior of the connection points is provided by the three filtering options provided. 

 If the Gender filter is on, male will only connect to female or neutral gender. Male 
(for example) cannot connect to male. 

 If the Size filter is on, only connection points of similar or overlapping sizes will 
connect together. (This feature is currently not active). 

 If the Shape filter is on, only connection points of similar shapes will connect 
together. 

The appearance of the connection points ids governed by further options. 

 The Pointer Size allows the display size of the connection points to be adjusted. 

 Line Size affects the size of connection lines. This feature is only active in the 
Merchandise module. 

 The colors affect the visual appearance of the connection point. 

Using the Attach Fixture Option 
In order to use the Attach Fixture option, there must already be at least one fixture with 
compatible connection points present in the floor plan. The default connection point will 
be active on the fixture being placed: 

 
When the active fixture come within a set proximity of any other fixture with compatible 
connection points, the two fixtures will snap together in an alignment determined by the 
position of the connection points. 
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If, there are no further operations to carry out, placement is completed by clicking on the 
x in the upper right part of the Insert/Edit Fixtures dialogue box, or pressing <Escape>. 

Move and Align Fixture option 
Note: Move and Align can be used in conjunction with the 
Offset the Fixture option. See the section on this option for 
more information. 

 
This option will be active when the Insert Fixture dialog box first opens if the Auto Align 
option has been chosen in the Fixturing tab of the configuration module. 

This allows the fixture to be aligned with lines in the floor plan. An example of its use 
would be to align a fixture with a line representing a wall. In the example below, the 
fixture being placed in the floor plan is first brought into proximity with the line 
representing the wall. (In this instance the wall is in an associated architectural plan). 

 
When the fixture reaches a sufficiently close proximity to a suitable line, it will 
automatically align to that line. 

 
If there are no further operations to carry out, placement is completed by clicking on the 
x in the upper right part of the Insert/Edit Fixtures dialogue box, or pressing <Escape>. 
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Move Fixture to Between Others option 

 
This option can only be selected after the fixture has been placed in the floor plan by 
another command from the Insert Fixture dialog box. It is used to place the fixture 
midway between two selected points. 

Note: This command works well in conjunction with the 
AutoCAD Object Snap (OSNAP) option. 

In this instance it is desired to place a fixture midway between the two existing fixtures 
in the floor plan. 

 
After selecting the Move Fixtures Between Others option in the dialog box, it is then 
necessary to click once in the floor plan to return focus to the floor plan. A prompt will 
appear in the command line asking the user to select the starting point of the line from 
which the midpoint will be selected. 

 
Clicking on this icon will bring up a dialogue at the cursor asking for the start position of 
the line on which the fixture will be placed at the midpoint. In this instance the insertion 
point of the first fixture has been selected by left clicking it. 

 
Another prompt will appear in the command line asking the user to select the end point 
of the line from which the midpoint will be selected. 
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The insertion point of the second fixture is selected by left clicking it. 

 
The insertion point of the fixture being placed will then be positioned exactly midway 
between the two selected points. 

 
If there are no further operations to carry out, placement is completed by clicking on the 
x in the upper right part of the Insert/Edit Fixtures dialogue box, or pressing <Escape>. 

Place Fixture on Top of Another option 

 
This option can only be selected after the fixture has been placed in the floor plan by 
another command from the Insert Fixture dialog box. It is used to place the active fixture 
on top of a selected object. In the example below, it is intended to place the condiment 
cabinet on top of the freezer. 
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After selecting the Place Fixture on Top of Another option, left click in the floor plan to 
transfer the focus to the floor plan. A prompt will appear in the command line 

 
On left clicking an object to select it, the insertion point of the object being placed on top 
will be placed in the centre of the selected object. 

 

Note: In cases like the above example, further operations 
may be necessary to complete positioning the fixture. 

Offset the Fixture option 

 
The Offset the Fixture option is used in conjunction with the Move and Align function. 
Move and Align will align the fixture being placed in the floor plan with a physical 
fixture such wall. Additional use of the Offset the Fixture allows the user to align at a 
specific distance from the selected object. The initial stage is to place the fixture in the 
floor plan with a left click to temporarily position it. Clicking the Offset the Fixture icon 
will bring up the Offset dialog box. 
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This allows the required offset to be entered - all offsets being relative to the front. In the 
above example an offset of 36" in the Y axis will place the fixture 36" away from the wall 
that will be selected using the Move and Align  option. Click OK and then select Move 
and Align. 

 
When the mouse cursor is close to a wall or other line, it will align relative to that wall at 
the specified offset. Left click to place the fixture. 

 
If there are no further operations to carry out, placement is completed by clicking on the 
x in the upper right part of the Insert/Edit Fixtures dialogue box, or pressing <Escape>. 

In-Line the Fixture option 

 
The In-Line the Fixture option allows users to align the fixture currently being placed 
with another fixture already in the floor plan. Clicking in In-Line the Fixture icon brings 
up the In-Line dialogue box. 
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The functionality is used as follows: in the example below, it is desired to align the blue 
fixture (in the process of being placed) with the already placed red fixture. Accordingly, 
one of the alignment buttons in clicked in the In-Line dialog box. 

 
This will result in a prompt to select a fixture. 

 
Click in the floor plan to change focus there and then click on the outline of the required 
fixture. The fixtures will be moved so they are in the desire alignment. 

 
Control will also be returned to the In-Line dialog box. Click the OK button to confirm 
the placement and return to the Insert Fixture dialog box. 

If there are no further operations to carry out, placement is completed by clicking on the 
x in the upper right part of the Insert/Edit Fixtures dialogue box, or pressing <Escape>. 

Change Justification option 

 
Clicking on the Change Justification icon brings up the Justification dialogue box. 
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This dialog box allows the datum used for inserting the fixture to be temporarily 
modified. In diagram 1 below, a fixture with a 'back-left' insertion point has been inserted 
using the centre of the red cross as a datum. In diagram 2, the justification has been 
changed to 'centre' and the centre of the fixture has moved over the datum point. 
Similarly, in diagram 3, the justification has been changed to front right and the location 
of the fixture has changed again. 

 

The Undo button will not be active until at least one change in justification has been 
made. Clicking undo will then return the fixture to its previous justification. Clicking OK 
will confirm the placement of the fixture and return the user to the Insert Fixture dialog 
box. 

Rotate the Fixture option 

 
The rotate fixture option allows a fixture to be rotated during placement. Clicking the 
rotate icon brings up the Rotate Block dialogue box. 
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Relative and Absolute Angles 
The Relative Angle is the angle the fixture will be rotated through each time the apply 
button is clicked. The Absolute Angle is the angle relative to the WCS that the fixture 
will be rotated to. Altering one of the values causes the result of the change to be 
reflected in the second value. 

 Relative Angle  

 If the relative angle is set, the value for the absolute angle is the angle of the fixture 
relative to the WCS after the rotation has been executed by clicking the Apply button. 

 
 In the above example a 30 degree relative rotation will be applied. After the rotation 

the UCS will be at a 60 degree angle to the WCS. 

 Absolute Angle  

 If the absolute angle is set, the relative angle is the angle the fixture will be rotated 
through to get to the specified absolute angle relative to the WCS. 

 
 In the above example, the UCS is to be set to an absolute angle of 270 degrees relative 

to the WCS. This will require a relative rotation of 240 degrees from its present 
position. 

Align with Object 
The usual use of the Align with Object option is to align with an object such as a wall in 
an architectural plan. In order to do so:    

1. Click the Align with Object Button. 

2. Click once in the floor plan to change the focus to the floor plan. 

3. Click on an object to set the alignment for the fixture. 

4. The fixture will rotate with the front face parallel to the selected object. 
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In the above example, the wall in the architectural plan has been used for alignment 
purposes, causing the fixture to rotate accordingly. 

Measure 

Clicking the Measure button allows the user to manually draw a line defining the 
rotation angle for the block. The initial point of the line has its origin at the insertion 
point of the block. The user sets the other end by left clicking at another point in the floor 
plan. 

 
If there are no further operations to carry out, placement is completed by clicking on the 
x in the upper right part of the Insert/Edit Fixtures dialogue box, or pressing <Escape>. 

Rotate the UCS option 

 
This option allows users to rotate the UCS (Universal Coordinate System). Planner has a 
World Coordinate System (WCS) that has a fixed set of orientations. Using the UCS 
allows the user to set a custom set of XY coordinate specific to the fixture placement. An 
example would be aligning relative to a wall. 

 Clicking the Rotate the UCS icon brings up the Rotate UCS dialog box. 
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Relative and Absolute Angles 
The Relative Angle is the angle the UCS will be rotated through each time the apply 
button is clicked. The Absolute Angle is the angle relative to the WCS that the UCS will 
be rotated to. Altering one of the values causes the result of the change to be reflected in 
the second value. 

 Relative Angle  

– If the relative angle is set, the value for the absolute angle is the angle relative to 
the WCS after the rotation has been executed by clicking the Apply button. 

 
– In the above example a 45 degree relative rotation will be applied. After the 

rotation the UCS will be at a 135 degree angle to the WCS. 

 Absolute Angle  

– If the absolute angle is set, the relative angle is the angle the present UCS will be 
rotated through to get to the specified absolute angle relative to the WCS. 

 
– In the above example, the UCS is to be set to an absolute angle of 45 degrees 

relative to the WCS. This will require a relative rotation of 80 degrees from its 
present position. 

Align with Object 
The usual use of the Align with Object option is to align with an object such as a wall in 
an architectural plan. In order to do so:    

1. Click the Align with Object Button. 

2. Click once on the floor plan to change the focus to the floor plan. 

3. Click on an object to set the alignment for the UCS. 
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4. The UCS will be set with the X axis perpendicular to the selected object and the Y 
axis parallel to it. 

 
In the above example, the wall in the architectural plan has been used for alignment 
purposes, causing the UCS (lower left) to rotate accordingly. 

Measure 
Clicking the Measure button allows the user to manually draw a line defining the X axis 
of the revised UCS. The initial point of the line has its origin at 0, 0 in the floor plan. The 
user sets the other end by left clicking at another point in the floor plan. 

 

Create an Array of Fixtures option 

 
The Create an Array of fixtures option allows users to insert a single fixture into the floor 
plan then create a regular array of that fixture. In  the example below the original 
checkout (in blue) has been arrayed to form a line of checkouts. 

 
In the second example, a single 4-Way clothing fixture (red) has been inserted into the 
floor plan and then arrayed to lay out part of a clothing department. 
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To create an array, first place a single fixture into the floor plan. On clicking the Create an 
Array of Fixtures option, the Array dialog box will appear. 

 

Options 

Columns and Rows 
Row and columns refers to the number or rows and columns of fixtures that will be 
present after the array has been created. 

 

Apply Button 
The apply button will result in the current settings in the Array dialog box being applied 
to create a temporary array in the floor plan. Changing the setting in the Array dialog 
box and clicking apply again will result in the displayed array being changed to match 
the new settings. 



Create an Array of Fixtures option 

304 Oracle Retail Macro Space Management 

Undo Button 
The Undo button will not be active until at least one trial version of an array has been 
placed in a floor plan. Clicking undo will take the use back to the previous version of the 
placed array. Clicking the Undo button will not change the settings in the Array dialog 
box. 

OK Button 
The apply button places a temporary version of the array in the floor plan. The OK 
button will make that array permanent and return the user to the Add Fixtures dialog 
box. 

Spacing, Number and Distance 
Spacing, number and distance are inter-related. The radio button selects the field that is 
the result of multiplying the other two fields together. 

 
 Spacing is the distance between successive insertion points. If the fixture is 24 inches 

long and the spacing is 60 inches, the insertion points will be 60 inches apart with a 
36 inch gap between fixtures. 

 Number is the number of fixtures in that direction. 

 Distance is the total distance the insertion points will occupy - this value does not 
take into account the dimensions of the fixture. Four fixtures with a spacing of 60 
inches will therefore occupy a distance of 180 inches. 

 

Rotation Angle 
The rotation angle allows the array to be drawn at a specified angle. 
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Measure 
Measure allows the user to select an area to draw the array in. The fixtures will be spaced 
according to the current settings in the array dialog box. On clicking the Measure button, 
the user will be taken to the floor plan. The user can then draw a rectangle from the 
fixture that is the origin or the array. Fixture outlines will automatically populate the 
rectangle. On left clicking to specify the final dimensions of the rectangle, the user will be 
taken back to the Insert Fixture dialog box. Simultaneously, the distance values in the 
dialog box will be updated. The user should then click the Apply or OK buttons to draw 
the array. 

 
If there are no further operations to carry out, placement is completed by clicking on the 
x in the upper right part of the Insert/Edit Fixtures dialogue box, or pressing <Escape>. 

Change the Size of the Fixture option 

 
This button will allow the fixture to change in size during insertion. This will only work 
for specific fixtures - those that have a size assigned in the Sizes tab of the Block Details 
dialog box in Fixture Studio. Such blocks are called stretchable. 
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If the block being inserted is stretchable and the Change the Size of the Fixture option is 
active, the Size dialog box will appear. This allows the use to set the size of the 
stretchable fixture to any value within the parameters configured in Fixture Studio. 

 
On clicking OK, the user will be returned to the floor plan with the Insert Fixture dialog 
box active. If there are no further operations to carry out, placement is completed by 
clicking on the x in the upper right part of the Insert/Edit Fixtures dialogue box, or 
pressing <Escape>. 

Insert a Copy of the Current Fixture 

 
This option allows the user to insert another instance of the last block to be inserted by 
simply clicking on the icon. This removes the need to re-select the fixture from the Object 
Browser. On clicking the Insert a Copy of the Current Fixture icon, another instance of 
the fixture will appear in the floor plan and the button selected will default to that 
selected in the Placement options of the Fixturing tab of the Configuration module. 

If there are no further operations to carry out, placement is completed by clicking on the 
x in the upper right part of the Insert/Edit Fixtures dialogue box, or pressing <Escape>. 

Undo the Last Change option 

 
The Undo the Last Change option undoes the effect of the last action carried out in the 
Insert Fixture dialog box. It will not be active until the first action has been completed. 
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Modify the Options for this Fixture 

 
Selecting this option brings up the Fixturing Tab from the Configuration Module. 

 
This allows users to configure some options determining how the Insert Fixtures dialog 
functionality will behave while the dialog box is active. Once changes have been made to 
the tab, it can be closed and another option selected on the Add Fixture dialog box. 
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Fixture Swap and Manipulation 

Overview of Fixture Manipulation 
The Planner module is integrated with AutoCAD. Experienced AutoCAD users can make 
use of the majority of AutoCAD functionality to lay out floor plans in the Planner 
module. However, AutoCAD is a complex program and some users carrying out store 
planning tasks may not be familiar with AutoCAD functionality. Accordingly, Planner 
has been provided with some Fixture Manipulation tools. These enable users to perform 
a variety of operations including moving, rotating and aligning fixtures. One way of 
accessing these is from the Fixturing toolbar. 

 

Fixture Manipulation and Child Objects 
One of the advantages of using the Fixture Manipulation tools is that they control child 
objects. The Planner floor plan is divided into layers, each containing a particular type of 
object - such as fixtures or products. The display or selection of objects is often controlled 
by turning off or locking layers. If purely AutoCAD tools are used, objects on the turned 
off or locked layers are not included in the selection. This can result in some objects being 
moved, while their child objects are left in their original location. Another problem that 
can occur when using AutoCAD selection tools is that it is possible to select objects that it 
is not intended to move. For example the selection set could include blocks representing 
pillars or columns in a store. Fixture Manipulation filters the selected objects so that only 
fixtures and merchandise are moved, together with their associated annotation and bay 
numbers. 

The available Fixture Manipulation options are: 

Group On or Group Off for Fixtures 
Gondolas are items of equipment placed in a precise relationship to each other. When 
manipulating gondolas it is sometimes useful to manipulate then as a whole and it is 
sometimes useful to manipulate individual parts of a gondolas. If Fixture Grouping is 
On, selecting one part of a gondola will select all parts of that gondola. If Fixture 
Grouping is Off, individual parts of a gondola can be selected without selecting the 
whole. 

Move Fixtures 
Move fixtures enables the user to move the selected items of equipment (together with 
any merchandise and annotation) any direction in the X and Y axes. The elevation of the 
equipment remains unchanged. 

Slide Fixtures 
Slide fixtures enables the user to move the selected items of equipment (together with 
any merchandise and annotation) at 90 degree increments to the present orientation and 
position of the fixture. This enables the user to move the selected fixtures left, right, 
forward or back. The elevation of the equipment remains unchanged. 
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Offset Fixtures 
Align fixtures enables the user to take a selected set of equipment (and its merchandise 
and annotation) and align it relative to another object in the floor plan. It is also spaced a 
selected distance (offset) from that object. This might be used to take a gondola and place 
it a specific distance from a wall. 

Match Rotation 
Match Rotation enables the user to take a selected set of equipment (and its merchandise 
and annotation) and align it relative to another object in the floor plan. 

Cut 
Cut removes the selected equipment (and its merchandise and annotation) from the floor 
plan and pastes them to the clipboard. If a planogram has been 'exploded' (shows full 
detail of shelves and merchandise), this detail will also be pasted to the clipboard. 

Copy 
Copy takes details of the selected equipment (and its merchandise and annotation) from 
the floor plan and pastes the information into the clipboard. If a planogram has been 
'exploded' (shows full detail of shelves and merchandise), this detail will also be pasted 
to the clipboard. 

Paste 
Paste takes the information from the clipboard and inserts it into the floor plan. If a 
planogram has been 'exploded' (shows full detail of shelves and merchandise), this detail 
will also be pasted to the floor plan. 

Delete 
Delete removes the selected equipment (and its merchandise and annotation) from the 
floor plan. 

Rotate 
Rotate takes the selected equipment (and its merchandise and annotation) and allows it 
to be rotated by any angle about the geometric center of the selected objects. 

Rotate 90 Degrees Clockwise 
Rotate 90 Degrees Clockwise takes the selected equipment (and its merchandise and 
annotation) and gives it a clockwise 90 degree rotation about the geometric center of the 
selected objects. 

Rotate 90 Degrees Anti-clockwise 
Rotate 90 Degrees Anti-clockwise takes the selected equipment (and its merchandise and 
annotation) and gives it an anti-clockwise 90 degree rotation about the geometric center 
of the selected objects. 

Rotate 180 Degrees 
Rotate 180 Degrees takes the selected equipment (and its merchandise and annotation) 
and gives it a 180 degree rotation about the geometric center of the selected objects. 

Mirror 
Mirror produced a mirror image of a selected set of equipment, merchandise and 
annotation. The selected objects are 'reflected' about a specified axis. 
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Array 
Array takes a selected set of equipment, merchandise and annotation and generates 
additional rows and columns of that set of objects. 

Overview of Fixture Swap 
The Fixture Swap functionality allows users to automatically swap selected fixtures in 
the active floor plan for replacements of a different type. Fixture Swap can be called from 
the Command Line (AVT_FIXTURESWAP) or from the Fixturing toolbar. 

 
The process works as follows: 

 

1. The Fixtures it is desired to swap in the floor plan are selected. 

2. The Fixture swap dialog box is selected and will populate with the selected fixtures. 

3. A fixture is selected to be swapped out. 

4. The fixture to be swapped in (replacement fixture) is selected. 

5. The two fixtures (in and out) are defined as a swap pair. 

6. The user continues to define swap pairs as required. 

7. When all swap pairs have been defined, the fixtures are swapped. 

Note: it is possible to reverse the first two steps - i.e. open the 
dialog box first, then select the required fixtures. 

Examples of Fixture Swaps 
One example of Fixture Swap is shown below, where it has been decided to replace two 
racking fixtures with slatwalls - allowing planograms involving hung products to be 
placed in the future. 

 
Fixture swap also changes the size of planogram placeholders if they are on the fixtures 
being swapped. In the example below, the original planograms are shown on the rear 
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gondola run. Two fixtures have been resized - and the planogram placeholders have 
changed size accordingly. This can be seen in the front gondola run. 

 

Accessing Fixture Swap and Manipulation Options 

Fixture Swap 
Fixture Swap can be initiated in the following ways: 

 From the command line by typing AVT_FIXTURESWAP and pressing Return. 

 From the Fixturing Toolbar. 

 

Fixture Manipulation 
Fixture Manipulation can be accessed in the following ways: 

From the command line by typing in individual commands and pressing Return 

Option Command 

Group On/Off None 

Move Fixtures AVT_MOVE 

Slide Fixtures AVT_SLIDE 

Offset Fixtures AVT_OFFSET 

Match Rotation AVT_MATCH_ROTATION 

Cut Fixtures AVT_CUT 

Copy Fixtures AVT_COPY 

Paste Fixtures AVT_PASTE 

Rotate Fixtures AVT_ROTATE 
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Option Command 

Rotate Fixtures 90 Degrees Clockwise AVT_ROTATE_90 

Rotate Fixtures 90 Degrees Anticlockwise AVT_ROTATE_270 

Rotate Fixtures 180 Degrees AVT_ROTATE_180 

Mirror Fixtures AVT_MIRROR 

Array Fixtures AVT_ARRAY 

As a keyboard shortcut 

Option Shortcut 

Group On/Off Ctrl + Alt + G 

Move Fixtures Ctrl + Alt + M 

Slide Fixtures Ctrl + Alt + E 

Offset Fixtures Ctrl + Alt + O 

Match Rotation Ctrl + Alt + L 

Cut Fixtures Ctrl + Alt + X 

Copy Fixtures Ctrl + Alt + C 

Paste Fixtures Ctrl + Alt + V 

Delete Fixtures Ctrl + Alt + D 

Rotate Fixtures Ctrl + Alt + R 

Rotate Fixtures 90 Degrees Clockwise Ctrl + Alt + Right Cursor Arrow 

Rotate Fixtures 90 Degrees Anticlockwise Ctrl + Alt + Left Cursor Arrow 

Rotate Fixtures 180 Degrees Ctrl + Alt + Down Cursor Arrow 

Mirror Fixtures Ctrl + Alt + I 

Array Fixtures Ctrl + Alt + A 

From the Fixturing toolbar 

 
 

Option Icon 

Group On/Off 
 

Move Fixtures 
 

Slide Fixtures 
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Option Icon 

Offset Fixtures 

 

Match Rotation 

 

Cut Fixtures 
 

Copy Fixtures 
 

Paste Fixtures 
 

Delete Fixtures 
 

Rotate Fixtures 
 

Rotate Fixtures 90 Degrees Clockwise 

 

Rotate Fixtures 90 Degrees Anticlockwise 
 

Rotate Fixtures 180 Degrees 
 

Mirror Fixtures 
 

Array Fixtures 
 

 

From the right click menu accessed in the floor plan 
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Note: these commands should not be confused with the pure 
AutoCAD commands available from (for example) the 
Modify menu. 
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Turning Grouping On or Off 
Grouping affects how objects are selected for Fixture Manipulation or Fixture Swap. 
Grouping is Toggled on or Off using the icon on the Fixturing toolbar. 

 

Grouping On 
If Grouping is turned on, selecting a single item of equipment in a gondola selects all 
items of equipment in that gondola. 

Grouping Off 
If Grouping is turned off, i tems of equipment within a gondola must be individually 
selected; either by clicking on them, or by using Windows or Crossing selection boxes. 

In the example below, one fixture in the upper double sided gondola has been clicked 
while grouping was turned on - resulting in all fixtures and fittings in the gondola being 
selected. Grouping was then turned off, and a single fixture clicked in the bottom double 
sided gondola. Because grouping was turned off, only a single fixture was selected. 
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Toggling Grouping On or Off has a significant effect on what is selected. 

Factors Affecting Fixture Swap and Manipulation 

Technicalities of Fixture Swap and Manipulation 

Synchronization 
Synchronization is used to ensure that the information in the database matches that held 
in the Planner floor plan. There are three forms of synchronization. 

 Auto-Synchronization which can be used to ensure a floor plan is correctly 
synchronized when it is opened. 

 Dynamic Synchronization which can be used to automatically write changes made 
by some AutoCAD commands immediately back to the database. 

 Manual Synchronization which allows the user to select objects to synchronize and 
where the data is to be written. 

Note: More information on these options can be found in the 
section on Synchronization. 

Prior to carry out any fixture swap or manipulation operations, it is suggested the user 
ensure that synchronization is up to date. 

Selection Sequence 
There are generally two ways a command can be executed: 

1. Select the objects first then issue the command. 

2. Issue the command and then select the objects. 

The examples given in this section are all based on selecting the objects first, then issuing 
the command. Issuing the command first, then selecting the objects is an equally valid 
way of working. 

In this case the command is invoked from the Fixturing toolbar. In the example below, 
the Move command has been selected. 
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A prompt then appears in the command line. This identifies the command that has been 
invoked and prompts the user to select the objects the command is to be applied to. 

 
Once the objects have been selected, the rest of the command is executed in a similar 
manner to when the objects were selected first and then the command invoked. 

Object Height 
The position of an object can be described relative to the origin of the floor plan by three 
coordinates: 

 
The origin of the floor plan is by convention always (0, 0, 0). 

1. The X axis is the distance along (to the left or right) of the origin. 

2. The Y axis is back of or in front of the origin. 

3. The Z axis is the height above or below the origin. 

 So, if an object is 20 feet to the left of the origin, 10 feet back from it and 3 ft above it, it 
would have Cartesian coordinates (expressed in feet) of   

(20, 10, 3). 

Note: Cartesian coordinates are often expressed in inches or 
millimeters. If expressed in inches, the example above would 
be (240, 120,  36). 

All the Fixture Manipulation and Fixture Swap operations will affect the distance along 
from and back from the origin (X and Y coordinates). They will not affect the height (Z 
coordinate). 

Fixture Manipulation and XData 
Fixture Manipulation relies on the block (fixture) having been registered in a specific 
manner in Fixture Studio. When saving a block, there is an option to Write Block Files. 
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Note: Users require the appropriate permissions to access 
Fixture Studio. 

This writes additional information into the block in the form of Extended Object Data 
(XData). XData is then referenced by the software when the fixture is manipulated by a 
user in the floor plan. If this data is absent - for example because the fixture is a raw 
AutoCAD block - then the fixture manipulation functionality will not be effective for that 
fixture. 

Note: XData is embedded into the fixture in a way that is not 
accessible to users. If the fixture manipulation commands 
are failing for some blocks, it is recommended that the block 
be saved again from fixture studio ensuring that the Write 
Block Files option is used. See the Fixture Studio User Guide 
for more information on how to create fixtures. 

Selection Methods 
Before carrying out Fixture Manipulation or Fixture Swap operations, users must be able 
to select objects in the floor plan. Selected objects have a dotted outline and the insertion 
point shows as a small blue square. 
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Individual Selection 
Individual objects can be selected by left clicking a line belonging to that object. 
Additional objects can be added to the selection set by continuing to left click lines in 
other items in the drawing. When all objects have been selected, the selection is 
completed by right clicking in the floor plan with the mouse. 

Window Selection Box 
One way of selecting multiple fixtures is to use a window selection box. To do this click 
on a point in the floor plan, hold down the left mouse button and move the cursor to the 
right of the first point. A blue box will result. All objects completely enclosed by the box 
will be selected. 

 
In the above example, fixtures F-11 and F-12 will be selected because they are completely 
enclosed, but fixtures like F-27 that are not completely enclosed will not be selected. 

Multiple windows selection boxes may be used to select objects. The selection is 
completed by right clicking in the floor plan with the mouse. 
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Crossing Selection Box 
One way of selecting multiple fixtures is to use a window selection box. To do this click 
on a point in the floor plan, hold down the left mouse button and move the cursor to the 
left of the first point. A green box will result. All objects fully or partially enclosed by the 
box will be selected. 

 
In the above example, fixtures F-10, F11, F-12, F-13, F-25, F-26, F27, and F-28 will be 
selected because they are fully or partially enclosed. 

Multiple crossing selection boxes may be used to select objects. The selection is 
completed by right clicking in the floor plan with the mouse. 

De-Selecting Fixtures 
Any existing selection set can be de-selected by hitting the escape key. 

AutoCAD's Object Snap Functionality 
AutoCAD has Object Snap functionality. This can be toggled on or off by clicking the 
button on the AutoCAD status bar. 

 
Right clicking the Object Snap icon and selecting Settings  enables the settings to be 
defined. Check boxes can be ticked to specify points that the cursor can snap to when 
carrying out fixture manipulation options. 
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When carrying out a Fixture Manipulation command (for example Move), the user will 
be prompted to pick a base point in the selected objects. 

 
If Object Snap is on, the cursor will snap to any points that have been specified in the 
Settings dialog box. In  the example below an Endpoint has been selected by clicking it. 

 
Once the first Object Snap point has been selected, the user will be invited to select a 
point to move to. 
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The user can then select another Object Snap point. In the example below, the corner of 
the wall in the architectural plan has been selected. 

 
On clicking the second Object Snap point the selected objects will be moved to that point. 
In the example below, the fixtures have been moved precisely into the corner of the wall. 

 

Note: for more information on using Object Snap or 3D 
Object Snap see the AutoCAD help material. 

Fixture Swap and Custom SQL 
The information in the Fixture Swap dialog box is controlled by via the Administration 
Module. For example, columns can be added or removed. 
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Modifying the list of information in the Fixture Swap dialog box is carried out in the 
Custom Query dialog box in the Administration module. This is accessed from the 
General menu. 
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Fixture Manipulation 

Move Commands 

Move Fixtures 
Move Fixtures allows the user to move the selected set of equipment, merchandise and 
annotation from one point to another in the floor plan. 

 
The command is invoked from the Move option on the Fixturing toolbar. 

 
In the example below, the double sided gondolas are to be moved relative to the single 
sided gondolas along the wall. 
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The initial stage is to select the gondolas to be moved. The outlines of the fixtures will 
turn dotted and the insertion points will show as blue boxes. (If using individual fixture 
selection, the selection set must be completed by clicking the right mouse button.  If 
using Windows or crossing selection boxes, continue selecting until all required objects 
are in the selection set). 

Note: Selection behavior will also be affected by whether 
Grouping is On or Off. 

 

The user can then click the Move icon on the Fixturing toolbar. The Insertion points will 
disappear, but the fixtures will still remain as dotted outlines. 
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At the same time, the user will be prompted (via the command line) to select a base point 
for the move. 

 
If Object Snap is turned on in the Status Bar, the user can 'snap' the cursor to a convenient 
point on one of the selected fixtures. 

 
The cursor will then snap to a selected point on the fixture. 
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The fixtures can then be moved via the cursor to the point they are required in the floor 
plan. The fixtures will appear as a 'ghost' outline until  finally placed. 

 

On left clicking at the selected point in the drawing, the fixtures will be moved to that 
point. 



 Fixture Manipulation 

 Fixture Swap and Manipulation 329 

 

Slide Fixtures 
Slide Fixtures allows the user to move the selected set of equipment, merchandise and 
annotation from one point to another in the floor plan. 

 
The command is invoked from the Slide option on the Fixturing toolbar. 
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The Slide option is a more restricted form of the Move command. Fixtures can only be 
moved at 0, 90, 180 or 270 degrees relative to the selected fixtures. If it is desired to move 
the fixtures a precise distance in the specified direction, this distance can be entered into 
the AutoCAD command line. In the example below, the double sided gondolas are to be 
'slid' relative to the single sided gondolas along the wall. 

 
The initial stage is to select the gondolas to be moved. The outlines of the fixtures will 
turn dotted and the insertion points will show as blue boxes. (If using individual fixture 
selection, the selection set must be completed by clicking the right mouse button.  If 
using Windows or crossing selection boxes, continue selecting until all required objects 
are in the selection set). 

Note: Selection behavior will also be affected by whether 
Grouping is On or Off. 
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The user can then click the Slide icon on the Fixturing toolbar. The selected fixtures can 
be 'slid' along the permitted axes until they are in the correct position. The fixtures will 
appear as a 'ghost' outline until  finally placed. 
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On left clicking at the required point, the fixtures will be repositioned. 
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Offset Fixtures 
Offset Fixtures allows the user to align the selected set of equipment, merchandise and 
annotation a set distance from a line (for example a wall) in the floor plan. 
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In the above diagram, the left hand example shows the effect of selecting a wall to offset 
from and setting an offset of 0: the selected objects will align directly along the wall. The 
right hand sample shows the effect of a positive offset: the selected objects have aligned a 
specific distance from the wall. In the diagram below, the double gondola is to be moved 
parallel to and 8 feet from the single gondola along the wall. 

 

The command is invoked from the Offset option on the Fixturing toolbar. 
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The initial stage is to select the gondolas to be moved. The outlines of the fixtures will 
turn dotted and the insertion points will show as blue boxes. (If using individual fixture 
selection, the selection set must be completed by clicking the right mouse button.  If 
using Windows or crossing selection boxes, continue selecting until all required objects 
are in the selection set). 

Note: Selection behavior will also be affected by whether 
Grouping is On or Off. 

 

The user can then click the Offset icon on the Fixturing toolbar. The user will then be 
prompted to set the Offset distance - the distance the gondola will be from the selected 
wall, etc. 

 
Alternatively, click two successive points in the floor plan. After clicking the first point, 
the user will be invited to click a second: 

 
This method can be used to measure an existing distance between two objects in the floor 
plan (for example a gap between two other gondolas) and use it for the offset. The user 
will then be invited to select a source edge. This is the edge of the gondola that will be 
moved relative to another object. 
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The user will then be invited to select an angle along the source edge. This is done by 
clicking another point on the face of the gondola. 

 

 

The user will then be invited to select an edge of the object to be aligned with. 
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In the example below, the user has selected the front edge of the single gondola along the 
wall. 

 
The user will then be invited to select an angle along the reference edge. 

 
This is done by clicking on another point on the front edge of the single gondola along 
the wall. 
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The user will be invited to select the side of the reference line the double gondola is to be 
offset to. 

 
This is done by clicking on the side of the single gondola we wish the double gondola to 
be offset to. 

 

As soon as this point is clicked, the selected equipment, merchandise and annotation will 
rotate until they are aligned with the selected edge. 
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If Grouping is On, how the offset fixtures line up to their datum fixtures depends on the 
fixture clicked on to select the fixtures to offset and the fixture selected to specify the 
fixtures to offset to. When the fixtures to be offset move, the insertion points of the two 
selected fixtures will align. In the example below, the top left fixture of the double 
gondola was clicked when selecting the objects to offset, and the top fixture was selected 
in the gondola to offset to (left hand diagram). The result is shown in the right hand 
diagram. 
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In the example below, the bottom left fixture of the double gondola was clicked when 
selecting the objects to offset, and the bottom fixture was selected in the gondola to offset 
to (left hand diagram). The result is shown in the right hand diagram. 
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Match Rotation 
Match Rotation  allows the user to align the selected set of equipment, merchandise and 
annotation with a line (for example a wall) in the floor plan. 

Note: If it desired to align the selected equipment, 
merchandise and annotation against a wall, etc., use the 
Offset command with an Offset of 0. 

In the example below, the single sided gondola is to be aligned with the wall behind it. 
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The command is invoked from the Match Rotation option on the Fixturing toolbar. 

 
The initial stage is to select the gondolas to be moved. The outlines of the fixtures will 
turn dotted and the insertion points will show as blue boxes. (If using individual fixture 
selection, the selection set must be completed by clicking the right mouse button.  If 
using Windows or crossing selection boxes, continue selecting until all required objects 
are in the selection set). 

Note: Selection behavior will also be affected by whether 
Fixture Grouping is On or Off. 
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The user can then click the Match Rotation icon on the Fixturing toolbar. The user will 
then be invited to select a source edge. This is the edge of the gondola that will be rotated 
relative to another object. 

 
This is done by clicking a point on the required edge of the gondola. 

Note: It is not possible to select an edge by clicking an 
insertion point. You must click on an edge of a fixture. 
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The user will then be invited to select an angle along the source edge. This is done by 
clicking another point on the face of the gondola. 

 

 
The user will then be invited to select an edge of the object to be aligned with. 
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In the example below, the user has clicked on the face of the wall the gondola run is to be 
aligned to.   

 

The user will then be prompted to select the direction for the edge. 

 
This is done by clicking on another point on the face of the wall. 
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As soon as the second point is clicked, the selected equipment, merchandise and 
annotation will rotate until they are aligned with the selected edge. 

 

If Grouping is On and the required fixtures are selected by clicking on an individual 
fixture, the insertion point of that fixture will serve as the point around which the fixtures 
will rotate. In the example below, if the top fixture (colored red in this example) is 
selected, the gondola will rotate about its insertion point. If the bottom fixture (colored 
blue in this example) is selected, the gondola will rotate about that insertion point. 
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Cut, Copy and Paste Commands 

Cut, Copy and Paste Commands 
The Cut, Copy and Paste commands take a selected set of equipment, merchandise, 
annotation and bay numbers and move them to or from the clipboard. The Delete 
command removes the selected set of equipment, merchandise, annotation and bay 
numbers from the floor plan. The commands are invoked from the Fixturing toolbar. 

 

Cut or Copy Commands 
The Cut Command removes the selected equipment, merchandise, annotation and bay 
numbers from the floor plan and places the information into the clipboard. Any previous 
information in the clipboard is overwritten. 

The Copy Command takes a copy of the selected equipment, merchandise, annotation 
and bay numbers from the floor plan and places the information into the clipboard. Any 
previous information in the clipboard is overwritten. 
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In the example below, the two double sided gondolas are to be either cut or copied from 
the floor plan and placed on the clipboard. 

 
The initial stage is to select the required fixtures. The outlines of the fixtures will turn 
dotted and the insertion points will show as blue boxes. (If using individual fixture 
selection, the selection set must be completed by clicking the right mouse button.  If 
using Windows or crossing selection boxes, continue selecting until all required objects 
are in the selection set). 

Note: Selection behavior will also be affected by whether 
Grouping is On or Off. 

 
If the Cut command is clicked on the fixturing toolbar, the selected equipment, 
merchandise, annotation and bay numbers will be removed from the floor plan and 
placed into the clipboard. Any previous information in the clipboard is overwritten. 
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If the Copy command is clicked on the fixturing toolbar, the command Line will 
prompted the use to specify a base point. 

 
 

 
 

If Object Snap is turned on in the Status Bar, the user can 'snap' the cursor to a convenient 
point on one of the selected fixtures. 

 

 
After clicking on the selected point, a copy of the selected equipment, merchandise, 
annotation and bay numbering will be taken from the floor plan and placed into the 
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clipboard. Any previous information in the clipboard is overwritten. In addition, the 
equipment, merchandise and annotation remains in the floor plan and remains selected. 

 

Paste 

Paste takes the information from the clip board and inserts it into the floor plan. The 
Paste command is invoked from the Fixturing toolbar. 

 
After clicking the Paste button, the equipment, merchandise, annotation and bay 
numbering will be taken from the clip board and placed in the floor plan relative to the 
mouse cursor. 
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Copying Between Floor Plans 
The Copy function also allows users to take information from one floor plan and transfer 
it to another floor plan. This is done as follows: 

1. Open or make active the floor plan it is desired to take the information from. 

2. Select the required equipment and merchandise 

3. Use the Cut or Copy commands to place a copy of the information in the clipboard. 
This information will include annotation, bay numbering, etc. 

4. Open or make active the floor plan it is desired to transfer the information into 

5. Use the paste command to add the information into the floor plan. 

The information will automatically be synchronized with the information in the database. 

Delete Command 
The Delete command can be used to delete fixtures, together with their associated 
shelves, merchandise, annotation and bay numbers. This is because the display or 
selection of objects is often controlled by turning off or locking layers. If purely 
AutoCAD tools are used, objects on the turned off or locked layers are not included in 
the selection. This can result in some objects being moved, while their child objects are 
left in their original location. 

The Delete function is found on the fixturing toolbar. 

 
In order to delete fixtures and their associated child objects: 

1. Select the required fixtures in the floor plan 

2. Click the Delete command on the Fixturing toolbar or on the Toolbar of the Fixturing 
Tab of the Object Browser 

3. The fixtures and their child objects will then be deleted. 
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Rotate Commands 

Rotate Fixtures 
Rotate Fixtures takes a selected set of equipment, merchandise and annotation and 
rotates them about the center of the selected objects. 

 
The command is invoked from the Rotate option on the Fixturing toolbar. 

 
In the example below, the double sided gondolas are to be rotated to through 80 degrees 
relative to the single sided gondola along the wall. 

 
The initial stage is to select the gondolas to be rotated. The outlines of the fixtures will 
turn dotted and the insertion points will show as blue boxes. (If using individual fixture 
selection, the selection set must be completed by clicking the right mouse button.  If 
using Windows or crossing selection boxes, continue selecting until all required objects 
are in the selection set). 
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Note: Selection behavior will also be affected by whether 
Grouping is On or Off. 

 
Once the fixtures have been selected and the Rotate button has been clicked on the 
Fixture Manipulation toolbar, they can be rotated around the center of the selected 
objects by means of the mouse cursor. The new position of the fixtures will be shown as a 
'ghost' outline. If this method of rotating the fixtures is being used, the fixtures will be 
drawn in their final position after a left mouse click in the floor plan. 

 
Alternatively, a precise rotation angle can be entered into the Command line.  If this 
method of rotating the fixtures is being used, the fixtures will be drawn in their final 
position when Return is pressed. 

 
The fixtures have been rotated as required. Other options (such as the Move or Slide 
commands can then be used to further adjust their position). 
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Rotate Fixtures 90 Degrees Clockwise 
Rotate Fixtures 90 Degrees Clockwise takes a selected set of equipment, merchandise 
and annotation and rotates them 90 degrees clockwise about the center of the selected 
objects. 

 
The command is invoked from the Rotate 90 degrees Clockwise option on the Fixturing 
toolbar. 

 
In the example below, the double sided gondolas are to be rotated 90 degrees clockwise. 
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The initial stage is to select the gondolas to be rotated. The outlines of the fixtures will 
turn dotted and the insertion points will show as blue boxes. (If using individual fixture 
selection, the selection set must be completed by clicking the right mouse button.  If 
using Windows or Crossing selection boxes, continue selecting until all required objects 
are in the selection set). The fixtures will be rotated about the center of the selected 
objects. 

Note: Selection behavior will also be affected by whether 
Grouping is On or Off. 

 
Once the fixtures have been selected, the Rotate 90 Degrees Clockwise button is clicked 
on the Fixture Manipulation toolbar. The fixtures will then be drawn in their final 
position in the floor plan. 
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Rotate Fixtures 90 Degrees Anticlockwise 
Rotate Fixtures 90 Degrees Anticlockwise takes a selected set of equipment, 
merchandise and annotation and rotates them 90 degrees anticlockwise about the center 
of the selected objects. 

 
The command is invoked from the Rotate 90 degrees anticlockwise option on the 
Fixturing toolbar. 

 
In the example below, the double sided gondolas are to be rotated 90 degrees clockwise. 
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The initial stage is to select the gondolas to be rotated. The outlines of the fixtures will 
turn dotted and the insertion points will show as blue boxes. (If using individual fixture 
selection, the selection set must be completed by clicking the right mouse button.  If 
using Windows or crossing selection boxes, continue selecting until all required objects 
are in the selection set). The fixtures will be rotated about the center of the selected 
objects. 

Note: Selection behavior will also be affected by whether 
Grouping is On or Off. 

 
Once the fixtures have been selected, the Rotate 90 Degrees Anticlockwise button is 
clicked on the Fixture Manipulation toolbar. The fixtures will then be drawn in their final 
position in the floor plan. 
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Rotate Fixtures 180 Degrees 
Rotate Fixtures 180 Degrees takes a selected set of equipment, merchandise and 
annotation and rotates them 180 degrees about the center of the selected objects. 

 
The command is invoked from the Rotate 180 degrees option on the Fixturing toolbar. 

 
In the example below, the double sided gondolas are to be rotated 180 degrees. 
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The initial stage is to select the gondolas to be rotated. The outlines of the fixtures will 
turn dotted and the insertion points will show as blue boxes. (If using individual fixture 
selection, the selection set must be completed by clicking the right mouse button.  If 
using Windows or crossing selection boxes, continue selecting until all required objects 
are in the selection set). The fixtures will be rotated about the center of the selected 
objects. 

Note: Selection behavior will also be affected by whether 
Grouping is On or Off. 

 
Once the fixtures have been selected, the Rotate 180 Degrees button is clicked on the 
Fixture Manipulation toolbar. The fixtures will then be drawn in their final position in 
the floor plan. 
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Other Commands 

Mirror Fixtures 
Mirror Fixtures enables users to produce a mirror image of the selected fixtures. 

In the example below, the merchandiser has decided to swap the equipment and 
merchandise to opposite sides of the aisle. The left hand side of the diagram below shows 
the aisle before mirroring and the axis about which the aisle will be mirrored. The right 
hand side of the diagram shows the aisle after mirroring. 

 

In the example below, the merchandiser has decided to swap the equipment and 
merchandise about the center of the aisle. The left hand side of the diagram below shows 
the aisle before mirroring and the axis about which the aisle will be mirrored. The right 
hand side of the diagram shows the aisle after mirroring. 
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The command is invoked from the Mirror option on the Fixturing toolbar. 

 
In the example below, the equipment and merchandise in the two double gondolas is to 
be mirrored about the specified axis. 

 
The initial stage is to select the objects to be mirrored. The outlines of the fixtures will 
turn dotted and the insertion points will show as blue boxes. (If using individual fixture 
selection, the selection set must be completed by clicking the right mouse button. If using 
Windows or Crossing selection boxes, continue selecting until all required objects are in 
the selection set). The fixtures will be mirrored about the center of the selected objects. 

Note: Selection behavior will also be affected by whether 
Grouping is On or Off. 
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Note: Care must be taken to select only the fixtures and 
merchandise it is intended to mirror. 

Click the Mirror command on the fixturing toolbar. The cursor will be returned to the 
floor plan and (if not already on) the AutoCAD Ortho command will be turned on. This 
restricts the permissible angle the fixtures can be mirrored through to 0, 90, 180 and 270 
degrees. Moving the cursor about will select the varying possible angles. At the same 
time a 'ghost' image will show where the fixtures are to be mirrored to. 

 
On left clicking in the floor plan, the selected objects will be mirrored. 
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Note: if i t is desired to mirror at any other angle than 0, 90, 
180 and 270 degrees, it is possible to manually turn off the 
AutoCAD Ortho command during the mirroring operation. 
The blocks can then be mirrored about any specified angle. 

Fix Mirrored Blocks 

Because the blocks have been mirrored, they are a precisely inverted reflection of the 
original block. This includes the insertion points. The Mirror command automatically 
calls the Fixed Mirrored Blocks command and (provided the block is symmetrical) the 
insertion points are adjusted to the correct position. 

Non-Symmetrical Objects 
The functionality is unable to fully mirror non symmetrical objects. An example would 
be the checkouts seen in the bottom of this diagram. The Mirroring axis is shown in the 
left hand part of this diagram. When the double sided gondolas and checkouts are 
mirrored, the double sided gondolas become a mirror image of each other. However, 
because the checkout are not symmetrical, they are 'reflected' to the new position, but the 
block itself remains 'un-reflected'. 
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Array Fixtures 
Array takes a selected set of equipment, merchandise and annotation and generates 
additional rows and columns of that set of objects. In the diagram below, the original red 
fixture has been used as the basis for an array of three rows and two columns of similar 
fixtures. 

 
The command is invoked from the array option on the Fixturing toolbar. 

 
Arraying can be used to speed up laying out the arrangement of equipment in a store. In 
the example below, the original checkout (shown in red for clarity), has been extended 
into a row of checkouts by means of the array command. 
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Similarly, in the example below, the original gondola (shown in red for clarity), has been 
copied twice by means of the array command. 

 
To use the array command, consider the following example: 
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Having laid out some initial checkouts and gondolas, it has been decided to put down an 
array of bins for special offers. The initial bin (shown in red for clarity) has already been 
placed. The array command can then be used to space additional bins. The steps are as 
follows: 

1. Establish the dimensions of the bin. In this example it is 36 inches square. 

2. Establish the X and Y dimensions for the array. In this case it has been decided to 
leave a 5 ft gap between adjacent bins in the X axis, and to align the bins with the 
ends of the gondolas in the Y axis. The gondola runs are 12 ft between centers. 

3. Select the bin and then click the Array command on the fixturing toolbar. This will 
cause the Array dialog box to appear. 

 
4. The number of columns is set to 3 (to match the number of gondolas) and the row 

offset is set to 144 (to match the centers of the gondola runs). 
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5. The number of rows is set to 2. As we want to leave 5 ft (60 inches) between the bins, 
the column offset is set to 96 (36 inches for the bin, plus 60 inches for the gap between 
them. 

6. Clicking the Preview button will show a preview of the arrayed fixtures. Pressing 
Escape will return the user to the Array dialog box. Pressing Return will place the 
arrayed fixtures in the floor plan. 

 

Fixture Swap 

The Fixture Swap Dialog Box 
The Fixture Swap dialog box is made up of a number of parts. 
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Options 

Toolbar 
The toolbar allows users to mirror (copy) and delete filter settings. It also allows users to 
delete defined swaps and to copy information to the clipboard. 

Filter Options 

Each column in the Selected Fixtures and Replacement Fixture sections of the dialog box 
can be filtered to refine the list of available data. 

Fixtures to Swap 

The Selected Fixtures/Fittings section contains a list of all equipment that was selected in 
the floor plan when the Fixture Swap dialog box was activated. 

Fixtures Available to Swap 

The Replacement Fixtures/Fittings section contains a list of all equipment that could be 
used to replace the equipment in the floor plan. 

Defined Swaps 

This section of the dialog box contains a list of all the fixture swaps that have been 
defined. 

Action Buttons 

The action buttons allow the user to execute the currently defined swaps, execute the 
currently defined swaps and exit, and cancel the currently defined swaps and exit. 



 Fixture Swap 

 Fixture Swap and Manipulation 369 

Status Bar 

The status bar gives information in the number of objects found in the drawing, and the 
number selected. 

The Fixture Swap Filters 
Filters are available to reduce the number of fixtures displayed for selection in the 
Selected Fixtures/Fittings and Replacement/Fixtures/Fittings frames of the Fixture 
Swap dialog box. They can be activated by clicking on the arrow head by each column of 
data. 

 
This will bring up a drop down menu with a number of options. 
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 Selecting Show All will remove the filters and show all rows of data. 

 Selecting Custom Filter will bring up a custom filter allowing Boolean operations on 
the data (see below). 

 Selecting Blanks will reduce the data to those rows that have blank values in that 
column. 

 Selecting Non-Blanks will reduce the data to those rows that have a value in that 
column. 

In addition, the lower part of the drop down menu contains a list of the individual items 
of data in that column. Clicking an item reduces the rows to that item of data. 

Custom Filters 
The custom filter option is invoked from the filter drop down menu. 

 
It enables users to use Boolean logic. In the above example (with numerical data 
selected), the lengths will be filtered to find all fixtures with lengths between 36 and 48 
inches. (This filtering logic also applied to Date values). 
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Condition Description 

Equals Values must be exact: for example select all rows with a value of 48 

Does Not Equal Values will exclude that value: for example select all rows that do not have a 
value of 48. 

Greater Than Selects all values above a specific value: for example Greater Than 48 will 
return 49, 50, 51, etc. 

Less Than Selects all values below a specific value: for example Less Than 36 will return 
35, 34, 33, etc. 

Greater Than or 
Equal 

Selects all values equal to or above a specific value: for example Greater Than 
or Equal to 48 will return 48, 49, 50, etc. 

Less Than or 
Equal 

Selects all values equal to or below a specific value: for example Less Than or 
Equal to 36 will return 36, 37, 38, etc. 

If a text value is selected, a different set of Boolean logic applies 

Condition Description 

Equals Values must be exact: will return rows that are an exact match for the entered 
text. 

Does Not 
Equal 

Values will exclude that value: will return rows that do not match the text 
string 

Contains Will return rows where part of the data matches the text string. (Uses implied 
wild cards). 

Does Not 
Contain 

Will return rows where no part of the data matches the text string. (Uses 
implied wild cards). 

Begins With Will return rows where the text string is an exact match for the start of the data. 

Does Not Begin 
With 

Will return rows where the text string is an exact match for the end of the data. 

Ends With Will return rows there the text string is not an exact match for the start of the 
data. 

Does Not End 
With 

Will return rows there the text string is not an exact match for the end of the 
data. 

 

Boolean logic also includes the use of And or Or. 

 And means that both conditions must be met. A and B means the data returned must 
contain both A and B. 

 Or means either condition can be met. A or B means the data returned can contain 
either A or B. It does not need to contain both. 
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Mirroring and Clearing Filters 

 
1. Mirroring Filters 

The Selected Fixtures/Fittings and Replacement Fixtures/fittings frames contain 
identical columns. If a  filter is set in (for example) the Fixture Length column in the 
Selected Fixtures/Fittings frame, clicking Mirror Filter will also set that fil ter in the 
Replacement Fixtures/fittings frame. (The reverse case also applies). 

2. Clearing Filters 

Clicking the Clear Filters icon will clear all the filters set in the Fixture Swap dialog 
box. 

Other Data Manipulation Options 
There are two other ways data can be ordered in the dialog box. 

Selecting Columns to Display 
Right clicking on the column header area in either the Selected Fixtures Fitting or the 
replacement Fixtures/fittings frames allows the users to select which columns of data are 
displayed. 

 

Note: Block Name and Block Type are mandatory columns 
and cannot be deselected. 
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Sorting Columns of Data 
Columns of data can be sorted in ascending or descending order by clicking the header. 
When the data in a column has been sorted, a small triangle will appear in the header - 
the direction of the triangle indicating whether the data is sorted ascending or 
descending. 

 
In the above example, the Width column has been sorted in ascending order. 

Note: the Width column can be compared to the Length 
column, where data has not been sorted. 

Carrying Out Fixture Swaps 
Carrying out Fixture Swaps is achieved as follows: 

1. The Fixtures are selected 

 

2. Fixture Swap is called 

This can be done from the Command Line (AVT_FIXTURESWAP) or from the 
Fixturing toolbar. 
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Note: Selecting the Fixtures and Invoking Fixture Swap can 
be done in either order. 

3. The Fixture Swap dialog box will open 

When the Fixture Swap dialog box opens, only the Selected Fixtures/Fittings list of 
data is populated. Filters can be used to refine the list. 

 
4. Select the Fixture or Fitting to be replaced 

The fixture or fitting to be replaced is selected in the list of Fixtures and fittings. This 
causes the list of replacement fixtures and fittings to populate. 
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It is possible to select multiple fixtures for replacement by holding down the Control 
Key and left clicking on additional rows. 

5. Select the Replacement Fixture or Fitting 

A replacement fixture or fitting is selected. (Filters can be used to refine the list of 
available replacements). Clicking the Add Swap Pairs button causes the Swap Pairs 
pane to populate. 

One a fixture has been added to a swap pair, the entry will be removed from the top 
(Selected Fixtures/Fittings) frame to prevent multiple swap types being defined for 
that fixture. If the swap pair is subsequently deleted, the fixture will be added back 
to those in the Selected Fixtures/Fittings frame. 

 
6. Make the Swap 
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Click the Apply button to cause all the defined swaps to execute and leave the dialog 
box open to define further swaps. Click the OK button to make all the defined swaps 
and exit the dialog box. 

Limitations of Fixture Swap 
The Fixture Swap functionality is useful for making large scale changes to equipment 
within a store plan, but there are some limitations on what it can achieve. These 
limitations are explained below. 

Size and Type 
Fixture Swap does not place any restrictions on the size of the equipment that can be 
swapped. In the example below, the back gondola run is the original gondola. The 
middle gondola run represents what would happen if 4 foot long fixtures were replaced 
by 3 ft long ones. The front gondola run shows what would happen if fixtures are 
replaced by inappropriate ones: in this instance racking has been replaced by freezer 
units. 

 

Effect of Planograms 
If exploded (3D) planograms have been placed on fixtures in Merchandiser, they will not 
be visible in Planner. However, as the information is held in the database on what 
fixtures do contain exploded planograms, fixture swaps will not be carried out on those 
fixtures. 

In the example below, the back gondola run has two planograms. The fixtures containing 
these planograms have been color coded yellow in this diagram. It would not be 
immediately apparent to a user in Planner that these fixtures contain planograms because 
they will not contain product blocks - unlike if the planogram was in 2D (imploded) 
form. 
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If the fixtures are selected for a fixture swap operation, only the fixture that does not 
have a planogram placed will be swapped, despite all fixtures being included in the 
selection. The effect of this can be seen in the front gondola run. The user will be given a 
warning in the AutoCAD command line - although the fixtures containing planograms 
are not identified. 

 

 

Note: one solution for this limitation is to create a KPI (Key 
Performance Indicator) to color code all fixtures containing 
planograms. It is then possible to determine which 
planograms are not merchandised (and which can be 
subjected for Fixture Swap) and which are merchandised 
and cannot be swapped. 

Effect on Planograms 
If planograms are present as placeholders (2D form), they are visible in the Planner 
module. If a fixture is swapped for one of a different size, the planogram placeholder is 
scaled to suit. However, the planogram design is not changed. In the example below, the 
rear gondola run has the planogram placed on a fixture of the intended size. In the front 
planogram run, the correctly sized fixture has been swapped for one that is both higher 
and wider. 
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The effect of this can be seen when the planogram is viewed in exploded (3D) form in the 
merchandiser module. As can be seen in the example below, both the shelving and 
merchandise fail to correctly fill the larger fixture that was swapped in. 

 

When swapping fixtures, it may be necessary to subsequently swap the existing 
planograms for ones of a more appropriate size for the replacement fixture.   

Note: planograms on inappropriately sized fixtures can be 
identified by means of KPI's and Reports. 
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30 
Gondolas on the Object Browser 

Overview of Gondolas 
Gondolas are pre-defined arrangements of fixtures and fittings. This enables long runs of 
fixtures to be put down quickly, making it easy to lay out or modify equipment in a floor 
plan. 

Fixture Studio 
Gondolas are configured in the Fixture Studio Module in the Gondola Definitions dialog 
box. This enables all details of the gondola to be configured including which options will 
appear in the Add Gondola dialog box in the Planner and Merchandiser modules. 

 

Planner Module 
Gondolas are placed in the Planner module by selecting a Gondola from the Object 
Browser and clicking the Add Gondola option on the toolbar. 
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After being invited to select a start position, the Add Gondola dialog box will appear. 

 
Users can select from a variety of options including: 

 Gondola Dimensions: in the above example users can select from six combinations of 
length and height. 

 Number of Bays: Users can select the number of bays to place. 

 Optional Parts: Some parts may be optional. In the above example users can opt 
whether to have Start and End Caps. 

 Origin and Placement Angle: Users can select where the gondola starts from and 
what angle to place it at. 

After selecting the appropriate options, click OK and the gondola will be placed. 

Overview of Gondolas on the Object Browser 
Clicking on the Fixturing Tab on the Object Browser brings up a series of options for 
adding, editing and deleting Fixtures and Gondolas. 
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 The Toolbar gives access to a series of options concerning gondolas. 

 The Buttons allow the user to toggle between Fixtures (Blocks) and Gondolas. 

 The Hierarchy Window allows users to select fixtures (or gondolas) from the list 
available. 

 The Properties Window shows the properties assigned to the selected fixture. This 
will be blank for gondolas. 

Note: The Summary Window has been removed from the 
Object Browser and is now called from the View menu. 

Using the Object Browser for Gondola Operations 
The Gondolas tool bar  is found on the Object Browser. It is selected by clicking on 
Gondolas in the Fixturing window. 

Overview of the Fixturing Tab 
The Fixturing tab allows users to add fixtures, fittings, gondolas and other equipment to 
the store plan. It is divided in to five parts as follows: 

 The toolbar – provides controls that allow users to add, edit, and delete fixtures and 
gondolas 

 The Fixtures window – shows a hierarchy of available blocks and gondolas 

 The Properties window – after selecting a block from the hierarchy, this window 
shows the details for the selected block.  The content of this window is customizable.  

A fourth option - the Fixtures Summary Window – shows details of the zones based on 
the currently active floor plan. This is now called from the View menu but can be docked 
in the Object Browser if required. 
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The Fixturing Tab Toolbar in the Object Browser enables the user to control all aspects of 
adding, editing and deleting fixtures and gondolas within the Planner and Merchandiser 
environments. 

Clicking on the Switch Buttons will determine whether the Fixturing or Gondola options 
are active. 

Fixturing Toolbar 

 
 

Icon Option Description 

 

Add Fixture Add a fixture to a floor plan. This will cause the Add Fixture dialog 
box to appear. 

 

Delete Fixture Delete the selected fixtures from the floor plan.  

 

Highlight 
Fixture in Floor 
Plan 

If selected, selecting a fixture in the Object Browser Fixture 
Hierarchy will cause the pertinent fixture to be highlighted in the 
floor plan. The exact nature of the highlighting will depend on 
selections made in the Fixturing Tab of the Configuration Module. 

 

Highlight 
selected item in 
tree 

If selected, selecting a fixture in the floor plan will cause the 
pertinent fixture to be highlighted in the Object Browser Fixture 
Hierarchy. 

 

Find This option brings up the Find dialog box, allowing users to search 
for objects in the Fixture Hierarchy.  

 

Options This option brings up the Fixturing Tab of the Configuration 
module, allowing users to customize their settings. 

 

Refresh This option refreshes the Object Browser with the latest information 
on fixtures and gondolas in the database. 

 

Show Attributes This option shows the fixture attributes for any selected fixtures. 
Fixture attributes are customizeable items of information assigned to 
specific fixtures. 

 

Promotional 
Fixtures 

This option allows the user to assign or remove the Promotional 
Attribute and to highlight fixtures with the promotional attribute.  

Gondola Toolbar 

 
 



 Using the Object Browser for Gondola Operations 

 Gondolas on the Object Browser 383 

Icon Option Description 

 

Add Fixture This option is grayed out and unavailable in Merchandiser. 

 

Delete Fixture This option is grayed out and unavailable on the Gondola toolbar. 

 

Highlight Fixture 
in Floor Plan 

This option is grayed out and unavailable on the Gondola toolbar. 

 

Highlight 
selected item in 
tree 

This option is grayed out and unavailab le on the Gondola toolbar. 

 

Find This option is grayed out and unavailable on the Gondola toolbar. 

 

Options This option is grayed out and unavailable on the Gondola toolbar. 

 

Refresh This option refreshes the Object Browser with the latest 
information on fixtures and gondolas in the database. 

 

Show Attributes This option shows the fixture attributes for any selected fixtures. 
Fixture attributes are customizeable items of information assigned 
to specific fixtures. 

 

Promotional 
Fixtures 

This option allows the user to assign or remove the Promotional 
Attribute and to highlight fixtures with the promotional attribute. 
This option has no effect in the merchandiser module. 

The Hierarchy Window 
The Hierarchy window displays both the block and the gondola hierarchies.  To toggle 
between the hierarchies use the Blocks or Gondolas buttons respectively. The hierarchies 
are defined in the Fixture Studio environment and show all the fixtures and gondolas 
that can be added to a store plan. 

The hierarchy can be expanded using the plus control next to each item on the hierarchy. 
It can also collapsed by using the minus control next to each item. 

An item in the hierarchy can be highlighted by clicking on the name of the block or 
gondola. 

 
The icons preceding the fixture name identify the type of equipment - equipment of 
similar types will have the same icon. 



Using the Object Browser for Gondola Operations 

384 Oracle Retail Macro Space Management 

The Properties Window 
The Properties window displays information for the block that has been selected in the 
blocks hierarchy. The content of this window is by modifying the Custom SQL in the 
database. This allows an implementer to specify the information that appears in the 
window. 

Note: See the Oracle Retail Macro Space Planning Data Model 
for information on Custom SQL. 

 

The Summary Window 
The Summary window displays information on the equipment placed in the currently 
open floor plan. The content of this window is by modifying the Custom SQL in the 
database. This allows an implementer to specify the information that appears in the 
window. As an example, the window could include a comparison between the 
equipment in the currently open floor plan and any designated prototype store. 

Note: See the Oracle Retail Macro Space Planning Data Model 
for information on Custom SQL. 

This window is now called from the View menu, although it can be docked in the Object 
Browser once called. 

Placing Gondolas 
To add a gondola to the store plan, highlight the required gondola in the 
hierarchy.  Press the Add Gondola button on the toolbar or drag and drop the gondola to 
the store plan drawing. 

The user is prompted to select a start point for the gondola. Pressing the left mouse 
button opens the Gondola Run dialog box. 
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The Gondola Run dialog box allows the user to select the dimensions of the blocks to use 
in the gondola.  It also allows the number of bays or length of the gondola to be set.  Once 
the desired options have been set, pressing the OK button closes the dialog and places all 
the blocks required for the gondola run in to the store plan. 

Refreshing the Object Browser 
The Refresh option refreshes both Fixtures and Gondola information in the respective 
hierarchical trees. 

 

Refresh This option refreshes the Object Browser with the latest 
information on fixtures and gondolas in the database. 

Clicking on the Refresh button in the Fixturing tab will load the latest fixture information 
from the database into the Fixture hierarchy. At the same time, it will load the latest 
gondola information from the database into the Gondola Hierarchy. 

Dragging and dropping a fixture from the appropriate hierarchy after the refresh button 
has been pressed will add that fixture to the drawing using the latest definition from 
Fixture Studio. Similarly, using the Add button will also add a fixture to the drawing 
using the latest definition from Fixture Studio. 

If a drawing is already open then fixtures already placed in the drawing will not use any 
changes loaded during the refresh operation until the drawing is closed and reopened. 
However, new fixtures added to the open drawing will use the new data. 

Functional Options for Gondolas 
The functional options on the gondola toolbar are as follows: 
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Add Gondola 
This option allows users to add a gondola by highlighting it in the hierarchy and clicking 
the Add button.  Alternatively, a gondola may be highlighted and 'dragged and dropped' 
into the floor plan. This will result in the Add Gondola dialog box appearing, allowing 
the user to specify further details of the gondola to be added. 

Delete Fixtures 
This option allows the user to delete selected fixtures in the floor plan. Which fixtures are 
selected will depend on whether Grouping is on or off in the Fixturing toolbar. 

 If Grouping is turned On, selecting a single fixture in the gondola will select all 
fixtures. These can then be deleted together by clicking the Delete icon. 

 If Grouping is turned Off individual fixtures in the gondola can be selected and then 
be deleted by clicking the Delete icon..  

Refresh 
The Refresh option refreshes both Fixtures and Gondola information in the respective 
hierarchical trees. Clicking on the Refresh button in the Fixturing tab will load the latest 
fixture information from the database into the Fixture hierarchy. At the same time, it will 
load the latest gondola information from the database into the Gondola Hierarchy. If a 
gondola definition has been updated in Fixture Studio, all gondolas placed after refresh 
will use the new information. However, any gondolas already placed in the floor plan 
will still conform to the old definition. 

Attributes 
Attributes only apply to fixtures. The option is available on the Gondolas toolbar as 
fixtures may require a ttributes to be assigned as part of the workflow immediately a fter 
the gondola has been placed in a floor plan. 

Promotional Fixtures 
Promotional Fixtures can be assigned by selecting a fixture or fixtures and clicking on the 
Promotional Fixture icon in the toolbar. The option is available on the Gondolas toolbar 
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as fixtures (such as end caps) may be required to be designated as promotional fixtures as 
part of the workflow immediately after the gondola has been placed in a floor plan. 

Non Functional Options for Gondolas 
Several options are grayed out and non-available for gondolas. 

 
This is because gondolas are treated as collections of fixtures once placed in a floor plan. 
In addition they can be modified by addition, changing or deletion of fixtures once 
placed. The Highlight in Store, Highlight in Tree, Find and Options icons are thus not 
appropriate for gondolas and have been disabled. 

Placing a Gondola - Basic Options 
Gondolas are placed in the Planner module by selecting a Gondola from the Object 
Browser and clicking the Add Gondola option on the toolbar. Alternatively, a gondola 
can be selected from the hierarchy, then 'dragged and dropped' into the floor plan. 

 
Users will then be invited to select a start position in the AutoCAD command line. 

 
Some AutoCAD options may help in selecting the start point. 
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 The Snap Mode can be turned on or off. If turned on, the cursor will snap to a grid of 

points in the floor plan. 

 The Grid Display turns display of the snap grid on or off. 

 Object Snaps (OSNAP) allows the cursor to snap to specific points in the floor plan 
(like the corner of another fixture). 

Note: See the AutoCAD help file for more information. 

Once the Start Position has been selected, the Add Gondola dialog box will appear. 

 

Gondola Dimensions 
Users can select the dimensions of the fixtures for the gondola. For many gondolas, the 
option will exist to select length, depth and height - although other options are possible. 
If a combination of sizes is selected that does not reference an existing fixture, an error 
message will appear. 
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Note: this problem can be prevented by careful configuration 
of the gondola options when defining the gondola in Fixture 
Studio. 

Options 
Some gondola parts can be made optional. These parts can be selected or deselected by 
means of the check boxes in the Options frame. 

Number and Angle 
The number of bays can be selected using the spin control, while the angle the gondola 
will be drawn at can also be specified. 

Placing the Gondola 
Click the OK button to place the gondola. It will then draw in the floor plan. 

 

Placing Island Gondolas 
Island Gondolas are placed using similar techniques. One useful technique is using 
AutoCAD construction lines and offsets. 
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In the example above, construction lines (the red lines in the screen shot) were drawn 
along the edges of the wall gondolas. Additional construction lines were then offset from 
the originals to give the correct spacings. In the above example, the construction lines 
were used to ensure the aisles were a precise 8 feet in width. After the gondolas have 
been placed, the construction lines will be deleted.    

Similar construction lines have been used to place the next sequence of gondola runs. 

 
After the construction lines are deleted, this leaves the new gondola runs precisely 
positioned with minimum aisle widths maintained. 
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Placing a Gondola - Advanced Options 
Gondolas running along walls will often require the specific number of bays required to 
fill a specified distance - for example from the corner of a wall to the edge of a door 
frame. The measure options allow users to place that gondola run quickly and accurately. 

 
 Number (Measure) allows the user to draw a line in the floor plan. This specifies the 

length of the gondola and which end of the line the first bay of the gondola will be 
drawn at. 
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 Starting Point (Measure) enables the user to specify point in the drawing which will 
be the origin from where the gondola will be drawn. 

 Start Position (left or right) specifies whether the first bay of gondola at the left end 
or right end of the gondola run. 

 Extend or Best Fit determines whether the number of bays drawn will fit entirely 
inside the line or partially extend outside of the line. 

Once these options are understood, it is simple to draw gondolas fast and accurately in 
plan view. When learning how to use the options, it is sometimes easier to draw some 
gondolas in isometric view to see how those options work. 

Worked Example 

AutoCAD Settings 
It is suggested that AutoCAD's Object Snaps (OSNAP) are turned on. This makes it easy 
to select corners, adjacent fixtures, etc as the starting point for the gondola. Ortho can be 
used if it is desired to draw the gondola at precise right angles in the floor plan. The snap 
grid and other options should be turned off. 

Placing the Gondola 
In the worked example below, it is desired to draw a gondola with its start point in the 
corner of the wall and extending up to the edge of the door. 

 
Select the required gondola in the object browser and click the Add Gondola icon. The 
user will be taken to the floor plan and requested (AutoCAD command line) to pick a 
start point. Click in the corner of the wall. This sets the coordinates for the starting point. 
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The Add Gondola dialog box will then appear. The initial stage is to click the Number 
(Measure) button. The user will be taken back to the floor plan. It is then necessary to 
click two points that will define the s tart point and end point of the gondola. 

 
On clicking the end point, the user will be returned to the Add Gondola dialog box. The 
Best Fit check box should be selected because that will ensure the maximum number of 
gondola bays will be drawn without obstructing the door. 

The other option to be selected is the Left/Right button for the start point. This is 
determined by which bay of the gondola will be drawn first. It will be at the start point of 
the line that was drawn to define the gondola length. In this case viewed from the front 
of the gondola the first bay to be drawn is on the right hand end of the gondola. 
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The start point is set to Right. On clicking the OK button the gondola will be drawn. 

 

Placing Island Gondolas 
One useful technique for placing island gondolas is using AutoCAD construction lines 
and offsets. 
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In the example above, construction lines (the red lines in the screen shot) were drawn 
along the edges of the wall gondolas. Additional construction lines were then offset from 
the originals to give the correct spacing. In  the above example, the construction lines 
were used to ensure the aisles were a precise 8 feet in width. The intersections of the 
construction lines can be used to specify the start and end points of the line defining the 
gondola position that is required after the Measure button is clicked in the Add Gondola 
dialog box. After the gondolas have been placed, the construction lines will be deleted.    

Similar construction lines have been used to place the next sequence of gondola runs. 
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After the construction lines are deleted, this leaves the new gondola runs precisely 
positioned with minimum aisle widths maintained. 
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Placing a Gondola - Other Considerations 
The section of help explains the more advanced options for gondola placement. This 
section should be read in conjunction with the section on basic options. 

Dimensions 
Gondolas can be assigned varying numbers of dimensions. The gondola definition in the 
example below is used to draw heavy duty racking used in storage areas. This racking 
comes in a standard depth and height, but in varying lengths. Accordingly, store 
planners are only required to select the length. 
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More complex gondolas can have up to six dimensions. In the example below the 
dimensions of both the main part of the gondola and the start and end caps can be 
specified. 

 
Dimensions do not have to be confined to physical sizes. In the example below, a 
gondola has been configured to allow the store planner to select the material as well as 
the physical dimensions. This would only be effective if the gondola parts come in 
similar sizes but different materials. 



 Placing a Gondola - Other Considerations 

 Gondolas on the Object Browser 399 

 

Extend and Best Fit 
Extend and best fit determine the number of bays that will be drawn for a specific 
measured length. 

 Best Fit: the number of bays drawn will be the maximum where the total length does 
not exceed the measured length. 

 Extend: the number of bays drawn will be the maximum where the start position of 
the last bay is inside the measured length. 

Extend will generally result in one more bay being drawn than best fit. 

 
In the above example, the red line represents the measured length. The gondola at the 
top was drawn using Best Fit., the one at the bottom with Extend. 

Gondolas and In-Store Space Collaboration 
There is a limitation on placing gondolas in the In-Store Space Collaboration application 
(a companion application to Macro Space Management). It can only place gondolas with 
three dimensions of Length, Depth and Height. Accordingly, more complex gondolas 
should be placed in Macro Space Management. Their position can then be adjusted if 
necessary in In-Store Space Collaboration. 
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Editing and Deleting Gondolas 

Editing Gondolas 

Grouping 
Once gondolas are placed, they effectively become a collection of associated fixtures. The 
behavior of a gondola for editing is determined by whether grouping is on or off. This is 
set using the Grouping option on the fixturing toolbar. 

 
If grouping is on, selecting a single fixture on the gondola will automatically select all 
fixtures. If grouping is off, individual fixtures in the gondola can be selected. 

Fixture Manipulation 
Once gondolas have been selected, their position can be modified by use of some of the 
Fixture Manipulation tools such as slide, move and rotate. 

Note: Fixture Manipulation tools are most useful for users 
not familiar with AutoCAD functionality. 

Editing using AutoCAD 
Once placed, fixtures can be moved and rotated using standard AutoCAD functionality. 
If AutoCAD functionality is used for this purpose it may be necessary to use 
synchronization afterwards to ensure the information in the floor plan and database is 
identical. 

Deleting Gondolas 
Because Gondolas become a collection of associated fixtures when they are placed, there 
is no Delete Gondola option on the Gondola toolbar on the Object Browser. The way to 
delete gondolas using Macro Space Management tools is to turn on grouping on the 
fixturing toolbar, select the gondola required for deletion and then use the Delete fixture 
option on the Fixturing toolbar of the Object Browser. 

 

Deleting using AutoCAD tools 
It is also possible to delete gondolas using standard AutoCAD functionality. It may then 
be necessary to use synchronization afterwards to ensure the information in the floor 
plan and database is identical. 
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Bay Numbering 

Overview of Bay Numbering and Bay Groups 
Bay Numbering (used in conjunction with Bay Groups) allows each fixture within the 
floor plan to be assigned a unique identification code for reporting and identification 
purposes. 

Note: Only fixtures can be assigned bay numbers. Fittings 
and shelves are automatically excluded from any selections 
made. 

Bay Groups 
Bay Groups are a preliminary action before bay numbering is applied. They enable a 
group of fixtures to be treated as a single bay with sub-numbers applied to the individual 
fixtures. 

 
In the example above, two fixtures have been grouped together for bay numbering 
purposes. When bay numbering was applied, the fixtures were given a master bay 
number (A-1) and two sub numbers (A-1.1 and A-1.2) 

Bay Numbering 
Bay Numbering applies an identification number to a fixture or bay group. These have a 
number of different shapes, colors and prefixes. 

 
When applied, bay numbering provides an easy way of locating specific fixtures in an 
electronic or printed copy of a floor plan. 

 

Gondola Numbering 
Gondola numbering is an alternative to bay numbering. 
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It is of the format: Gondola Number/Gondola Side/Gondola Level/Fixture Number. 
Thus 1/2/0/4 is gondola number 1 in the drawing, the second side of the gondola, level 
0 (floor level) and the fourth fixture on that side. 

Preparations for Bay Numbering 

Synchronization 
Before bay numbering is carried out, it is recommended that the floor plan be 
synchronized to ensure information in the database matches the information in the floor 
plan. Several factors a ffect synchronization. 

Auto-Synchronization 

If auto-synchronization is on, the floor plan will automatically be synchronized when it is 
opened. Bay Numbering at this point will not require any further synchronization. 

Dynamic Synchronization 

If dynamic synchronization is on, changes made to fixtures, products , planograms and 
other blocks  made with AutoCAD tools will be immediately written back to the 
database. The floor plan will not generally require any further synchronization before 
bay numbering is carried out. 

Manual Synchronization 

If auto or dynamic synchronization are turned off (or if the user suspects some other 
form of problem), the floor plan can be manually synchronized in order to ensure 
information in the database matches the information in the floor plan. This is done by 
means of the Synchronization dialog box. This can be invoked from the file Menu or the 
Retail toolbar. 
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Note: See the help file section on Synchronization for further 
information. 

Fixture Adjacency 
Some features in the bay numbering dialog box rely on the Fixture Adjacencies to be up 
to date. To run Fixture adjacency, select Calculate Fixture Adjacency from the 
Calculations  menu. 

 
After the Fixture adjacencies have been updated, a confirmatory dialog box will appear. 

 

Accessing Bay Numbering 
The Bay Numbering dialog box can be accessed from the Insert Menu.  
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Alternatively, it can be accessed from the Bay Numbering toolbar. 

 

The Bay Numbering Dialog Box 
The Bay Numbering dialog box has three main parts: 

 
 The Select Bays frame has the options for selecting some or all of the fixtures in the 

floor plan for bay numbering, together with some options as to the sequence they 
will be numbered in. 

 The Group frame allows users to label sub-sets of fixtures and to specify the form of 
the text. 

 The Action frame allows users to actually add or remove bay numbers. 

Reference Blocks 
The blocks used for bay numbering are registered in Fixture Studio in the Reference 
section of the fixture hierarchy. It is not recommended that users make any changes to 
these blocks unless they understand how they are configured. 
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The Bay Numbering Dialog Box 
The Bay Numbering dialog box has three main parts: 

 
 The Select Bays frame has the options for selecting some or all of the fixtures in the 

floor plan for bay numbering, together with some options as to the sequence they 
will be numbered in. 

 The Group frame allows users to label sub-sets of fixtures and to specify the form of 
the text. 

 The Action frame allows users to actually add or remove bay numbers. 

Select Bays Frame 

Add or Remove Radio Button 
The Add  or Remove radio button determines whether the next selection of fixtures will 
be added to or removed from any already selected fixtures. In the above example, 54 
fixtures have already been selected. Because the Add radio button is selected, and 
fixtures selected in the floor plan will be added to this total. 

Use Adjacencies 
If the Use Adjacencies option is selected, this will use the Fixture Adjacency information 
to decide what sequence to add bay numbers in. In order to use this option the Fixture 
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Adjacency option from the Calculations  menu must first have been run. Once the Use 
Adjacencies check box has been selected, the Sort Bays and Direction options will become 
available. 

 Sort Bays enables the direction Radio button to become active 

 The Left to Right or Right to Left radio button causes fixtures selected in bulk with 
AutoCAD windows or crossing selection boxes to be numbered in the sequence 
specified by the Fixture Adjacency calculation. 

If fixtures have not been selected in a specific sequence (for example with an AutoCAD 
Fence command) and the Use Adjacencies command is not selected, fixtures will number 
in the sequence the information was written to the database when they were placed in 
the floor plan. This may result in apparently random bay numbering sequences in the 
floor plan. 

Selection Options 
 Clear Selection will de-select all currently selected fixtures. 

 Preview will cause all currently selected fixtures to highlight in the drawing - the 
highlighting method will depend on the options chosen in the Fixturing tab of the 
Configuration module. 

 Select Bays takes users to the currently active floor plan and allows users to select the 
fixtures to be bay numbered using AutoCAD selection methods. 

 By Bay Run will not be active unless the Use Adjacencies check box has been 
checked. Sort Bays and either Left to Right or Right to Left should also be selected. 
Providing Fixture Adjacencies has been run from the Calculate menu first, clicking 
By Bay Run will allow the user to select a gondola by clicking a fixture in it. All  
fixtures in the gondola will then be bay numbered. 

 By Group can be used if named groups of numbered bays are already present in the 
floor plan. Selecting the required name from the drop down list in the Group frame 
and clicking the By Group button will cause those fixtures to be selected. 

 All Bays will select all fixtures in the floor plan. 

 Unlabeled Bays will select all bays that have not yet been assigned a bay number. 

Group Frame 
 Name enables users to specify a reference name for a group of fixtures that will be 

assigned bay numbers. Example of names would be Food and Drink, Clothing, 
Health and Beauty. The button to the right of the drop down list will take users to the 
floor plan. Clicking on a bay number will return users to the Bay Sequence 
Numbering dialog box with the name for that sequence of bay numbers selected. 

 Prefix enables users to specify a letter, number or symbol to be added before the bay 
number. Adding a prefix of A- will result in fixtures being numbered A-1, A-2, a-3 
etc. 

 Start is used to specify the number that numbering will start at. Bay numbers may 
not be duplicated, so two bay numbers cannot both have the number 10 assigned. A-
10 and B-10 are not regarded as duplicates. 

 Label Block specifies that shape of the outline that will surround the bay number. 

 Color specifies the color for the text of the bay number. The color of the Label Block 
cannot be specified. 

 Scale specifies the size of the text. The bay number can be made larger or smaller by 
adjusting this value. 
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 Labeling/Gondola Numbering: This radio button specifies whether to apply bay 
numbering or gondola numbering. 

Action Frame 
 Add: selecting this option will add the specified bay numbering to the selected 

fixtures. 

 Remove: selecting this option will remove the existing bay numbering from the 
selected fixtures. 

 Exit: This option will close the Bay Numbering dialog box. 

Adding Basic Bay Numbering 
This worked example shows how to add basic bay numbering to a gondola. 

 

Running the Fixture Adjacency Calculation 
To ensure the bay numbering follows a neat sequence, the first stage is to run the 
Calculate Fixture Adjacencies option from the Calculations menu. This ensures that the 
database contains current information on which fixtures are to the left, right, behind or 
above each other. 
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Operations in the Bay Numbering Dialog Box 

 

Select Bays Frame - Options 
The first stage is to set how the bays will be numbered when selected. 

 The radio button is set to Add. At this stage there will be 0 bays selected. When we 
add bays at a later stage, we want them to be added to the selection. 

 The Use Adjacencies, Sort Bays and Left to Right options are selected. This will 
ensure bay number in a logical sequence. 

Group Frame 
The next stage is to set some information as to the appearance of the bay numbering. 

 The Name is what this group of bay numbers will be called. In this example it is 
Food. If it is intended to apply bay numbers to other gondola later, this set of bay 
numbers might be given a name like clothing. 

 The Prefix will go before the bay number - in this case it will result in the fixtures 
being numbered F-1, F-2, F-3, etc. 

 Start is the value of the first bay number. In this case the numbers will start at 1. 

 The Label Block will result in a circular outline, while the Color for the text is set to 
Red. 

 The Scale is left at 1 as this is a good size for the text, while Labeling is selected to 
place Bay Numbers. 
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Select Bays Frame - Selecting the Bays 
The next Stage is to select the bays. To do this, click the Select Bays button. This will take 
the user to the floor plan. Select the fixtures by standard AutoCAD methods and right 
click to finish the selection. In the example below, the fixtures are being selected by a 
Crossing Selection Box. 

 
On right clicking to complete the selection, the user will be returned to the Bay 
Numbering dialog box. 

Action Frame 
The Bay Numbering can now be added by clicking the Add button in the Action frame. 

 

Advanced Bay Numbering 
Note: Please refer to the Adding Basic Bay Numbering topic 
first before following this worked example. 

It is possible to use the AutoCAD Fence command to exert precise control over the bays 
selected and the sequence they will number in. In the example below, a limited number 
of fixtures have been selected for numbering. 

 

Bay Numbering Dialog Box 
The first stage is to bring up the Bay Numbering dialog box. 
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Note: there is no need to run the Fixture Adjacency 
calculation - in this example the bays will be numbered in 
the sequence they are selected with the Fence command. 

Select Bays Frame - Options 
The first stage is to set how the bays will be numbered when selected. 

 The radio button is set to Add. At this stage there will be 0 bays selected. When we 
add bays at a later stage, we want them to be added to the selection. 

 The Use Adjacencies option is not selected. This will ensure that the fixtures bay 
number in the order they are selected. 

Group Frame 
The next stage is to set some information as to the appearance of the bay numbering. 

 The Name is what this group of bay numbers will be called. In this example it is TV. 
If i t is intended to apply bay numbers to other gondola later, this set of bay numbers 
might de given a name like clothing. 

 The Prefix will go before the bay number - in this case it has been set as TV-. 

 Start is the value of the first bay number. In this case the numbers will start at 1. 

 The Label Block will result in a circular outline, while the Color for the text is set to 
Blue. 

 The Scale is left at 1 as this is a good size for the text, while Labeling is selected to 
place Bay Numbers. 

Select Bays Frame - Selecting the Bays 
The next Stage is to select the bays. To do this, click the Select Bays button. This will take 
the user to the floor plan. Type the word Fence into the AutoCAD command line. 
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A fence is a line. Any fixtures the line passes through will be selected. The fence must 
start outside of the first fixture, only pass once through any selected fixture and finish 
outside of the last fixture. 

 
Once the fence has been drawn, press Return to indicate the fence is complete and right 
click to complete the selection set. The user will be returned to the Bay Numbering dialog 
box. It will show 7 fixtures have been selected. 

Action Frame 
The Bay Numbering can now be added by clicking the Add button in the Action frame. 

 

Removing Bay Numbering 
Removing bay numbering is the reverse of adding it. Bay Numbering can be removed in 
various ways. 
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All Bays Option 
This is the simplest way of removing bay numbers. Simply click the All Bays button in 
the Select Bays Frame. This will select all fixtures in the currently active floor plan. Click 
Remove in the Action frame and all bay numbering in the floor plan will be removed. 

Select Bays Option 
The Select Bays  option allows the user to use standard AutoCAD selection methods such 
as windows and crossing selection boxes or the fence command. Once the required 
fixtures have been selected click Remove in the Action frame and the bay numbering will 
be removed from the specified fixtures. 

Name Option 
This method relies on the fact that specific bay numbers are associated with a name in the 
Name drop down list in the Group frame. The first stage is to set the name to that 
required. This can be done by manually setting the name to that required or by clicking 
the button to the right of the name drop down list. This will take the user to the floor 
plan. Click on a bay number and this will select its parent name. Next click the By Group 
button to select all fixtures associated with that name. Finally, click Remove  in the Action 
frame and the bay numbering will be removed from the specified fixtures. 

Bay Groups 
Bay Groups can be used to group several fixtures together for reporting purposes. An 
example of this would be fixtures holding long products such as wooden dowel or 
electrical conduit in a DIY store.  In the example below, the two left-most fixtures have 
been combined into a bay group with master bay number of 1 and sub bay numbers of 
1.1 and 1.2. 
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Accessing the Bay Group Options 
Bay Group options can be accessed from the Modify > Blocks menu or the Bay 
Numbering toolbar. 

 
The can also be accessed from the Bay Numbering toolbar. 

 
These give access to three options: 

 Group fixtures (bays) to make them into a  bay group. 

 Clear the bay group so it reverts to individual fixtures for bay numbering purposes. 

 Select the bay group by clicking on a member to show all other members. 

Bay Group Operations 

Grouping Fixtures to make them into a Bay Group 
To make Bay Groups from Fixtures  

1. From the Modify >Blocks menu, click the Group Bays option. Alternatively use the 
Group Bays option from the Bay Numbering toolbar. 

2. A prompt will appear in the command line asking the user to select the required 
fixtures. 

 
3. Fixtures can be selected by standard AutoCAD selection methods including 

individual selection, selection windows or a fence. Selection must be terminated by 
the standard AutoCAD method of a right click. 
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The selected fixtures will now be treated as a bay group. 

Clearing Bay Groups 
To remove a bay group is done as follows: 

1. From the Modify > Blocks menu, click the Clear Bay Group option. Alternatively use 
the Clear Bay Group option from the Bay Numbering toolbar. 

2. A prompt will appear in the command line asking the user to select a fixture. 

 
3. A single fixture can be selected by clicking it. This will cause the fixtures forming the 

bay group to be de-selected. 

Selecting a Bay Group 
Selecting the fixtures forming a bay group is done as follows: 

1. From the Modify > Blocks menu, click the Select Bay Group option. Alternatively use 
the Select Bay Group option from the Bay Numbering toolbar. 

2. A prompt will appear in the command line asking the user to select a fixture. 

 
3. A single fixture can be selected by clicking it. This will cause all other fixtures in the 

bay group to be selected. 

 

Note: It would also be possible to use a KPI to show fixtures 
in bay groups. The simplest way to do this would be to 
reference the FIX_BAYGROUP field in the AVTTB_FIXTURE 
table. 

Bay Numbering and Bay Groups 
When fixtures are bay numbered, fixtures associated with a bay group will receive a 
master bay number and sub bay-numbers for individual fixtures. In the example below, 
there is one bay group of 4 fixtures; two bay groups of two fixtures each and two single 
bays.   
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Merchandise in Planner 

Overview of Merchandising in Planner 
The merchandising options in Planner allow users to lace planograms or products. 

 
Planner can be used to merchandise a store at placeholder level - it cannot be used to 
merchandise at display style level. Two forms of placeholders are possible: 

 Products: Placeholders can be at any level in the hierarchy from SKU upwards. 

 Planograms 

In both cases, the placeholders indicate the presence of specific items of merchandise 
exists on a fixture. However, the placeholders themselves do not hold any information on 
the product quantity, position or orientation. 

Using External Information to Plan Merchandise 
Store planning is not done in isolation. A key objective is to take optimized data from 
other applications and use it to translate a list of tabulated requirements into an 
optimized spatial arrangement. 
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Product Targets and Prototype Stores 
The flowchart below shows one method to achieve this. 

 
1. Data on the quantities of required products is generated by an external application. 

2. This information is imported into Macro Space Planning's Product Target table. 

3. The product targets are used to create (or update) a prototype store. This translates a 
tabulated list of information into a spatial arrangement of products and planograms. 

4. The prototype store is used as a basis for comparison for other stores. For example, 
stores in a specific cluster in Store Manager could be validated against the prototype 
before being put into service. 

Using Product Targets 
The Macro Space Planning Database contains a Product Target table. 

 
This table can be used to hold information from another application - such as Category 
Management. It can be populated imported data for base linear or shelf linear lengths for 
products at Category, Sub-Category or Segment level. This information can be both store 
and season specific, allowing the table to hold optimized information. 

Product Targets and Quick Reports 
Quick Reports can be accessed from the View menu. They are designed to give a 
continually updated view of specific aspects of the currently active floor plan. Macro 
Space Planning is supplied with a standard set of Quick Reports, but retailers can 
develop their own customized quick reports to suit their specific business processes. 
(This can be done by implementers or administrators making changes to the Custom 
SQL table in the database). In the example below a Quick Report has been developed to 
show the product targets for the currently active floor plan. It shows the base linear for 
products at Segment level, together with  the average gross margin for those segments. 
This data can then be compared with data for merchandise actually placed in the store to 
ensure that the broad quantities of products placed fall within calculated criteria.   
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Using Prototype Stores 

Placing Merchandise 
Prototype stores can be used to convert a list of product targets into a specific spatial 
arrangement. In the example below, aisles have been drawn to indicate traffic flow and 
planograms placed to meet the base linear targets. This information can be used by other 
store planners as a comparison when planning their stores. In the example below, once 
the prototype has been selected or planned, other store planners can see which 
planograms belong in which aisle and which sequence they are placed in. 

 

Comparing with Quick Reports 
It is also possible to use Quick Reports for comparison purposes: for example it is 
possible to produce a custom quick report that compares the base linear values of 
merchandise in the prototype store with that in the current store. 
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Comparing with Store Comparison 
The Store Comparison option can be used to establish what is the same, different, 
missing or present in larger quantities in one store compared to another. 

 

Note: For full information on the tables in this section see the 
Oracle Retail Macro Space Planning Data Model. 

Planogram Forms 
Planograms can exist in several forms in a floor plan. 
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In the above diagram: 

 The planogram on the left is in 2D form. This is purely a placeholder and the 
database will not hold floor plan specific information on the position of the shelves 
or products in the planogram. 

  The planogram in the centre is in 2.5D form. The shelves are accurately represented 
by the products are in placeholder form with no information on quantity, position or 
orientation. 

 The planogram on the right is in 3D form. Shelves are accurately represented, as is 
the quantity, position and orientation of the products. 

Planogram Placement in Planner 
Planograms in Planner always place in 2D form. They can be exploded to 3D form in the 
Merchandiser module if full planogram details are required to be visible, but will still 
only appear as placeholders in Planner. 

Note: If the planogram is in 2D form, it can be viewed in 
Schematic Preview  in In-Store Space Collaboration, while 
if it is 3D form it can be viewed in Front Graphical View. 

Shelf and Product KPI's and Reports 
KPIs and reports need to take into account the form of the planogram. If i t is in 2D form, 
full planogram details can only be found in the Plano table (and its Child tables). If the 
planogram has been exploded in Merchandiser, the KPI reports can use other tables in 
the database - for example the Shelf and Product tables. The form of the KPIs reports is 
thus dependent on how the application was configured when it was implemented. 

Note: For more information on these tables see the Oracle 
Retail Macro Space Planning Data Model. 

Effect of Settings in Configuration Module 
Settings in the Merchandising tab of the Configuration module can have a significant 
effect on the way merchandise places. 
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Full information on each setting can be found in the Configuration Module User Guide, 
but the following basic settings are helpful for new users: 

Selection Frame 
This frame controls how fixtures are selected for placing merchandise on. Set the 
following: 

 Fixture Selection Method to Standard Selection. 

 Always Show Selection Dialog to On. 

 Select Whole Planogram to On. 

 Sort left-most to On. 

Sort Left-Most 
Sort left-most selects the fixtures in a left to right order, irrespective of the order in which 
they were selected. This is based on the fixtures as viewed from the front. The effect can 
be seen for the gondola in the diagram below. 
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If Sort Left-most is turned off, multi-bay gondolas will have the bays placed in the 
sequence the fixtures were selected, not the sequence they were designed for. 

Highlight Frame 
This frame controls how merchandise is highlighted in the floor plan. 

 Set highlight method to Flash. 

Check Rules Frame 
This frame controls the advisory warnings that occur when placing planograms. 

 Set all Check Rules to On with the exception of allow Multiple Profiling. 

The Floor Plan Active Date 

Overview of Floor Plan Active Date 
The Active Date  is intended as a filter to ensure that only appropriate merchandise is 
placed in a floor plan. It is visible at the top of the Object Browser. 

 
It is set by double clicking on it. This will bring up the Change Date dialog box. 
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This can be set to one of three options: 

 Effective Date. The Effective Date is the date the floor plan is scheduled to come into 
service. If the Effective Date has been set in the File Properties dialog box for the floor 
plan in Store Manager, the Active Date of the floor plan will be set to reflect this. 

 Current Date. If selected, the active date will be set to today's date. 

 Other Date. If selected, this allows the Active Date to be set to any required date. 

MERCH_TREE_EFFECTIVE_DATE System Variable 
The effect of the Active date can be turned on or off by means of the 
MERCH_TREE_EFFECTIVE_DATE system variable in the Administration Module. If 
turned on all products and planograms that have an Effective date after the Active Date 
of the currently active floor plan will be grayed out and unavailable for selection from 
the Object Browser. 

Using the Floor Plan Active Date 
If the MERCH_TREE_EFFECTIVE_DATE system is On, merchandise with: 

 An Effective Date after the Active Date set for the floor plan will be grayed out and 
unavailable for placement. This is because the product or planogram is not scheduled 
to be available until after the date the floor plan is scheduled to go into service. 

 An Expiry Date before the Active Date set for the floor plan will be grayed out and 
unavailable for placement. This is because the product or planogram will be removed 
from the list of available merchandise before the floor plan comes into service. 

Limitations of the Floor Plan Effective Date 
If a file has not been given an effective date, all products will be available. If products are 
copied from one drawing to another, they will be placed in the drawing even if their 
product dates are not valid for this file. 

Display Style Products and Exploded Planograms 
There are two forms of product that can be placed in the Merchandiser module, but 
which are not visible in the Planner module. 

Products at Display Style Level 
There are a number of possible levels in the product hierarchy. The lowest is Display 
Style. This is the physical form a SKU can adopt in the store.  In the image below from 
the Merchandiser module, the physical form can be seen.  
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However, Display Styles cannot be placed in Planner, so they do not appear in the Object 
Browser. In the screenshot below, the same part of the product hierarchy is shown in the 
Object Browser in both the Planner and Merchandiser modules. The Merchandiser 
hierarchy (on the right) shows the display styles, while the Planner hierarchy does not. 

 
Planner can only display products down to SKU level using product placeholders. It 
cannot display products at Display Style level. Accordingly, Display Style level products 
in Merchandiser will not be visible. This can result in an apparently empty fixture in 
Planner actually containing display styles. 

Planogram Form 
Planograms can exist in several forms in a floor plan. 
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In the above diagram taken from the Merchandiser module: 

 The planogram on the left is in 2D form. This is purely a placeholder and the 
database will not hold floor plan specific information on the position of the shelves 
or products in the planogram. 

  The planogram in the centre is in 2.5D form. The shelves are accurately represented 
by the products are in placeholder form with no information on quantity, position or 
orientation. 

 The planogram on the right is in 3D form. Shelves are accurately represented, as is 
the quantity, position and orientation of the products. 

Planogram Placement in  Planner 
Planograms in Planner always place in 2D form. They can be placed in 2D, 2.5D form or 
3D form in Merchandiser. 2D and 2.5D planograms can also be exploded to 3D form. 
When in 2.5D or 3D form, the planograms will not be visible in Planner. This can result in 
an apparently empty fixture in the Planner module actually containing shelves and 
products. 

Use of KPIs 
Although neither display style products, nor 2.5D or 3D planograms show in the Planner 
module, the information exists in the database. It is therefore possible to create KPI's that 
will highlight apparently empty fixtures in planner that have in fact been populated in 
the Merchandiser module. 

Promotional Fixtures 
Certain fixtures with a store are known to generate high levels of profits. Examples 
include end caps on gondolas and displays by the checkout designed to increase impulse 
buying. Macro Space Planning allows specific fixtures in a floor plan to be designated as 
Promotional Fixtures. These fixtures can them be readily identified. They can then be 
used for special offers, promotions or the introduction of new products, etc. 

Some retail chains also have a specific team responsible for merchandising promotional 
fixtures - designating the fixtures as such assists in identifying which fixtures that team is 
responsible for the merchandise on. 
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Assigning Promotional Fixtures 
Once fixtures have been placed in a floor plan, they can be designated as promotional 
fixtures by using the Promotional Fixtures option from the Blocks toolbar of the 
Fixturing tab of the Object Browser. 

 
 

 

Promotional 
Fixtures 

This option allows the user to assign or remove the 
Promotional Attribute and to highlight fixtures with the 
promotional attribute.  

Identifying Promotional Fixtures 
Once promotional fixtures are assigned, they can be identified in two ways in a floor 
plan. 

Highlight 
The Promotional Fixtures option includes a highlight option in the drop down list of 
options. This will cause any fixtures that have been designated as Promotional fixtures to 
be highlighted in the floor plan. The exact highlighting method will depend on the 
options selected in the Merchandising Tab of the configuration module. 

Key Performance Indicator 
 Another way of identifying promotional fixtures is with  KPI's. Without the KPI selected, 
the Promotional Fixtures are difficult to identify. With the KPI active, the promotional 
fixtures are readily apparent. In this case the end caps have been designated as 
promotional fixtures. 
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Note: one of the easiest ways of seeing fixture KPI's is to use 
the Conceptual Visual Style option from the View >  Visual 
Styles menu. This causes the entire fixture to color, not just 
the outlines. 

Using Promotional Fixtures 
There are a number of ways of using promotional fixtures. One possible method is: 

1. Identify fixtures that have a high visibility to shopper traffic. Such fixtures 
include end caps on gondolas, display on checkout, power wings and bins in the 
centre of aisles. 

2. Use the Promotional Fixture on the Object Browser to designate those fixtures as 
promotional fixtures. 

3. Bay number these fixtures differently from other fixtures in the floor plan - possibly 
with a P suffix. 

4. It is then possible to report on and merchandise those fixtures separately to the other 
fixtures in the store - for example it would be possible to produce a weekly store plan 
showing promotional fixtures only that would allow a constantly changing program 
of special offers. 

Planogram Substitutions 
Planogram Substitutions can be used to automatically swap one planogram for another 
in single or multiple stores across the retail chain. 

Configuring Planogram Substitutions 
Planogram substitutions are configured in the Administration module - using the option 
assessed from the Merchandising menu. 
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Many planogram substitutions are then executed automatically using batch processes to 
modify the information held in the database. If this is the case, the Planner floor plan may 
require synchronization so that the information in it matches that held in the database. 

Manually Running Planogram Substitutions 
Users with the correct privileges can also manually run planogram substitutions from the 
Tools menu for the currently active floor plan. 

 

Unknown Category 
The Product hierarchy in the Object Browser contains the products of "unknown" type. 
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These products are in the hierarchy as defaults for the planogram import process and 
should play no role in merchandising floor plans. 

System Variables Used in the Merchandising Tab 
There are four system variables that affect the Merchandising Tab in Planner: 

1. MERCH_DB_DETAIL specifies whether 2D, 3D or full 3D information should be 
saved to the DB (Merchandising). The more detail that is specified, the more data 
storage capacity will be required. 

2. MERCH_DWG_DETAIL specifies whether 2D, 3D or full 3D information should be 
saved to the drawing. Specifying more detail will result in larger drawing files. 

3. MERCH_TOLERANCE_OVER specifies how much larger a planogram can be 
relative to the nominal size of a fixture and still be placed. 

4. MERCH_TOLERANCE_UNDER specifies how much larger a planogram can be 
relative to the nominal size of a fixture and still be placed. 

Note: The MERCH_DB_DETAIL system variable should be 
defined during the implementation stage and not changed 
frequently. 

Note: Some of these system variables can be changed in both 
the Administration and Configuration Modules. 
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33 
Products on the Object Browser 

Overview of Products on the Object Browser 
Clicking on the Merchandising Tab on the Object Browser brings up a series of options 
for adding, editing and deleting Products and Planograms. 

 
 The Toolbar gives access to a series of options concerning products or planograms. 

 The Buttons allow the user to toggle between products or planograms. 

 The Hierarchy Window allows users to select specific products or planograms from 
the list available. 

 The Properties Window shows the properties assigned to the selected object. 

Using the Object Browser for Merchandising Operations 
The Merchandising tab allows users to add product placeholders (products), and 
planogram placeholders (planograms) to the store plan. A product is any category, sub-
category, or SKU that is included in the product hierarchy, i.e. any level in the hierarchy. 
Planograms are also organized in to a hierarchy of planogram groups. However, you can 
only place planograms in to the store plan. Planogram groups cannot be placed. 
Placeholders are markers that can be placed on to fixtures to indicate the product 
category, sub-category or planogram that will be used. 

The Merchandising tab is divided in to 5 parts: 
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 The toolbar – provides controls that allow products and planograms to be added, 
edited, and deleted. 

 The Merchandise window – shows a hierarchy of available products and 
planograms. 

 The Properties window – shows details for the product that has been selected in the 
product hierarchy. Similarly, it will show details of a planogram that has been 
selected in the planogram hierarchy. The content of this window is customizable. 

 The Summary window – shows details of products and planograms placed based on 
the active store plan. The content of this window is customizable.  

 The Preview window – shows a sample picture of product display styles selected in 
the product hierarchy 

Note: Product display styles (which show the physical form 
of the SKU) are only available in Merchandiser. 

The Merchandising Tab Toolbar in the Object Browser enables the user to control all 
aspects of adding, editing and deleting products and planograms within the Planner and 
Merchandiser environments. 

Clicking on the Switch Buttons will determine whether the Product or Planogram options 
are active. 

Products Toolbar 

 
 

Icon Option Description 

 

Add Product This option is grayed out. Products can be added by dragging and 
dropping. 

 

Delete 
Product 

Delete the planograms on the currently selected fixtures in the floor plan. 

 

Highlight in 
Store 
  

If selected, selecting a product in the Object Browser Product Hierarchy 
will cause the pertinent product to be highlighted in the floor plan.  

 

Highlight in 
Tree 

  

If selected, selecting a product in the floor plan will cause the pertinent 
product  to be highlighted in the Object Browser Fixture Hierarchy 

 

Find This option brings up the Find dialog box, allowing users to search for 
objects in the Fixture Hierarchy.  

 

Options This option brings up the Merchandising Tab of the Configuration 
module, allowing users to customize their settings. 

 

Refresh This option refreshes the Object Browser with the latest information on 
products and planograms in the database. 
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Planogram Toolbar 

 
 

Icon Option Description 

 

Add Planogram Planograms can also be added by dragging and dropping. 

 

Delete Planogram Delete the planograms on the currently selected fixtures in the 
floor plan. 

 

Reverse Planogram 
Placement Direction 

If toggled on, this reverses the sequence the planogram bays 
are placed. 

 

Highlight in Store If selected, selecting a product in the Object Browser 
Planogram Hierarchy will cause the pertinent planogram to be 
highlighted in the floor plan.  

 

Highlight in Tree If selected, selecting a planogram in the floor plan will cause 
the pertinent planogram be highlighted in the Object Browser 
Fixture Hierarchy 

 

Find This option brings up the Find dialog box, allowing users to 
search for objects in the Fixture Hierarchy.  

 

Properties  This option brings up the Merchandising Tab of the 
Configuration module, allowing users to customize their 
settings. 

 

Refresh This option refreshes the Object Browser with the latest 
information on products and planograms in the database. 

The Hierarchy Window 
The hierarchy window displays both the product and the planogram hierarchies. To 
toggle between the hierarchies use the Products or Planograms buttons respectively. The 
Product hierarchy is defined in the Product Studio module and shows all the products 
that can be added to a store plan. The Planogram hierarchy can be configured in 
Merchandiser and shows all the planograms that can be added to a store plan. The 
hierarchy can be expanded using the plus control next to each item on the hierarchy. It 
can also collapsed by using the minus control next to each item. 

Product Hierarchy 
The product hierarchy is show down as far as SKU level. Products at Display Style level 
are not shown in Planner because they can neither be placed nor seen. 
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The different colored folders show the different levels in the hierarchy. 

Icon Description 

 

Product Company 

 

Product Group 

 

Product Division 

 

Product Department 

 

Product Class 

 

Product Sub-Class 

 

Product Item 

 

Product SKU 

Planogram Hierarchy 

Planograms are organized in a hierarchy of planogram groups, with planograms 
associated with a specific group. 

 
The different colored folders show the different levels in the hierarchy. 

Icon Description 

 

Planogram Company 

 

Planogram Group 

 

Product Division 

 

Product Department 

 

Planogram Class 

 

Planogram Sub-Class 
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Icon Description 

 

Planogram 

The Properties Window 
The Properties window displays information for the merchandise that has been selected 
in the product or planogram hierarchy. The content of this window is by modifying the 
Custom SQL in the database. This allows an implementer to specify the information that 
appears in the window. 

Note: See the Oracle Retail Macro Space Planning Data 
Model for information on Custom SQL. 

 

Refreshing the Object Browser 
The Refresh option refreshes both Product and Planogram information in the respective 
hierarchical trees. 

 

Refresh This option refreshes the Object Browser with the latest 
information on products and planograms in the database. 

Clicking on the Refresh button in the Merchandising tab will load the latest product 
information from the database into the Product hierarchy. At the same time, it will load 
the latest planogram information from the database into the Planogram Hierarchy. 

Dragging and dropping a product or planogram from the appropriate hierarchy after the 
refresh button has been pressed will add that merchandise to the floor plan using the 
updated definition. If a floor plan is already open then merchandise already placed in the 
drawing will not use any changes loaded during the refresh operation until  the floor plan 
is closed and reopened. However, new products or planograms added to the open 
drawing will use the new data. 

Factors Affecting Product Operations 
A number of factors affect product placement. 

Object Browser and Object Grid 
Products can either be added from the Object Browser or Object Grid. Which one will 
result in more efficient product addition depends both on the situation it is being used in 
and user preferences. 



Factors Affecting Product Operations 

436 Oracle Retail Macro Space Management 

Active Date 
The active date can be seen at the top of the Object Browser. 

 
If the MERCH_TREE_EFFECTIVE_DATE system variable (Administration module) is 
set to on, this will place constraints on what products can be added: 

 If the Effective Date of the product is after the Active date of the floor plan, the 
product cannot be placed because it will not be available when the floor plan is 
implemented. 

 If the Expiry Date of a product is before the Active Date of the floor plan, the product 
cannot be placed because it will no longer be available when the floor plan is 
implemented. 

Fixture Selection 
There are two possible fixture selection methods. These can be set in the Merchandising 
Tab of the Configuration module - accessed by clicking the Properties Icon on the 
Products toolbar of the Object Browser. 

 
There are two methods. Standard Selection  is suggested for new users. 

Grouping 
When the fixtures were placed in the floor plan, if more than one fixture was placed at 
one (for example if a gondola was placed) it is possible to select all fixtures that were 
placed together, or individual fixtures. This is controlled by the Grouping option on the 
Fixturing toolbar. 

 
It is recommended that Grouping be turned Off while placing products. That way 
individual fixtures can be selected. If Grouping is left On, when an individual fixture is 
selected from a gondola, all fixtures and fittings in that gondola will be simultaneously 
selected. 

Fixtures and Fittings 
The floor plan can contain a mixture of fixtures and fittings. Only fixtures can accept 
merchandise. If an attempt is made to merchandise a fitting, a warning will appear in the 
command line. 
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Product Type 
In Planner, products can only be added as placeholders. The floor plan will indicate that 
a specific type of product is present on the fixture, but no information on quantity, size or 
orientation can be determined from it. Product placeholders can be added from any level 
on the product hierarchy from SKU upwards. An example of use would be adding 
category level placeholders to get some preliminary reports on a new floor plan. 
Merchandiser allows a floor plan to be merchandised with an additional level of detail - 
Display Styles. These allow information on quantity, size or orientation for a specific 
product to be associated with a floor plan. 

 
Display Styles cannot be placed in Planner and so cannot be seen in the Object Browser 
(left hand image). They can be seen in the Object Browser in the Merchandiser module 
(right hand image). 

Visibility of Display Styles 
If products are placed at Display Style level in Merchandiser (or if Planograms are 
exploded to 3D form), these forms of merchandise will not be directly visible in Planner. 

 
Macro Space Management has the capacity to create custom KPI's. In the above example, 
a KPI has been created to show fixtures populated with Display Styles. In the example 
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above, fixtures containing products placed at display style level in either merchandiser or 
In-Store Space Collaboration are apparent. 

Adding Product Placeholders from the Object Browser 

Sequence of Actions Required 
There are two potential ways of adding products. The first is to select the required fixture 
first. 

1. Select required fixture or fixtures. 

2. Select Product in Hierarchy in Object Browser or in List in Object Grid 

3. Click the Add icon 

The alternative is to select the product first. 

1. Select Product in Hierarchy in Object Browser or in List in Object Grid 

2. Click the Add icon 

3. Select required fixture or fixtures. 

Either way is valid. This example will use the latter option of selecting the product first 
and the fixtures last. 

Adding Product Placeholders 
Product Placeholders only indicate the presence of an item of merchandise on a fixture. 
This can be at any level from SKU upwards. Product placeholders do not give any 
information on the product form or quantity. 

 
Adding products can be carried out as follows: 

1. Select the Products Button on the Merchandising tab of the Object Browser 
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2. Select Required Product from Hierarchy 

The initial stage is to select the required product from the hierarchy.  

Note: If products cannot be found by means of a manual 
search, there is a Find option available. (See below). 

3. Select Add Option from Toolbar 

4. Selecting Fixtures 

On clicking Add Product, the command line in Planner will prompt users to select 
fixtures. 

 
These can be selected by standard AutoCAD methods including left clicking 
individual fixtures or using window and crossing selection boxes. In this instance, 
four fixtures have been selected be left clicking, the information being reflected in the 
command line. 

 
On completing the selection with a right click (the standard AutoCAD way of 
finishing selecting objects) the selected fixtures will be populated with placeholders. 

 
At the same time as the fixtures are populated, they will annotate with information 
on what products have been placed. 

Note: Annotation is controlled using the Text Styles option 
accessed from the Planning Menu in the Administration 
Module. 

Adding Multiple Product Placeholders to a Fixture 
It is possible to add multiple Product placeholders to a single fixture. Once the fixture has 
been merchandised with the first placeholder, it can be merchandised with a second 
placeholder by following exactly the same procedure. 
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The second fixture from the left has been merchandised with a combination of Beers, 
Lagers and Ciders and Spirits placeholders. This situation might occur if a store planner 
was considering having the upper shelves on a fixture devoted to spirits and the lower to 
beers, lagers and ciders. The annotation can be set of offset so that the annotation for the 
second placeholder does not overwrite that for the first. 

Using the Find Option 
The Find option can be found on the Products toolbar. It can be used if a store planner 
does not know how to manually navigate to the required product. On clicking the Find 
icon, the Find Product dialog box will appear. 

 
To use this dialog box: 

1. Type a search string into the Find text box. (The text string used implied wild cards). 

2. Click the Find icon 

3. Highlight a product in the list returned. 

4. Click OK to be taken to that product in the product hierarchy in the Object Browser. 

Adding Product Placeholders from the Object Grid 
The list of merchandise that is populated to the Object Grid depends on the Custom SQL. 
This can be configured by Administrators directly in the database to return either 
products or planograms. (It is not possible for the Object Grid to return both sorts of 
results in Planner). Generally, the Planner module is configured to return planograms 
corresponding to the node selected in the product or planogram hierarchy. In the 
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example below, clicking the Carbonated Drinks node in the Object Browser has caused 
the Object Grid to populate with planograms associated with that node.  

 

Note: The planograms returned are all those whose products 
have that node in the hierarchy as a common parent. 

Deleting Product Placeholders 
Deleting Products can only be done from the Object Browser 

Sequence of Actions Required 
There are two potential ways of deleting products. The first is to select the required 
fixture first. 

1. Select required fixture or fixtures. 

2. Click the Delete icon 

3. Confirm in the delete Planograms dialog box. 

The alternative is to select the delete option first. 

1. Click the Delete icon 

2. Select required fixture or fixtures. 

3. Confirm in the delete Planograms dialog box. 

Either way is valid. This example will use the latter option of selecting the delete option 
first and the fixtures last. 

Deleting Products 
Deleting products can be carried out as follows: 
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1. Select the Products Button on the Merchandising tab of the Object Browser 

2. Select the Delete option from the Toolbar 

3. Selecting Fixtures 

On clicking Delete Product, the command line in Planner will prompt users to select 
fixtures. 

 
These can be selected by standard AutoCAD methods including left clicking 
individual fixtures or using window and crossing selection boxes. In this instance, 
four fixtures have been selected be left clicking, the information being reflected in the 
command line. 

 
Note: Clicking on the products themselves will not be 
effective - deleting products requires the user to select the 
parent fixtures for the products. Accordingly, users should 
left click on the fixture itself or use window and crossing 
selection boxes that encompass both the product and its 
parent fixture. 

On right clicking to complete the selection, the Delete Products dialog box will 
appear. 

4. Delete Products Dialog Box 

The Delete Products dialog box allows users to confirm which products to delete. 
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– The Radio Button specifying whether to Delete complete instance or Only delete 

from the selected fixtures only applies to planograms. 

– Select the required products to delete 

– Click OK to delete the specified products. 

– The specified products will be deleted and the Delete Products dialog box will 
close. 

Note: The Delete Products dialog box will always appear if 
two or more products are selected. It will also appear if a 
single product is selected if the Always show selection dialog 
option is checked in the Merchandising tab of the 
Configuration module. 

Highlighting Options for Products 
There are two highlighting options available on the Product toolbar. 

 Highlight Product 

 Highlight Selected Product in Tree 

 
 

 

Highlight Product 
in Floor Plan 

If selected, selecting a product placeholder in the Object Browser 
Product Hierarchy will cause the pertinent product to be highlighted 
in the floor plan.  

 

Highlight selected 
item in tree 

If selected, selecting a fixture in the floor plan will cause the pertinent 
product to be highlighted in the Object Browser Product Hierarchy. 

Highlight Product 
Highlight Product allows a user to find a product in the floor plan. The option has to be 
turned on by toggling the icon on the Product toolbar so it is depressed. After the icon 
has been toggled on, highlighting any product in the product hierarchy will cause the 
selected product to be highlighted in the floor plan. The highlighting method will 
depend on setting in the Merchandising tab of the Configuration module. 
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Note: It is recommended that the Highlight Product option 
be left off until needed - leaving it on may have a marginal 
impact on performance in the floor plan. 

Highlight Selected Item in Tree 
Highlight Selected Item in Tree allows a user to select a fixture in the floor plan and have 
it highlighted in the Product Hierarchy in the Object Browser. The option has to be 
turned on by toggling the icon on the Product toolbar so it is depressed. Clicking on the 
product in the floor plan will then cause that product to be highlighted in the hierarchy. 

Note: It is recommended that the Highlight Product in Tree 
option be left off until needed - leaving it on may have a 
marginal impact on performance in the floor plan. 

Configuring Merchandise Behavior 
The way merchandise behaves can be configured in the Configuration module. To access 
the Zones tab, click Options  on the either the Products or Planograms toolbar in the 
Object Browser. 

 

Options This option brings up the Merchandising Tab of the 
Configuration module, allowing users to customize 
their settings. 

This will bring up the Merchandising tab of the Configuration module. Settings in this 
tab can have a significant effect on the way merchandise places. 

 

Full information on each setting can be found in the Configuration Module User Guide, 
but the following basic settings are helpful for new users: 
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Selection Frame 
This frame controls how fixtures are selected for placing merchandise on. Set the 
following: 

 Fixture Selection Method to Standard Selection. 

 Always Show Selection Dialog to On. 

 Select Whole Planogram to On. 

 Sort left-most to On. 

Highlight Frame 
This frame controls how merchandise s highlighted in the floor plan. 

 Set highlight method to Flash. 

Check Rules Frame 
This frame controls the advisory warnings that occur when placing planograms. 

 Set all Check Rules to On with the exception of allow Multiple Profiling. 

Find Product in Tree 
Find in Tree allows users to search for Products in the Product Hierarchy. 

 
 

 

Find This option brings up the Find dialog box, allowing users to 
search for objects in the Product Hierarchy.  

 

Clicking the icon will bring up the Find Product dialogue box. 

 
To use the dialogue box: 

1. Type a text string into the text box 

2. Click on the search Icon 

3. Any products with a name matching the search string will be listed 
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4. To select a product in the hierarchy, highlight it and click the OK button 
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Master Planograms 

Overview of Master Planograms 
Master Planograms are a way of reducing the frequency with which floor plans need to 
be modified and published. They act as placeholders in a floor plan. The floor plan or 
planogram publishing batch processes are then run at intervals to determine if the floor 
plan or planograms need publishing.  If master planograms are present in the floor plan, 
they will have a mapping to an individual planogram. The individual planogram is then 
published in place of the master planogram. As the underlying master planograms 
remain unchanged, this reduces the frequency with which floor plans need to be updated 
and published. 

Overview of General Process 
The basic process for using master planograms is seen below. 

 
A floor plan has been created with master planograms present. A batch process is run at 
regular intervals. 

 The floor plan publishing batch process determines if the floor plan has been 
superseded by a more recent design. If so the floor plan would be published (and 
later made current). If a floor plan contains purely master planograms, the general 
reason for revising the floor plan would be to change the position of those master 
planograms. If the position is not changed, there would be no need for a revised floor 
plan. 

 The planogram publishing batch process identifies the individual planograms 
associated with each master planogram. If it identifies a new or revised planogram 
that has met or exceeded its publish date, the planogram will be published (and later 
made effective). 

The advantage of master planograms can thus be seen: if individual planograms were 
used, the floor plan would need to be updated and republished each time a planogram 
was changed. With this method the floor plan only needs updating when the space 
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allocated to categories/sub-categories is changed. This saves effort in the store planning 
process. 

Placing Master Planograms 
Placing Master Planograms is identical to placing individual planograms. They are 
placed in the floor plan identically to individual planograms. The key difference is that 
master planograms are left in place until the location or amount of space allocated to 
product categories and sub-categories changes. As there is a mapping between master 
planograms and individual planograms, each time planogram publishing is executed, the 
specific individual planogram associated with each master planogram is published. If the 
individual planograms are updated, the updated versions will publish with no need to 
publish a revised floor plan. 

Configuring Master Planogram Functionality 
Master Planograms are placeholders placed in a floor plan. The planogram definition 
contains a number of fields that can be compared with similar fields in the individual 
planograms. If the fields in both the master planogram and the specific individual 
planogram match, the specific individual planogram will be substituted for the master 
planogram during the Planogram Publishing process. Other fields are used for more 
aspects of planogram functionality. For example the Publish date is used during the 
planogram publishing process to determine when it is appropriate to publish a 
planogram. Similarly, the status shows where the planogram is within its business life 
cycle. 

Note: In order for the Master Planogram functionality to 
work, considerable configuration has to be carried out 
during the implementation of the software. If this has not 
been done, it will not be possible to use Master Planograms. 
Describing how to configure the functionality is outside the 
scope of this help file. The information is available in a white 
paper on My Oracle Support. 

Information Used in Master Planogram Functionality 
Some information associated with a planogram design is associated with the master 
planogram functionality. This can be seen on the Details and Properties tab of the 
Planogram Design dialog box accessed in the Merchandiser module. 



 Overview of Master Planograms 

 Master Planograms 449 

Details Tab 

 

Information Significance 

Master 
Planogram 

This is a flag indicating whether the planogram design is a mater planogram or an 
individual planogram. 

Client Code 

This is a code generally brought in during planogram import. Different revisions 
of the same planogram will have the same client code, enabling them to be 
identified. This field is not directly involved with the master planogram 
functionality, but enables the imported planograms in the MSP database to be 
related to the original information in the third party planogram design software. 

Status 

This indicates where the planogram is in its business life cycle. A range of statuses 
are possible depending on the retailer’s business processes.   
If planograms are brought in by import, one option is for the status for an 
individual planogram to be Authorized. As the Publish Date and Effective Date 
are met and exceeded for individual planogram, the status will successively 
change to Published and then Current. 
Planogram designs could also be brought in from the planogram design software 
already at Current status as an indication the design has been approved for 
service. 
Finally, it is possible to configure additional planogram statuses in the 
Administration module. (See the Oracle Retail Macro Space Planning Administration 
User Guide for details). It would be possible to configure an entirely separate 
status for master planograms. 

Note: it is expected that there will only be one 
version of a master planogram for a specific 
category or sub-category in the database. This is 
because it acts as a placeholder and there is no 
need to modify the design. 

Publish Date  
This is the assigned date at which the status of the planogram will change from 
Authorized to Published. It is generally changed automatically by the planogram 
publishing batch process. 
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Information Significance 

Effective Date 

This is the assigned date at which the status of the planogram will change from 
Published to Current. There is no standard process for this in Macro Space 
Planning. It requires an implementer to set a mechanism like a stored procedure 
execute at intervals by a batch process. 

Family Code 

This is a code indicating the general family the planogram belongs to. It could 
indicate (for example) whether the planogram belongs to a Value, Standard or 
Premium range or products. Alternatively it could indicate that the planogram is 
designed for a convenience store, Metro store, Supermarket or Super Store. The 
nature of Planogram Families will vary from retailers to retailer. 

Assortment 
Code 

Many retailers create specific assortments for particular demographics, types of 
retail outlet and so on. This field holds the code identifying that assortment. It 
relates back to the retailer's category management system. 

Properties Tab 

 

Information Significance 

Parent 
Product 

This indicates the node in the product hierarchy that is the parent for all products in 
the planogram. It will normally be a category or subcategory. 

Size This is the overall size of the planogram. 

Number of 
Bays 

This is the number of bays (fixtures) that the planogram is designed to be placed on. 

Overview of Selection Method for Individual Planograms 

Note: The mapping process is configurable, so this section 
illustrates the process for the stored procedure supplied with 
the application. 

The basic flow for selecting the individual planogram related to a master planogram is 
shown in the flowchart below. The core of the process is a stored procedure which is 
referenced by other parts of the application - for example the batch process for 
publishing planograms. This stored procedure is customizable. Providing the basic 
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parameters are left unchanged it can be modified to meet retail chain specific 
requirements. 

Note: Individual aspects of the process will be discussed in 
more detail later. 

 

Steps in Selection Method 

Note: This is a simplified form of the flowchart used to 
explain the basic concepts. The information used will 
obviously very from retail chain to retail chain. 

1. Finding Planograms of a Common Family 
The first stage of finding an individual planogram is to list all planograms that 
belong to the same family that has been assigned to the Master Planogram. This 
family is identified in the Family Code field of the Details tab of the Planogram 
Design dialog box. 

2. Find Product Category Master Planogram Belongs To 

The next stage is to find the subset of individual planograms that belong to both the 
same Family and Product Category as the Master Planogram. The Product Category 
is identified in the Parent Product field of the Properties tab of the Planogram Design 
dialog box. 

3. Find Assortment 

The sub-set of individual planograms can be further reduced in size by looking for 
planograms with a product assortment that matches the Master Planogram. This 
information is held in the Assortment Code field of the Details tab of the Planogram 
Design dialog box. 
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4. Find Dimensions 

The Master Planogram will have been placed on one or more fixtures. The lengths 
those fixtures will be summed to find the overall length for the planogram - for 
example 12 feet.  The maximum depth and height will also be used. The subset of 
individual planograms is further reduced to match the cumulative dimensions of the 
fixtures the master planogram has been placed on. This information is displayed in 
the Size field of the Properties tab of the Planogram Design dialog box. 

5. Find Number of Bays 

As part of the continuing process of reducing the number in individual planograms 
in the sub-set matching the data for the master planogram, the number of fixtures the 
master planogram has been placed on is compared to the number of bays the 
individual planogram is designed for. This enables the software to differentiate 
between a 12 foot planogram made up for 3 x 4ft bays and  a 12 foot planogram made 
up for 4 x 3ft bays. The number of bays is displayed in the Number of Bays  field of 
the Properties tab of the Planogram Design dialog box. 

Note: This check is only used if more than one planogram of 
the required length exists. 

6. Identify Revision 

The final stage in identifying the individual planogram to use relative to the Master 
Planogram is to look at the Publish Date and Effective Date. These are used to 
determine whether an existing planogram should be used or replaced by a newer 
one. If the Publish Date has been met or exceeded, running the batch process will 
result in the planogram being published. 

Note: If no specific individual planogram could be 
identified, this should be identified by a process set up by 
the retailer. Failure to do so may result in problems with the 
replenishment system. 

Example of Use 
The following simplified example shows the Master Planogram functionality in use. 

 
1. Version 1 of the floor plan is in service.  



 Configuration for using Master Planograms 

 Master Planograms 453 

This version of the floor plan has been in service for some time. 

2. Batch Processes Execute on 7th June. 

The Floor Plan batch processes executes on the 7th  June.  It does not find a more 
recent floor plan with a Publish or effective date that has been met or exceeded, so 
the current version of the floor plan remains in force. The Planogram Publishing 
batch process also executes. It identifies any individual planograms associated with 
Master Planograms that have Publish Dates or Effective Dates met or exceeded and 
with publishes them or makes them current. 

3. Batch Processes Execute on 14th June. 

The Floor Plan batch processes executes again on the 14th June.  It still does not find 
a more recent floor plan with a Publish or effective date that has been met or 
exceeded, so the current version of the floor plan remains in force. The Planogram 
Publishing batch process also executes. It identifies any individual planograms 
associated with Master Planograms that have Publish Dates or Effective Dates met or 
exceeded and updates as required. 

4. Batch Processes Execute on 21st June. 

The Floor Plan batch processes executes again on the 21st June.  The floor plan 
publishing process finds another version of the floor plan with a Publish Date that 
has been met or exceeded, so the floor plan is published. The Planogram Publishing 
batch process also executes. It identifies any individual planograms associated with 
Master Planograms that have Publish Dates or Effective Dates met or exceeded and 
updates as required. 

On the 7th  June and 14th June the floor plan did not require modification and thus the 
use of master planograms streamlined the store planning process. 

Creating an Example Master Planogram 
Master Planograms can be created in a number of ways. These include: 

Creation Method Source of Information Responsibility  

Import from third party 
planogram software 

Oracle documentation on planogram import Implementer 

Create using SQL statement 
Oracle white paper on creating master 
planograms on My Oracle Support Implementer 

Create in Merchandiser Merchandiser Help File User 

Configuration for using Master Planograms 
This information is primarily for use by Administrators. It is intended to provide a point 
of reference for trouble shooting. 

Configuration in the Database 

Class Store Assortment Table 
For the master planogram process to work, some configuration needs to be done directly 
in the database. The table is the Class Store Assortment table. This configuration can 
only be carried out by an administrator with direct access to the database. 

Note: See the Oracle Retail Macro Space Planning Data Model 
for full details of the Class Store Assortment table. 
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This requires populating with several pieces of information. 

Column Description 

PRD_ID 
The identifier for the node in the product hierarchy that is the parent 
for the products in the master planogram. 

STR_ID 
The identifier for the store in which the master planogram will be 
placed. 

CSA_ASSORTMENT_CODE 
The information held in the Assortment Code field of the master 
planogram. 

Store Specific Implementation Dates 
Store specific implementation dates allow the setting of a new planogram to be spread 
across a range of dates if required. This information is held in the POG Store Date table. 
Store specific dates should not be used if the generic effective and expiry dates for an 
individual planogram do not cover the entire life cycle of the planogram across all stores. 
If the generic effective and expiry dates do not cover this life cycle, it is possible to have 
gaps in the master planogram mapping where a store specific effective date is later than 
the generic expiry date of the planogram's previous revision. In this event no individual 
planogram will be mapped by the planogram publishing or printing processes. 

Note: See the Oracle Retail Macro Space Planning Data Model 
for full details of the POG Store Date table. 

Configuration in the Administration Module 

Planogram Publishing 
Planogram Publishing needs to be configured as following using the Planogram 
Publishing Configuration dialog box accessed from the File menu in the Administration 
module. The changes required are on the Output tab as the Template, Collation and 
Validation tabs can be configured when the Immediate Planogram Publishing 
functionality is invoked from the Planner and Merchandiser modules or from In-Store 
Space Collaboration. 
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Note: For the Master Planogram functionality to work, the 
output format must be set to Organize by Store. 

Configuration Module 
The Merchandising tab of the Configuration Module has a series of Check Rules. These 
govern the warnings given when planograms will be placed. Because the master 
planogram has to have a set of dimensions and a specific number of bays, if the master 
planogram (which is only a placeholder) is placed on different number of fixtures or on a 
fixture of a different dimension to the one is created on, a warning might result. 
Accordingly, when placing master planograms, it is often best to deselect the Planogram 
Length, Planogram Depth and Planogram Height warnings. 
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Quick Reports 
Because most users will not be able to access the database, it may be necessary to set up 
quick reports to show the data in specific tables for experimenting with Master 
Planogram. This example of a Quick Report shows the contents of the Class Store 
Assortment table. This enables someone experimenting in a floor plan to see the 
information held in the database and confirm it is appropriate for the planograms 
involved. 

 

Note: For information on the Custom SQL  table concerned 
setting up Quick Reports, see the Oracle Retail Macro Space 
Management Data Model. 
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Manually Running the Master Planogram Functionality 
There are two ways of seeing the master planogram functionality in action: using the 
Immediate Planogram Publish functionality or using the Print Planogram functionality. 
Both ways are described below, together with some simple trouble shooting suggestions. 

Placing the Master Planogram 
The first stage is to place the master planogram. This needs to be placed in a floor plan 
within a store specified in the Class Store Assortment table.  The master planogram 
functionality will reference this table, so if the store is not referenced within it, the master 
planogram functionality will not map to an individual planogram. The master 
planogram can be placed on one bay, in which case the one bay variant of the individual 
planogram will be published when required. Or it can be placed on two bays - in which 
case the two bay variant will be published. 

Note: The information populated into the object grid is 
determined by Custom SQL held in the Custom SQL  table. 
This custom SQL can be modified so only display master 
planograms pertinent for the active floor plan. For 
information on the custom SQL table see the Oracle Retail 
Macro Space Planning Data Model. 

Print Planogram 
The Print Planogram functionality is accessed from the File menu in the Planner and 
Merchandiser modules (Print > Print Planograms). This will bring up the Print 
Planogram dialog box. Ensure that the value in the Floor Plan Date field is set beyond 
the Publish Date of the planogram. The master planogram in the floor plan will have 
been substituted for by an individual planogram - the functionality having mapped the 
correct individual planogram to the master planogram. On clicking Print, the individual 
planogram will print to the designated printer. 
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Printing will not change the status of the printed planogram. 

Publishing the Planogram 
Publishing the planogram will change the status of the planogram from Authorised to 
Published (if the Publish date is today's date or in the past).  The dialog box is called from 
the File menu > Publish Planograms. Again the master planogram will be mapped to an 
individual planogram. On clicking OK, the individual planogram will be published to 
the Publish Planogram folder (specified in the Directories tab of the Configuration dialog 
box), confirming the master planogram has mapped correctly. 
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Detailed information on what was published will also be in the Publish Planogram Log 
table in the database. Other information may be found in the Error table. (See the Oracle 
Retail Macro Space Planning Data Model for more information.)  Users without access to the 
database will need access to reports showing the contents of those tables. 

After Publishing the Planogram 
When the planogram is published, that informs the store both of the planogram design 
and that it is to be implemented in the future. It is also an indication that the required 
merchandise needs to be ordered through the replenishment system. The date that the 
planogram is to be put into service is the effective date. 

Implementing the Planogram 
When the planogram is published, that informs the store both of the planogram design 
and that it is to be implemented in the future. It is also an indication that the required 
merchandise needs to be ordered through the replenishment system. The date that the 
planogram is to be put into service is the effective date. This can be in one of two places 
in the software: in the Planogram design dialog box and in the Planogram Store Date 
table. 
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Planogram Design Dialog Box 

 
The effective date is shown in the Effective Date field. This is the global effective date 
and if no information pertinent to the planogram is in the Planogram Store Date table, 
the planogram will be put into service simultaneously across the entire retail network. 

Planogram Store Date Table 
This table can be used to override the global effective date assigned to the planogram. 
This holds the name of the planogram, the stores it is designed for and the date it is to be 
implemented. In the simple example below, the planograms are designed to go into 
service at one week intervals. This table would typically be populated by an import 
process. It holds a set of store specific effective dates. 

 
The planogram publishing functionality references this table during publishing. If there 
is no Store Specific Effective Date for the planogram, the planogram is published when 
its general Effective Date is reached. If there is a Store Specific Effective date, this 
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overrides the general effective date and the planogram is published using the store 
specific date. 

Note: For more information on the Planogram Store Date 
table, see the Oracle Retail Macro Space Management Data 
Model. 

Signaling the Execution Date to the Store 
Signaling the planogram implementation date to the store requires a retailer specific 
method. This would normally be set up on implementing the software. 

Master Planograms and Batch Processes 
Master Planograms are intended to be a way of reducing the churn in floor plans. Instead 
of continually issuing updated floor plans when individual planogram designs are 
changed, the floor plan would have master planograms in it. These master planograms 
would not require updating until the space allocated to categories and sub-categories is 
changed. Retailers would run a planogram publishing process at intervals; typically 
through a batch process.  The basic stages are as follows: 

 

Configure Planogram Publishing 
The planogram publishing process is configured in the Administration Module using the 
Planogram Publishing Configuration dialog box. 
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Note: See the Oracle Retail Macro space Management 
Administration Module User Guide for full details of how to 
configure this dialog box. 

This determines the location planograms will be published to and the format they will be 
published in. 

Place Master Planograms 
Placing Master Planograms is identical to placing individual planograms. They are 
placed in the floor plan identically to individual planograms. The key difference is that 
master planograms are left in place until the location or amount of space allocated to 
product categories and sub-categories changes. As there is a mapping between master 
planograms and individual planograms, each time planogram publishing is executed, the 
specific individual planogram associated with each master planogram is published. If the 
individual planograms are updated, the updated versions will publish with no need to 
publish a revised floor plan. 

Batch Process 
Although planograms can be manually published, the most usual process is to publish 
using a batch process run at regular intervals. This identifies planograms that require 
publishing and publishes them in the required form to the required location.  Running 
planogram publishing as a batch process requires and MSP tool called Batchrunner.exe. 
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This can be run manually or through a third party scheduling tool. The operation can be 
customized using command line switches. 

Note: See the Oracle Retail Macro Space Management 
Administration Module User Guide for full details of how to 
use Batchrunner.exe. 

Verifying Results 
After the planogram has been published via the batch process, the results should be 
verified to see all planograms have been published successfully. There are two ways of 
doing this - these should be set up during implementation. The most common are: 

Publish Planogram Log 
All results from publishing planograms are written to the Publish Planogram Log table. 
 During implementation a report should be configured to report on these results. This 
should include: 

 Any planograms that have failed to publish  

– For a variety of reasons some planograms may fail to publish. These should be 
listed in the report and the reasons identified. Failure to publish planograms may 
mean that they will not be executed at the required time. 

 Any Master Planograms that have Published  
– Each master planogram should have a specific individual planogram associated 

with it that should publish when the planogram publishing is run. If there is no 
associated specific individual planogram, or if any associated specific individual 
planogram does not meet the criteria to be published, the master planogram will 
be published instead. Any master planograms that have published should be 
listed and the reason investigated. 

Note: For full details of the Publish Planogram Log table, see 
the Oracle Retail Macro Space Planning Data Model. 
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35 
Planograms on the Object Browser 

Factors Affecting Planogram Operations 
A number of factors affect planogram placement. 

Object Browser and Object Grid 
Planograms can either be added from the Object Browser  or Object Grid . Which one 
will result in more efficient product addition depends both on the situation it is being 
used in and user preferences. 

Active Date 
The active date can be seen at the top of the Object Browser. 

 
If the MERCH_TREE_EFFECTIVE_DATE system variable (Administration module) is 
set to on, this will place constraints on what products can be added: 

 If the Effective Date of the planogram is after the Active date of the floor plan, the 
planogram cannot be placed because it will not be available when the floor plan is 
implemented. 

 If the Expiry Date of a planogram is before the Active Date of the floor plan, the 
planogram cannot be placed because it will no longer be available when the floor 
plan is implemented. 

Fixture Selection 
There are two possible fixture selection methods. These can be set in the Merchandising 
Tab of the configuration module - accessed by clicking the Properties Icon on the 
Products toolbar of the Object Browser. 

 
There are two methods. Standard Selection  is suggested for new users. 
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Grouping 
When the fixtures were placed in the floor plan, if more than one fixture was placed at 
one (for example if a gondola was placed) it is possible to select all fixtures that were 
placed together, or individual fixtures. This is controlled by the Grouping option on the 
Fixturing toolbar. 

 
It is recommended that Grouping be turned Off while placing products. That way, 
individual fixtures can be selected. If Grouping is left On, when an individual fixture is 
selected from a gondola, all fixtures and fittings in that gondola will be simultaneously 
selected. 

Fixtures and Fittings 
The floor plan can contain a mixture of fixtures and fittings. Only fixtures can accept 
merchandise. If an attempt is made to merchandise a fitting, a warning will appear in the 
command line. 

 

Sort Left Most 
When selecting fixtures, if selecting by individual left clicks, the fixtures are added to the 
selection in the sequence they are selected. If the fixtures are selected by a Windows or 
Crossing selection box, the fixtures in the selection are ordered in the sequence they were 
placed in the drawing. For multi-bay planogram placement it is generally necessary to 
place the bays in a specified sequence; functionality called Sort Left Most can be 
activated from the Merchandising tab of the Configuration module. (This tab can be 
accessed by clicking the Options icon on the Planogram toolbar on the Object Browser). 

 
The selected fixtures will them be populated left most first. 
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The left-most fixture is based on when the fixtures are viewed from the front. The 
apparent front direction will change when the back face of a gondola is considered 
relative to the front. 

Planogram Reversal 
Some multi-bay planograms are designed to be viewed from a specific direction. How 
the bays are placed depends on the traffic flow along an aisle. 

 
When aisles are drawn, they can be used to show the direction of traffic flow along an 
aisle. It is from the head of the aisle (denoted by its name or number), to the other end. In 
the above diagram, traffic predominately flows from right to left. If it is desired to place a 
3 bay planogram with Bay 1 the first to be viewed by shoppers, then how it is placed will 
depend on which side of the aisle it is placed. If it is placed on the island gondola (Bays 
B-1, B-2 and B-3) with sort left most on, it can be placed in its normal sequence. 

If i t is placed on the wall gondola (Bays A-1, A-2 and A-3) the effect of sort left most will 
be to place the first bay at A-1, where it will be the last bay to be seen by a customer 
following the normal direction of travel along an aisle. This can be corrected by using the 
Reverse Planogram option on the planogram toolbar. 
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Reverse Planogram Placement 
Direction 

Reverse the sequence the planogram bays are 
placed in. 

The effect of this is to reverse the sequence the bays are placed, with Bay 3 being placed 
first. Bay 1 will thus end up on fixture A-3 and will be the first bay seen by a customer. 

Check Rules 
Check Rules are used when planograms are placed. They provide a series of warnings if 
a planogram is being placed on inappropriate fixtures. The selection of the check rules is 
in the Merchandising tab of the Configuration module (accessed from the Options button 
on the Planogram toolbar). 

 
Depending on the selections made, warnings will be given during planogram placement 
if the fixtures do not match the ones the planogram was designed from. 

 

Selecting More or Less Fixtures than Bays 
Multi-bay planograms are designed for a specific number of fixtures. If more or less 
fixtures are selected, the following will happen. 

 If fewer fixtures are selected and the planogram is being placed in normal sequence, 
bays will be placed in number order until all selected fixtures are populated. For a 
four bay planogram with three fixtures selected, bays 1, 2 and 3 will place, with bay 4 
not being placed. 

 If less fixtures are selected and the planogram is being placed in reversed sequence, 
bays will be placed in reverse number order until all selected fixtures are populated. 
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For a four bay planogram with three fixtures selected, bays 4, 3 and 2 will place, with 
bay 1 not being placed. 

 If more fixtures are selected, than there are bays in the planogram, the last bay to be 
placed will be repeated. For a four bay planogram being placed on five fixtures, the 
bay sequence will be bay 1, bay2, bay 3 bay 4, bay 4. If the planogram is placed in 
reverse, the bay sequence will be bay 4, bay3, bay 1 bay 1, bay 1. 

Exploded Planograms 
Planograms can be places in two main forms: 2D (imploded) and 3D (exploded). In the 
diagram below, the planogram on the left is in 2D form and the one on the right is in 3D 
form. 

 
Planograms placed in the planner module are always placed in 2D form, with no details 
of products or shelves visible. Planograms in the Merchandiser module can be toggled 
between 2D and 3D form. If exploded to 3D form in Merchandiser, the planograms will 
no longer be directly visible in Planner. 

Visibility of Exploded Planograms 
If products are placed at Display Style level in Merchandiser (or if Planograms are 
exploded to 3D form), these forms of merchandise will not be directly visible in Planner. 
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Macro Space Management has the capacity to create custom KPI's. In the above example, 
a KPI has been created to show fixtures populated with display styles and exploded 
planograms. In the floor plan to upper right, the fixtures are apparently unpopulated. 
When the KPI has been used (lower right), the populated fixtures become visible. 

Master Planograms 
Master planograms are a way of reducing the churn in floor plans. They act as 
placeholders and can have specific individual planograms mapped to them. When 
planograms are printed or published, the specific individual planogram is output. This 
removes the need to continually update the floor plan every time planograms are 
changed. For more information see the section on Master Planograms. 

Adding Planograms from the Object Browser 

Sequence of Actions Required 
There are two potential ways of adding planograms. The first is to select the required 
fixture first. 

1. Select required fixture or fixtures. 

2. Select Planogram in Hierarchy in Object Browser or in List in Object Grid 

3. Click the Add icon 

The alternative is to select the planogram first. 

1. Select Planogram in Hierarchy in Object Browser or in List in Object Grid 

2. Click the Add icon 

3. Select required fixture or fixtures. 

Either way is valid. This example will use the latter option of selecting the planogram 
first and the fixtures last. 
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Adding Planogram Placeholders 

 
Adding planograms can be carried out as follows: 

 
 

 

Add Planogram Planograms can be also be added by dragging and 
dropping. 

 

Reverse Planogram Placement 
Direction 

If toggled on, this reverses the sequence the 
planogram bays are placed. 

1. Select the Planograms Button on the Merchandising tab of the Object Browser 

2. Decide if Planogram is to be placed Normally or Reversed 

When multi-bay planograms are designed, they sometimes take traffic direction into 
account. 
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If Planner aisles have been drawn, these can be used to identify the predominant 
traffic flow in the real life aisle. In the above example traffic is flowing from right to 
left. If Sort Left Most is On (Merchandising tab in Configuration Module) the selected 
fixtures will be populated with the left most fixture first (as viewed from the front of 
the fixture. 

In the above example, if the planogram is to be placed match its flow instructions, it 
can be placed normally on the lower (island) gondola, but must be placed reversed 
on the upper (wall) gondola. 

3. Select Reverse Planogram if Required 

If i t is necessary to reverse the planogram, the Reverse Planogram option must be 
toggled On  by depressing the icon on the toolbar. 

Note: When the Reverse option is no longer needed it should 
be toggled off. This will prevent planograms being placed 
reversed when not required. 

4. Select Required Planogram from Hierarchy 

The initial stage is to select the required planogram from the hierarchy. In  this 
example, the 2 Bay Tilda Rice Planogram is to be added. Useful information is 
displayed in the properties window. 

Note: If planograms cannot be found by means of a manual 
search, there is a Find option available. (See below). 

5. Select Add Option from Toolbar 

The next stage is to click Add Planogram on the toolbar. 

6. Selecting Fixtures 

On clicking Add Planogram, the command line in Planner will prompt users to select 
fixtures. 

 
These can be selected by standard AutoCAD methods including left clicking 
individual fixtures or using window and crossing selection boxes. In this instance, 
four fixtures have been selected be left clicking, the information being reflected in the 
command line. 
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On completing the selection with a right click (the standard AutoCAD way of 
finishing selecting objects) the selected fixtures will be validated against information 
in the planogram design. 

7. Check Rules 

The check rules are set in the Merchandising Tab of the Configuration Module. This 
can be accessed by clicking Properties on the Planogram toolbar. This will bring up 
the Merchandising Tab from the Configuration Module. This allows the Check Rules 
to be set - settings being individual to each user. 

 
Note: See the Configuration Module Help File  for detailed 
information on these settings. 

These settings determine which validation rules are applied. Any violations come up 
in the Planogram Placement Errors dialog box, otherwise the planogram is placed. 

8. Planogram Placement Errors  

 
If the validation process identifies problems, the Planogram Placement Errors dialog 
box will appear. This will identify problems based on the check rules selected. The 
user then has two options: 

– Click OK. The planogram will not be placed. 

– Click Ignore. The warnings will be overridden and the planogram placed. 
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Store planners should exercise caution when overriding the warnings. This will 
result in a planogram being placed on an inappropriate fixture in the real life store. 
Some of the potential consequences of this include: 

– Planogram being placed on fixture of different dimensions to what it was 
designed for. The number of facings and total quantities of products on the shelf 
could be incorrect. For example, if there are fewer products on the shelves than 
the planogram designer intended, there could be frequent out of stocks and loss 
of sales. 

– Planograms being placed on inappropriate fixtures - for example by overriding 
temperature warnings. If the planogram is designed for a chiller unit at standard 
chill temperature (0 - 1 degrees centigrade) and it is placed on a chiller set to a 
different temperature, product life should be shortened and losses incurred by 
having to throw away spoiled produce. 

– Turning off the Multiple Profiling warning could result on two planograms 
being placed on a fixture when only one was intended. 

– Turning off the Split Planograms warning could result in inappropriate 
planogram placement. For example a 2 bay planogram could be placed either 
side of a 3 feet wide pillar, impacting on sales for that planogram. 

9. Planogram Placement 

If there are no check rule violations, or if the Check Rule warnings are overridden, 
the planograms will be placed in the floor plan. 

 
At the same time as the fixtures are populated, they will annotate with information 
on what planograms have been placed. 

Note: Annotation is controlled using the Text Styles option 
accessed from the Planning Menu in the Administration 
Module. 

There are two forms of annotation in the above example: 

– Profile Annotation: These are numbers identifying the Bay of the planogram. 
These numbers can be used in conjunction with any aisles drawn in the floor 
plan to determine whether a planogram has been placed in normal or reversed 
order. 

– Planogram Annotation: This is information identifying the planogram. A 
common way of doing this is via the planogram name. 
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Placing Individual or Master Planograms 
There are two options for placing planograms - master planograms and individual 
planograms. 

 Master Planograms 

 Master Planograms act as placeholders. They can be placed on fixtures and then will 
remain in place. The intent is to stop churning of floor plans each time individual 
planograms are updated. 

 Individual Planograms 

 Individual planograms can be placed by themselves. Alternatively, if master 
planograms are in use, they can be mapped to those master planograms. If master 
planograms are in use, then when planograms are published the individual 
planograms mapped to each master planogram in a floor plan will be published. 

In the example below (simplified for the purposes of this help file) there are a series of 
individual planograms. There are three types of planogram: Value, Standard and 
Premium. And they come in three lengths: 8ft, 12ft and 16ft. There are three master 
planograms supplied: Value, Standard and Premium.   

 
If master planograms are in use, when planograms are published (via the MSP 
publishing process), the following will happen: 

 If the Value Ice Cream master planogram has been placed on two 4ft fixtures, the 8ft 
Value Ice Cream planogram will be published. 

 If the Premium Ice Cream Master Planogram has been placed on four 4ft fixtures, the 
16ft Premium Ice Cream planogram will be published. 

As individual planograms are progressively updated, providing the mapping remains 
between master planogram and individual planograms, the updated individual 
planograms will be published (via the MSP publishing process). This reduces the need to 
keep continually updating floor plans when planograms are updated. 
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Note: For more information see the section on Master 
Planograms 

Adding Planograms from the Object Grid 
The list of merchandise that is populated to the Object Grid depends on the Custom SQL. 
This can be configured by Administrators directly in the database to return either 
products or planograms. (It is not possible for the Object Grid to return both sorts of 
results in Planner). Generally, the Planner module is configured to return planograms 
corresponding to the node selected in the product or planogram hierarchy. In the 
example below, clicking the Carbonated Drinks node in the Object Browser has caused 
the Object Grid to populate with planograms associated with that node.  

 

Note: The planograms returned are all those whose products 
have that node in the hierarchy as a common parent. 

Sequence of Actions Required 
There are two potential ways of adding products. The first is to select the required fixture 
first. 

1. Select required fixture or fixtures. 

2. Select Product in Hierarchy in Object Browser or in List in Object Grid 

3. Click the Add icon 

The alternative is to select the product first. 

1. Select Product in Hierarchy in Object Browser or in List in Object Grid 

2. Click the Add icon 

3. Select required fixture or fixtures. 

Either way is valid. This example will use the latter option of selecting the product first 
and the fixtures last. 

Adding Planograms 
Adding planograms can be carried out as follows: 

1. Select the Planograms Button on the Merchandising tab of the Object Browser 

2. Select Required Product Group in the hierarchy. 

The initial stage is to highlight the required product group in the hierarchy. 
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Toggling the Refresh button on in the Object Grid will then populate the Object Grid 
with a list of products associated with that Product Group. This list can be refined 
using the options in the Filter and Sort options in the Object Browser. 

3. Adding the Product 

To add the product, highlight the fixture the product will be added to, highlight the 
required product in the Object Browser and click the Add button. The product will 
then be added. 

 
Note: If a fixture has not been selected, the user will be able 
to select it in the floor plan using standard selection 
methods. 

The selected fixtures will be populated with the product placeholder. 

 
Note: Annotation is controlled using the Text Styles option 
accessed from the Planning Menu in the Administration 
Module. 

Deleting Planograms 
Deleting Planograms can only be done from the Object Browser 
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Sequence of Actions Required 
There are two potential ways of deleting planograms. The first is to select the required 
fixture first. 

1. Select required fixture or fixtures. 

2. Click the Delete icon 

3. Confirm in the delete Planograms dialog box. 

The alternative is to select the delete option first. 

1. Click the Delete icon 

2. Select required fixture or fixtures. 

3. Confirm in the delete Planograms dialog box. 

Either way is valid. This example will use the latter option of selecting the delete option 
first and the fixtures last. 

Deleting Planograms 
Deleting planograms can be carried out as follows: 

1. Select the Planograms Button on the Merchandising tab of the Object Browser 

2. Click the Delete option from the Toolbar 

3. Selecting Fixtures 

On clicking Delete Planogram, the command line in Planner will prompt users to 
select fixtures. 

 
These can be selected by standard AutoCAD methods including left clicking 
individual fixtures or using window and crossing selection boxes. In this instance, 
four fixtures have been selected be left clicking, the information being reflected in the 
command line. 

 
Note: Clicking on the planograms themselves will not be 
effective - deleting planograms requires the user to select the 
parent fixtures for the planograms. Accordingly, users should 
left click on the fixture itself or use window and crossing 
selection boxes that encompass both the planogram and its 
parent fixture. 

On right clicking to complete the selection, the Delete Planograms dialog box will 
appear. 

4. Delete Planograms Dialog Box 

The Delete Planograms dialog box allows users to confirm which planograms to 
delete. 
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 The Radio Button specifying whether to Delete complete instance or Only delete 

from the selected fixtures only applies to planograms. 

– If Delete complete instance is selected, the entire planogram will be deleted, even 
if just a single bay of a multi-bay planogram has been selected. 

– If Only delete from the selected fixtures is selected, only those parts of the 
planogram on the selected fixtures will be deleted. 

Note: Caution should be used when selecting the Only 
delete from the selected fixtures option. This could result in 
some bays of a multi-bay planogram being left in the floor 
plan while others are deleted. 

 Select the required planograms to delete 

 Click OK to delete the specified planograms. 

 The specified planograms will be deleted and the Delete Planograms dialog box will 
close. 

Note: The Delete Planograms dialog box will always appear 
if two or more planograms are selected. It will also appear if 
a single planogram is selected if the Always show selection 
dialog option is checked in the Merchandising tab of the 
Configuration module. 

Highlighting Options for Planograms 
There are two highlighting options available on the Planogram toolbar. 

 Highlight Planogram 

 Highlight Selected Product in Tree 

 
 

 

Highlight 
Planogram in Floor 
Plan 

If selected, selecting a planogram in the Object Browser Planogram 
Hierarchy will cause the pertinent planogram to be highlighted in 
the floor plan.  

 

Highlight selected 
item in tree 

If selected, selecting a planogram in the floor plan will cause the 
pertinent planogram to be highlighted in the Object Browser 
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Planogram Hierarchy. 

Highlight Planogram 
Highlight Planogram allows a user to find a planogram in the floor plan. The option has 
to be turned on by toggling the icon on the Planogram toolbar so it is depressed. After 
the icon has been toggled on, highlighting any planogram in the product hierarchy will 
cause the selected planogram to be highlighted in the floor plan. The highlighting 
method will depend on settings in the Merchandising tab of the Configuration module. 

Note: It is recommended that the Highlight Planogram 
option be left off until needed - leaving it on may have a 
marginal impact on performance in the floor plan. 

Highlight Selected Item in Tree 
Highlight Selected Item in Tree allows a user to select a planogram in the floor plan and 
have it highlighted in the Planogram Hierarchy in the Object browser. The option has to 
be turned on by toggling the icon on the Planogram toolbar so it is depressed. Clicking 
on the planogram in the floor plan will then cause that planogram to be highlighted in 
the hierarchy. 

Note: It is recommended that the Highlight Planogram in 
Tree option be left off until needed - leaving it on may have 
a marginal impact on performance in the floor plan. 

Reverse Planogram 
Some multi bay planograms are designed for being viewed from a specific direction of 
travel: left to right or right to left. The predominant direction of travel can be identified in 
an aisle. Based on this direction of travel and the side of the aisle chosen, the planogram 
may need to be placed in normal or reversed sequence. 

 
Reversing Planogram is carried out by toggling the Reverse Planogram option in the 
Planogram toolbar On or Off.  

 If toggled Off, planograms will place in normal bay sequence. 

 If toggled On, planograms will place with the bays in reverse sequence. 
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Reverse Planogram Placement 
Direction 

Reverse the sequence the planogram bays are 
placed in. 

Find Planogram in Tree 
Find in Tree allows users to search for Products in the Product Hierarchy. 

 
 

 

Find This option brings up the Find dialog box, allowing users to search for objects in the 
Planogram Hierarchy.  

 

Clicking the icon will bring up the Find Product dialogue box. 

 
To use the dialogue box: 

1. Type a text string into the text box 

2. Click on the search Icon 

3. Any planograms with a name matching the search string will be listed 

4. To select a planograms in the hierarchy, highlight it and click the OK button 
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36 
Planogram Substitution 

Configuring Access to the Planogram Substitution Functionality 
Access to the planogram substitution functionality is configured in the Administration 
Module. Only users with access to the Administration module will be able to configure 
access to the Planogram Substitution functionality. 

The steps can be summarized as follows: 

User Group Role 
The User Group the User belongs to (accessed from the Security menu > Functional 
Security dialog box > User Groups tab in the Administration Module) must have the 
Admin User role assigned. 

 

Add User Group to Planogram Substitution Command Group 
While still in the Functional Security dialog box, switch to the Group relationships tab. 



Planogram Substitution Technicalities 

484 Oracle Retail Macro Space Management 

 
The User Group the User belongs to must be a member of the Planogram Substitution 
command group. 

In addition, the permissions must also be set (right click menu) for that User Group. 

 
When the above actions have been carried out, specific users will have been assigned the 
right to access the Planogram Substitution Functionality in the Planner Module and to 
run substitutions in the currently active floor plan. 

Planogram Substitution Technicalities 

Forms of Planogram Representation 
There are three forms that planograms can take. 

 2D Planogram (Placeholder) 

 3D planogram (called 2.5 D in the Merchandiser Module). 
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 3D with Product Items (Full Detail). 

These appear in the Merchandiser module as follows: 

 
A 2D planogram is purely a placeholder. A 3D planogram (2.5 D in Merchandiser) shows 
the shelves and a simple product block to show the shelves are occupied. A 3D 
planogram with Product items shows the shelves, together with full  details of the 
products. 

Planograms can only be placed in 2D form in the Planner module and in In-Store space 
Collaboration. Users in the Merchandiser module have the option to place in 2.5D or 3D 
form (depending on settings in the Merchandising tab of the Configuration Module) and 
can explode 2D or 2.5D planograms to the 3D form. 

Planograms are only visible in the Planner module if they are in 2D form. Planograms in 
2.5D or 3D form will not be visible (but can be indicated by means of a KPI). 

The PLANOGRAM_SUBSTITUTION_PROCESS_EXPLODED System Variable 
The PLANOGRAM_SUBSTITUTION_PROCESS_EXPLODED system variable has a 
significant impact on the way planogram substitutions are carried out. It can be set to 0, 
1, 2, 3 or 4 in the Administration Module (General menu). 

System Variable Values 

System 
Variable 

Description 

0 Only planograms in 2D form will be substituted - with planograms in 3D form being 
ignored. The substituted planograms will be placed in 2D form. No information on the 
planograms that have been ignored for substitution will be written to the Planogram 
Substitution Log. 

1 Only planograms in 2D form will be substituted - with planograms in 3D form being 
ignored. The substituted planograms will be placed in 2D form. Information on the 
planograms in 3D form that have been ignored for substitution will be written to the 
Planogram Substitution Log. 



Planogram Substitution Technicalities 

486 Oracle Retail Macro Space Management 

System 
Variable 

Description 

2 Planograms in 2D form will be substituted with planograms also in 2D form. 
Planograms in 3D and 2.5D form will be placed in 2D form when substituted. 

3 3D and 2.5D planograms will be substituted by 2D planograms. A warning will be 
written to the Planogram Substitution Log identifying the 3D and 2.5 D planograms that 
were placed in 2D form during the substitution. 

4 Planograms in 3D form will be substituted with planograms also in 3D form. 
Planograms in 2D form will be placed in 3D form when substituted. Planograms in 2.5D 
form will be replaced by a 2D form if that is the way the planogram design has been 
defined. It will be replaced by a 3D form if the planogram design is in 3D format. 

Examples of Planogram Substitution 
Planogram Substitution can come in many forms. This allows users complete flexibility 
in selecting planograms to be substituted and defining the planograms that are to be 
inserted as their replacements. 

Note: A number of examples are given below - in practice 
the validity of each substitution will be determined by rules 
selected on the rules tab of the Planogram Substitution 
Definition dialog box. For example, if the 'Length' rule is off, 
lengths will not be validated and planograms of unequal 
lengths can be substituted. 

One to One 
The simplest form of planogram substitution is a 'one to one' substitution. One 
planogram of a specified length is replaced by another planogram of equal length. 

 
In the above example, the 12 foot planogram 'B' has been replaced with another 12 foot 
planogram 'C'. 

One to Many 
Another form of planogram substitution is a 'one to many' substitution. One planogram 
of a specified length is replaced by two or more planograms whose combined lengths are 
the same as that of the planogram they are replacing. 

 
In the above example the 12 foot planogram 'B' has been replaced by the 4 foot 
planograms 'D', 'E' and 'F' . 

Many to One 
In Many to One planogram substitutions, several planograms are selected and replaced 
by a single planogram equal in length to the sum of the lengths of the planograms it is 
replacing. 
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In the above example, the 8 foot planogram 'A'  and the 12 foot planogram 'B' are to be 
replaced by the single 20 foot planogram 'G'. 

Many to Many 
A 'Many to Many' planogram substitution occurs when multiple planograms are selected 
for replacement and are substituted for by multiple planograms occupying the same 
length as the planograms they are replacing. 

 
In the above example, the 8 foot planogram 'A'  and the 12 foot planogram 'B' are to be 
replaced by the 4 foot planogram 'H' and the 16 foot planogram 'J'. 

One to None 
It is possible to carry out a One to None Substitution - the removal of a planogram 
without specifying a replacement. This might be called for when a planogram has to be 
removed for legal reasons, etc., but no replacement has been decided on. 

 
In the above example the planogram 'X' on the end cap of the gondola is to be removed 
without a replacement being specified. 

Note: it is also possible to carry out 'Many to None'  
substitutions. 

One to None with Fixture Removal 
As well as a One to None substitution, it is also possible to remove the parent fixture. 
This might be because parts of a store are being assigned to a different purpose and the 
fixturing is changing as well as the planograms. 

 
In the above example the planogram 'X' on the end cap of the gondola is to be removed 
along with its parent fixture. 

Revision Substitution 
If no existing planograms have been selected for substitution, it is still possible to carry 
out Revision Substitution.  Revision Substitution is when slight changes have been made 
to a planogram design and it has been saved as a new version rather than a new design. 
When planogram substitution is carried out, all other planograms in the store will be 
automatically be updated to the latest revision providing the Effective Date of the 
revision is less than the Active Date of the floor plan the Revision Substitution is being 
carried out in. 
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Accessing and Configuring Planogram Substitutions 

Accessing the Planogram Substitution Functionality 
The Planogram Substitution functionality is accessed from the Tools menu. 

 
 

Functionality  Source Comment 

Planogram Substitution. Planogram Substitution module. Pertinent permissions required. 

Planogram Substitution (Run). Planogram substitution module. Pertinent permissions required. 

Permissions to access the planogram substitution functionality are set in the 
Administration module. If the appropriate permissions are not available, a warning 
message will result and access to the functionality will be denied. 

 

Configuring Planogram Substitutions 

Note: For full details on the Planogram Substitution dialog 
boxes click the Help buttons on the dialog boxes. 

Upon selecting Planogram substitution from the Tools menu, the first dialog box to open 
is the Planogram Substitution dialog box. 

 
Double clicking any named planogram substitution will bring up the Planogram 
substitution definition dialog box. 
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Details of an individual planogram substitution can be configured in the dialog box. 

Note: Substituting Master Planograms should only be done 
on a one-to-one basis because the required length is not 
defined in the planogram definition. 

Running Planogram Substitutions 
Note: Users will require permissions to be set in the 
Administration Module before they can access the 
Planogram Substitution functionality. 

Initiating the Planogram Substitution 
Planogram Substitutions can be initiated from the Tools Menu. 
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This will cause all valid substitutions to be run for the currently active floor plan. 

Alternatively, users can use the Run option in the Planogram Substitution dialog box. 

 
Only highlighted planogram substitutions will run - in the above example the Brown to 
White Bread substitution has been selected. 

Actions after Running a Planogram Substitution 
Planogram Substitutions execute in the database. In the example above, the database 
table will have been changed to indicate the currently active floor plan now contains a 
White Bread rather than a Brown Bread planogram. However, the information in the 
displayed in the Planner floor plan will remain unchanged. In order to make the floor 
plan match the information in the database, synchronization is required. This is done by 
calling the Synchronization dialog box from either the File menu or Retail toolbar. 
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After Synchronizing Match the Database, the planograms in the currently active floor 
plan will match those held in the database. 
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37 
Aisles in Planner 

Overview of Aisles 
Aisles are lines drawn in Planner to represent actual aisle in stores: They serve several 
purposes: 

 They allow actual aisles in stores to be identified in a floor plan. 

 They allow traffic flows to be specified 

 The allow reports to be created showing the performance of specific aisles. 

 

In the above diagram, each aisle is represented by a line identified by a number, letter or 
simple word. In the above diagram there are three aisles; numbered 1, 2 and 3. Aisles can 
be used to identify the general direction of traffic flow through a store. Shoppers are 
defined as starting at the head of an aisle and moving towards its end. 
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In the above diagram, the implied traffic flow is specified by the aisles placed in the floor 
plan. 

Note: Actual traffic flows in a store will have to be 
determined by observation - possibly by use of observers or 
reviewing security camera footage. 

After the aisles have been drawn, the Calculate Aisle Adjacency function (available from 
the Calculations menu) will cause fixtures to be associated with the nearest aisle within a 
specific distance. 

 

In the above diagram the fixtures have been bay numbered for clarity. Each fixture 
(identifiable by its bay number) will associate itself with the nearest aisle. Once fixtures 
have been associated with aisles, this information can be used for reporting purposes. For 
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example, it would be possible to report on the performance of all planograms sharing an 
aisle. 

Adding, Editing and Deleting Aisles 
Adding, Editing and Deleting Aisles is controlled from the Aisles toolbar. 

 

Adding Aisles 
Adding Aisles is initiated by clicking Add Aisle on the Aisles toolbar. 

 
The Aisle dialog box will appear, allowing the name of the aisle to be specified. 

 
After entering the aisle name and clicking OK, the command line will invite the user to 
select the start point. 

 
After specifying the start point the user will be invited to select the next point. 

 
The user may draw a straight aisle using just two points, or they may opt to add 
additional segments. Pressing Return will cause the aisle to be drawn. 

 

Useful Ways of Drawing Aisles 
Many of the standard AutoCAD methods can be used to draw aisles. Two useful ones 
are: 
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Mid of 2 Points (m2p) 
The AutoCAD Mid of 2 Points command is initiated by entering m2p into the command 
line. 

 
This will result in the user being invited to select 2 points. The aisle will be drawn 
initiating from the centre of a line connecting those two points. 

 
In the above example, the m2p command has been used for the start and the end of the 
aisle, resulting in an aisle drawn equidistant from both gondolas and neatly aligned with 
the ends. 

Construction Lines 
AutoCAD allows the use of construction Lines - infinitely long straight lines. There (in 
conjunction with other AutoCAD functionality such as Offsets and Object snaps) can be 
used to accurately lay out aisles. In the example below, construction lines have been 
added to the floor plan using Offsets and Object snaps. 

 
The Aisle can then be drawn by snapping to the intersections. 
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When the construction lines are deleted, an accurately positioned aisle remains. 

 

Editing Aisles 
Editing Aisles is initiated by clicking Edit Aisle on the Aisles toolbar. 

 
The command line will then invite a user to select an aisle. 

 
This can be selected by left clicking on it to select it then right clicking (standard 
AutoCAD method to end selection). The aisle dialog box will then appear. 
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The name of the aisle can then be edited. 

Editing Aisle Positions 
Aisle positions cannot be edited by Macro Space Management (MSM) functionality. 
Instead AutoCAD functionality must be used. For example, the position could be 
changed by means of the Move command. After the move command has been used, the 
MSM Synchronize functionality must be used to ensure the changes are written back to 
the database. 

Deleting Aisles 
Editing Aisles is initiated by clicking Delete Aisle on the Aisles toolbar. 

 
The command line will then invite a user to select an aisle. 

 
This can be selected by left clicking on it to select it then right clicking (standard 
AutoCAD method to end selection). Upon right clicking, the selected aisle or aisles will 
be deleted without further confirmation. 

Aisles and Aisle Adjacency 
After aisles have been drawn in a floor plan, the Calculate Aisle Adjacency option 
(Calculations menu) will associate fixtures with aisles. This section of help explains that 
process. 

ADJACENCY_AISLESIZE System Variable 
The ADJACENCY_AISLESIZE  system variable (set in the System Variables dialog box 
in the Administration Module) determines the maximum distance a fixture can be from 
a file and still be associated with it. When the Calculate Aisle Adjacency option is run, 
the distance perpendicular to the front of each fixture will be determined. Each fixture 
will be associated with the nearest aisle - provided it is within the maximum distance set 
by the ADJACENCY_AISLESIZE system variable 
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In the diagram above, the fixtures will be associated with Aisle 1 because that is the 
closest and within the maximum distance specified by the ADJACENCY_AISLESIZE  
system variable. If Aisle 1 did not exist, the fixtures would not be associated with Aisle 2 
because that is outside the maximum distance specified in the 
ADJACENCY_AISLESIZE system variable 

 
Care needs to be taken if the aisle is not parallel to the front of the fixtures. In the above 
example, Fixture 1 will associate with Aisle 1, but Fixture 5 (which is outside the 
ADJACENCY_AISLESIZE distance) will not. 

Ordering Fixtures for Reporting Purposes 
Once the Calculate Aisle Adjacencies functionality has been run, information will be 
written to the AVTTB_AISLE_ADJACENCIES table. This contains several pieces of 
information useful for reporting including the distance from the start of the aisle and 
whether the fixture is on the left or right of the aisle. 

 

Distance from Start 
The distance from the start is measured from the start of the aisle to the centre of the 
front face of the fixture. In the above diagram, Fixtures 1 - 6 can be ranked in their 
sequence along the aisle. 

Location to Left or Right 
Aisles are drawn to show the general direction of travel of shoppers. The start of the aisle 
is shown by the location of its name, with direction of travel towards the other end. 
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Fixtures associated with an aisle are show to the left or right relative to the direction of 
travel. 

Potential Problems with Aisle Adjacency 
The diagram below shows a correctly drawn aisle and one with potential problems. 

 

Aisle A 
Aisle A has all fixtures within the distance specified within the 
AVTTB_AISLE_ADJACENCIES system variable and can be used for accurate reporting. 

Aisle B 
There are two problems with Aisle B: 

 The aisle is in a 'U' shape. As distances are measured from the start of the aisle to the 
centre of the front of the fixture, Fixture 22 will be closest to the start. However, 
Fixture 20 will be shown as closer to the start than Fixture 24, leading to reports 
ranking the fixtures in an incorrect sequence along the length of the aisle. 

 One end cap (Fixture 21) is not pointing at the aisle. It will 'feel out'  to the maximum 
distance specified in the AVTTB_AISLE_ADJACENCIES system variable, fail to find 
the aisle and not be included in reports associated with that aisle. 

When drawing aisles, care needs to be taken to ensure that fixtures will correctly 
associate with the pertinent aisles and the sequence they are reported on is correct.   
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38 
Annotation in Planner 

About Annotation 
Annotation is used to label objects with text within a floor plan. This information then 
assists anyone reading the floor plan with identifying those objects. The example below is 
annotation for a zone. 

 
The example below shows two bay numbered fixtures that have been labeled with three 
forms of information: 

 The fixture name 

 The planogram 

 The bay number for the planogram 

 
The form of the annotation is configured using the Text Styles Administration Tool 
dialog box from the Planning Menu in the Administration Module. 
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Note: See the Administration Module User Guide for 
information on how to configure Text Styles. 

Using Annotation 
Note: For fixtures to annotate, the Include in Fixture 
Annotation check box must be selected for that item of 
equipment in the Category tab of the Block Details dialog 
box in Fixture Studio. 

Annotations can be selected from the Modify>Text menu. Alternatively, the same 
options can be selected from the retail toolbar. 
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Annotating Objects 

Annotate Fixtures 
Fixtures do not automatically annotate when placed in a floor plan. If the Include in 
Fixture Annotation check box has been checked in Fixture Studio, clicking the Annotate 
Fixtures option will cause all valid fixtures to annotate or refresh. 

Annotate Products 
Clicking Annotate Products will cause annotation associated with products and 
planograms to refresh. 

Annotate 
Clicking Annotate will bring up the Annotate dialog box. 
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 The Refresh button ensures that all recent changes to the annotation rules made in 

the Administration module are updated in Planner. 

 Highlighting an annotation style causes that specific style to be selected for updating. 

 The Select>> button takes the user to the floor plan where standard AutoCAD 
methods can be used to select a specific subset of objects for updating. 

 The OK button causes the selected objects to update. 



 

Drawing Comparison 505 

39 
Drawing Comparison 

Overview of Drawing Comparison 
Drawing Comparison can be used to compare the equipment, planograms and product 
categories in two floor plans. This can be done in one of two ways: 

 Comparison between the currently active floor plan and any designated prototype 
store for that floor plan. 

 Comparison between the currently active floor plan and any other currently active 
floor plan. 

Accessing Drawing Comparison 
Drawing Comparison can be accessed in two main ways: 

From the View Menu in  Planner 
Drawing Comparison can be accessed from the View Menu. 

 
Alternatively, it can be accessed from the local C:\Program Files\Oracle 
Retail\MSM\Apps directory. 
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Opening Floor Plans with Store Comparison 

Opening Directly from Directory 
If opened directly from the local C:\Program Files\Oracle Retail\MSM\Apps 
directory, there are two ways Store Comparison can behave. These depend on whether 
the Planner Module is open or not. 

Opening without the Planner module being open 
If the Planner module is not open, the Select File dialog box will appear. Highlight   

 

Using Drawing Comparison 
Once the floor plans have been selected, the Drawing Comparison  dialog box will 
appear. This can be used to show differences between the selected floor plan and the 
template/prototype store it is being compared with. 
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Menus and Toolbar 

Menu Bar 
There are three Menus - File, View and Reports  

 

File Menu 

This contains the following options: 

 Open opens the Select File dialog box, allowing users to select floor plans to compare. 

 Export exports the current set of results to an Excel spreadsheet. 

 Print Preview brings up the Print Preview dialog box. This gives a preview of the 
information to be printed. Users can opt to print the information or exit the option. 

 Printer Setup being up a dialog box for changing the default printer and options for 
that printer. 

 Exit causes store Comparison to close. 

View Menu 
This contains the following options: 

 Sort Ascending sorts the data into ascending order. It will be based on the column 
containing the currently highlighted cell. 

 Sort Descending sorts the data into descending order. It will be based on the column 
containing the currently highlighted cell. 

 Refresh updates the results with any changes made in the floor plans since Drawing 
Comparison was opened. Once circumstance where Refresh could be used was if a 
store planner was manually changing planograms in a floor plan so that it conformed 
to those in the prototype store. Refreshing at intervals would keep the list of current 
differences between the floor plans updated. 

 Enable Docking can be toggled on and off. If docking is On, the Drawing 
Comparison dialog box will dock to the left of Planner, displacing Planner to the 
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right to make room. If docking is Off, the Drawing Comparison dialog box can be 
positioned in any convenient location. 

Reports Menu 

The Reports menu allows users to toggle between one of three report modes: 

 Report on difference in placed Planograms between the two selected floor plans. 

 Report in differences in placed Categories between the two selected floor plans. 

 Report in differences in placed Fixtures between the two selected floor plans. 

Note: Reporting on differences between Categories is not 
currently operational. 

Toolbar 
The toolbar contains the following options 

Icon Description   

 

Select Drawings to 
Compare 

This option will open the Select Drawings to Compare dialog box. 
The user can then select the floors plans for comparison. 

 

Print Preview This option will bring up the Print Preview dialog box. Users can opt 
to print the information or exit the option. 

 

Display Tree View This option will cause information to be displayed in a tree (or 
hierarchical) view. 

 

Display List View This option will cause information to be displayed in a list (tabular 
form). 

 

Sort Column in 
Ascending Order 

This will sort the data into ascending order. It will be based on the 
column containing the currently highlighted cell.  

 

Sort Column in 
Descending Order  

This will sort the data into descending order. It will be based on the 
column containing the currently highlighted cell.  

 

Show All Values 
This will show all data from the two floor plans being compared. It 
will include data that is identical.  

 

Only Show Differences 
This will only show data that differs between the two floor plans 
being compared. 

Using Drawing Comparison 

Tree and List View 
The information may be view in one of two modes depending on user preference. These 
are Tree View (left in the screen shot below) and List View. 
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Users can toggle between the two views by using the appropriate icon in the toolbar. 

Note: in Tree view, the icons change if there are differences 
between the store and the template/prototype. In  the screen 
shot above, the tooltip contains the ID of the Planogram 
Group, the last two digits of the planogram code and the 
form of the difference.   

Show All Values or Only Show Differences 
Users can select the amount of information displayed. This can be all items (left in the 
screen shot below) or only the items that differ. 

 

Possible Differences 
There are four types of potential differences between the two selected floor plans. These 
are: 

 Under: The quantity on the store is smaller than the quantity in the 
template/prototype. 

 Over: The quantity on the store is greater than the quantity in the 
template/prototype. 

 Missing: An object is present in the template/prototype that is not present in the 
store. 

 Illegal: An object is present in the store that is not present in the template/prototype. 

These differences can apply to: 

 Equipment Placed. 

 Planograms Placed. 

 Categories Placed (not operational at present). 
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Other Planner Functionality 

Restructure Drawing 
Restructuring Drawing can be initiated from the Retail Toolbar. 

 
Alternatively, the functionality can be invoked from the Modify menu. 

 
This will bring up the Restructure Drawing dialogue box. 
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The purpose of this dialog box is to restore blocks in the currently active floor plan to 
match the properties of the blocks as defined in Fixture Studio. 

Selecting Blocks for Restructuring 
Selecting Blocks for Restructuring is done by using the varying selection options and 
building up a list of blocks for the Restructuring operations to be carried out on.   

 
Each selection is added to the current list (Add to Selection radio button) or removed 
from the current list (Remove from Selection radio button). A list containing several 
types of blocks can thus be built up - the total number of blocks currently selected being 
shown in the dialogue box. 

Clicking on Select or Select By Block temporarily hides the Restructure Drawing 
dialogue box and takes the user to the currently active floor plan. 

The apply button will remain grayed out until blocks have been selected and one or more 
check boxes selected. 

Select 
Select takes the user to the drawing where they can use standard AutoCAD selection 
methods to select one or more blocks. Valid methods include individual selection, 
windows or crossing selection boxes and fences. Selection must be completed with a 
right mouse click. 
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Select by Block 
This option takes the user to the currently active floor plan. Selecting an individual block 
will select all blocks of that type. Multiple block types may be selected before selection is 
completed with a right mouse click. 

Select all Blocks 
Clicking this button will select all blocks in the currently active floor plan. 

Clear Selection 
Clicking this button will deselect all currently selected blocks. Once the blocks have been 
selected, varying restructuring options can be chosen. 

 

Restructure Block Options 

Redefine blocks from Disk 
If the master block definition registered in Fixture Studio has been updated, it is possible 
to update the older version of the block held in the currently active floor plan with the 
more recent block held in Fixture Studio. On clicking the Apply button the block 
definition held in the 'database' section of the drawing will be updated, resulting in all 
visible instances of the block being changed. 

Note: Block names will be ignored if they are not registered 
in Fixture Studio. 

Explode Composite Blocks 
This option will take any selected blocks and determine if they are composite (a block 
made up of made up of two or more previously defined blocks). 

If any blocks are composite, they will be exploded into their component blocks and any 
connection points associated with the composite blocks removed. (If individual blocks 
within the composite have connection points assigned, these will not be affected). 

Note: Blocks correctly registered and configured in Fixture 
Studio have an attribute called BSLINK-ATT assigned to 
them. If a composite has this attribute assigned, it will be 
removed when the composite is exploded using Restructure 
Drawing. If the composite is exploded using AutoCAD 
Explode, this attribute may be left in the floor plan. It is 
therefore suggested that Macro space Planning composites 
are exploded using Restructure Drawing. 
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Reset Level 
This option results in any selected blocks being reassigned to the level (elevation above 
floor level) they are assigned to in the Insertion Tab of the Block Definition dialog box in 
Fixture Studio. 

If the level is set to 'undefined', no changes will be made in the level for the block. 

Note: Both shelves and products should be on undefined 
levels and should not be affected by this command. 

Reset Color, Line Type and Line Weight to BYLAYER 
If the colors, line types and line weights of any selected block in the currently active floor 
plan are different from the default properties of the layer on which they have been 
placed, the properties of the selected blocks will be set back to those defaults. An 
example of this could be if a KPI was run in the floor plan. If there was some sort of 
failure before the floor plan was checked back in, the individual blocks in the drawing 
could be colored according to the KPI. Running Reset Color, Line Type and Line Weight 
to BYLAYER will reset those properties to the default values assigned in Fixture Studio. 

Reset Layer 
If the selected block is on a different layer to that defined for that block in Fixture Studio, 
the block will be reassigned to that layer in the currently active floor plan. 

List Unknown Blocks 
It is possible for blocks to exist in the drawing, but not be registered in Fixture Studio. 
These sorts of blocks are shown in the Processing Blocks dialogue box that appears when 
the drawing is being restructured. 

 
  

The Retail Layers Toolbar 
The Retail Layers Toolbar enables users to quickly control which layers pertinent to 
Retailing are visible. 

 
 

Buttons Description 

 

  

Turns on all zones, zone text and aisles / boundary layers 
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Buttons Description 

 

  

Turns off all zones, zone text and aisles / boundary layers 

 

  

Turns on all fixtures (but not fittings) 

 

  

Turns off all fixtures (but not fittings) 

 

  

Turns on all fittings (but not fixtures) 

 

  

Turns off all fittings (but not fixtures) 

 

  

Turns on all products, shelves and associated annotation 

 

  
Turns off all products, shelves and associated annotation 

 

  
Turns on all general notes, markups and general dimension lines 

 

  
Turns off all general notes, markups and general dimension lines 

 

Toggles fixtures to 2D layer (if set up for this) 

 

Toggles fixtures to 3D layer (if set up for this) 

Display 2D and 3D 
The Display 2D and Display 3D options are available from the View pull down menu. 
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They are also available from the Retail Layers toolbar. 

 
This functionality is specific to Macro Space Management. It requires fixtures that have 
been configured in a specific way prior to having been registered in Fixture Studio. (The 
method is described in more detail in the Fixture Studio help file). Fixtures that have not 
been configured in this manner will not toggle between 2D and 3D form. 

If Display 2D is selected, only the base of the fixture will be displayed, giving an outline 
plan view. If display 3D is selected, all of the fixture will be displayed, giving a three 
dimensional view if the drawing is viewed from an oblique angle. 

The purpose of the 2D functionality is to simplify the floor plan when the floor plan is 
being published prior to being put into service. Instead of all the construction lines for 
the fixtures being visible, only the outline is visible in the printed output. This makes the 
published plan easier to read when distributed to the stores for implementation. 

The difference can be seen in the example below where the same fixtures can be seen in 
both 3D form (top) and 2D form (bottom). 



 Display 2D and 3D 

 Other Planner Functionality 517 

 





 

Validating Floor Plans 519 

41 
Validating Floor Plans 

Validating Floor Plans 
Prior to authorizing a floor plan, it should be validated to see if it is optimum.   

Reasons for Validating Floor Plans 

Merchandise Placement Errors 
Compliance is a key issue for retailers. Placing planograms on incompatible fixtures can 
lead to errors in product placement immediately the planogram is set. These placement 
errors can lead to the performance of the planogram being misinterpreted. For example, 
if there are few facings placed than designed for a product, its financial performance will 
be below that intended. An analyst looking at planogram performance might then be 
misled when the planogram is redesigned. 

Merchandise Optimization 
Planograms will generally be placed within a floor plan to meet an overall set of targets. 
An example would be the profitability of categories, aisles, departments and the overall 
floor plan. Forecast results could be calculated and compared to target. Any areas of the 
store falling short of target could then be replanned. 

Other Forms of Validation 
Retailers may have other reasons for validating floor plans meet the overall strategic 
plan. An example if this would be if the retailer was stocking a particular range of 
products as an image builder for the chain. Retailers might then want to validate that the 
placement of these image building products met requirements. 

Methods of Validating Floor Plans 
There are several methods of validating floor plans. 

Quick Reports 
Quick Reports (accessed from the View menu in both Planner and Merchandiser) enable 
the user to get specified results back from the floor plan. Macro Space Management 
comes with a set of pre-configured quick reports that can be used to check either for 
errors or for ways to further optimize the floor plan. 

 Example Quick Reports that can be used to check for errors are those for multi-
placed planograms or unpopulated fixtures. 

 Example Quick Reports that can be used to optimize floor plans include results for 
financial performance - for example planogram space measures. It is then possible to 
check forecast planogram performance against location in the floor plan. 

In addition to the pre-configured reports that are supplied, it would be possible to 
configure Quick Reports to meet retailer specific requirements. For example it would be 
possible to create a Quick Report identifying seasonal planograms and their expiry dates. 
It would then be possible to validate that there is a minimum period (say 4 weeks) 
between the floor plan going into service and the first seasonal planogram requiring 
replacement. 
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Key Performance Indicators 
KPIs can be used to visually indicate performance in the current floor plan. As with KPIs, 
MSM comes with a set of pre-configured KPIs that can be used to check either for errors 
or for ways to further optimize the floor plan. 

 Example KPIs that can be used to check for errors are those for planograms on 
fixtures of incorrect length, depth of height. 

 Example KPIs that can be used to optimize floor plans include results for financial 
performance - for example it is possible to show forecast profit and see if the high 
profit planograms are in physical locations that would justify those forecasts. 

In addition to the pre-configured KPIs that are supplied, it would be possible to 
configure KPIs to meet retailer specific requirements. For example it would be possible to 
create a KPI identifying all planograms with particular User Defined Attributes. An 
example of this would be UDAs identifying planograms that contain organic food 
products. It would then be possible to visually check the location of all organic products 
within the floor plan to see if they are logically placed in relation to each other. 

BI Publisher Reports 
BI Publisher reports are configured independently of MSM but could be used to give 
overview data on the floor plan. For example, historical data can be used to forecast the 
profitability of each planogram. It would be possible to use this forecast profitability to 
summarize profitability for the floor plan by category, aisle, department and overall. 
Each of these profit results could then be compared to pre-determined targets to see if the 
results are acceptable. 

Business Process for Validating Floor Plans 
The business process for validating floor plan will vary from retailer to retailer. One 
option is to put in a specific status (customizable in the Administration module) 
indicating the floor plan is awaiting validation. After the floor plan has been developed, 
it could be set to ready to validate status. If the floor plan meets requirements, the status 
could then be set to authorized and the floor plan set on the road to going into service. 
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Overview of Calculations 
Macro Space Management has many capabilities. One of these is to understand space. 
After creating a floor plan, it is then possible to run a number of calculations that give 
information on how well (or how badly) the floor plan has been laid out. This 
information can then be used to further optimize the floor plan, enabling a retailer to 
maximize the sales and profit from the available area. One example is area calculations: 
this apportions the floor area in a specific floor between the fixtures in that floor. This 
data then allows the amount of aisle space allocated to a fixture to be taken into account. 
In the screen shot below, the red areas show points where customers can stand in a floor 
plan and see a lot of fixtures - including end caps. This enables a retailer to identify prime 
areas to place high margin merchandise. 

Custom Reports and KPIs 
The results of the varying calculations write back to tables within the database. The 
template database supplied does not contain any specific reports or KPI's that can make 
use of that information. However, one of the aims of Macro Space Planning is to allow 
users to understand the use of space within their bricks and mortar retail outlets. It is 
possible to produce custom reports or KPI's that will enable them to optimize that space. 
Some of the reports/KPIs that can be created are detailed for each type of calculation 
within this section of the user guide. 

Example of Use of Calculations 
Consider a number of categories associated with snacks and convenience buys. 

Users not using Macro Space Management will have information in tabulated form. 

Category Base Linear (feet) Profit Profit per foot Base Linear 

Crackers and Savory Biscuits 12 $3,600 $300 

Chocolate 16 $6,400 $400 

Crisps and Snacks 12 $3,000 $250 

Sweet Biscuits 8 $2,400 $300 

Sweets, Mints and Gums 4 $1,400 $350 

If users use the Allocated Area calculation, it is possible to extend this information to take 
into account the aisle space associated with the fixtures the products are on. For example, 
it is now possible to see that chocolate is showing a good profit when related to base 
linear, but a poor one when the about of floor space assigned to it is taken into account. 

Category Base Linear 
(feet) Profit Profit per foot 

Base Linear 
Allocated Area 
(Square Feet) 

Profit per 
Square Foot 

Crackers and 
Savory Biscuits 12 $3,600 $300 720 $5 



Overview of Calculations 

522 Oracle Retail Macro Space Management 

Category Base Linear 
(feet) Profit Profit per foot 

Base Linear 
Allocated Area 
(Square Feet) 

Profit per 
Square Foot 

Chocolate 16 $6,400 $400 1,600 $4 

Crisps and Snacks 12 $3,000 $250 600 $5 

Sweet Biscuits 8 $2,400 $300 400 $6 

Sweets, Mints and 
Gums 

4 $1,400 $350 280 $5 

If used in conjunction with EPOS data, a KPI could be created that shows fixtures 
containing these products and whether they are on target for budgeted profit. 

 

Here a store planner (or store manager) can see at a glance which fixtures contain 
products that are performing well or badly. In this case it is possible to see an end cap is 
performing below expectations and further investigation is required to identify the 
reasons. 

Calculations and the Business Process 
Calculations - providing the necessary reports and KPI's are available - can be used at 
any stage of the store planning process. 

 
The initial stage would be for a floor plan to be created or modified. Calculations would 
then be run on that store plan, leading to information on how effectively the space within 
the store was being used. This information would allow a store planner to keep returning 
to his floor plan and optimizing it.  Once optimized, the floor plan would be published 
and put into service. Once operational in a real life store, EPOS and other data from the 
'live store' could be used to determine what improvements to make in the next iteration 
of the floor plan. 

The necessary reports and KPIs resulting from the calculations are likely to be retailer 
specific - every retail chain has its own ideas and theories about how best to utilize the 
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space within its retail outlets. These reports and KPIs can be developed from a thorough 
knowledge of the technicalities of retail and careful study of how data is stored within 
the Macro Space Planning database. 

General Technicalities for Calculations 

Initiating Calculations 
Calculations are initiated from the Calculations menu. 

 

Imploded and Exploded Planograms 
Planograms can exist in two forms: 2D (imploded) and 3D (exploded). 

 
The example planogram on the left is imploded (2D) and takes the form of a product 
block occupying the volume of the planogram. There is no information on the shelves 
and individual products present. The planogram on the right has been exploded to 3D 
form and contains information on both shelves and individual products. Planograms can 
be changed between the imploded and exploded form in the Merchandiser module. The 
Face Plane and Space Measurement calculations will only return meaningful results for 
planograms in 3D (exploded) form that contain Display Styles. 

Information on Database Tables 
Information is provided in the following sections on the database tables associated with 
the calculations. These are not generally accessible to normal users, but only to those 
with the correct privileges for accessing the database. This information has primarily 
been provided as an aid to anyone intending to produce custom reports. 
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Allocated Areas 

Principles of Allocated Areas 
The Allocated Area calculation is used to apportion areas of floor space to specific 
fixtures. This allows reports on performance to take into account the way the floor has 
been laid out. 

 
In the above simplified example, fixtures are shown with a solid outline and the resulting 
allocated area with a dotted outline. It can be seen that an end cap will receive a greater 
allocated area than a standard fixture, while a fixture at an aisle end could have an 
allocated area intermediate between the two. The result can be seen in the following 
table. 

Fixture Footprint Sales Sales 
ft2 

Allocated 
Area 

Sales 
ft2 

Standard 
Fixture 8 ft2 $1,200 $150 16 ft2 $75 

Aisle 
Fixture 8 ft2 $1,800 $225 40 ft2 $45 

End Cap 8 ft2 $54000 $375 60 ft2 $90 

 

If performance figures were looked at purely on the basis of fixture area (footprint), it 
would appear that the aisle end fixture was performing well.  However, when the floor 
area allocated to it is taken into account, i t can be seen that the sales per square foot are 
disappointing. 

This form of analysis allows a number of facets of floor layout to be explored: 

 Wider aisles may mean fewer fixtures in a store, but will increased product visibility 
lead to higher sales? 

 Are products performing badly because visibility for their parent fixture is poor and 
customers can't see them? 

 How significantly does fixture position (end of aisle, centre of aisle) impact on sales? 

Space Measurements 
The Allocated Area result is also used in the Space Measurement calculation. 
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Allocated Area Calculation Technicalities 

System Variables Affecting Allocated Areas 
The following system variables affect the allocated areas calculation: 

 AREA_LARGE_INCREMENT 

 AREA_MEDIUM_INCREMENT 

 AREA_SMALL_INCREMENT 

 AREA_MAX_DISTANCE 

 AREA_UNIT_OF_MEASURE 

These system variables are set in the Administration Module - see the Administration 
Module User Guide for more information. 

Area Calculation Directions 
The directions for which the calculations apply for a specific type of fixture are set in the 
Block Details dialog box in Fixture Studio. 

 
Fixtures such as spinners or bins that can be seen from all directions might have all four 
area calculation directions set. Conversely, fixtures such as slatwalls will not have the 
products visible from the back and will have their directions set to left, right and 
forward. See the Oracle Retail Macro space Management Fixture Studio User Guide for more 
information. 

Internal Area Zone and AREA_MAX_DISTANCE_SYSTEM_VARIABLE 
Two factors affect the maximum area that can be allocated to a fixture: the Internal Area 
zone and the AREA_MAX_DISTANCE system variable. 
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Individual fixtures feel out' in the specified directions until: 

1. They reach another fixture. 

2. They reach the boundary of the Internal Area zone. 

3. They reach the distance specified in the AREA_MAX_DISTANCE system variable. 

If the maximum distance is greater than the distance to the boundary of the Internal Area 
zone, the area allocated to that fixture will be determined by the distance to the Internal 
Area zone boundary. 

Sharing Areas between Fixtures 
If fixtures share areas, the space will be apportioned between them. 

 

If we take the example of Fixture 1, i t will feel  out towards Fixtures 3 and 4. Similarly, 
Fixtures 3 and 4 will feel  out towards Fixture 1. The total areas will be subdivided 
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between then, which will approximate to the hatched areas in the diagram above. The 
end cap is more complex. It will feel out forwards until  it reaches the boundary of the 
internal area. It will also feel  out left and right and will be constrained by Fixtures 2, 3, 5 
and 6. The end cap will thus be allocated a larger area. 

Using the Allocated Area Calculation 

Running the Allocated Area Calculation 
The Allocated Area calculations can be run from the Calculations menu 

 

Allocated Area Results 
Allocated Area results are stored in the Fixture table in the database.  Allocated Areas are 
only assigned to fixtures - they are not assigned to fittings, shelves, etc. As the database 
table contains entries for all types of equipment, the results will have to be filtered to be 
specific for fixtures. 

Note: For full details of database tables, see the Oracle Retail 
Macro Space Planning Data Model. 

Reporting Using Allocated Areas 
The default database supplied with Macro Space Planning does not contain any KPIs or 
Reports that use the results of Allocated Area calculations. These will have to be 
configured by the user; possibly using EPOS data. Possible reports include: 

 Fixtures with allocated areas above or below a specified value. 

 Total sales values per unit of allocated area. 

 Total profit per unit of allocated area. 

 Fixtures over and under-performing financially based on allocated area. 

Aisle Adjacencies 

Principles of Aisle Adjacencies 
The Aisle Adjacency Calculation is used to assign fixtures to MSP Aisles. As these aisles 
have a direction, it is also possible to determine the sequence of the fixtures along that 
aisle. After products or planograms have been associated with those fixtures, it is then 
possible to generate reports stating whether those products are well or badly placed 
along the aisle. 
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In the above example, Aisle 3 contains fixtures 18 - 22, with Fixture 18 at the start of the 
aisle and Fixture 22 at the end. It is then possible to use this information in custom 
reports. For example, once the planograms on the fixtures are known, it would be 
possible to: 

 Identify whether multi-bay planograms have been placed matching the direction of 
traffic flow they have been designed for. 

 Identify whether there are desirable product affinities - for example are pasta sauces 
next to pasta. 

Aisle Adjacency Technicalities 

System Variables Affecting Aisle Adjacencies 
The ADJACENCY_AISLESIZE system variable specifies the maximum distance that a 
fixture can be from an Aisle and still be associated with it. For example, if the 
ADJACENCY_AISLESIZE is set to 48 inches (4 feet), no fixture greater than that distance 
from the aisle will be associated with it. This system variable is set using the System 
Variable dialog box accessed from the General Menu in the Administration module. 

Method of Measuring Distances 
The Aisle Adjacency table contains two distances associated with a specific aisle. 

 AIL_DISTANCE_FROM_START  

– This distance is measured from the start position of the aisle to the centre of the 
front of the fixture. 
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– In the above example, the red lines indicate the distances from the start of Aisle 2 

to Fixtures 12, 13 and 14. For this reason, it is best not to draw aisles using paths 
that turn through several right angles. 

 
– In the above example Fixtures 1 and 6 will be shown as the closest to the start of 

the aisle; the true sequence along the aisle is 1 - 6. 

  AIL_DISTANCE_FROM_AISLE  

– This distance is calculated perpendicular to the front of the fixture. 
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 In the above example the centers of the fronts of both fixtures are the same vertical 

distance from the aisle. However, because the distance to the aisle is measured 
perpendicular to the front of the fixture, Fixture 1 will be shown as being closer to the 
aisle than Fixture 2. 

Note: For full details of database tables, see the Oracle Retail 
Macro Space Planning Data Model. 

Items of Equipment that can be Assigned to Aisles 
Only equipment of type Fixture can be assigned to aisles in the Aisle Adjacency table. 
(Fixture types are assigned in the Category Tab of the Block Details dialog box in the 
Fixture Studio module - see the Oracle Retail Macro Space Management Fixture Studio User 
Guide for more information). In addition Fixtures will only be assigned to a single aisle - 
this will be the nearest aisle within the limits set by the ADJACENCY_AISLESIZE system 
variable. 

Using the Aisle Adjacency Calculations 
The default database supplied with Macro Space Planning does not contain any KPIs or 
Reports that use the results of Aisle Adjacency calculations. These will have to be 
configured by the user, and would require using data from other tables. Possible reports 
include: 

 Identifying whether multi-bay planograms have been placed matching the direction 
of traffic flow they have been designed for. 

 Identifying whether planograms that require power (for example TV planograms) 
are in aisles that have been supplied with power 

 Identifying whether there are desirable product affinities - for example whether pasta 
sauces are next to pasta. 

 Identifying whether there are undesirable product affinities - for example whether 
shotgun shells are next to baby food. 

If the ADJACENCY_AISLESIZE system variable is set to a sufficient size, it is possible to 
include the fixtures on both sides of the aisle, allowing the product affinities to be 
established for products sharing the entire aisle. 

As an example, a short report could be generated for an aisle containing the 'Rice, Pasta 
and Noodles' category. 

Segment Side of 
Aisle 

Distance from 
Start 

Base Linear of 
Product Profit/Foot 

Instant Rice Left 0 ft 12 ft $125 

Ready to Heat 
Rice 

Right 0 ft 8 ft $150 

Instant Noodles  Left 12 ft 8 ft $75 



 Fixture Adjacencies 

 Calculations 531 

Instant Pasta Right 8 ft 4 ft $125 

Dry Short Pasta  Right 16 ft 4 ft $100 

This enables a store planner to see that the Instant Noodles segment with a profit of $75 
per base linear foot is placed in a prime position in the centre of the aisle yet is under-
performing. 

Fixture Adjacencies 

Using Fixture Adjacencies 

Fixture Adjacency Results 
Aisle Adjacency results are stored in the Fixture Adjacency table.  More information 
pertinent to gondolas is stored in the Fixture Sequence table. 

Note: For full details of database tables, see the Oracle Retail 
Macro Space Planning Data Model. 

Using the Fixture Adjacency Results 
1. Product Adjacencies 

Fixture Adjacency results are a necessary precursor for running the Product 
Adjacency calculations. 

2. Reports Based on Fixture Adjacencies 

Although it is not usual to generate reports or KPIs based on Fixture Adjacencies, it 
would be possible to produce specialized reports. An example would be to generate 
a report that used Fixture UDAs to identify if a fixture used to hold hot food has been 
placed directly behind a fixture used for frozen products. 

Fixture Adjacency Technicalities 

System Variables Affecting Fixture Adjacencies 
The following system variables affect the fixture calculation: 

 ADJACENCY_FIXTURE_SIZE 

 ADJACENCY_LATERALGAP 

 ADJACENCY_VERTICALGAP 

These system variables are set in the Administration Module - see the Oracle Retail Macro 
space Management Administration Module User Guide for more information. 

Bitwise System Variables 
The results of the Fixture Adjacency calculations are stored in the Fixture Sequence 
table. The type of adjacency is stored as a bitwise system variable: 

1 = Adjacent to Right 

2 = Adjacent to Left 

4 = Adjacent to Back 

8 = Aisle Adjacency (Not in Use) 

16 = Not in Use 

32 = Adjacent Above 
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Bitwise variables can be built up of combinations of numbers, so 5 = Adjacent to Right 
and Behind. 

Note: For full details of database tables, see the Oracle Retail 
Macro Space Planning Data Model. 

Principles of Fixture Adjacencies 
The Fixture Adjacency calculation is used for several purposes: 

 To determine which fixtures are assigned to a specific gondola and what the 
relationship of the fixtures are to each other within the gondola. 

 As a precursor to updating result in the Fixture Sequence table which is used to hold 
additional information on the arrangement of fixtures within gondolas. 

 As a necessary predecessor to the Product Adjacency calculation. 

 As a necessary predecessor  to placing multi-bay planograms  in In-Store Space 
Collaboration 

The Fixture Adjacency calculation determines which fixtures are to the left, right, above 
or behind other fixtures. 

 
In the above example, Fixture 2 has Fixture 1 to the left, Fixture 4 behind and to the right, 
etc. 

Note: For full details of database tables, see the Oracle Retail 
Macro Space Planning Data Model. 

Product Adjacencies 

Principles of Product Adjacencies 
The Product Adjacency Calculation is used to determine the relationship of products on 
adjacent fixtures to one another. Products may be to the left, right, above or on the same 
fixture as other products. Results are aggregated up to sub-class (sub-category/sub-
segment) level. 
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A necessary precursor for running the product adjacency calculations is that the Fixture 
Adjacency Calculation has been run first.  When run, Product Adjacency aggregates the 
products up to subclass (sub-category/sub-segment) level and then reports which 
products are to the left/right/above other products. This information can then be used in 
conjunction with the Adjacency Severity rules to identify products that are well or badly 
placed. 

The Adjacency Severity rules are configured in the Administration module. 

 
The results are stored in the Adjacency Rule table. 

Note: For full details of database tables, see the Oracle Retail 
Macro Space Planning Data Model. 

Using Product Adjacencies 

Product Adjacency Results 
Product Adjacency results are stored in the Product Adjacency table.  The main way of 
using the product adjacency results is in conjunction with the Adjacency Rules 
table (Adjacency Rule table). This allows a report to be generated specifying whether 
products that are to the left, right or above another product are products that are 
desirable or undesirable to have in that relationship. 

Note: For full details of database tables, see the Oracle Retail 
Macro Space Planning Data Model. 
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Face Planes 

Using the Face Plane Calculations 
Face Plane results are stored in the Face Plane table. 

 

Using the Face Plane Results 
There are a number of potential ways of using the face plane results. 

 By linking to individual planograms placed in a floor plan (Plano table) to generate 
area based performance metrics. 

 By linking to the Aisle adjacency table to generate area based performance metrics 
for that aisle. 

 By linking to the product hierarchy (Product Def table) and the products placed in a 
floor plan (Product table) to generate area based performance metrics for entire 
categories, segments or sub-segments in a floor plan. 

Note: For full details of database tables, see the Oracle Retail 
Macro Space Planning Data Model. 

Face Plane Technicalities 

System Variables Affecting Face Plane Calculations 
There is no system variable connected with the Face Plane calculations. 

Imploded and Exploded Planograms 
Planograms can exist in two forms: 2D (imploded) and 3D (exploded). 

 
The example planogram on the left is imploded (2D) and takes the form of a product 
block occupying the volume of the planogram. There is no information on the shelves 
and individual products present. The planogram on the right has been exploded to 3D 
form and contains information on both shelves and individual products. 
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Planograms can be changed between the imploded and exploded form in the 
Merchandiser module. The Face Plane calculation will only return meaningful results for 
planograms in 3D (exploded) form that contain Display Styles. 

Display Styles 
Display Styles are the lowest level in the MSP Product hierarchy. Each display style is 
associated with a specific SKU and contains information on product dimensions. When 
the Face Plane calculation is run, results are aggregated up to the parent SKU. 

Calculation Method 
The calculation method is as follows: 

 

1. The total frontal area is found by multiplying the length of the shelf (or fixture) by 
the available height. 

2. The frontage product occupies on the shelf is determined - for example Product 3 in 
the above example occupies 50% of the shelf. 

3. The total frontal area is proportioned among the products according to the frontage 
they occupy. 

  

Product Total 
Area Frontage Face Plane 

1 4 ft2 50% 2 ft2 

2 4 ft2 35% 1.4 ft2 

3 4 ft2 15% 0.06 ft2 

Principles of Face Planes 
Face Planes can be used to calculate the frontal area of products at display style level. 
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In the above example the base of the fixture contains a single product (1), the first shelf 
two products (2 & 3) and the top shelf three products (4, 5 & 6). The Face Plan calculation 
can be used to relate sales information to the frontal area of the products. 

Product 
Number Sales Area Sales ft2 

1 $225 4.5 ft2 $50/ft2 

2 $135 2.25 ft2 $60/ft2 

3 $90 2.25 ft2 $40/ft2 

4 $75 1.5 ft2 $50/ft2 

5 $45 1.5 ft2 $30/ft2 

6 $105 1.5 ft2 $70/ft2 

 

This allows (for example) space trading to be carried out. Product 5 is occupying the 
same frontal area as Product 6, but is generating less than half the sales per square foot. 
There would thus be a case to increase the number of facings of Product 6 and 
correspondingly reduce the number of facings of Product 5. 

Note: For a similar calculation using volumes see the section 
on Space Measurement. 

Space Measurements 

Using Space Measurements 
Space Measurement results are stored in the Product Measurement table. 
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Reporting Using Space Measurements 
The default database supplied with Macro Space Planning does not contain any KPIs or 
Reports that use the results of Space Measurement calculations. These will have to be 
configured by the user; possibly using EPOS data. Results will be aggregated up to sub-
class (sub-category/sub-segment) level. 

Possible reports include: 

 Products at subclass level expressed as feet of shelf length (base linear plus shelf 
linear). 

 Sales turnover for products at subclass level expressed as turnover per foot of shelf 
length (base linear plus shelf linear). 

 Profit for products at subclass level expressed as profit per foot of shelf length (base 
linear plus shelf linear). 

 Products at subclass level expressed as square feet of floor area (based on allocated 
area). 

 Sales turnover for products at subclass level expressed as turnover per square feet of 
floor area (based on allocated area). 

 Profit for products at subclass level expressed as profit per square feet of floor area 
(based on allocated area). 

 Products at subclass level expressed as a cumulative volume (based on display, 
nominal or allocated volumes). 

 Sales turnover for products at subclass level expressed as a turnover per unit volume 
(based on display, nominal or allocated volumes). 

 Profit for products at subclass level expressed as profit per unit volume (based on 
display, nominal or allocated volumes). 

Note: For full details of database tables, see the Oracle Retail 
Macro Space Planning Data Model. 

Principles of Space Measurements 
Space Measurements are used for calculating linear dimensions and volumes associated 
with planograms in a floor plan. These can then be combined with EPOS data for 
reporting purposes. For the full set of information in Space Measurements, the allocated 
area calculation must first have been run. In addition, the planogram must be in 
Exploded (3D) form - if not, the shelf linear figure will be inaccurate. Products will be 
aggregated up to sub-class (sub-category or sub-segment) level. The Space Measurement 
calculation provides the following information: 
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Base Linear and Shelf Linear 

 

 Base Linear is the length of the fixture. 

 Shelf Linear is the cumulative length of the shelves on the fixture. 
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Footprint and Allocated Area 

 

 Footprint is the physical space the fixture occupies on the floor. It is calculated by 
multiplying the fixture length and depth. 

 Allocated Area is the space the fixture occupies on the floor when any associated 
areas of its aisle have been apportioned to it. 

Display Volume, Nominal Volume and Allocated Volume 
These provide different volumes for calculation purposes: 

 Display Volume is the actual volume occupied by the products. This will be less than 
the maximum volume of the parent fixtures because of finger gaps, unused spaces, 
etc. 

 Nominal Volume is the Base Linear value for the parent fixtures, multiplied by the 
values of the CALC_STND_DEPTH and CALC_STND_HEIGHT system variables. 
This provides a nominal volume for the fixtures that is purely dependent on the Base 
Linear values. 

 Allocated Volume is the Allocated Area for the parent fixtures multiplied by the 
value of the CALC_STND_HEIGHT system variable. It gives a volume within the 
floor plan for reporting purposes that takes into account any aisle space associated 
with the fixtures but which is not dependent on the height of the fixtures. 
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Space Measurement Technicalities 

System Variables Affecting Space Measurement 
The following system variables affect the Space Measurement calculation: 

 CALC_STND_DEPTH 

 CAL_STD_HEIGHT 

These system variables are set in the Administration Module - see the Oracle Retail Macro 
Space Management Administration Module User Guide for more information. 

Imploded and Exploded Planograms 
Planograms can exist in two forms: 2D (imploded) and 3D (exploded). 

 
The example planogram on the left is imploded (2D) and takes the form of a product 
block occupying the volume of the planogram. There is no information on the shelves 
and individual products present. The planogram on the right has been exploded to 3D 
form and contains information on both shelves and individual products. Planograms can 
be changed between the imploded and exploded form in the Merchandiser module. The 
Space Measurement calculation will only return meaningful results for planograms in 3D 
(exploded) form that contain Display Styles. 
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Overview of KPIs 

Overview of KPIs 

Types of KPI 
KPIs are used to color code objects in the Planner and Merchandiser modules and in In-
store Space Collaboration to indicate performance. There are four types of object that can 
be color coded using KPI's. 

 Zones 

 Fixtures  

 Shelves  

 Products  

Because the Planner module does not generally show shelves or products at Display 
Style level, these forms of KPI are not generally used in that module. 

Configuring KPIs 
KPI's are configured in the Administration module. This can only be done by users with 
access to that module. 

Zones 
Zones can be color coded according to performance criteria. In the example below, the 
zones in Planner have been color coded according to the percentage of the available area 
taken up by equipment. As the number of fixtures in a zone increases, the color coding of 
a zone changes to reflect the increasing amount of floor area taken up by equipment. 
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How a zone will color for a KPI in Planner depends on whether it is hatched or not. In 
the screen shot below, the left hand image shows a KPI applied with hatching turned off. 
In this case, the line defining the boundary of the zone will color. In the right hand image 
hatching has been applied. In this case the entire zone will color. 

 
Zone KPIs will also display in the Merchandiser module. Objects not specific to the KPI 
in the Merchandiser module will display in a semi-transparent form. In  the example 
below, the fixtures have been turned semi-opaque. 
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Fixtures 
Fixtures can also be color coded by performance criteria. In the example below from the 
Planner module, fixtures designated as promotional fixtures have been color coded 
differently to standard fixtures. 

 
How Fixtures display in Planner depends on the visual style used. These can be changed 
using the visual style toolbar (shown below the fixtures). 
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The fixtures on the left are shown in conceptual visual style, the ones on the right in wire 
frame. 

Note: If KPI's are displayed in wire frame mode, only the 
outlines of the fixture will color. 

Fixture KPI's will also display in the Merchandiser module. 

 

Fixtures and Coloring for KPIs in Planner 
For fixture KPI's to work in Planner, the AutoCAD blocks used to represent the fixtures 
must have specific properties. Specifically, the block referenced by Fixture Studio must 
have the Color properties set to By Block. This enables individual fixtures to color as 
specified by the KPI functionality. If the Color property is left as the default (By Layer), 
the KPI will not work in Planner. 
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Shelves 
Shelf KPI's are generally only be used in the Merchandiser module. In this example the 
shelves on the fixtures have been color coded according to their performance. Objects not 
specific to the KPI will display in a semi-transparent form. In the example below, the 
fixtures have been turned semi-opaque. 

 

An example of a Shelf KPI might be a book shop giving the performance of the genre of 
books each shelf contains. 
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Products 
Product KPI's can only be used in the Merchandiser module. In this example the 
products on the shelves and fixtures have been color coded according to their 
performance. Objects not specific to the KPI will display in a semi-transparent form. In 
the example below, the fixtures and shelves have been turned semi-opaque. 

 

Applying the KPI 
This section shows how to run a KPI. 

General Information on Using KPIs 
KPIs are controlled from the Toolbar on the Object Browser.  

 
 

Icon Description Purpose 

 

Add KPI Apply the currently selected KPI in the hierarchy to the currently active 
floor plan. 
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Icon Description Purpose 

 

Remove 
KPI 

Clear the current KPI from the floor plan. 

 

Edit KPI Edit the parameters for the currently active KPI. 

 

Refresh KPI Refresh the data for the currently active KPI. 

 

View Data View the data being used in the currently active KPI. 

 
Refresh All Refresh the Object Browser with the latest information from the database. 

When using KPIs, the following rules apply: 

 Only one KPI can be run at a time on any one floor plan. 

 Multiple floor plans can be open. Each open floor plan can have one KPI active. This 
KPI can be different for each floor plan. 

Starting a KPI 
To start a KPI, highlight the required KPI in the hierarchy on the Object Browser then 
click Add KPI on the toolbar. If a KPI is already in use a warning dialog box will appear. 

 
Clicking Yes will cause the current KPI to be replaced. Initiating the KPI will bring up the 
Key Performance Indicator dialog box. This has three Tabs. 

Note: For the Planner module, generally only zone and 
fixture KPIs are appropriate. It is not generally possible to 
display meaningful KPIs or shelves or products at display 
style level. 

Details Tab 
The Details tab allows the user to override the default name for the KPI by typing their 
own name into the Name text box. 
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Stores Tab 
The Stores Tab allows the user to select data from another store and overlay that on the 
current store. It is activated by deselecting the Current Store check box and highlighting 
the required store.  

 
In order to use this functionality, the query that powers the KPI must have been 
configured accordingly. Typically, data used will be general performance data associated 
with (for example) planograms. This data can be associated with the planograms 
physically placed in a new iteration of the floor plan to predict financial performance. 
This requires the SQL statement or stored procedure associated with the KPI to have 
been configured to use this planogram performance data. Selecting a store in the Stores 
tab is therefore only likely to be used for KPIs set up for very specific purposes by 
individual retail chains. 
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Note: As an example of the problems associated with suing 
data from specified stores, KPI's based on Fixture IDs 
(FIX_ID) will not generally work. This is because fixtures in 
different drawings will not have comparable fixture IDs. 
However, planogram performance data can often be used 
because this can be related to the parent fixtures in the two 
different floor plans involved. 

Date Tab 
The Date Tab allows the user to select the date range for time sensitive data. The date 
ranges are linked to those specified in the Calendars option in the Administration 
module.  

 

Date Options 
 Effective Date sets the date to be used in the query to the Effective Date set for the 

floor plan (if previously defined). The Effective Date is set in the File Properties 
dialog box in Store Manager and will be available if the floor plan is at Authorised 
status or later. 

 Current Date sets the date to be used in the query to the date the floor plan was made 
current. This is applicable if the floor plan is at Current status. 

 Other Date enables the user to set a date using the calendar control activated from 
the drop down list. 

 Active Date sets the date to be used in the query to the Active Date set for on the 
Object Browser (if previously defined). 

Data Type 
Data type specifies the date range the selected date is applicable to. The options are: 

 All dates (no date range specified). 

 Year 

 Season 

 Quarter 

 Month 

 Week 



Applying the KPI 

550 Oracle Retail Macro Space Management 

 Day 

Using the Date Options and Data Type 

The date options and data type are used in combination to find the data range required 
or the data. The date is the starting point. This can then be related to a specific calendar 
period containing that date. If for example, the date type is set to Month and the selected 
date is 14th March 2014, the query will return a specific Calendar ID (CAL_ID) from the 
database that can be used to select other data associated with that CAL_ID - for example 
performance data. 

 
How the date options and data type are used depends on the sophistication of the query 
used  

 Simpler queries (generally SQL statements) can be written for specific time periods - 
for example months. If the query is given a title such as Financial Performance 
(Month), the user will know to select Month in the data type drop down list in order 
for the KPI to work correctly. 

 More complex procedures (generally stored procedures) can be written to select the 
calendar period based on the selection made in the data type drop down list. So (for 
example) if the user selected Quarter, the query would look for a CAL_ID in the 
Calendar table specifying the Quarter containing the required date. Conversely, if the 
user selected Month, the query would look for a CAL_ID in the database specifying 
the required Month. 

Note: For more information on the Calendar table see the 
Oracle Retail Macro Space Planning Data Model. 

Availability of Date Related Data 

KPIs based on dates will only work if the correct data is present in, or has been imported 
into the database. For example queries on financial performance will only execute 
correctly if point of sale data aggregated to the correct time periods has first been 
imported into the appropriate tables referenced by the query. 

Starting the KPI 
After the appropriate selections have been made in the Key Performance Indicator dialog 
box, click OK. The KPI will start.  

Viewing the Data 
The Data for the currently active KPI can be viewed by clicking View Data on the Object 
Browser toolbar. 

 
This will bring up the Key Performance Indicator Data dialog box. This contains the 
data used to color code the objects in the floor plan.  
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 The initial column will have an identifier for the object being colored. This will 

generally be a zone, fixture, shelf or product ID. 

 Cost, Price and Movement are not currently enabled. 

 Indicator is the value being used to decide the applicable band that a specific object 
falls into. This may either be a value determined directly from the database or a value 
calculated from a number of database values. 

 Color is the color the object will be color coded relative to the value of the indicator. 

Editing, Refreshing and Deleting the KPI 
KPIs can be edited, refreshed and deleted.  

Editing the KPI 
To edit the KPI, click Edit KPI on the toolbar of the KPI tab of the Object Browser. This 
will bring up the Key Performance Indicator dialog Box. This enables the user to modify 
the options selected when the KPI was initiated. (See the section on adding a KPI for 
more information). 

 
This enables the user to modify the store or date being used to select the data. 
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Refreshing the KPI 
To refresh the values displayed in the KPI, click Refresh KPI on the toolbar of the KPI 
tab of the Object Browser. This will refresh the KPI with the latest values in the database. 
KPIs would normally be refreshed if dates or other data has been changed when the KPI 
was edited. 

Deleting the KPI 
To delete the KPI, click Delete KPI on the toolbar of the KPI tab of the Object Browser. 
The KPI will be removed without further confirmation. 

Tips for KPIs in Planner 
Two types of KPI are generally applicable in Planner: Zones and Fixtures. (It is unlikely 
that Shelf and Product KPI's will be used). There are a number of methods that can be 
used to maximize the visual impact of the KPI. 

Layers 
AutoCAD allows selected layers to be turned on or off. Turning off layers (such as the 
Placeholder layer in order to hide products) may make KPIs appear in a less cluttered 
form. 

Zone KPI's 
Zones can have hatch styles assigned. These can be turned on or off using the options in 
the toolbar of the zones tab on the Object Browser. Assigning a hatch to the zone and 
turning it on for the KPI makes the result far more visible. 

 
In the above example, the zone KPI has hatching turned off for the zone on the left and 
turned on for the zone on the right. 

Fixture KPI's 
Fixtures are often displayed in wire frame mode. In this form, only the outline of the 
fixture is colored. This can make it difficult to see the color of the KPI. By changing to 
Conceptual visual style, the KPI displays in a clearer format (View Menu > Visual 
Styles).  
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In the above example, the upper set of fixtures is in wire frame mode, the lower in 
conceptual style. 
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Quick Reports 

About Quick Reports 
Quick Reports can be called from the View menu in the Planner and Merchandiser 
modules. Because each retailer will have a different slant on the information they wish to 
see during store planning, Quick Reports can be customized to user requirements. They 
are used to provide information on specific aspects of the currently active floor plan. 

 
In the example above, a Quick Report has been configured to show all unpopulated 
fixtures in a floor plan. The store planner can then use the bay number or the highlight 
button on the toolbar to identify the fixtures. 

Forms of Quick Reports 
Quick Reports are of three broad types: 

General Reports 
These are reports that give general information from the database without being 
dependent on a floor plan or planogram being open. The example below shows a Quick 
Report developed to show which floor plans are currently checked out. 

 

Floor Plans 
These are reports that give information on the currently active floor plan. The example 
below shows a comparison between planograms placed in the currently active floor plan 
and the designated prototype store. 
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Planograms 
Quick Reports for Planograms can only be accessed when a planogram design is open for 
review in the Merchandiser Module. This form of Quick Report cannot be accessed from 
the Planner Module. In  the example below, a simple Quick Report has been developed to 
list what products are present on what shelves in each planogram bay. 

 

Quick Reports and KPI's 
Quick Reports and KPIs complement each other. KPI's can be used to visually display the 
same information that a Quick Report can display in tabular form. For example, fixtures 
generating high levels of sales can be seen at a glance - as can poorly performing ones. As 
the KPI shows performance date in bands, it could be complemented by a Quick Report 
showing detailed information for each fixture. 

Configuring Quick Reports 
Quick Reports are completely configurable by implementers or administrators with  
access to the Macro Space Planning (MSP) Database. Information on how to carry out this 
configuration is included with the Macro Space Planning Data Model. Anyone wishing 
to configure will need a good working knowledge of SQL and a detailed knowledge of 
the database schema. 
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What Quick Reports Can Be Used For 
Quick Reports can be used to display any information in the database pertinent to store 
planning tasks. Some examples of potential uses: 

Compliance 
Compliance is verifying that the floor plan does not contain errors that may prevent the 
floor plan being correctly implemented when the floor plan is published and put into 
service. Example Quick Reports that are possible include: 

Aisles 

 Planograms that have a flow direction not appropriate for the aisles they have been 
placed in. 

Equipment 

 Items of equipment that are not due to come into service or will be taken out of 
service when the floor plan is implemented. 

 Fixtures that have not been populated with merchandise or which have multi -placed 
planograms. 

Merchandise 

 Planograms on inappropriate fixtures; for example fixtures of the wrong size or 
wrong temperature range. 

 Multi-placed planograms that require correction. 

Zones 

 Merchandise that is not appropriate for that zone - for example clothing in a Food 
and Drink zone. 

External Information 
External information can be used as a basis for planning the currently active floor plan. 
Examples of such information include: 

 Product Targets: information from an external application such as Category 
Management as to the types and quantities of merchandise that are recommended for 
placement in the floor plan. 

 Comparison with Prototype Store: If a prototype store has been assigned, reports 
could compare the zones, fixtures, merchandise and financial performance of the 
currently active floor plan to its prototype. 

Fixture Attributes 
Customizable Fixture Attributes can be assigned to fixtures in a floor plan. This is done 
using the Fixture Attributes option in the Fixturing toolbar on the Object Browser. 
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These attributes can then be inspected on a 'fixture by fixture' basis in the floor plan by 
another store planner. It may be more convenient to create a quick report summarizing 
the information in the floor plan. 

Performance Metrics 
After Point of Sale data has been imported into the MSP database, this information can be 
used to give a variety of tabulated reports on performance of the currently active floor 
plan. Examples of such performance metrics include: 

 Sales and profit by zone (department). 

 Cumulative sales volume for a fixture. 

 Cumulative sales volume for a fixture expressed relative to the area occupied by the 
fixture and the area of aisle allocated to it. 

 Cumulative profit for a fixture. 

 Cumulative profit for a fixture expressed relative to the area occupied by the fixture 
and the area of the aisle allocated to it. 

 Best and worst performing products in the floor plan. 

Planogram Substitutions 
MSP can automatically substitute planograms in an existing floor plan and then publish 
that floor plan for implementation. Quick Reports could include: 

 Planograms that were substituted and their bay numbers. 

 Signage that will require changing as a result of the substitutions. 

Promotional Fixtures 
Promotional fixtures are fixtures that have been flagged in the MSP database as being in 
a position will generate high sales volumes. Examples include end caps, free standing 
bins for special offers and checkouts holding merchandise designed to induce impulse 
buys. It is possible to generate Quick Reports specific to these promotional fixtures  
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Note: The above list is not exhaustive. Any information in 
the database can potentially be used to give information on 
the currently active floor plan and hence improve some 
aspect of that floor plan. 

Using Quick Reports 
To open a Quick Report, select the Report option from the View menu. 

 

This will bring up the Quick Reports dialog box. The required report can be selected 
from the drop down list. On clicking the selected report, it will open. 

 
On clicking the selected report, it will open. 
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Multiple reports can be open at one time by revisiting the view menu and selecting 
additional reports. 

Dynamically Updating 
Quick Reports do not dynamically update so, once opened, they will progressively lose 
accuracy as changes are made in the floor plan. To overcome this, Quick Reports can be 
instantly updated by clicking Refresh in the toolbar. 

Synchronization 
Quick Reports are based on information currently held in the database. They will not be 
accurate if differences exist between the currently open floor plan and the database. 
Examples of this include changes made to zones with AutoCAD tools and changes made 
to the database with Batch tools. If in any doubt, the Synchronize option should be used 
to ensure the information in the current Planner floor plan and the database is identical. 

Quick Reports Toolbar 
The Quick Reports toolbar has the following options: 

Icon Description Comment 

 

Print 

This option will print the current 
contents of the quick report to the 
default printer for the computer 
MSM is being run on. 

 

Copy to 
Clipboard 

This option will copy the current 
contents of the report to the 
Windows clipboard. From there it 
can be pasted into other 
applications like Excel.  

 

Select report 
This option allows a user to select 
an alternative Quick Report 
without closing the dialog box. 

 

Refresh 

This option refreshes the quick 
report with the latest data held in 
the database. It also clears any 
filters that have been set. 
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Icon Description Comment 

 

Filter 

This filters the data in the report 
to match the data in the currently 
highlighted cell. Multiple filters 
can be used, each refining the 
data. 

 

Highlight in 
Floor Plan 

This option causes the selected 
object to highlight in the floor 
plan. For this to work in Planner 
the Quick report must contain the 
AutoCAD handle. 
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